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This is the third book I have written about using screen reader programs in the Windows environment. The first one was about formatting Word documents. The second one concerned browsing the Internet. I initially thought about continuing writing in piecemeal fashion, perhaps tackling Excel or PowerPoint as standalone projects. But upon further reflection, I thought a book resembling a one-stop shop” would make a more meaningful contribution to the blindness community. Hence, this book endeavors to cover what I consider to be all the basics that a screen reader user needs for using the most important applications in the Windows environment.
When students take science or math classes, it’s a given that they get a textbook. By contrast, screen reader trainees are often pretty much on their own when it comes to finding useful reference material. 
To be sure, a wealth of available training and reference resources exists, but it is scattered about in user manuals, websites, podcasts, YouTube videos, books and technology discussion lists. Unlike an iPhone which is a tightly-integrated environment where a single company controls all the hardware and software, learning how to use a PC with screen readers involves gaining familiarity with your individual desktop or laptop computer, the Windows operating system, one or more screen reader programs, several Microsoft Office software applications, one or more web browsers, and a few other important applications like Adobe Acrobat Reader and Dropbox. Experienced screen reader users are adept at finding what they need, but less experienced users too often remain frustrated and confused. 
My hope is that this book becomes a standard reference for using Windows on the PC with screen reader programs. You might ask whether such a resource has ever existed in the past? As far as I am aware, The answer is no. It is not meant to replace all the other reference resources, but rather to provide a solid foundation, all in a single place. 
Much of the screen reader basic training I conduct takes place over two to four -week time periods. After considerable repetition and refinement, I have sort of developed a script in my head. Much of it is transcribed here. The book covers all that material and extends it, hence its subtitle “All the Basics and More.”
The overall objective of this book is to provide a solid foundation for using Job Access with Speech (JAWS), Non-Visual Desktop Access (NVDA), and Windows Narrator with the most important applications used on the PC. These include the Windows operating system, the four primary Office Suite applications (Word, Outlook, excel and PowerPoint), and the three most commonly used web browsers (Google Chrome, Microsoft Edge, and Mozilla Firefox). Dropbox and OneDrive, two popular Cloud-based file sharing programs, are also covered. So too is Adobe Acrobat Reader for accessing PDF files and Zoom Cloud Meeting for participating in remote teleconferences. 
The book is intended for both beginners and intermediate users. It is hoped that those who already have a fair amount of experience using screen reader programs in the Windows environment will find useful tools and techniques to enhance their skills.
Software versions used in this book include the Windows 10 21H2 build which came out in November 2021, the October 2021 release of Windows 11, JAWS 2021, NVDA 2021.1, and the version of Narrator that came out in Spring 2020, and which has not been significantly updated since. I use Office 365. Where differences exist between the Office 365 licensed version and purchased versions of Office 2019 or 2016, these are noted. Regarding Windows 10 and 11, I discuss differences I have detected, but with the caveat that Windows 11 is only a few months old, and will presumably evolve over the coming months. Therefore, I may have failed to detect some differences, and things may change as Microsoft digests customer feedback on Windows 11. 
I should also mention that the book does not address screen magnification for low-vision users. Nor does it address use of Braille displays for the unfortunate reason that my Braille skills are woefully inadequate. 
The most efficient way to move through this book to find the information you want is to navigate by heading. There are two ways to do this with each of the screen reader programs. First, with JAWS and Narrator, access a list of headings by pressing Insert F6. Normally, you could then Down and Up arrow to move heading by heading, and then press Enter to get into the text at that point. But because this book has more than 500 headings, this is not an efficient way to move around. Instead, after pressing Insert F6, press the letter C to first-letter navigate chapter by chapter. Down arrow to a section that interests you, and press Enter to go to that section in the text. Or if you already know the number of the chapter you want, after pressing Insert F6, press that number on the number row. This brings you to the first section in that chapter. Then Down arrow to the section you want to read and press Enter to get into the text at that point. With NVDA, you can also access a list of headings, but I find this confusing. To learn why I feel this way, see Chapter 3.5.1.
With all three screen readers, you can also switch to a virtual mode in Word. This takes the document out of edit mode and enables you to efficiently navigate by heading level. With JAWS, press Insert Z. You can then press one on the number row to jump chapter by chapter because each chapter title is marked as a level one heading. You can then press two on the number row to skip to each level two heading within the chapters, and so on. The NVDA and Narrator equivalents are called Browse mode and Scan mode, respectively. With both of these screen readers, press Insert and the Spacebar together to activate these modes. As with JAWS, you can then press one, two, etc. to jump by each heading level. To find out more about these navigation modes, see Chapter 3.5.1.
When finished, press Insert Z with JAWS again to turn Quick keys off, or Insert Spacebar to turn off the NVDA Browse mode or the Narrator Scan mode. 
But here’s a little hint. Leave these modes on because this will prevent you from mistakenly typing random text into the book. If you inadvertently place typos in the text, be sure not to save the document when you exit out of it. To exit without saving, press Alt F4, tab to the Don’t save button, and press Enter. 
Throughout this book, you will encounter a number of links to web pages where you can find out more about a particular topic. Assuming your computer is connected to the Internet, press Enter on the link to open the associated web page. With JAWS and Narrator, you can also press Insert F7 to get a list of links. With NVDA, Insert F7 brings up an Elements List. See Chapter 3.5.1 on how to use the NVDA Elements list in Word. 
There are also several footnotes. Presence of a footnote is indicated by a numbered superscript in the main text. To navigate to footnote text, press the Control and Page down keys together to go to the top of the next page. Then Up arrow a few times to the footnote text. With JAWS, you can also navigate to footnotes by turning on Quick keys. To do this, press Insert Z (JAWS will say “Quick keys on”), and navigate to the next and previous footnote by pressing O and Shift O, respectively. 
Here’s how the book is organized. It has ten chapters and three appendices. The First chapter covers basic settings for the three screen reader programs – JAWS, NVDA and Windows Narrator. It also discusses how to access help resources. Chapter Two deals primarily with file and folder management in the Windows operating system environment. I highlight the most significant differences I have detected between Windows 10 and 11 that may be of relevance to screen reader users. The chapter also identifies settings you may want to change when you first get your computer, menu types and dialog box elements you will encounter, text navigation, reading and editing, and options for opening programs. 
The next four chapters cover the Microsoft Office Suite. Drawing on my first book,[footnoteRef:1] Chapter Three covers formatting documents in Word. It provides an overview of ribbon menus and when to use them, as well as a number of useful formatting tools. Chapter 4 covers Outlook, including message basics, attachments, navigating and managing folders, contacts, and the Calendar. The fifth chapter discusses Excel, including elements of basic spreadsheets, formulas, sorting data, and various other operations. Creating PowerPoint presentations is covered in Chapter Six. Different slide and presentation formats are discussed. Strategies for making effective presentations are identified.  [1:  “Format Your Word Documents with JAWS and NVDA: A Guide for Students and Professionals.” Available at: http://www.nbp.org/ic/nbp/WORD-FORMAT.html?id=M8Kz6eGi
] 

Chapter Seven discusses web browsing with Google Chrome, Microsoft Edge and Mozilla Firefox. It draws extensively on my second book. [footnoteRef:2] The eighth chapter returns to the screen reader programs, this time identifying useful customizations used in conjunction with Windows, the Office Suite and web browsers. Chapter Nine covers tools for proofreading and review, including spellchecking, the JAWS Text Analyzer and Speech and Sounds Schemes features, the NVDA Document Formatting and the Narrator Verbosity features, and Comments and Track Changes in Word. The final chapter identifies a set of other useful applications, topics, and tools. Applications covered include reading PDFs with Adobe Acrobat Reader DC, and file sharing with Dropbox and OneDrive. [2:  “When One Web Browser Is Not Enough: A Guide for Windows Screen Reader Users.” It is no longer available because of outdated content.
] 

The book includes three appendices. The first one presents a list of keystrokes to serve as a convenient reference. Appendix II is a glossary with over 100 definitions of computer-related terms. The final appendix provides a set of practice exercises you can complete to hone your skills. 
I would like to thank Greg Donnelly and Dina Rosenbaum, President and Chief Program Officer, respectively, at the Carroll Center for the Blind for providing a wonderful work environment and encouraging me to write this book. Heather Thomas and Bruce Howell, also of The Carroll Center, provided detailed chapter-by-chapter comments identifying mistakes, as well as ways to improve the book and make the text clearer. I cringe whenever I think about what this book would have looked like without their invaluable contributions. 
[bookmark: _Toc58830999][bookmark: _Toc58926337][bookmark: _Toc59171419]I alone am responsible for all errors, inaccuracies, and omissions. That said, this book was finalized in November and December 2021, and all steps and procedures presented here were double-checked then. However, technology is always changing, so some of the text below may become outdated as time passes. It is my intention to regularly update the book. Beyond that, it is my hope that this book becomes a standard reference for screen reader users wishing to become more productive in the Windows environment, as well as for others whose vocation is to help blind people learn how to use assistive technology. 
If you would like to make suggestions on ways to improve the book, new topics for inclusion in future editions, or alert me to errors, I would be grateful for your input. You can contact me by email at david.kingsbury@carroll.org. 
In order for as many people as possible to have access to this book, we at the Carroll Center have decided to distribute it free-of-charge. It is my intention to issue regular updates, revising it to reflect changes in technology and adding sections. This will make it a living document rather than a one-off that loses its relevance in just a short time - a frequent problem with technology books. 
If you appreciate the information you find in the book, the effort it took me to write it, and the sacrifices made by my wonderful colleagues who took time out of their busy schedules to review it, I would be eternally grateful if you made a contribution to the Carroll Center. You can do this using the following link:
DONATE to The Carroll Center for the Blind - Make a Difference
Thank you and happy reading!
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This chapter provides basic information about the three leading screen reader programs used in conjunction with the Windows operating system: Job Access with Speech (JAWS), Non-Visual Desktop Access (NVDA), and Windows Narrator.
What is a screen reader program? This definition comes from the American Foundation for the Blind: “Screen readers are software programs that allow blind or visually impaired users to read the text that is displayed on the computer screen with a speech synthesizer or braille display. A screen reader is the interface between the computer's operating system, its applications, and the user. The user sends commands by pressing different combinations of keys on the computer keyboard or braille display to instruct the speech synthesizer what to say and to speak automatically when changes occur on the computer screen.”[footnoteRef:3] [3:  Cited from: https://www.afb.org/blindness-and-low-vision/using-technology/assistive-technology-products/screen-readers] 

Speech is substituted for vision and keystroke combinations are used for navigation and executing commands in place of the mouse. These keystrokes may be ones created for the screen reader program itself, or they may be Windows-based keystrokes. The vast majority of keystrokes covered in this book are actually Windows keystrokes rather than keystrokes created by screen reader program developers.
I will first cover modifier keys. These are common to all three screen readers. I will then cover the basics of each of the screen reader programs. More advanced topics such as how to customize these programs will be covered later in the book.
1.1 Modifier Keys
Each screen reader program allows you to use up to three modifier keys. A modifier key, when used in combination with other keys, executes a function of the screen reader program. For example, the Insert Key held down together with T reveals the title of the open window for all three screen reader programs.
The three possible modifier keys are the actual Insert key (also known as the Extended Insert key), the Zero key on the number pad, and the Caps lock key. All desktop keyboards have these three keys. Some laptop models lack one or both of the Insert keys. For Narrator, all three modifier keys are set by default. For JAWS and NVDA, the Insert and Num Pad Zero keys are set by default, but you need to manually add the Caps lock key. I will discuss how to do this later in the JAWS section of this chapter.
When the Caps lock key is set as a modifier key, to actually use it for locking and unlocking capital letters, tap it twice quickly to toggle it on and off. For Fusion users running ZoomText and JAWS together, you will need to press the Caps lock key three times rather than twice. In many situations, you will probably prefer to use the Caps lock key with your left hand if the additional combination keys are located on the right side of the keyboard. 
User guides for each of the three screen reader programs also refer to modifier keys as the JAWS, NVDA, or Narrator key. For the remainder of the book, to streamline the text, I will simply say “Insert key” when referring to use of modifier keys. 
1.2 JAWS Basics
To open the JAWS program, press Control Alt J together. To close JAWS, press Insert F4, followed by pressing the Spacebar to confirm.
You must manually set up the shortcut keystroke for opening the program. Unlike for NVDA and Narrator, it is not automatically done as part of the initial installation. To do this:
Press Windows M or Windows D to go to the Desktop.
Press J to go to the JAWS Icon, but do not press Enter on it. This icon is placed on the Desktop during program installation. 
Press the Applications key, Up arrow to Properties, and press Enter. If you are using a laptop computer without a dedicated applications key, press Shift F10 instead (for more on using the Applications key to bring up context menus, see Chapter 2.4.1.3).
Tab twice to the Shortcut key edit box, and type in the letter J (Control and Alt are automatically added).
Tab to the OK button and press Enter.
If a Continue button appears, press the Spacebar.
You should now be done. However, if you do not have administrative rights, you will also have to Enter the administrator’s password after pressing the Continue button.
I am sometimes asked why a blind person would ever want to close JAWS or another default screen reader if having it open is the only way to know what is going on. There are at least three reasons. First, if you use more than one screen reader, you will want to know how to open and exit each one. You will want to exit the currently operating screen reader before opening a new one to avoid voices speaking simultaneously. Second, sometimes your screen reader “misbehaves.” It stops speaking for no apparent reason, reads content incorrectly, or does other strange things. Closing the screen reader and reopening it often solves the problem. And third, you are running another program with its own built-in voice that may conflict with the screen reader voice. Examples are Talking Typer for practicing typing and Kurzweil 1000 for scanning documents. It may be helpful to close your screen reader while running these programs.
It is possible to change the Voice rate, or voice speed, with all three screen readers. With JAWS, you can change both the default Voice rate, as well as change it temporarily as follows:
· To change the default Voice rate, hold down the Control, Windows, and Alt keys together, and then press the Page up and Page down keys to increase and decrease the Voice rate, respectively. As you increase the Voice rate, JAWS will say “faster, faster.” As you decrease it, JAWS will say “slower, slower.”
· The first method for changing the Voice rate temporarily is to hold down the Control and Alt keys together, and then press the Page up and Page down keys to increase and decrease it, respectively. Here too, JAWS will say “faster, faster” and Slower, slower.”
· The second method is used with the Say all or Continuous reading keystroke, allowing you to adjust the Voice rate without interrupting speech. Press Insert and the Down arrow Key together to start continuous reading. Then press the Page up and Page down keys to increase and decrease it, respectively. As you press Page up or Page down, reading will recommence at the top of the paragraph you are currently in.
In this context, “temporary” means that once you leave the window where you have adjusted the Voice rate, either by Alt Tabbing away from the window or closing the window with Alt F4, it reverts back to the default rate.
1.2.1 Basic Settings
These are accessed in the Basic settings dialog. To examine these, you need to get into the JAWS menus. There are various ways to open the JAWS menus. One way is to do the following:
1. Press Windows D or Windows M to go to the Desktop. 
2. Press J to get to the icon for your version of JAWS, and press Enter.
3. Press Enter or Right arrow to open the Options submenu.
4. Press Enter on Basics.
5. Tab through the various settings.
I will only discuss the settings I consider the most important ones you may wish to change. These are listed below in the order in which they are encountered as you Tab through the Basic settings dialog.
1.2.1.1 Automatically start JAWS
This is important if you want JAWS to start speaking during the computer startup and login process. Note that you need to have administrator privileges to make any of these startup changes. 
If you want JAWS to be your default screen reader program and you are not sharing the computer with sighted users, do the following: 
1. Press Enter on this setting which opens a smaller dialog box within the larger Basic settings dialog.
2. You first land on the Automatically start JAWS at the log on screen checkbox. If it is not already checked, press the Spacebar to check it. This ensures that JAWS will start speaking when the Windows log on screen appears.
3. Tab to Automatically start JAWS after log on for all users, and check this checkbox if you are not sharing the computer with sighted users. Even if you are, perhaps still check it and tell them how they can exit JAWS by pressing Insert F4. 
4. Tab to the Start JAWS after log on for this user combo box. Assuming you are the primary user of the computer, Up or Down arrow to Always.
5. Tab to the OK button and press Enter. 
6. JAWS will say “User account control dialog.” If you have administrator rights to make changes to the computer, Tab to the Yes button and press Enter. If you do not have administrator rights, the computer administrator will need to make these changes for you.
This returns you to the Basic settings dialog. Continue tabbing.
1.2.1.2 Prompt to Confirm When Exiting JAWS
This is checked by default, meaning that when you attempt to exit JAWS by pressing Insert F4, you will first be asked if you want to exit JAWS. If you uncheck this checkbox, when you press Insert F4, you will immediately exit the JAWS program. If you are a beginner, you may be more comfortable keeping this checked so that you don’t accidentally exit JAWS. Once you are a bit more experienced, uncheck it to eliminate the step of needing to confirm before exiting.
1.2.1.3 Automatic Notification of Updates
This is checked by default and it is a good idea to leave it this way. JAWS updates are issued every couple of months or so, and contain bug fixes and new features. You should stay up-to-date and performing updates only take a few minutes. You don’t need to do updates immediately, but can wait until a time when it is more convenient. 
1.2.1.4 Run JAWS from System Tray
Checking this does two useful things. First, when you Alt Tab through your open windows, JAWS will no longer appear as one of the windows. I like doing this because it saves me an unnecessary Alt Tab. Second, it adds the option of pressing Insert J to open the JAWS menus. I like this because it is a quick and easy way to open the JAWS menus from anywhere in the computer. 
When you press Insert J, a list of submenus appears, including submenus for options, utilities, languages, and help. Down arrow and press Enter or Right arrow to open one of the submenus.
If you make this change, it will take effect the next time you start JAWS. 
1.2.1.5 Use Keyboard Layout
This combo box has three choices: desktop, laptop, or kinesis. The default is desktop, and Kinesis is a specialized ergonomic keyboard that you would only choose if you had one of them. JAWS keystrokes frequently use keys located on the numeric keypad on the right side of the keyboard. Many laptop computers do not have numeric keypads. But even if you have a numeric keypad, I recommend you choose the laptop option which has two advantages. First, it gives you an additional JAWS modifier key option because it enables the Caps lock key to become an additional JAWS modifier key. This makes it easier to execute JAWS keystroke combinations that require pressing a key with your right hand. For example, it is easier to tell the time by pressing Caps lock with your left hand and F12 with your right hand, than using your right hand to press both the Insert and F12 keys at the same time. Second, you will now need to quickly press the Caps lock key twice to toggle Caps lock on and off. This makes it less likely that you will accidentally turn Caps lock on by mistake. 
I always put computers in laptop mode, regardless of whether I am using a desktop or laptop keyboard. I am not aware of any disadvantages if you choose this option. 
After Up or Down arrowing to your keyboard layout choice, Tab to the OK button and press Enter to save your changes. 
1.2.2 Getting Help
JAWS help resources are extensive and varied, including hot keys providing keystroke lists, a user guide that you can access in various ways, tutorials, and numerous online training resources. I will start with hot keys. 
1.2.2.1 JAWS Hot Keys
While in any application, you can press Insert H and Insert W to quickly get a list of JAWS and Windows keystrokes, respectively. Note that while the Insert and Caps lock keys can usually be used interchangeably, only the Insert key can be used for bringing up the list of JAWS keyboard commands. The Caps lock key will not work. 
This tool can be helpful to both novices and experienced users. For example, if you are on a web page, pressing Insert H brings up a virtual viewer screen that gives you a list of JAWS web navigation keystrokes that range from basic ones like those for headings, links, and form fields, to somewhat more advanced ones like those for frames and placemarkers. When the Virtual viewer appears, it will read continuously. Press the Control key to stop speech and press the Down arrow key to read line by line through the list of keystrokes. You can select and copy text in the Virtual viewer if you want to paste it into a Word document. When finished, you must press the Escape key in order to exit the Virtual viewer and return to the screen you were on. 
Pressing Insert W provides a list of Windows keystrokes for the application you are currently in. Navigate through the list as above. 
Another quick help keystroke is Insert F1. This is called Screen-Sensitive Help. Here too, depending on what application you are in, information for navigating that application is provided. I find it is more helpful for some applications than for others. Examples where it provides particularly helpful information are:
· In Word documents, information on margin dimensions and page header/footer text and page numbering, table navigation.
· At the top of a web page, information on the number of regions, links and headings.
· In JAWS settings menus, explanations of what each setting will do.
Here to, when finished, press the Escape key to exit the Virtual viewer.
1.2.2.2 Help Topics
Unlike with the other two screen readers, the JAWS user guide is not accessed all in one place online. Instead, you access it from inside the JAWS Help menu and is called Help topics. Accessing Help topics is a bit like the story of the blind man and the elephant. Depending on how you approach the Help topics, you will get a view from the trunk, legs or tail. While this makes accessing help more flexible, it also requires some explanation. 
To access JAWS Help topics:
1. Assuming you have set up the JAWS hot key as outlined above, press Control Alt J. 
2. If you hear “JAWS context menu,” press H to access the Help menu. If you do not hear this, press the Alt key to open the menus and then press H. 
3. Down arrow twice to JAWS Help topics and press Enter.
The JAWS Help topics are organized into four views or “pages.” You navigate through them by pressing Control Tab. These four pages are:
· Contents page: A tree view of “books,” sections and individual Help topics.
· Index page: A list of keywords, similar to an index at the back of a textbook.
· Search page: For conducting full text searches. 
· Favorites page: For storing favorite previous searches.
The window for each of the pages is divided into two panes. The left pane is for navigating to Help topics or entering search terms and finding results. Content is found in the right pane. Switch between the two panes by pressing F6. When you navigate to your desired topic in the left pane, you must press Enter on it before switching to the content in the right pane. If you do not do this, the content displayed will be that of the previous topic you accessed rather than the one you want now.
I consider the Contents and Search pages to be the most useful. I will only cover these two pages here. For the Index page, if you do not guess a term that is contained in the index, no results will appear. Regarding the Favorites page, I think it is simply more straightforward to search for terms as they come up rather than maintain a list of favorites. 
As mentioned above, the Contents page is organized in a tree view. See Chapter 2.6.4.5 on how to navigate tree views. The tree view is organized into “books” at level 0. There are 17 books in the JAWS 2021 Help Content page. “Topics” are found at levels 1 and 2 of the tree view. 
When you navigate to a topic that interest you, remember to press Enter on it. Then press F6 to move to the right pane where you can read the content using standard text reading keystrokes. Because the text is presented in HTML format, as on web pages, you can press H here to move to the next heading. You can also press Insert F7 to get a list of links to access related sections of the Help topics. If you would like to access additional Help topics, press F6 to return to the left pane and navigate through the tree view to find another topic. 
To now move to the Search Page, press Control Tab twice. This places you in an edit field where you can type in your search term. Let’s use the example of typing in “Quick Settings.” Now Tab once to the List topics button and press Enter or the Spacebar. Tab one more time to a list of search results. For Quick Settings, there are 87 search results. You can Down arrow through them, or first-letter navigate. Obviously, in this case it is more efficient to press Q for Quick Settings. As above, be sure to press Enter. Then press F6 to switch to the right pane to read the associated content. 
I generally find the Contents page more useful for obtaining information on more general topics. Examples are getting an overview of things like Convenient OCR or Text Analyzer. For more specific concerns, the Search page often gets you to the content you want more quickly. 
1.2.2.3 Other Useful JAWS Help Resources
Additional help resources can be accessed through the JAWS Help menu. For a useful orientation, go to the Help topics Search page and search for Help Menu Overview. Among the most useful additional resources are:
· Commands Search: Use this tool to locate specific JAWS keystrokes. You can also access Commands Search by pressing Insert and Spacebar together and then J. This lands you in a search box where you can type in the term for which you want to get a list of relevant keystrokes. 
· Basic Training: This is a set of nine tutorial modules where you can follow instructions either through text or a recorded voice reading the text. 
· Web Resources: This submenu of the Help menu provides links to various training pages on the Freedom Scientific website. Two pages are especially worth highlighting: Surfing the Internet where detailed information is presented about navigating the web with JAWS; and the Free Training Webinar page where you can listen to and download archived webinars on a wide variety of topics. 
1.3 NVDA Basics
Press Control Alt N to open NVDA. To exit or “quit” the program, press Insert Q, followed by tabbing to the OK button and pressing the Spacebar. When you open and quit the program, NVDA will indicate this with ascending and descending sounds, respectively.
NVDA shortcut keystrokes for increasing and decreasing the Voice rate are Control Insert Up arrow and Control Insert Down arrow, respectively. Unlike JAWS, it is not possible to temporarily change the Voice rate.
1.3.1 Important Settings
To open the NVDA menus where important settings are found, press Insert N. Remember that the Caps lock key is an additional NVDA modifier key. Using that key in combination with N is easier for most people. I will discuss three settings categories where the most important settings are found: General, Speech, and Keyboard. 
To access General Settings:
1. Press Caps lock N, Down arrow once to the Preferences submenu, and press Enter.
2. Press Enter again on Settings. This lands you on the first category which is General. 
3. In this category, Tab to the Show exit options when exiting NVDA checkbox. This is checked by default, meaning that a dialog box will come up when you press Insert Q to quit NVDA. You will then need to Tab once to the OK button and press Enter. If you uncheck it, pressing Insert Q will immediately close NVDA. This is my preference. A descending noise will be heard, providing a clear indication that you are exiting the program. 
4. Tab to the Play sounds when starting or exiting NVDA checkbox. This is checked by default and you should leave it that way. 
5. Tab to the Login level - start NVDA after I sign in checkbox. Check this only if you want NVDA to be your default screen reader. 
6. Tab to the Login level – Use NVDA during sign in requires administrator privileges checkbox. Check this only if you want NVDA as your default. 
7. Tab to the Automatically check for NVDA updates checkbox and leave this checked. NVDA updates are issued roughly every three months and it is good to stay current. 
8. Tab to the Notify for pending update on startup checkbox. Leave this checked for the same reason.
9. Tab to the OK button and press Enter to save changes. 
NVDA uses the voices built into the Windows operating system, as well as one other category of voices. These include: E Speak English, Microsoft Speech API 4 (SAPI 4 for short), Microsoft Speech API 5 (SAPI 5), Windows 1 Core Voices, and No speech.
E Speak English is a synthesized voice that many people, including me, find annoying. For a long time, it was the default voice, as well as the voice you heard when installing NVDA updates. Somebody suggested at some point to change the default installation voice to one of the Windows voices. I am convinced this caused many people to start using NVDA because the E Speak voice was jarring to a large number of potential users. If it was the first thing you heard, and you were unaware that you could change voices, it was enough to cause you to avoid using NVDA. This was the case for me until I got to know the program better and realized I could change voices. 
To access the voices, you need to go to the Speech Settings. Steps are:
1. Press Insert N, Down arrow once to Preferences, and press Enter. Note that I said earlier that I would use the Insert key as a convention for all modifier keys. But for accessing the NVDA menus, you will probably find it easier to press Caps lock N. 
2. Press Enter again on Settings. 
3. Down arrow once to Speech. 
4. Tab once to the Speech properties page where the current voice synthesizer package is indicated. 
5. To switch to another voice package, Tab once to the Change button and press Enter.
6. You land in the Select synthesizer combo box. Up or Down arrow to your new choice and press Enter. 
7. This returns you to the Speech properties page where the new voice synthesizer package is indicated. You can now Tab to change several settings for this voice package. 
8. Tab to the Voice combo box. Here you can Up or Down arrow to select another voice within this package. As you arrow down, you will hear a sample of each voice.
9. Tab to the Rate slider. Press the Left or Right arrow to lower or raise the Voice rate by one percent. Press Page up or Page down to increase or decrease the speed by 10 percent increments. If this is the last setting you want to change, press Enter.
10. Otherwise continue tabbing to the Punctuation level combo box. Up and Down arrow through the choices which include none, some, most, and all. The default is Some. 
11. Tab to the OK button and press Enter. 
The last important initial area to examine in Settings is the Keyboard category. This category contains options that set how NVDA behaves as you type. To access it:
1. Press Caps lock N, Down arrow once to Preferences, and press Enter.
2. Press Enter again on Settings. 
3. Down arrow to Keyboard, and Tab through the options. 
I will cover what I consider to be the more important ones in the order in which they appear as you Tab through the dialog box:
· Keyboard layout: This combo box lets you choose between Desktop and Laptop layouts. Laptop layout behaves similarly to Laptop layout with JAWS (see Chapter1.2.15 above).
· Select NVDA Modifier Keys: The checkboxes in this list are the same as those for the other two screen readers: the Caps lock key, the Insert key on the Number pad, and the Extended Insert key.
· Speak Typed Characters and Speak Typed Words: This is where you make your Typing echo selection. Typing echo is the audio feedback that is “echoed” back to you as you type. Combinations of checking and unchecking these checkboxes gives the four Typing echo options. 
· Characters: Check Characters and uncheck Words. Insert 2 toggles Characters on and off.
· Words: Uncheck Characters and check Words. Insert 3 toggles Words on and off.
· Characters and Words: Check both of them.
· None: Uncheck both of them.
· Speech interrupt for typed characters: If switched on, speech is interrupted each time a character is typed. This is on by default, and you want to keep it on. Otherwise, if, for example, you navigate to a link on a web page, you will need to hear the entire label of the link before pressing Enter to activate it. This has the effect of making your computer sound very sluggish. 
· Speech interrupt for Enter key: If on, speech will be interrupted each time the Enter key is pressed. This is on by default. For the same reason as above, this should not be changed. 
· Allow skim reading in Say all: If on, certain navigation commands (like quick navigation in Browse mode or moving by line or paragraph) do not stop Say all. Instead, Say all jumps to the new position and continues reading. This is unchecked by default. You should press the Spacebar to enable it. 
· Beep if Typing Lowercase Letters when Caps lock is On: Keep this enabled so you are warned when you are mistakenly typing with Caps lock on.
· Speak Command Keys: When enabled, NVDA announces all non-character keys you type on the keyboard (Enter, tab, Alt Tab, Control C, Control X, arrow keys, etc.). Toggle this on and off with Insert 4. I generally keep it on because I want to hear most of these keystrokes (Enter, Control C, Control V, etc.) when I press them. I toggle it off when doing a lot of Up and Down arrowing to navigate text line by line, not wanting to hear “Down arrow, Down arrow, Down arrow” constantly. I hope that some day the NVDA folks either remove this from the list of command keys, or allow a degree of customization so I can get rid of this irritating feature. 
· Play sound for spelling errors while typing: When enabled, a short buzzer sound is played when a word you type contains a spelling error. It is useful if you prefer to correct typing errors as you type, rather than waiting until running Spellcheck.
· After making your changes, Tab to the OK button and press Enter to save them. 
1.3.2 Getting Help
NVDA help resources can be found by pressing Insert N and Down arrowing to the Help submenu and pressing Enter. Here you can find the NVDA user guide and a quick reference guide for commands. Access the online user guide at:
NVDA User Guide
The user guide can be easily navigated by heading. Each chapter is a level one heading. The quick reference guide appears in tabular form so can be navigated using table navigation keystrokes for the web. See Chapter 7.1.2 and 7.1.5 for details on heading and table navigation on the web, respectively.
1.4 Windows Narrator
Narrator is Microsoft’s own screen reader, integrated into the Windows operating system. Although Narrator has been around for a long time, it has only become a credible screen reader in the last several years. Impressive progress has been made to transform Narrator into a viable alternative to JAWS and NVDA. While it does not yet have as extensive a set of features as the other two screen readers, Microsoft has shown a strong commitment to accessibility. 
Control Windows Enter is the toggle for opening and closing Narrator. When you open Narrator, you will hear “starting Narrator.” When exiting, you will hear “exiting Narrator.”
The first time you open Narrator, you land in the Narrator Home page window rather than remaining in the current window. You will probably not want this to happen every time you open Narrator. To turn this off:
1. Press Control Windows N to get into the Narrator Settings menu.
2. Tab to the Show narrator Home when Narrator starts checkbox and uncheck it. 
3. Press Control Windows Enter to exit Narrator and the same keystroke to reopen it to verify that Narrator no longer opens on Home. 
4. If you ever want to open Narrator Home, press Control Windows N, Tab once to Open Narrator Home, and press Enter.
1.4.1 Important Settings
Control Windows N is the keystroke for opening Narrator Settings. Press Tab to move through them. I will discuss below what I consider to be some of the more important settings.
· View the complete guide to Narrator online: Open this to access the Narrator user guide. 
· Start Narrator after sign in for me checkbox: Turn this on only if you wish to make Narrator your default screen reader. 
· Start Narrator for everyone before sign in checkbox: Same as above. Turn this on only if you want to make Narrator your default screen reader. 
· Personalize Narrator’s voice choose a voice combo box: Narrator uses the voices that come with the Windows operating system. Current English voices include two male voices (David and Mark) and one female voice (Sira). If you are going to use more than one screen reader program, use a different voice for Narrator than for the others to avoid confusion about which screen reader you are using. 
· Add more voices link: Open this to download voice packages for other languages.
· Change voice speed slider: Left and Right arrow to decrease and increase the voice speed. As you Left or Right arrow, you will hear the speed adjust. The shortcut key to do this is Insert plus to increase the Voice rate and Insert minus to decrease it. 
· Lower the volume of other apps when Narrator is speaking checkbox: Also known as Audio ducking, this temporarily lowers the volume of competing audio (YouTube videos, Zoom meetings, etc.) while you are typing so you can more easily hear your keystrokes. Keep this checked. I can’t think of any practical reason to disable it. 
· Change the level of detail Narrator provides about text and controls combo box: This is known as “verbosity,” and there are five levels. Press Alt Down arrow to expand this list. You can access the verbosity levels more quickly by pressing Insert V repeatedly to move between the five levels which are: 
· Level 1 - Text only: You hear text with no punctuation or web page controls spoken (links, headings, etc.). On the web, this is especially useful for reading newspaper articles and not hearing unnecessary information. 
· Level 2 - Some control details: Gives a limited level of information on controls in some applications.
· Level 3 - All control details: This is the default level. It gives a full reading experience along with all details about an application’s controls as you interact with them. 
· Level 4 - Some text details: This level gives most text attributes (bold, italics, heading levels, etc.). 
· Level 5 - All text details: This level is best used when proofreading a document to check formatting. It provides complete details about heading levels, font attributes, type and size, bullet shapes, and other formatting. 
· [bookmark: _Hlk62802274]Change what you hear when typing. A series of checkboxes appear, the first two relate to what other screen readers refer to as “Typing echo” (hear letters, numbers and punctuation as you type, and hear words as you type). Similar to NVDA above, different combinations of checking and unchecking them give you the four options: 
· Check the first checkbox for characters only.
· Check the second checkbox for words only.
· Check both for characters and words.
· Check neither to hear nothing as you type.
There are several more checkboxes related to changing what you hear. I suggest retaining the default settings which I indicate by noting on or off: 
· Hear function keys as you type – off.
· Hear arrow, Tab, and other navigation keys as you type – off.
· Hear when toggle keys like Caps lock and Num lock are turned on or off – on.
· Hear Shift, Alt, and other modifier keys as you type - on.
· Select keyboard layout: The default is standard which means that Narrator will use the same modifier keys as JAWS and NVDA. The other choice is Legacy, which is a configuration for older versions of Narrator. Don’t change this. 
· Select Narrator key: By default, both Insert keys and the Caps lock key are enabled. Don’t change this. 
· Get help link: Activate this link if you are having problems with Narrator and wish to request assistance.
Give feedback link: Activate this link if you want to make suggestions on ways to improve Narrator.
While you can Tab through all of the above settings, you can move more quickly by pressing Insert Spacebar to put Narrator in Scan mode. Then you can press H to navigate heading by heading through the Settings categories, which are:
· Start-up options
· Personalize Narrator's voice
· Change what you hear when reading
· Change what you hear when typing
· Choose keyboard settings
· Use Narrator cursor
· Use braille
· Manage your data and services
When you arrive at a heading that interests you, tab through the individual settings under that heading. 
1.4.2 Getting Help
Narrator has an accessible online user guide. You can get to it via the Narrator menu (see previous section), or by going to the following link:
Complete Guide to Narrator
The user guide can be accessed with standard screen reader keystrokes for web browsing (see Chapter 7.1). A table of contents with links to eight chapters and several appendices appears on this page. Sections in each chapter are easily navigated by heading.
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This chapter discusses the Windows operating system environment, including differences between Windows 10 and 11, keyboard and screen layout, the different types of menus you will encounter when executing commands, settings you may wish to change, file management basics, and text reading and editing. 
Windows is the operating system for your computer. In essence, the operating system is the brain of your computer. It is defined by Techterms.com as follows: “An operating system, or "OS," is software that communicates with the hardware and allows other programs to run. It is comprised of system software, or the fundamental files your computer needs to boot up and function. Every desktop computer, tablet, and smartphone includes an operating system that provides basic functionality for the device.”
Windows 10 first appeared in 2015. The new Windows 11 became available in October 2021. The next section discusses differences between the two versions of this operating system.
2.1 Overview of Differences Between Windows 10 and Windows 11
Over the past several years, major updates of Windows 10 have been released twice annually, in the spring and fall. The most recent major update is referred to as Windows 21H2, shorthand for the second half of 2021. Minor updates are released once or twice weekly, and are done automatically. These regular updates are primarily bug fixes and security-related.
With much fanfare, Microsoft rolled out the new Windows 11 operating system on October 5, 2021. Millions of PC users have recently been asking the question “should I upgrade?" The first thing to say is that there is no urgency to quickly switch over to Windows 11. Microsoft will continue supporting Windows 10 with regular updates until at least October 2025. 
The second thing I will say is that, as of the finalization of this book in late 2021, I have not yet encountered any compelling new features that make me want to rush out and upgrade. Nor are there any serious accessibility problems that would compel me to avoid switching over. 
The most significant changes are visual or cosmetic in nature and will not be covered here. Others are, at least in my opinion, not terribly significant, like renaming the Ease of Access Center as the “Accessibility Center.” Or a new set of sound schemes you hear after initiating various actions like installing a new device. Or the intricacies of navigating to places in the Start menu that are more efficiently accessed in other ways.
A few caveats. I have only briefly used Windows 11, so this is by no means a comprehensive list of changes. And as Microsoft receives customer feedback, the company may make changes over the next few months that render some of my current observations out-of-date. 
I will now identify those differences between Windows 10 and Windows 11 that I consider important. First, File Explorer, the app used for file and folder management, has a different menu structure than Windows 10. Windows 10 uses the ribbon structure (see Chapter 2.4.1.1 on ribbon organization and navigation) while Windows 11 has more of a drop-down menu structure. To access the new Windows 11 menu, referred to as the “Command bar,”, first open it by pressing the Alt key. You first land on the New button on the Command bar. You will hear that it is collapsed. Right and Left arrow to various other buttons, some of which are also collapsed. These include Cut, Copy, Paste, Rename, Share, Delete, Sort, View, and More app bar. For any of the collapsed buttons, press the Spacebar to expand them, and Up or Down arrow to the command you want to execute or setting you want to change. A helpful article that provides a detailed overview of the Windows 11 File Explorer menu structure can be found at:
How to Use Windows 11 File Explorer, by Kazim Ali Alvi
Sections of this chapter where the Windows 11 Command bar is referred to include those for showing file extensions, changing folder views, sorting files and folders, and toggling on and off the full folder path display in the Title bar. 
Another difference between Windows 10 and 11 relates to the steps for changing default programs. I consider this a big step backwards. With Windows 10, it is quick and easy to change default web browsers and media players. It is considerably more complicated and time-consuming to do this with Windows 11. Some reviewers criticize Microsoft for deliberately doing this to stifle competition, hoping that people will just stick with Edge and Groove Music, the factory web browser and media player defaults, respectively. I frequently change my default web browser, and greatly appreciate how quick and easy it is to do with Windows 10. Given my own priorities (after all, I wrote a book called “When One Web Browser Is Not Enough”), this is an important reason why I will not be switching to Windows 11 any time soon. You may be happy sticking with Edge, or making a one-time switch to a different browser, so this may not be a deal breaker for you. How to change default programs with Windows 10 and 11 is covered in Chapter 2.5.7. 
It is possible to customize Windows 10 so that you hear the familiar Windows 7 sound when you start up your computer. By default, a new sound is built in when you start Windows 11. See Chapter 2.5.10 on how to enable the startup sound for Windows 10. 
Customizing which apps appear in the System Tray is another area where steps are different between Windows 10 and 11.
Now, let’s get familiar with the Windows operating system in a screen reader environment. 
2.2 Keyboard Help
All three screen reader programs have this feature which helps you learn the functions of important keys on your computer by putting you in a temporary help mode. This is a safe way to explore your keyboard, so that you don’t inadvertently execute unwanted functions. For example, if you press your Delete key, your screen reader will identify the key and say what it does rather than actually deleting something. This is especially useful if you have just acquired a new laptop because the location of important navigation keys varies by laptop model. Their location is more standardized on desktop keyboards. 
Pressing Insert 1 on the number row toggles Keyboard Help on and off with all screen readers. When you do this, JAWS will say “Keyboard Help On/Off.” NVDA will say “Input Help On/Off” Narrator will say “Input Learning On/Off.”
Beyond the keys of the alphabet and the number row, what are those important navigation keys you want to be able to locate on your computer? First is the “six-pack,” so named because it is a cluster of six keys (two rows with three keys each) near the top right side of a standard desktop keyboard. From left to right, the top row includes the Insert, Home and Page up keys. The bottom row includes the Delete, End and Page down keys. These keys tend to be near the top right of most laptop models. For example, most HP models have these as the top right six keys from right to left in the order Page down, Page up, End, Home, Delete and Insert. 
You should also locate the four arrow keys clustered near the bottom right of your computer.
For keyboards with a number pad, when the Num lock key is switched off, you also have the option of using the keys clustered around the Five key. The key above, below, to the left and right of the Five key are the Up, Down, Left and Right arrow keys, respectively. The keys to the left and right of the Up arrow key are the Home and Page up keys, respectively. The keys to the left and right of the Down arrow key are the End and Page up keys, respectively. If this text sounds a bit confusing, it won’t after you turn Keyboard Help on and play around with it a bit.
Starting on the bottom row of your keyboard, at the extreme left, desktop keyboards usually have three keys to the left of the Spacebar (Control, Windows, Alt). Laptop keyboards have four keys (Control, Function, Windows and Alt, with the order of Control and Function flipped for some Lenovo models). Most desktop keyboards have the Alt, Control and Applications key to the right of the Spacebar. Beyond an Alt key to the right of the Spacebar, laptops are not consistent on what is located to the right of the Spacebar. If your laptop has a dedicated Applications key, it will usually be two keys to the right of the Spacebar. However, these days many laptops do not have an Applications key. If this is the case, you must use Shift F 10 instead to access it. 
When using Keyboard Help with Insert 1, and based on default settings for which keys are announced by the three screen readers, NVDA and Narrator do a better job of announcing the keys along the bottom row of the keyboard. As well as a few more. When you press the Control, Windows and Alt keys along the bottom row, JAWS is silent. JAWS also does not announce the Insert and Shift keys when using Keyboard Help. 
Finally, find your Tab and Escape keys which are consistently found near the top left of all keyboards. Also find the Backspace key which is usually located on the right side of your keyboard, somewhere along the second row from the top. 
Why do these keys matter? Sighted people hardly ever use these keys because they navigate with the mouse. As a screen reader user, you will use a variety of combinations involving these keys to substitute for the mouse. 
Once you get familiar with your keyboard layout, you may never use Keyboard Help again. But it is a nice feature when you get a new computer or are using an unfamiliar one. 
2.3 The Desktop
When you boot up your computer, the Desktop is displayed once the startup process is complete. The Desktop includes a set of icons which take up most of the screen, and a Taskbar that spans a bottom strip of the screen. 
2.3.1 Desktop Icons 
Desktop icons represent shortcuts to files, folders, applications and web pages, as well as files or folders you have saved directly to the Desktop. These icons are arranged in columns and rows. They are small files that point to a program, folder, document, or web page. Clicking on a shortcut icon takes you directly to the object to which the shortcut points. Pressing the Delete key on such an icon only removes the shortcut. It does not remove the associated file, folder, or application from your computer. If you have the Deletion confirmation option enabled (see Chapter 2.5.1), and you attempt to delete a shortcut, your screen reader program will ask you if you want to move the shortcut to the Recycle Bin. If you have saved a file or folder to the Desktop, the deletion confirmation message will ask you whether you want to move the file or folder to the Recycle Bin. Be sure that this is what you want to do because, in this case, you are not deleting a shortcut, but the actual file or folder. 
The array of icons on desktops differs from one computer to the next. The only shortcut present on all computers is the one for the Recycle Bin. After logging in, focus is on the Desktop. To quickly access it at any time during your computer session, press Windows D or Windows M. Sometimes you need to press these keystrokes twice to place focus on the Desktop. If you press these keystrokes several times and do not hear anything, it may be because your focus is already on the Desktop. If you are not sure, press Insert T to hear the title of the window. Hopefully, your screen reader will say “Desktop 1.”
To explore which icons are present on your Desktop, press Windows D or Windows M to go there. Now press either Home or Control Home to place focus on the top left icon. Unless you have rearranged the icons, the Recycle Bin icon is usually the top left icon. When you press Control Home, your screen reader will say the name of that icon, as well as how many icons are present on your Desktop. You can now Down arrow to go down the first column of icons. Depending on the size of the icons, screen resolution, and the size of your monitor, there will be somewhere between five and ten icons in each column. When you get to the bottom of a column, you can press the Right arrow to go to the next column and then Up arrow through that column’s icons. 
Arrowing around is a good way to get an idea of which icons are present on your Desktop. However, the quick way to get to the icon you want is to use first-letter navigation. Then press Enter to open the associated file, folder, program, or web page. How to create desktop shortcuts for folders, files and programs is covered in Chapter 2.8.1. Creating them for web pages is covered in Chapter 7.8. 
Pro-actively managing your Desktop will make you a more efficient computer user. Below are a few rules of thumb you should follow:
· Don’t allow your Desktop to get too cluttered. Delete shortcuts for things you rarely or never use. Set yourself an upper limit of 40 or 50 desktop icons.
· Limit yourself to four or five shortcuts for web pages. Reserve these for only those web pages you visit several times each week. For web pages you visit less frequently, create favorites/bookmarks instead (see Chapter 7.7).
· Create shortcuts for folders you will visit frequently, including Documents and Downloads. If you use Dropbox and/or OneDrive, create shortcuts for these too.
· Create shortcuts for files you plan on visiting frequently. For many years, I have had a contact information file shortcut on my Desktop. It is a grab bag of phone numbers, street addresses of friends and businesses. I can easily access it to find contact information, as well as quickly add new information to it. 
· Create shortcuts for files you plan on visiting frequently in the short-term. Let’s say you have a work or school assignment that you will be working on every day for the next two weeks. Create a shortcut to this file so you can quickly access it. Once the assignment is completed, delete the shortcut, leaving the associated file somewhere on your computer. I regularly add and remove shortcuts to files and folders for short-term projects. 
Some people like to reorganize their desktop icons. Others don’t really care because they exclusively use first-letter navigation to access them. Changing the size of icons, as well as reorganizing them, is quick and easy to do. 
Steps for changing icon size are:
1. Press Windows M or Windows D to get to the Desktop.
2. If you land on the top left icon, arrow to any of the other icons (for some reason, the remaining steps won’t work if you start from this icon). 
3. Press Control Spacebar to deselect all icons.
4. Press the Applications key where you first land on the View submenu. 
5. To change the size of the icons, press Enter here, Down arrow to your choice and press Enter. Choices are large, medium, and small. 
To reorder your desktop icons:
1. Repeat steps one through four above. 
2. Down arrow once to the Sort by submenu. 
3. Press Enter to open this submenu where you can rearrange the sort order of the icons. Options include name, size, item type, and date modified. 
I occasionally find sorting by date modified useful if I have recently created a shortcut but can’t remember its name. Sorting this way positions the most recently created shortcuts at either the top left or bottom right of the Desktop, making it easier to find them. 
2.3.2 The Taskbar
With Windows 10, by default, the Taskbar is located along a bottom strip of the screen. It contains the Start button on the left side and the System Tray (also known as the Notification Area) on the right. It also includes the current time on the far right side and a list of recently used apps to the right of the Start button. You can also pin items to the Taskbar, but there are more efficient ways to access them. The Windows 11 Taskbar has a different visual look, but I will not cover it here. 
Much of the taskbar area contains titles for open windows. Whenever you open an application, it shows up in the Taskbar. Sighted people can click on icons for currently open applications, making that window active and appearing in front of other windows. Screen reader users access these windows by holding down the Alt and Tab keys together.
The Start menu appears at the bottom left of the screen. The quickest way to access it is to press the Windows logo key. This opens the Start menu with initial focus in a search box. Here you can begin typing the name of a program, folder, file, or Windows setting you want to access. For frequently visited programs like Word or Outlook, typing just the first letter is usually enough to populate the search box with the desired program name. As soon as you hear the name of the desired program, press Enter to open it. Some people prefer opening programs in this way. Others prefer accessing them by creating desktop shortcuts. Do what’s most comfortable for you. 
You can access the list of programs installed on your computer by pressing the Windows key, and then Down arrowing through the list of All apps. If you open the Start menu and then press the Tab key, you can Down arrow through choices which include your user folder, Documents, Pictures, Settings, and Power. 
The System Tray, also known as the Notification Area in Windows 10, is located in the lower right area of the screen. With JAWS, you can access it by pressing Insert F11. With NVDA and Narrator, press Windows B, and then Down arrow through the list. It displays a series of icons for certain programs, as well as some computer settings, the most important being: 
· Internet connectivity status: This indicates whether your computer is connected to a Wi-Fi network, and if so, the network is identified. 
· Battery level for laptop computers: The percentage charge is indicated, as well as whether the computer is plugged in and charging. If only a percentage level is indicated, the laptop is not plugged in. For some laptop models, an estimated amount of time before the battery runs out is also indicated. 
· Speaker volume: This is expressed as a percentage of the maximum system volume. Knowing that you can adjust volume via the System Tray can be useful if you are working on an unfamiliar computer. To adjust the volume, press Enter on Speaker volume, Down arrow to Open volume mixer and press Enter. This opens an up down slider. Press the Up and Down arrows to adjust volume by one percent increments, Page up and Page down to adjust it by 20 percent increments, or Home or End to maximize or minimize volume. Press Enter to make your change. Note that for each of these steps, you must press Enter. Pressing the Spacebar will not work. 
Finally, with JAWS and NVDA, you can find out the time by pressing Insert F12. Hold down the Insert key and press F12 twice to hear the date with these two screen reader programs. With Narrator, pressing Insert F12 will tell you both the time and the date. 
2.3.3 Customizing the System Tray
You can customize the System Tray to add or remove items. To do this with Windows 10:
1. Press the Windows key to open the Start menu’s search box.
2. Type the first few letters of the word “taskbar,” minus the quotes, and press Enter when you hear “Taskbar settings system settings.”
3. Tab several times to the Notification Area select which items appear on the Taskbar link, and press Enter. 
4. Tab to the Always show all icons in the Notification Area button. If you press the Spacebar to toggle it on, all items (usually 15 to 20) will appear in the System Tray. 
5. Or if you toggle it off, you can then continue tabbing, pressing the Spacebar to check and uncheck those items you want to appear or not appear in the System Tray. Items you should check were mentioned above. There are others you may also wish to check. For example, if you use Dropbox or OneDrive, it is a good idea to check these too. 
6. When finished, press Alt F4 to close this window. There is no OK button here. 
Choosing which icons appear in the System Tray is more complicated to do with Windows 11. Note that it is also referred to as the Taskbar overflow in Windows 11. To change which icons appear in the System Tray, do the following:
1. Press the Windows key to open the Start menu search box, type in Control Panel and press Enter. 
2. First-letter navigate to the Taskbar and navigation link, and press Enter.
3. Tab to the Taskbar corner overflow grouping and press the Spacebar to expand it.
4. Tab once to a list of possible icons to include. 
5. Down arrow through the choices. When you land on a program or setting you want to add or remove from the System Tray, Tab once, and press the Spacebar to toggle it on or off. 
6. Shift Tab once to return to the list, Down arrow to the next item you want to include or remove and repeat the above step.
7. When finished making your selections, press Alt F4 to close this window. There is no OK button to Tab to. 
Open the System Tray by pressing Insert F11 in JAWS or Windows B with NVDA and Narrator, and verify that your changes appear.
As far as I know, if you want all items to appear in the System Tray, it is not possible to do this by pressing a single checkbox as is the case with Windows 10. In addition, network status, speaker volume and battery level for laptops cannot be removed from the System Tray, but this is not a problem because you should always retain them. 
2.3.4 Powering Off Your Computer from the Desktop
Don’t make it your routine to press and hold down the Power button when shutting down. Doing this too often could damage your computer. The best way to power off is to first navigate to the Desktop and then press Alt F4, the same keystroke used for closing other windows. This lands you in a combo box with several choices. Most of the time you land on shutdown. If you Up or Down arrow there are other choices. In order from the top of the list, these are switch user, sign out, sleep, shutdown, and restart. If you choose restart, your computer will power off and then automatically reboot. Update an shut down and update and restart are sometimes also present. 
If you press Enter on shutdown, your computer will power off directly, but only if no windows are open with unsaved files or email messages. If such windows are still open, your screen reader will indicate that shutdown or restart has been blocked. If you want to save anything in these still open windows, Tab to the Cancel button and press Enter. Then Alt Tab to the window with your unsaved work, and save it. 
If you don’t need to save any of this work, you can Tab a number of times to the Shutdown anyways or Restart anyways button and press Enter on it to power off the computer. 
[bookmark: _Toc1629854][bookmark: _Toc40521045][bookmark: _Toc40521218][bookmark: _Toc40521501]2.4 Accessing Commands
On a Windows PC with Microsoft Office, commands are accessed and executed in several ways. Commands can be found in the ribbon system of menus, introduced in Office 2007. One can also access a number of commonly used commands and settings with context menus accessed using the Applications key. Shortcut keys can be used for quickly executing commands. Common examples from earlier in this chapter are Control C, Control X, and Control V for copying, cutting, and pasting files, respectively. Once you navigate to commands via the ribbons or context menus, some commands can be executed by pressing Enter or the Spacebar. Others require that you open a dialog box or submenu and navigate through to modify settings, enter information, and/or execute commands. 
2.4.1 Types of Menus
[bookmark: _Toc1629855]2.4.1.1 Ribbons 
Beginning with the Office 2007 suite, Microsoft introduced ribbons. These have been present ever since for all the Office upgrades: 2010, 2013, 2016, and 2019 (this last being the version used with Microsoft 365 licenses). You will encounter ribbons with Word, Excel, Outlook, and PowerPoint. Ribbons are also present in the Windows 10 version of File Explorer, the Windows 10 application for managing files and folders. 
Ribbon menus consist of an upper and Lower ribbon. The Upper ribbon is opened by pressing Alt. A narrow horizontal strip will appear across the top of the screen. In most cases, the first time you Press Alt during a session, you will land on the Home tab. A tab is a broad grouping of commands. One navigates between the various tabs by using Right and Left Arrow keys. 
From the Upper ribbon, press the Tab key and a second (wider) horizontal strip appears below it with icons grouped in that tab category. This is the Lower ribbon. You navigate from one command to the next by pressing the Tab key. Press Shift Tab to go to the previous command.
By default, both the upper and Lower ribbons are visually displayed, or expanded, for most of the Microsoft applications. The one exception is File Explorer, used for managing files and folders, which is collapsed. That said, you may still find some of these ribbons collapsed that are supposed to be expanded. You need to expand them to make them behave correctly.
To do this, while in the ribbons, press Control F1. Your screen reader should say “ribbons expanded.” Once expanded, they tend to stay that way. 
It’s hard to know if the ribbons are behaving correctly when you are new to them, because you don’t know what correct behavior sounds like. If you press Alt the first time during a session in an Office application, and you land on the File tab, that is a giveaway that the ribbons are collapsed. You will need to expand them. Or, if you try some of the ribbon commands enumerated in this book, and you just can’t get to them, try expanding the ribbons and see if that helps. 
When to use ribbons to execute commands, versus alternative ways, will be discussed more extensively in Chapter 3.1.
2.4.1.2 Drop-Down Menus
A drop-down menu presents a horizontal list of menu areas along a menu bar that you Right and Left arrow across. Some common menu areas are file, edit, and tools. When you press the Up or Down arrow on one of these menu areas, a list of choices will "drop-down" below that menu area. Applications discussed in this book which use drop-down menus include JAWS, Mozilla Firefox, Internet Explorer, and Adobe Acrobat Reader
[bookmark: _Toc1629856]2.4.1.3 Context Menus
Context menus are activated by pressing the Applications key. This is roughly equivalent to right clicking for mouse users. On desktop keyboards, the Applications key is typically the third key to the right of the Spacebar. For some laptop models, it is the second key to the right of the Spacebar. Yet nowadays, many laptop keyboards do not have a dedicated Applications key. Instead, it is necessary to Press Shift F10 to access context menus. Shift F10 works on any computer, including those with a dedicated Applications key. 
[bookmark: _Toc1629859]2.4.1.4 Submenus
A submenu is a nested menu within another menu. They are present in numerous Lower ribbons and in context menus accessed via the Applications key. Unlike dialog boxes, submenus do not have OK and Cancel buttons. They also have fewer types of controls than dialog boxes, limited largely to buttons and edit boxes. 
Submenus encountered in Lower ribbons are opened by either pressing Enter or the Spacebar. You press the Tab and Shift Tab keys to move through them. 
Submenus encountered via the Applications key can be opened by either pressing Enter or the Right arrow, then using the Up or Down arrow to move through your choices. 
[bookmark: _Toc1629858]2.4.2 Dialog Boxes
A dialog box is a window that pops up on the screen with options that you can select. After the selections have been made, you can typically Tab to an OK button to enter the changes. You can press either the Cancel button or the Escape key to discard the selections. The computer is engaging you in a dialogue of sorts. 
2.4.2.1 Dialog Box Elements
A number of different elements or controls typically appear in a dialog box. You navigate through the dialog box by pressing Tab to get to the next control, or Shift Tab to move to the previous one. Your cursor will eventually wrap around. 
If you listen carefully, JAWS does a good job of telling you what element you have landed on and how to navigate it and register information. NVDA and Narrator do this slightly less well. The elements or controls you will encounter are listed below:
· Radio buttons: Use the Up or Down arrow to make your selection, and then Press Tab to move to the next element of the dialog box.
· Edit boxes: Type in text like your name, street address, etc.
· [bookmark: _Hlk59386512]Combo boxes: This is a drop-down list. Use the Up or Down arrow or first-letter navigate to your choice. You can also Press Home or End to move to the first or last choice in the list, respectively.
· Edit combo boxes: A hybrid of edit boxes and combo boxes. You can Press the first letter, or several letters of your choice, and then use the Down arrow to quickly navigate to your selection. You can also type in the full word or number. NVDA and Narrator are less consistent than JAWS in identifying these, sometimes saying Just “edit” rather than “edit combo.”
· Edit spin boxes: Use the Up and Down arrow to select a preset numerical value, or you can type it in manually. Edit spin boxes always involve numerical values, while edit combo boxes may involve numerical values or words.
· Checkboxes: Press the Spacebar to check or uncheck choices.
· Left/right sliders: For adjusting percentage values along a continuum. Press the Left and Right arrow to lower and raise by one percent, respectively. Press Page down and Page up to raise by a larger percent (ten or 20 percent, depending on the slider), and Home and End to maximize or minimize the value. An example is adjusting the JAWS Voice rate in the Voice Settings dialog box. 
· Up/down sliders: For adjusting percentage values along a continuum. Press the Down and Up arrow to lower and raise by one percent, respectively. Press Page down and Page up to raise by a larger percent (ten or 20 percent, depending on the slider), and Home and End to maximize or minimize the value. An example is adjusting the computer’s speaker volume accessed via the System Tray.
· Buttons: Press Enter or Spacebar to activate. 
· Split buttons: If you Press Enter or Spacebar on a split button, this will execute the default change. If you Press Alt Down arrow, this will expand a list and you can choose from several other options using the four arrow keys. When you navigate to a split button via the ribbons, JAWS will clearly indicate this, saying “press Alt plus Down arrow for more options.” NVDA will say “split button collapsed,” but will not prompt you to Press Alt Down arrow to access more options. 
· [bookmark: _Hlk528946946]List views: Contains multiple items such as files or folders, allowing you to select desired items with the Arrow keys or first-letter navigation. The Save As dialog box has a list view for selecting the folder where you wish to save a file. 
· Tree views: Organizes folders into a hierarchical view allowing the folder structure of your computer to be represented. Use the Right arrow to open or expand a folder, the Left Arrow to close or collapse a folder, and the Up and Down arrow to move within a folder level. The Save As dialog box has a tree view for navigating the folder hierarchy of your computer.
2.4.2.2 Multi-page dialog Boxes
Some dialog boxes are split into several pages. One example is the Paragraph dialog box. With JAWS, you will know if you have landed in a multi-page dialog box if JAWS says the word “page.” For example, when you land in the Paragraph multi-page dialog box, you will first hear “indents and spacing page.” Press Control Tab once and you will hear “line and page breaks page.” NVDA does not indicate this when you first land in a multi-page dialog box, but will do so once you start pressing Control Tab.
A variation on multi-page dialog boxes can be found in the Options dialog box of each of the Office applications, which is situated in the File tab (shortcut: Alt F T). When you open it, focus starts in a category list. You can use the Down arrow, or first letter-navigate to the category you want. When you use the Arrow keys to get to a category, the rest of the dialog box changes to show the options in the selected category. Do not Press Enter or Spacebar because this will just exit you from the dialog box. Instead, press Tab to move through the options as you would in a typical dialog box.
2.5 Important Initial Settings You May Want to Change
If you just purchased your shiny new computer, there are several settings you will want to change. The first five in this section are crucial for making your computer work effectively. These are the factory defaults related to showing deletion confirmations, unhiding file extensions, and if you have a laptop, switching the FN key to classic functionality and disabling the Touchpad. You will also need to connect to the Internet via a local Wi-fi network. In situations where you need to navigate to the Control Panel to change some settings, you should change to Large icons view for remaining steps to work correctly. 
The remaining items are more a question of personal preference. 
2.5.1 Showing Deletion Confirmations
By default, when you press the Delete key on a selected file or folder, the files go to the Recycle Bin without any warning. This is dangerous because you can inadvertently delete files and folders without knowing it. To turn on the deletion confirmation setting:
1. Press Windows M or D to go to the Desktop.
2. Press R until you get to the Recycle Bin icon.
3. Press the Applications key, Up arrow once to Properties, and press Enter.
4. Tab several times to the Display delete confirmation dialog checkbox and press the Spacebar to check it.
5. Tab to the OK button and press Enter.
Now when you press the Delete key on a file, you should hear “Delete file dialog, are you sure you want to move this file to the Recycle Bin?” You land on the Yes button, so press Enter or the Spacebar to confirm. 
2.5.2 Unhiding File Extensions
A file extension, or Filename extension, is a suffix at the end of a computer file. It comes after the period and is usually three to four characters long. File extensions for Microsoft Office versions from 2007 and newer are: DOCX for Word; XLSX for Excel; and PPTX for PowerPoint. 
When you receive a new computer, you should change the default factory setting for showing file extensions which is set as off. Hearing the file extensions will make it easier to distinguish files from folders because folders don’t have extensions. To do this:
1. Navigate to a folder with lists of folders and files in it. The Documents folder is a good place to go.
2. Press the Alt key to open the File Explorer Upper ribbon.
3. Right arrow to the View tab on the Upper ribbon.
4. Tab several times to the Filename extension checkbox and press the Spacebar to check it. 
Now when you arrow down to a file, you should hear its extension. 
2.5.3 Switching the FN Key to Classic Function Key Use on a Laptop
Laptop computer keyboards (and some desktop keyboards) use the FN key to switch between different uses of the function keys: Classic use of the F1 to F12 keys; and special actions related to audio volume, playback, and hardware features. On most laptop models, the FN key is located just to the right of the lower-left Control key. However, for many Lenovo laptops, the FN key is the bottom left key. 
Screen reader users need their function keys to be set for Classic function key use. If this is not the case, you will need to press the FN key and F1 through F12 in combination with other keys in order to execute common commands. If, for example, you attempt to close the current window by pressing Alt F4, tell the time with Insert F12, or the Spellcheck a Word document with F7, and don’t get the expected result, chances are that the FN key is set incorrectly. While you can press the FN key in combination with these keystrokes, it is awkward and inefficient.
When you get a new computer, the function keys may or may not be set for Classic use. If not set for Classic use, you need to make this switch. Depending on your laptop model, you may be able to change it by either hitting the FN key together with the Shift key, the Escape key, or the Caps lock key. Try these keystroke combinations. Then with any of the three screen readers, try telling the time by pressing Insert F12. If one of these keystroke combinations works for switching to Classic function key use, be sure to remember it because you might mistakenly toggle it off in the future. 
If none of these key combinations work for changing FN key functionality, seek advice from the vendor or manufacturer who sold you the computer, or the state blindness agency that gave it to you. You may be required to go into the laptop’s Basic Input/Output System (BIOS) and change it. The BIOS is a pre-installed program that the computer uses to start up. It checks all your hardware connections and locates all your devices. If all is well, the BIOS loads the operating system into the computer's memory and finishes the boot-up process. Because the BIOS begins operating before any of the screen reader programs start up, it is not accessible. You may need sighted assistance to change FN key functionality. Ideally, this person should be tech savvy, because going into the BIOS is not something that should be attempted by novices.
2.5.4 Disabling the Touchpad on a Laptop
A touchpad is a flat control surface used to move the cursor and perform other functions on a laptop computer. Located below the Spacebar, it replaces the functionality of a mouse and is controlled with your finger. By sliding your fingertip along the surface, you can move the cursor on the screen. Some touchpads have two rectangular keys below them, which correspond to the left and right mouse clickers, respectively. 
If your touchpad is enabled, it is hard to avoid brushing your palm over it. This will make your cursor shoot around in a document window or switch to another window. You will find this annoying and frustrating. To stop this from happening you will need to disable your touchpad. But it is important to also know how to reenable it in case you need assistance from a sighted person. Without resort to a touchpad or mouse, even the most tech-savvy sighted person will have a hard time helping you. 
How to disable/enable the Touchpad varies by laptop brand and model. Fortunately, for many laptop models, it is easy to do. Try the following:
1. Press Windows to open the search box.
2. Type in the first few letters of touchpad until you hear “Touchpad settings system settings,” and then press Enter.
3. If you land on the Touchpad button and it is switched on, press Enter to disable it. Then press Alt F4 to exit this window.
4. To verify that it is disabled, move your fingers around on the Touchpad or press one of the Touchpad clickers. If nothing happens, then it is disabled.
To reenable the Touchpad, repeat the steps above. 
For some laptop models manufactured by HP, tapping twice near the upper left corner of the Touchpad toggles it off and on. 
If none of these disable your touchpad, consult the manufacturer or the store where you bought it. 
In the worst case scenario, disabling the Touchpad must be done in the BIOS (see Appendix III for its definition) and this is not accessible. If you find this out prior to buying a laptop, don’t buy it. In my opinion, this is a serious enough drawback to disqualify the model from consideration.
If you have purchased such a laptop, a possible workaround is to attach a cheap mouse via the USB port. Hopefully you can then find a setting that overrides and disables the Touchpad when a mouse is connected to the computer. Just place the mouse somewhere out of the way. 
Sometimes, the Touchpad reenables itself without you having done anything. If this happens, simply disable it again. 
2.5.5 Connecting to a Wi-Fi Network
When setting up your computer, one of the first things you will need to do is to connect to your home Wi-Fi network. If using a laptop and traveling, you also need to know how to do this to connect to networks in those other locations. 
There are two types of networks: secure networks which are private and for which a password is required; and public networks, which do not have passwords. Your home network will be a secure network. 
Steps for connecting to a network are:
1. Press Windows I to get into Windows Settings.
2. Tab once, Down arrow to Network and Internet, and press Enter.
3. Tab once, Down arrow to Wi-Fi, and press Enter.
4. Tab to the Show available networks link and press Enter.
5. Down arrow through the list of nearby networks. As you Down arrow, each network will be designated as either secure or public. Press Enter on the network to which you want to connect
6. Tab once to the Connect automatically checkbox and press the Spacebar to check it. This avoids having to rejoin the network the next time you turn on your computer. 
7. Tab to the Connect button and press Enter. If you are connecting to a public network, you are done. Press Alt F4 to close the window.
8. But if you are connecting to a secure network, you will now be asked to type in the password for that network. 
9. Press Enter after typing in the password. You are now connected to this secure network. Press Alt F4 to close the window.
If the name of your desired network does not appear, go to the bottom of the list, and press Enter on Hidden. Here you can type in the network name and complete the steps above to connect to it.
2.5.6 Changing the Control Panel View
The Control Panel is a place where users can modify system settings and many other things related to operation of the computer. In several sections of this book, you will be instructed to go to the Control Panel to change some settings. You should change the Control Panel view to either small or large icons for remaining steps to work correctly. 


To change the view:
1. Press the Windows key to open the Start menu search box, type in the first few letters of “Control Panel,” and press Enter when you hear it.
2. Tab once to the Category button and press the Spacebar.
3. Down arrow to either the Small icons or Large icons button and press Enter.
You will now be able to Down arrow or first-letter navigate through the list of items (expressed as “links”) and press Enter to activate them.
2.5.7 Changing Default Programs
As mentioned earlier in this chapter, procedures for changing default programs for applications like web browsers and music players are quick and easy with Windows 10 and more tedious and time-consuming with Windows 11. I will cover steps for doing this with Windows 10 first. 
Among the default applications you can easily change with Windows 10 are those for Email, audio players, and web browsers. The Windows 10 factory defaults are the native Mail app for Email, Groove Music for music or audio players, and Edge for web browsers. First, what does it mean for these to be your default applications?
If you press Enter on the link for an email address you find in the body of an email message, that email address will be placed in the To field of your default mail program. If you have Outlook on your computer, you will want to change this from the native Mail app to Outlook. 
Pressing Enter on a file with an audio extension like MP3, WAV, or WMA will open that file in the default media player. If you prefer to use an app other than Groove Music, you can change the default to Windows Media Player or another popular audio app like WINAMP or VLC if you have installed these. 
Regarding web browsers, Microsoft Edge is the factory default. The version that came out in January 2020 is fully accessible and gaining quickly in popularity. That said, you may prefer Google Chrome or Mozilla Firefox. 
Note that for apps that are not native to Windows 10, you will need to install them before they can appear as additional default options. 
To change these defaults:
1. Press the Windows Key to open the Start menu, placing focus in the search box.
2. Type the first few letters of “Default app settings system settings.” As soon as you hear these words, press Enter. 
3. You first land on Email, with the name of the current default app identified. Again, the factory default is Mail.
4. Press Enter or Spacebar. A pop-up appears. Tab to your new default choice, presumably Outlook, and press Spacebar to select it. 
5. Tab several times to Music player. Groove Music is the factory default.
6. Press Enter or Spacebar. A pop-up appears. Tab to your new default choice, and press Spacebar to select it. 
7. Tab to Web browser. Microsoft Edge is identified here as your default.
8. Press Enter or Spacebar, Tab to your new default choice, and press Spacebar to select it. 
9. Press Alt F4 to close this window (there is no OK button to activate). 
Using web browsers as an example, here are the steps for changing programs with Windows 11. 
1. Press the Windows Key to land in the search box.
2. Type the first few letters of “Default app settings system settings.” When you hear these words, press Enter. 
3. Tab several times to the Set default applications list box.
4. Down arrow to the browser you want for your default. You must Down arrow. First-letter navigation does not work in this list. Press the Spacebar on your choice to select it. 
5. Down arrow to HTTP, and Edge will be identified as the current default if this is the first time you are changing it. 
6. Press the Spacebar which opens a pop-up. Tab to your new choice and press the Spacebar to change the default browser for this. 
7. Tab to Set default file types or link types. 
8. Down arrow to HTTPS and repeat the above step. 
9. Also repeat the above steps for.htm,.html, and any other web-related file types you use. 
While in this settings area, if you plan on using Acrobat Reader as your default PDF viewer, change your default for this file type too.
Follow similar steps if you want to change your default music player from Groove Music to some other app like Windows Media Player, WINAMP, or VLC. Common audio File types to change include.MP3,.WAV,.WMA, and a few others. 
2.5.8 Turning Off the File Path Display in the Title Bar
If, for example, you are in the Documents folder and you press Insert T to hear the title of the window, sometimes the factory default is to give the full path rather than the name of the folder. For example, your screen reader may say “C:\Users\David\Documents,” rather than simply “Documents.” While there are occasions when it is helpful to hear the full file path, usually it is more verbosity than you prefer to hear. To turn this off in Windows 10, do the following:
1. Navigate to the Documents folder because you first need to be in a list view of folders and files in order to change the setting. 
2. Press the Alt key to open the Upper ribbon, left arrow once to the File tab, Down arrow to Options and press Enter. The ribbon shortcut for this is Alt F O, but it does not work consistently.
3. Press Control Tab once to go to the View Page of this multi-page dialog box.
4. Tab to the Advanced settings tree view.
5. Down arrow to Display the full path in the title bar. If it says “on,” press the Spacebar to toggle it off.
6. Tab to the OK button and press Enter.
If you have turned off the full file path display, but now want to hear it, you can do this by pressing Alt D to find it on the Address bar. 
Steps for turning on or off display of the full path in the Title bar with Windows 11 are:
1. Press the Alt key to open the Command bar, Right arrow to the More apps button, and press the Spacebar to expand it.
2. Down arrow to Options and press Enter.
3. From here, follow steps 3 through 6 above. 
[bookmark: OLE_LINK2][bookmark: OLE_LINK3][bookmark: OLE_LINK4][bookmark: OLE_LINK7]2.5.9 Turning Off the Backstage View in Office Applications
Changing this setting is not as critical as some of the ones above, but you may prefer to do it. When you first open Word, Excel, or PowerPoint, instead of immediately landing in a blank document, worksheet, or presentation, you land in something called the “Backstage view.” A list of buttons appears. You can either press the Spacebar or Escape to get into an environment where you can start working. But, if instead, you prefer to get right into a blank document, worksheet, or presentation every time, you can turn off the Backstage view in each of these applications as follows: 
1. Open Word, Excel, or PowerPoint, and press the Escape key to get out of the Backstage view. 
2. Press Alt F T, which is the shortcut key to get into the Options menu for each of these applications. Be sure to press these keys separately, not all together.
3. You land in a list of categories, the first one being General, which is the one you want.
4. Tab several times to the Show the start screen when this application starts checkbox and press the Spacebar to uncheck it. 
5. Tab to the OK button and press Enter. 
2.5.10 Enabling the Windows Startup Sound
While not entirely necessary, some people long for the days of Windows 7 when a familiar chime played during startup. For screen reader users, the chime provides an added layer of assurance that the computer is starting up properly. In Windows 10, this has been removed as a default setting. If you want to enable it, steps are:
1. Press Windows I to get into Windows Settings.
2. Tab once, Down arrow to Personalization, and press Enter.
3. Tab once, Down arrow to Themes, and press Enter.
4. Tab to the Windows sounds default button and press the Spacebar.
5. Up or Down arrow to Windows default, Tab to the Play Windows startup sound checkbox and press the Spacebar to check it. 
6. Tab to the OK button and press Enter.
Now restart your computer to verify that the old familiar startup sound plays. 
If you want to disable the startup sound, repeat steps one through four above, uncheck the Play Windows startup sound checkbox, Tab to the OK button and press Enter.
For Windows 11, a startup sound has been incorporated by default, so you don’t need to set it up. 
2.6 File Management Basics
File Explorer is the Windows application for file management. You can use it to navigate through your files and folders, as well as organize them. 
2.6.1 The Folder Structure of Your Computer
It is important to fully understand the folder structure of your computer. This knowledge provides the foundation of much that follows. Understanding your computer’s folder structure will make your life easier for the following reasons:
· You will be less likely to “lose” files when saving them.
· You will be more confident when downloading files from the Internet. 
· You will be more comfortable managing external devices like thumb drives and external devices that you use with your computer like Victor Reader Streams. 
· You will be more confident using Cloud sharing applications like Dropbox and OneDrive. 
· You will be more likely to back up your work onto external devices once you see how easy it is to do. 
· You will do a better job of organizing your files into folders so you can find them more quickly.
Let’s now take a tour through the various levels of your computer’s hard drive. We will do this using a list view of your folders and files. With a list view, you go down a level by pressing Enter. Within a level, you can Up and Down arrow, first-letter navigate, and press Home and End to go to the top and bottom of the list, respectively. To go back up one level, you can press the Backspace key, Alt Left arrow, or Alt Up arrow.
1. Begin by pressing the Windows key and typing “This PC” in the search box. Usually, typing just the first one or two letters suffices to bring this up. Press Enter.
2. Either Right arrow or Down arrow and you will hear names of several folders contained in your User folder. Among these are Desktop, Documents, Downloads, Music, and Pictures.
3. Stop when you hear Devices and drives. If it also says “collapsed,” press the Spacebar to expand it. 
4. Down arrow or Right arrow. Depending on your computer model, you may hear it say Windows C, O SC, Local Disk C, or something else followed by C. Whichever it is, all will end with C because the C drive is your computer hard drive. Remember the first letter so you can use first-letter navigation to get to it more quickly in the future. 
5. To the right or below of the C drive are listed other drives like a DVD drive if you have one. You will also hear the names of other drives if you currently have something connected via one of your USB ports.
6. Press Enter on your C drive and this will bring you to the next folder level. Unless you are a technician, you will never visit most of the folders at this level. However, a few are worth mentioning. The folders and files that make up the various programs installed on your computer are located in the Program Files and Program Files (X86) folders. You may never visit these, but it can be useful to know where they reside. 
7. Down arrow to the Users folder and press Enter to go to the next level in your folder structure. 
8. A number of individual user folders are listed in this folder. By far the most important is your own user folder, usually named for you. Press Enter here to access your user folder.
9. Down arrow and you will hear the names of about a dozen folders. Among the most important are:
· Documents- By far your most important folder. This is where you will store files that you create like Word documents, Excel spreadsheets, and so on. Unless you specify otherwise, all Office files you create are saved to this folder.
· Downloads: Unless you specify otherwise, files downloaded from the Internet go here by default.
· Favorites: Favorites created in Internet Explorer are saved here. With the demise of Internet Explorer, this folder is no longer important. 
· OneDrive: If you have a OneDrive account for cloud file sharing, those files will be located here. Similarly, if you maintain a Dropbox account on your computer, a Dropbox folder is also located in your user folder.
· Music, Pictures, and Video folders are also contained in your user folder. You may or may not use these. If you have lots of music or photos, you may prefer saving them to these folders to avoid cluttering your Documents folder with them. 
10. Now arrow up or down to the Documents folder and press Enter.
11. Folders and files you have created are listed here. At the top of the list, folders appear alphabetically from A to Z. Under these, files not in folders are listed A to Z. We will return to the Documents folder soon and spend some time there.
12. Now press the Backspace key to go back up one level, returning to your User folder, with cursor focus on Documents. The computer remembers the path you took. 
13. Backspace again to ascend to the Users folder with focus on your user folder.
14. Backspace one more time and you land in the C drive folder with focus on Users.
Backspace one final time to return to the This PC folder. 
15. Press Alt F4 to exit File Explorer.
Now repeat the steps, this time going more quickly by using first-letter navigation. 
1. Begin by pressing the Windows key, typing in the first couple of letters of This PC and pressing Enter.
2. Press the first letter associated with your C drive and then Enter.
3. Press U for Users and then Enter.
4. Press the first letter of your User folder name and then Enter.
5. Press D a couple of times until you get to Documents and then press Enter.
With regard to ascending up through the folder hierarchy, in addition to backspacing, you can also press Alt Left arrow or Alt Up arrow. Backspacing or Alt Left arrowing behave similarly. However, there is a subtle difference between backspacing/Alt Left arrowing versus Alt Up arrowing. Pressing Alt Left arrow or Backspace works as described above if you went down through a folder path to arrive there. However, if you did not follow a folder path, nothing will happen if you press either of these keystrokes. 
By contrast, pressing Alt Up arrow will move up a level in the folder hierarchy, regardless of how you got there in the first place. For example, if I began by pressing Enter on my desktop shortcut to Dropbox and then pressed either Alt Left arrow or Backspace, nothing would happen because I didn’t follow a folder path to get there. But if I pressed Alt Up arrow instead, this would move me up one level in my folder hierarchy, landing in my user folder because my Dropbox folder resides there. 
2.6.2 Creating Folders, Selecting, Copying, Cutting and Pasting Files
You will be more efficient if you get in the habit of organizing your files in folders. At least initially, you will probably do most of this work in your Documents folder. As mentioned above, by default, the Documents folder is sorted alphabetically with folders at the top of the List view, and files not in folders underneath. You can navigate through the List view by pressing Home and End to quickly go to the top and bottom of the list, respectively. You can also up and Down arrow through the list, or first-letter navigate. 
To create a new folder, press Control Shift N (or the ribbon shortcut Alt H N), type in the name, and press Enter. The folder will now be placed alphabetically within the list of existing folders. If you ever want to rename it, press F2, edit the text, and press Enter.
Copying or moving files into folders involves three operations:
· Selecting the file or files.
· Copying or cutting them to the Clipboard.
· Navigating to the folder where you want to place them, and then pasting them.
Single or multiple files can be selected. 
For single files:
1. Up or Down arrow or first-letter navigate to the file you want to copy or move. Placing focus on it with your cursor selects it. If it is the first file in the list, and it is not already selected, you can also press the Spacebar to select it.
2. Press Control C to copy the file, or Control X to move it. JAWS will say “copied or cut selection to clipboard.” NVDA will say “Control C or Control X.” Narrator will say “C copied or X cut.”
3. Navigate to the folder where you want to place the file and press Enter to open it.
4. Press Control V to paste the file. JAWS will say “pasted selection from clipboard.” NVDA will say “Control V.” Narrator will say “pasted.”
To select contiguous files, that is, multiple files that are above or below each other in the list:
1. Navigate to the first file you want to select, as above.
2. Hold down the Shift key and Down arrow to select the additional files you want to select. Your screen reader will say “selected” and the names of these additional files. If you go too far, with the Shift key still held down, Up arrow and your screen reader will say “unselected.”
3. Repeat the steps above to copy or cut the files and paste them. 
To select noncontiguous files, that is, selecting some while skipping over others:
1. Navigate to the first file you want to select, as above.
2. Hold down the Control key and Down arrow past the files you don’t want to select. Your screen reader will say “not selected” and the file name for each one you go past.
3. With the control key still held down, press the Spacebar on those files you want to select. Your screen reader will say “Control space.”
4. Repeat the steps above to copy or cut the files and paste them. 
For the above two operations, if you let up the Shift or Control key in the middle of the process, and then start arrowing again, this unselects everything you have already selected. You will need to start over again.
A few other useful file and folder selection keystrokes are:
· Control A: Select all files and subfolders within a folder.
· Control Shift Home: Select from the file or folder where your cursor is focused to the top of the list within a folder.
· Control Shift End: Select from the file or folder where your cursor is focused to the bottom of the list within a folder.
2.6.3 Deleting Files, Folders, and Using the Recycle Bin
Periodically clean up your computer by deleting files and folders you no longer need. This is a two-step process: moving them to the Recycle Bin and permanently deleting them from inside the Recycle Bin. 
To move files or folders to the Recycle Bin, select them as outlined above and press the Delete key. If it is a single file, Your screen reader will say, “Delete file dialog, are you sure you want to move this file to the Recycle Bin?” Press the Spacebar to confirm. If you have selected multiple files, your screen reader will say the number of files selected. If you are deleting folders, your screen reader will indicate that they are folders. 
If you press the Delete key and the files simply go away without any deletion confirmation message, be sure to turn this deletion confirmation setting on following the steps outlined in Chapter 2.5.1. If you leave this turned off, you risk inadvertently deleting files and folders without knowing it.
You can permanently delete files and folders in the Recycle Bin. You can also restore files and folders to their original location if you mistakenly delete them. However, note that if you delete files and folders from an external device such as a thumb drive, they will be permanently deleted. You can’t get them back.
To access the Recycle Bin, press Windows M or D to go to the Desktop, press R to get to the Recycle Bin icon, and press Enter. To permanently delete individual files or folders, down or Up arrow to that file or folder and press the Delete key. Your screen reader will ask you if you want to permanently delete this file or folder. Press the Spacebar to confirm. Press Control A to select all files and folders if you want to empty the Recycle Bin, and then press Enter to confirm. You can also empty it by pressing the Applications key on its Desktop icon, Down arrowing to Empty Recycle Bin, and pressing Enter.
If you want to restore a deleted file or folder to its original location, Down arrow to that file or folder and press Enter. You land on a Restore button. Press Enter or Spacebar to confirm. Then press the Escape key to return to the Recycle Bin.
2.6.4 Folder Views
When you open most folders with a list of files in them, by default, subfolders within that folder are sorted alphabetically by name at the top of the list, with files not in folders sorted alphabetically below the subfolders.[footnoteRef:4] There are also various views for arranging files and folders. Views include details, list, tiles, content, small, medium large, and extra large icons. I will largely limit discussion to the Details and Large Icons Views. [4:  One notable exception is the Downloads folder. By default, this folder is sorted by date, with the most recently downloaded file or folder at the top  of the list. I prefer this sort mode for downloads because I usually want to deal with the item just downloaded right away, and I can easily find it. ] 

2.6.4.1 Details View
For most folders, or more precisely, for folders primarily containing documents and audio files (as opposed to pictures or videos), the default View is the Details View, and it is generally the most useful and accessible one. For folders containing primarily documents, this view not only displays the filename, but also the date it was last saved or revised. For folders containing primarily audio files, This view displays the filename, and music-related information like title, contributing artists, and album. For this information to be meaningful, it assumes the file’s author has properly tagged it to include this information. 
The List view is also accessible, but only provides the file name. 
It is best to start in the Documents folder to examine the Details view. To view this information:
1. Down arrow to a file. You will hear the filename with its extension, assuming it is set to hear the file extension (see Chapter 2.5.2). 
2. Right arrow once to hear the date and time the file was last modified.
3. Right arrow again to hear the file type.
4. Right arrow one last time to hear the file size in kilobytes or megabytes. 
Knowing when a file was last modified can be useful for verifying that you are working on the latest version of a document, or that it saved properly the last time you revised it. Knowing the size of a file can be useful if you are thinking of attaching it to an email message and there is a size limit on attachments, or you want to clean up your folders. 
If you arrow up or down to a folder, you can Right arrow to hear the date modified and that the type is “folder.” However, you will not hear its size. With NVDA and JAWS, you can also get the size information by checking its properties. To do this:
With your cursor focus on the folder, press the Applications key, Up arrow once to Properties, and press Enter. With NVDA, one of the types of information you will hear is the size of the folder. With JAWS, once you start hearing various properties spoken, press Insert B and you will also hear the folder size. As far as I know, it is not possible to detect folder size with Narrator. 
You can also access Properties by pressing Alt and Enter together.
In addition, you can change the information provided in the Details View. I often do this in folders predominantly made up of audio files because I don’t find the displayed items very useful. Default items in the Details view are name, number, title, contributing artist, and album. Unless I am organizing a music database, the only item I consider of any use is the name of the file. I would like to hear the date of the file and its size, but these do not appear by default. The quickest way to have the same information displayed in the Details view for documents is as follows:
1. Place your cursor focus on the folder where you want to change the elements displayed in the Details view.
2. Press the Applications key, up arrow once to Properties, and press Enter (shortcut for Properties is Alt Enter).
3. Control Tab to the Customize page of this multi-page dialog. You land on the Optimize this folder for combo box. 
4. Up or Down arrow to Documents.
5. Tab to the Also apply this template to all subfolders checkbox and press the Spacebar if you want this version of the Details view to apply to subfolders.
6. Tab to the OK button and press Enter.
2.6.4.2 Large Icons View
The default view for folders made up predominantly of pictures and videos is the Large Icons view. This is useful for sighted computer users because it allows them to preview pictures and photos by seeing an image of it. This view is of little use to screen reader users with limited or no usable vision. Moreover, this view can be confusing if you are unaware of it. Filenames are arranged in a grid which means that if you up and Down arrow, you will only hear the first file in a row of files, thus failing to detect most of them. The other icon views (small, medium, and extra large) behave in a similar fashion. To detect all the files, right and left arrow instead of up and Down arrowing. If you Right arrow, when you reach the end of a row, it will wrap around to the next row. You can also switch to the Details View and then up or Down arrow through the list of files. 
2.6.4.3 Changing Views
With Windows 10, to switch from the Large icons view to the Details view:
1. While in the folder with pictures or videos, press Alt to open the Upper ribbon in Windows File Explorer. You should first land on the Home tab. If instead, you land on the File tab, this means that your ribbons are not maximized. Press Control F1 to do this. Otherwise,  the remaining steps will not work.
2. You should first land on the Home tab. If instead, you land on the File tab, this means that your ribbons are not maximized. Press Control F1 to do this. Otherwise,  the remaining steps will not work.
3. From the Home tab, Right arrow twice to the View tab on the Upper ribbon.
4. Tab into the Lower ribbon to the Layout Toolbar change your view drop-down. It will also say Large Icons, indicating that this is the current view for the folder.
5. Press Enter which opens a grid with several rows of choices. If you Down arrow once, and then Right arrow once, you should land on Details (your screen reader program says “details grid”). If this does not get you there, try different combinations of the four arrow keys to find it.
6. Press Enter on Details grid to switch to that view.
You can make this the default view for all folders containing files of this type as follows:
1. While in this same folder after having change the view, press the Alt key to open the Upper ribbon.
2. Left arrow to the File Tab, Down arrow to Options, and press Enter. The shortcut key is Alt F O, but it does not work consistently. 
3. Press Control Tab once to go to the View Page of this multi-page dialog box.
4. The first place you land, your screen reader will say “You can apply this view to all folders (such as details or large icons) to all folders of this type, apply to folders button.”
5. Press the Spacebar and you will be asked “Do you want all folders of this type to match this folder's view settings?”
6. Press the Spacebar on the Yes button to confirm.
7. Tab to the OK button and press Enter. 
While this seems to work for changing from one view to another, it does not seem to work for permanently changing the items shown in the Details view. When I have tried to permanently do this for folders with audio files, the changes do not remain saved. You may get better results by using the method I outlined above for changing the elements displayed in the Details view for individual folders and their subfolders.
To switch from the Large icons view to the Details view using Windows 11:
1. While in the folder with pictures or videos, press Alt to open the Command bar.
2. Right arrow to the View button and press the Spacebar to expand it.
3. Down arrow to Details and press the Spacebar to switch to this view. 
To make this the default view for all folders containing files of this type, steps in Windows 11 are:
1. While in this same folder after having change the view, press the Alt key to open the Command bar, Right arrow to the More apps button, and press the Spacebar to expand it.
2. Down arrow to Options and press Enter.
3. This opens a multi-page dialog box. Press Control Tab once to go to the View Page of this multi-page dialog box.
4. The first place you land, your screen reader will say “You can apply this view to all folders (such as details or large icons) to all folders of this type, apply to folders button.”
5. Press the Spacebar and you will be asked “Do you want all folders of this type to match this folder's view settings?”
6. Press the Spacebar on the Yes button to confirm. 
7. Tab to the OK button and press Enter. 
2.6.4.4 Sorting Files Within Views
As mentioned at the beginning of this section, by default, folders are sorted alphabetically by name at the top of the list, with files not in folders sorted alphabetically below the folders. You can change this to sort by type of file, size of file and various other criteria. You can also sort by ascending and descending order. For example, the default for sorting by name is ascending, or in other words, alphabetically by folder and file name from A to Z. 
With Windows 10, to change the sort criteria while in a given folder:
1. Press Alt to open the Upper ribbon, Right arrow to the View tab, Tab to the Sort by drop-down, and press Enter. Remember to have your ribbons maximized by first pressing Control F1.
2. Down arrow through the options and press the Spacebar on the sorting criterion you would like to switch to. 
3. If you want to switch between ascending and descending, it is quicker to Up arrow and press the Spacebar to make this change. 
You may have had the experience of opening a folder and for some mysterious reason unknown to you, discovering that the folder is “upside down,” with the Z files at the top of the list and the A files at the bottom. Use the Sort By drop-down to change from descending order back to ascending. 
I sometimes temporarily change to sort by type, if I want to bunch all my Excel, Word, or PDF files in one place. Then I change back to sort by name, keeping this as my default.
To change the sort criteria while in a given folder with Windows 11:
1. Press Alt to open the Command bar, Right arrow to the Sort button, and press the Spacebar to expand it.
2. Down arrow through the options and press the Spacebar on the sort criterion you would like to switch to. 
3. If you want to switch between ascending and descending, it is quicker to Up arrow and press the Spacebar to make this change. 
2.6.4.5 Folder Tree Views 
A tree view organizes folders into a hierarchical view allowing you to navigate through folder levels from left to right. However, unlike list views, tree views cannot be used to navigate to and open individual files. Common places where you encounter them include the Save As dialog box for saving files, the Outlook folder structure, and JAWS Help topics.
Moving from left to right, the tree view hierarchy is displayed as levels 0, 1, 2, 3, and so on. Use the Right arrow to open or expand a tree view level, the Left Arrow to close or collapse it, and the Up and Down arrow to move within a tree view level.
[bookmark: _Toc1629861]2.7 Text Reading, Navigation and Editing
2.7.1 Reading and Navigation
The following keystrokes are used for reading and navigating text in the body of Word documents, Outlook messages, and pages on the Internet. Where JAWS, NVDA, and Narrator keystrokes differ, this is noted. 
· Right/Left Arrow: Move to and read characters to the right and left of the cursor.
· Control Right/Left Arrow: Move to and read the next and previous word. 
· Down/Up Arrow: Move to and read next and previous line.
· Control Down/Up Arrow: Move to and read next and previous paragraph.
· Insert Down arrow: JAWS and Narrator Say all command or continuous reading from the point of the cursor. 
· Insert A: NVDA Say all command or continuous reading from the cursor when NVDA is set in Laptop keyboard mode. 
· Control Home: Move to the top of the document or web page.
· Control End: Move to the bottom of the document or web page.
· Home: Move to the start of the line.
· End: Move to the end of the line.
· Control Page up/Down: Move to previous and next page in Word. 
[bookmark: _Toc1629862]2.7.2Text Selection and Basic Editing
Most of the above keystrokes, when combined with the Shift key, select the corresponding text. Text selection keystrokes are:
· Shift Right arrow: Select characters to the right.
· Shift Control Right arrow: Select words to the right.
· Shift Down arrow: Select current line.
· Shift Control Down arrow: Select current paragraph.
· Control A: Select the entire document or web page text.
· Shift Control Home: Select from the cursor point to the top of the document or web page.
· Shift Control End: Select from the cursor point to the end of the document or web page.
· Shift Home: Select from the cursor point to the start of the line.
· Shift End: Select from the cursor point to the end of the line. 
Once you have selected text, basic editing keystrokes are:
· Control C: Copy selected text.
· Control X: Cut selected text.
· Control V: Paste selected text.
· Delete: Delete selected text.
Cut, paste, and delete functions are not applicable to web pages and other “read only” environments.
If you select text and then want to deselect it, press any of the four Arrow keys, or the Home or End keys. It is important to note that if you select text and then hit, say, a letter, the selected text will be replaced by that letter. Ditto for pressing the Spacebar, Tab, and a number of other keys. If you do this mistakenly, immediately Press Undo (Control Z) to cancel this keystroke and restore your selected text. 
2.7.3 Understanding Cursor Logic When Editing
When deleting and inserting individual characters, it is important to understand the logic of cursor behavior. Knowing how your screen reader talks to you when doing this will help you avoid frustration, as well as make you more efficient and productive. TO get a sense of cursor behavior and the resulting screen reader feedback, do the following:
1. Type the word “chat,” minus the quotes.
2. Left arrow back until you hear the letter C.
3. Press the Delete key. You will hear the letter H. You have removed the letter C, and the word “hat” remains.
4. Position your cursor on the letter A and press the letter E. This places this letter before the letter A, now giving you the word “heat.”
The Backspace key removes the character before the announced character. Do the following:
1. Place the cursor on the letter E in “heat.”
2. Press the Backspace key. You will hear the letter H which you have just deleted, leaving the word “eat.”
Many people, including me, are more comfortable backspacing out characters because it is more intuitive to hear the character you are removing rather than the character just after the one you deleted. Whichever your preference, the important thing is to understand the cursor logic and what your screen reader is saying to you. 
Here’s another little cursor idiosyncrasy worth understanding. If you are now left with the word “eat on the line, you might logically think there is no way to place text after the T in “eat.” After all, T is the last character on the line, so if you arrow to that letter and all new text goes before the T, how can you possibly place text after the letter T? The answer is that, after typing “eat,” a carriage return code is automatically placed after it. Right arrow once past the letter T and your screen reader will say something sounding like “blank.” Because this carriage return code is present, you can continue typing, for example, adding the letters I N G to compose the word “eating.”
You can also select text and type replacement text over it. If I have misspelled a word, rather than do the individual character editing steps above, I often find it quicker to select that entire word with Control Shift Right arrow and then retype the correct word right over it. One other thing: note that when you select a word, the space just after the word is also selected, so edit accordingly, to be sure the right number of spaces are present after the word.
2.8 Opening Applications and Individual Files
There are numerous ways to open applications and individual files. One way to open an application installed on your computer is to press the Windows key to bring up the Start menu where you first land in a search box. Begin typing the name of the application until you hear its full name. Then press Enter. 
To open an existing file previously created in an application, navigate to that file in whichever folder it is located and press Enter. The file will open in its default program. Files with a.docx file extension will open in Word, files with a.xlsx extension will open in Excel, and files with a.PPTX extension will open in PowerPoint. 
2.8.1 Desktop Shortcuts for Files, Folders and Applications
You can create shortcuts for files, folders, applications, and web pages, enabling you to quickly open these items from the Desktop. I will cover the first three here. See Chapter 7.8 on how to do this for web pages.
Steps for creating desktop shortcuts are the same for individual files and folders:
1. Navigate to the file or folder for which you want to create a shortcut, but do not open it. 
2. Press the Applications key.
3. Down arrow a number of times to the Send To submenu and press Enter or the Right arrow to open it. Alternatively, after pressing the Applications key, press N to get into this submenu more quickly. 
4. Down arrow to Desktop create shortcut, and press Enter.
5. To verify, press Windows D or Windows M to go to the Desktop and first-letter navigate to the new shortcut. It will have the name of your file or folder followed by “-shortcut.”
6. To edit the shortcut, press F2 which is the Rename keystroke. When finished editing, press the Enter key to retain your edits. Press Escape instead if you do not want to keep the edits.
To create a desktop shortcut for an application:
1. Press the Windows key and type in the name of the application until you hear its full name. Do not press Enter.
2. Press the Applications key, Down arrow to Open file location and press Enter. This places your cursor on the shortcut file for opening the application. This file is buried deep in your Programs folder, a place that would be very difficult to find otherwise. 
3. Press the Applications key again, arrow down to the Send To submenu and press Enter or the Right arrow to open it. 
4. Down arrow to Desktop create shortcut, and press Enter.
5. To verify, press Windows D or Windows M to go to the Desktop and first-letter navigate to the shortcut
2.8.2 Creating Shortcut Keys for Opening Programs
Once you have added a desktop shortcut for a program, you can also define a shortcut key, also referred to as a hotkey, for quickly opening that program from anywhere on the computer. This hotkey will be a combination of Control Alt plus some letter or number you add. However, avoid choosing a key combination that will conflict with key combinations used in other contexts. For example, if you chose Control Alt 1 for some application, you will no longer be able to use that key combination in Word for creating a level one heading or in Outlook for switching to the Day View in the Outlook calendar. Also avoid Control Alt N because this is the hotkey for opening NVDA. Also be aware that if you delete the Desktop shortcut for that program, the hotkey will no longer work.
If you have ever created the Control Alt J hotkey for starting JAWS, the procedure is exactly the same for other programs. We will use Word as an example, setting the hotkey as Control Alt W. If you already have a shortcut for Word on the Desktop, do the following:
1. Press Windows M or Windows D to go to the Desktop.
2. Press W to go to the Word Icon.
3. Press the Applications key, Up arrow to Properties, and press Enter. This opens the Shortcut page of the Word Properties dialog.
4. Tab twice to the Shortcut key edit box, and type in the letter W (Control and Alt will automatically be added).
5. Tab to the OK button and press Enter.
6. If a Continue button appears, press the Spacebar.
You should now be done. However, if you do not have administrative rights, you will also have to Enter the administrator’s password after pressing the Continue button.
Now press Control Alt W from anywhere on the computer and Word should open.
If you do not have a shortcut for Word on your Desktop, do the following instead:
1. Press the Windows key and begin typing in “Word” until you hear its full name. Do not press Enter.
2. Press the Applications key, Down arrow to Open file location and press Enter. 
3. Repeat steps 3 through 6 above to define the hotkey. 
2.9 Saving Office Documents
Rule Number One of document preparation is to save early and often. Some people mistakenly think that saving is the last thing you do after typing the text, spellchecking, and editing. This is a recipe for potential disaster. Follow this path and your own goof ups, inexplicable crashes, your screen reader abruptly going silent for no apparent reason, and other acts of God could cause you to lose hours of work. Get into the habit of doing an initial save just a couple of minutes into working on your document. When you pause to take a breath, reflexively press Control S to update your save. Now when your computer misbehaves, the worst outcome is that you have lost a couple of minutes of work, rather than a couple of hours or more.
For Word documents, Excel workbooks and PowerPoint presentations, initial file saving is performed in the Save as dialog box. 
To perform an initial save, press F12 to open this dialog box. 
You land in an edit field where a filename is proposed, appearing as follows for each of the three Office Suite programs:
· Word: the Filename edit field is prepopulated with a proposed filename, including the entire first line or a segment of that line, followed by the default.docx extension. If you are happy with this, press Enter and the file will be saved to your default folder for saving documents, usually the Documents folder. If you wish to give the file another name, simply type over the proposed name and press Enter to save it to the default folder.
· PowerPoint: the Filename edit field is prepopulated with a proposed filename, which is the text you have inserted in the Title placeholder of the Title slide, followed by the default.pptx extension. Here too, if you are happy with this, press Enter and the file will be saved to your default folder for saving documents. Otherwise, type in a new title and press Enter. 
· Excel: the Filename edit field is prepopulated with a generic filename (Book1, Book2, etc.), followed by the default.xlsx extension. You will want to rename this, typing over the prepopulated text to give it a filename reflecting the file’s content. Pressing Enter then saves it to the default folder. 
If instead of saving to the default folder, you want to save the file to a subfolder of the default folder, after pressing F12 press Shift Tab twice to get to a list view of these subfolders. Now Down arrow or first-letter navigate to the subfolder where you want to save the file. Press Enter to get into it. Now press Tab twice to go back to the filename edit field where you first landed in the Save As dialog box. Press Enter and the file will be saved in this subfolder. 
There are a couple of other useful places in the Save as dialog box worth examining. After landing in the Filename edit field, Shift Tab three times to land in a tree view which you can navigate through Using the keystrokes mentioned earlier in this chapter. Begin Right arrowing through the various tree view levels to see where your file is located. This can be useful if you are currently in the file and can’t remember exactly where you saved it. The tree view maps the folder path. 
You can also use the tree view to quickly save the file to another folder on your computer other than the Documents folder or one of its subfolders. For example, let’s say you want to save the file to the Music folder. Do the following:
1. Press F12 to open the Save as dialog box.
2. Shift Tab several times to the tree view. 
3. Press M until you hear “music,” and press Enter. You may hear “enter,” or you may hear nothing at all, but this locks it in. 
4. Tab once to the List view of folders and files contained in the Music folder. 
5. If you want to save your file to one of the subfolders in the Music folder, Down arrow or first-letter navigate to that folder and press Enter. 
6. If you simply want to save your file to the Music folder, and not to any of its subfolders, ignore the step above.
7. Tab to the Filename edit box where you first landed after opening the Save as dialog box, and press Enter to save the file in this new location. 
You can also save files in formats other than the default format. To do this:
1. Press F12 to open the Save as dialog box.
2. Tab once to the Save as type combo box, and Down arrow to your file format selection. File type choice options differ from one application to the next.
3. Shift Tab once back to the Filename edit box (where your new file extension has been added to replace the default extension) and press Enter to save it.
After the initial save, press Control S to save any subsequent changes you have made in the document. As stressed above, save early and often. Make frequent updating into a reflex. It’s your best defense against losing large amounts of work.
If you start working on a document, and want to exit it without saving it, press Alt F4 and then Alt N. This will close the document window without saving it.
2.10 Tips for Finding “Lost Files”
You will be less apt to lose files if you understand the folder structure of your computer and are comfortable navigating the Save as dialog box. Yet, even then, there will be times when you simply cannot remember the name of a file you created a few days ago, or you have forgotten where you saved it. Here are a couple of ways to retrieve these hard-to-find files. 
If you can remember one or two words in the filename, open the Start menu and type in those words in the Search field. Note that typing upper or lower case letters does not matter when performing searches. If you are lucky, the entire filename will populate the search box. If it does not, Down arrow through the various categories (which, depending on the words you have typed in, may include find results on the web, in folders, apps, and others), until you arrive at Find results in documents. If you find the file here, press Enter if you want to open it. If instead of opening the file, you would just like to know its location on your computer, with Windows 10, you can Right arrow once, Down arrow to Open file location, and then press Enter. This will place your focus on the file where it is situated in your folders. You can now press Insert T to hear the name of the folder where it is located. You can also press Alt D to go to the Address bar and hear its full folder path. 
Note that the Open file location option is not currently available in Windows 11 for files. 
In addition, after Right arrowing in the Start menu, you can Down arrow just below the Open file location choice to copy the file path to the Clipboard and press Enter on it. You can then open Word or some other text editor and paste the full file path there. For example, I searched for a meatball recipe on my computer and was able to paste the following file path: “C:\Users\david\Dropbox\Training files\Recipe for Meatballs.docx.” This works with both Windows 10 and 11. 
If you cannot remember anything about the filename, in Word, Excel, and PowerPoint, you can find recently used files as follows:
1. In the relevant Office application, press Alt F R to open the Open file dialog.
2. Tab several times to Pin files you want to easily find later.
3. Down arrow through the files, which are listed chronologically starting with the most recently opened file at the top of the list.
4. Press Enter on the desired file if you want to open it. 
Or press the Applications key, where there are additional choices, including, open file location, open a copy, delete file, copy path to clipboard, and a few others.
2.11 Identifying the Current Version of Your Software
If you are having a problem with a specific software application, you will want to know what version you are using before asking for help. That will be the first question any technical support person will ask you. There are various ways to find out this information. Some work better than others depending on what screen reader you are using, or for which software application you are trying to identify the version. 
Windows 10 updates every spring and fall with a new build. To find out which Windows 10 semi-annual build you are using, press the Windows key, type in “winver” minus the quotes, and press Enter. You will then hear “Microsoft version 20H2” if you are using the Fall 2020 version. Or you may instead hear 2004 (Spring 2020), 1909 (Fall 2019), or 1903 (Spring 2019). 
If you are using JAWS, with focus in the window for a particular application, press Control Insert V and JAWS will indicate the version of that software. 
However, Control Insert V works poorly for identifying your Microsoft Office version. The information given is vague. Instead, from inside any of the Office Suite applications, press the keys Alt F D A consecutively. This brings you into the About Account section of the File Tab and clearly identifies your version of Office. For example, if you are in Word and press this keystroke combination, you will hear “Word 365, Word 2016 or Word 2019,” clearly indicating which version you are running.
To find out your JAWS version, get into the JAWS menus using any of the approaches identified in Chapter 1.2 and then press H (for the Help menu) and A (for About). The JAWS version and most recent update will be announced. 
Regardless of which screen reader program you are using, for many software applications that use standard drop-down menus (Adobe Acrobat reader is one example), try pressing Alt to open the drop-down menus, press H, and then A for About, and the version will be announced. 
[bookmark: _Toc58831001][bookmark: _Toc58926339][bookmark: _Toc61188500][bookmark: _Toc88666512][bookmark: _Toc89178569][bookmark: _Toc89179296][bookmark: _Toc90034557][bookmark: _Toc90034687][bookmark: _Toc90201421][bookmark: _Toc90459027][bookmark: _Toc91081650][bookmark: _Toc91241380][bookmark: _Toc91585879][bookmark: _Toc92278040]To find out your version of NVDA, press Caps lock N to get into the NVDA menus and then press H (for the Help menu) and A (for About). The NVDA version is announced.
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This chapter covers the basics of formatting Word documents. Much of the text is drawn from my 2019 book entitled “Format Your Word Documents with JAWS and NVDA: A Guide for Students and Professionals.” It is available from the National Braille Press Book Store. The web address is Format Your Word Documents with JAWS and NVDA, by David Kingsbury
I begin with an overview of the ribbon menus. This section is relevant for all Office applications. The chapter covers all basic document formatting areas, as well as some more intermediate-level topics. It also discusses saving documents with the Save As dialog box and some other useful tools. Spellchecking and proofreading are covered in Chapter 9.
3.1 Ribbons in Word and When to Use Them
A general overview of Ribbon menu structure and navigation was presented in Chapter 2.6.1.1. Here are more specifics on the Word ribbons. Word Upper ribbon tabs (and shortcut keys for getting to them more quickly) include:
· File (Alt F)
· Home (Alt H)
· Insert (Alt N)
· Design (Alt G)
· Layout (Alt P)
· References (Alt S)
· Mailings (Alt M)
· Review (Alt R)
· View (Alt W)
· Help (Alt Y)
A number of context-specific tabs will also appear when you format tables, pictures, and various other things. For example, if your cursor is situated in a table and you press Alt to open the Upper ribbon, as you press Right arrow two additional Table Tools tabs will appear: a Design tab and a Layout tab. These two tabs contain commands specific to table formatting. 
[bookmark: _Toc1629857]When should you use the ribbon menus? The short answer to this question is “it depends.” First, some background, and then, a couple of examples. 
Why was the ribbon structure introduced in the first place? The answer has some bearing on strategies for how screen reader users access commands. For sighted users, many more commands are readily visible in the Lower ribbon than in a typical menu bar with a drop-down menu. This is because of the horizontal layout of the Lower ribbon. Over 40 commands are readily visible in the Lower ribbon of the Home tab. So many commands cannot fit onto the screen for a drop-down menu, which is a narrow vertical strip. While a sighted user can easily point and click on whatever command icon they wish to activate, the screen reader user may be required to press Tab many times to get to the same place. This means that, at least for some commands, learning the shortcut key or accessing a command via the Applications key is a better choice. It depends on the command and how often you think you will use it. To tease out the pros and cons of using the ribbons, the options for accessing the Font dialog box and the Margins submenu are good examples.
The Font dialog box can be accessed in three ways: In the Home tab Lower ribbon; via the Applications key context menu for Word; and by pressing the shortcut key. I will talk about these options from the least efficient to the most efficient in terms of numbers of keystrokes. 
The least efficient way to access the Font dialog box is through the ribbon menus. This involves:
1. Pressing Alt to access the ribbon menus, either landing on the Home tab or Pressing the Left arrow one or more times if you land elsewhere on the Upper ribbon. 
2. Pressing Control Right arrow twice to get to the Font group.
3. Pressing Tab about 15 times to get to the Font dialog box launcher and Pressing Enter. 
This totals about 20 keystrokes, which is not very efficient. 
A far quicker way to get to the Font dialog box is to go in via the Applications key as follows:
1. Press the Applications key, or Shift F10 if your keyboard does not have an Applications key.
2. Press the Down arrow several times to get to Font and press Enter.
This totals only four keystrokes, clearly preferable to the ribbon option. 
The shortcut key for accessing the Font dialog box is Control D, which is obviously the most efficient way to navigate into the Font dialog box. 
By definition, shortcut keys are always the most efficient way to execute a command. Does this mean that you should use up lots of brain cells to memorize loads of shortcut keys? Probably not. If you rarely change your fonts, remembering that the Font dialog box can be found by pressing the Applications key and the Down arrow just a couple of times is fine. If, however, you think you will frequently change fonts, it is probably worth it to memorize the shortcut key. More details on changing fonts are found in Chapter 3.2.2 below.
Now let’s talk about margins. These can be changed via the ribbons or the shortcut key. They do not appear in the context menu, the Applications key is not an option. The shortcut key is Alt P M. To navigate there via the ribbons, do the following: 
1. Press Alt to open the Upper ribbon. 
2. If you land on the Home tab, Right arrow three times to get to the Layout tab.
3. Press Tab once to get to the Margins submenu and press Enter. 
This totals six keystrokes. Because the Margins submenu happens to be the first stop in the Layout tab’s Lower ribbon, it is relatively painless to access the Margins submenu via the ribbons. This is clearly not the case for the Font dialog box launcher, which is located much deeper in the Lower ribbon of the Home tab.
More details on changing margins can be found in Chapter 3.2.4 below.
For any command you want to execute, you will want to consider the following questions in deciding whether to access it via the ribbons, Applications key, or shortcut key:
· How many keystrokes are required to navigate to the command in the ribbon menus?
· Is the command present in the context menu accessed via the Applications key or by pressing Shift F10?
· How easy is it to memorize the shortcut key?
· How frequently will you use the command?
As you gain experience formatting Word documents, more and more shortcut keys will eventually lodge themselves in your memory. And based on how often you use various commands, you will also figure out what is the best choice for you.
[bookmark: _Toc1629866][bookmark: _Toc40521047][bookmark: _Toc40521220][bookmark: _Toc40521503]3.2 Formatting Basics
This section covers the basic requirements for properly formatting the body of a Word document. If you are comfortable with these commands, you are well on your way to creating professional-looking documents. 
A number of the most important formatting commands are located in the Font and Paragraph dialog boxes. I will start with these.
[bookmark: _Toc1629867]3.2.1 Format Checking with Insert F
Insert F (F for “format”) is a valuable keystroke in both JAWS and NVDA for identifying a number of the most important elements of font and paragraph formatting. You will first hear information on font formatting, and then paragraph formatting. With Narrator, Insert F provides font formatting information only, not paragraph formatting. 
Font-related formatting information you will hear includes:
· Attributes (bold, italics, underline)
· Font name (Arial, Times New Roman, etc.) 
· Color foreground and background (black on white, etc.)
Paragraph-related formatting information you will hear with JAWS and NVDA includes:
· Line spacing (single space, double space, etc.)
· Indentation (if any)
· Alignment (left, center, right, or justify)
If you press Insert F in a Word document without first selecting text, you will hear formatting information associated with your cursor point only. If you move your cursor elsewhere in the document, the formatting might very well be different there. 
If you first select some text, and then press Insert F, you will hear formatting information for the selected text. However, if formatting is not uniform throughout the selection, you might hear things like “mixed point size,” “mixed font,” “mixed alignment,” and so on. 
Before making font and paragraph format changes, you should always press Insert F to hear your current formatting. After making changes, you should verify by pressing Insert F again. 
If you are new to using this keystroke, the amount of information read to you all at once can be overwhelming. With both JAWS and NVDA, if you hold down the Insert key and then press F twice, you can press the Up and Down arrows to read each font and paragraph format setting separately. When finished, press the Escape key. 
[bookmark: _Toc1629868]3.2.2 Font Dialog Box 
As mentioned earlier in this chapter, the best ways to access the Font dialog box are to either use the shortcut key (Control D) or press the Applications key, use the Down arrow to move to Font, and press Enter. 
You can change many things in this dialog box, but we will limit ourselves to the font name, attributes, point size, and color. Here are the steps:
1. Select the text for which you want to change font formatting. 
2. Press Control D to open the Font dialog box (or access it via the Applications key).
3. This lands you in the Font edit combo box. Type the first letter of the font name you want and press the Down arrow until you hear your font choice (you can also type in the first few letters or the entire name of the font).
4. Tab once to the Font style edit combo box. Use the Up or Down arrow to choose either Regular, Italic, Bold, or Bold Italic.
5. Tab once to the Size edit combo box. Use the Up or Down arrow to choose your point size choice or type in the point size you want. 
6. Press Enter if these are the only formatting changes you want to make. 
7. Press Insert F to verify that your choices have registered.
If you also want to change the color of your text, Tab once past the Size edit combo box to the Color button. Press the Spacebar, which brings you into a color picker palette.
The color palette is navigated as follows. If you press Home or the Up arrow as far as you can, your screen reader will say “automatic,” which means that the foreground color is black. If you now press the Down arrow once, you will land on a color and hear “accent 1,” “accent 2,” etc. These “accents” are different shades of that color, moving from lighter to darker shades. You can Right and Left arrow to find other colors. If you simply want black, either press the Up arrow until you hear “automatic,” or press Home once. When you hear the color you want, press Enter. Do not press the Spacebar (even though your screen reader program may tell you to do so) because it will not get you out of the color picker. Now press Tab quite a few times to get to the OK button and press Enter or Spacebar to make the change. 
Be sure to press Insert F to check your work. Note that different versions of JAWS will announce color information differently. JAWS 2021 says “black on white.” But with earlier versions, you may hear “default on default,” and even “black on black,” which is of course nonsensical. Unless you have changed the default foreground and background colors, which you should not do for normal text, black text on a white background is the default.
Although you can bold and italicize text via the Font dialog box, this is done more easily with shortcut keys. First, select the text you want to change. Useful shortcut keys are:
· Control B: Bold on/off
· Control I: Italicize on/off
· Control U: Underline on/off
These are toggles. If text is already bolded, pressing Control B will turn bolding off. Your screen reader will say “bold off” or “bold on.” Ditto for italicizing and underlining. 
[bookmark: _Toc1629869]3.2.3 Paragraph Dialog Box
The most important formatting options here include: 
· Alignment (left, center, right, justify)
· Left and right indentation
· Special, which refers to indenting the first line of every paragraph, as well as hanging indentation
· Before and After paragraph spacing
· Line spacing (single or double being the most common)
There are other options in this dialog box, but we will limit ourselves to the ones listed above. Here goes!
First, select the text for which you want to change paragraph formatting. If you want to do this for the entire document, press Control A to select all the text. 
The Paragraph dialog box launcher is found in the Home tab, but similar to the Font dialog box, navigating to it is not worth the trouble. Instead, use either the shortcut key (Alt H P G) or open the context menu with the Applications key, Down arrow to Paragraph, and press Enter. 
The first place you land is the Alignment combo box. You can use the Down and Up arrow to move between the four choices. These are:
· Left: Places text flush against the left margin. This is the default.
· Center: Centers text on the line. You may want to use this for titles and some section headings.
· Right: Places text flush against the right margin. You will rarely, if ever, use this. 
· Justify: Places text flush against both the left and right margins. 
After Up or Down arrowing to move to your choice, Tab to Left Indent. If you want to indent an entire paragraph, or several paragraphs, press the Up or Down arrow to move to the desired value or type it in (usually 0.5 inches).
Press Tab once to get to Right Indent and enter your value in the same way as for Left Indent. 
Tab to Special where the default choice is None. Down arrow once to get to First line if you want to indent the first line of every paragraph. Now press Tab once and you will hear “0.5,” or in other words, one half inch. You can use the Up or Down arrow to change this, but the default is one half inch, and you will usually leave it this way. 
People often manually press Tab once on the first line of every paragraph, or even worse, press the Spacebar five times. Other than the time-consuming nature of doing this, if you are visually impaired and move some of your text around while editing, you might unwittingly scatter some of these tabs and random spaces inside your paragraphs. Indenting the first line in the Paragraph dialog box is a more efficient and cleaner way to do this. 
Now press Tab until you hear “before.” You may also hear “0 point” because for Normal text, 0 point (or no spacing), is the default Before paragraph spacing. You should not change this for normal text. In the discussion of headings and styles below, we will see that, by default, Before paragraph spacing is more than 0 point for headings.
Now press Tab until you hear “after.” This comes by default from the factory as either 8 or 10 point. As 11 or 12 point is the typical size of regular print for sighted readers, 8 or 10 point translate to a tiny bit less than a full blank line of spacing after each paragraph. If you want to remove any built-in spacing between paragraphs, change this by Up or Down arrowing to 0 point. 
Blind screen reader users need to keep one important consideration in mind. Many of us (myself included) press Enter twice when they end a paragraph: The first Enter is the usual hard return anybody does at the end of a paragraph. The second hard return is to manually place a blank line between one paragraph and the next one. This makes it easier for the blind user to distinguish when one paragraph ends and another one begins because the screen reader program says “blank” for the empty line between paragraphs. If this is your practice, continue doing it. However, be sure to set your After paragraph spacing at 0 point. If you fail to make this adjustment, you will be putting excessive spacing between paragraphs—the 8 or 10 point spacing from the factory in addition to the 11 or 12 point spacing you add when you press Enter that second time. Be sure to avoid making this unsightly error.
Now Tab to the Line spacing combo box. This is set to single spacing by default. If you want to change to double spacing, press the Down arrow twice to Double.
Now Tab to the OK button and press Enter or Spacebar to make these changes.
It’s always a good idea to confirm your changes have registered by pressing Insert F again. After hearing the font information, and if you have made some of the paragraph formatting changes I mentioned above, your screen reader will say something like “line spacing double, first line indented by zero point five inches, alignment left.” To check Before and After paragraph spacing, you have two choices. You can return to the Paragraph dialog box and press Tab to go through and see if your chosen values are still there. Or you can navigate to the Before and After paragraph spacing options in the Layout tab of the ribbon. Shortcut keys for these are Alt P S B and Alt P S A, respectively. 
3.2.4 Setting Margins
A margin is the blank space between the physical edge of a page and where print begins. In Word, default margin dimensions are one inch from the top, bottom, left, and right edges of the page. 
To know what your current margins are with JAWS, you can press Insert F1, which brings up a virtual viewer with Screen-Sensitive Help. You will hear a lot of information, and eventually the left, right, top, and bottom margin dimensions. If JAWS speaks too fast for you to hear the margins, you can use your Up and Down arrow to read the text line by line. When finished, be sure to press Escape to exit JAWS Screen-Sensitive Help and return to the document. If you are reading this book electronically in Word, press Insert F1 now to hear the margin dimensions.
Neither NVDA nor Narrator have such a help tool, so you need to get into the Margins submenu to detect your current settings. We’ll see how this is done in a moment. 
You can access the Margins submenu via the ribbons or use the shortcut key (Alt P M). Margins are the first stop on the Lower ribbon of the Layout tab, so when you use the Right or Left arrow to get to the Layout tab, press Tab just once to land on the Margins command, and press Enter.
You will now hear “last custom margins settings” or “normal.” Normal is one inch all around. As you press Tab to move through the options, you will hear “narrow,” which is 0.5 inches all around, “moderate” (left and right 0.75 inches, one inch top and bottom), and several others. When you land on the one you want, press Enter or Spacebar. This will return you to the document with the margins changed for the entire document if it only has a single section, or just for the section you are in (see more on sections in Chapter 8, section 8.3). 
If you want to set your margins with dimensions other than the pre-determined configurations mentioned above, you need to set custom margins. To do this:
1. Open the Margins submenu as above.
2. Press Shift Tab once to get to Custom Margins and press Enter.
3. You land in an edit spin box for the top margin. The current top margin value is displayed. Press the Up or Down arrow to adjust by one-tenth inch increments, or manually type in your new choice. 
4. Press Tab, and type in your desired bottom margin.
5. Press Tab to Left and type in the value.
6. Press Tab to Right, type in the value, and press Enter.
7. With JAWS, press Insert F1 once again to hear your new margin dimensions.
As mentioned above, NVDA and Narrator do not have an Insert F1 equivalent for quickly checking current margins. You instead have to navigate to the Custom margins dialog and press Tab to move through and hear the dimensions.
[bookmark: _Toc1629871]3.2.5 Changing Default Font, Paragraph, and Margin Settings
To change font defaults:
1. In the Font dialog box, make changes as instructed in Chapter 3.2.2 above. Common default font settings might be Times New Roman, Arial, or Calibri; Regular; 11 or 12 point; with black (automatic) for color. 
2. Press Tab a number of times to the Set as default button. Press Enter or Spacebar.
3. Be careful here because audio feedback is deceptive. You land on an OK button that appears to say that Pressing it will change the default. Do not press Enter here.
4. Instead, press Tab twice to get to a radio button. Use the Up arrow to get to the All documents based on the Normal template radio button, and press Enter. 
5. To test this, open a new document with Control N and press Insert F to check formatting. You should now hear your new default font settings.
To change paragraph defaults:
1. Press Alt H P G, or use the context menu to get into the Paragraph dialog box, make whatever changes you wish (most important are Alignment, First Line indentation, Before and After spacing, and Line Spacing).
2. Press Tab a number of times to the Set as default button. Press Enter or Spacebar. As above with setting default fonts, be careful here because of the misleading audio feedback.
3. Press Tab twice. Then Up arrow to select the All documents based on the Normal template radio button, and press Enter. 
4. To test this, open a new document with Control N and press Insert F to check formatting. You should now hear your new default paragraph settings.
To change margin defaults: First, note that you may never need to do this because the most commonly accepted margin defaults are one inch all around. But if you need to change them, do the following:
1. Press Alt P M to open the Margins submenu.
2. Press Shift Tab once to get to the Custom margins dialog, and press Enter.
3. In the four edit spin boxes (Top, Bottom, Left, Right), type in your desired default margins.
4. Press Tab a number of times to the Set as default button, and press Enter. 
5. Press Enter again to confirm that you want to change your default margins. Note that this is not as tricky as for changing font and paragraph defaults. 
6. To test this with JAWS, open a new document with Control N and press Insert F1 to check your margins. With NVDA and Narrator, open a new document, reopen the Custom margins dialog, and press Tab to move through Top, Bottom, Left, and Right to hear your new default margins. 
7. Press the Escape key. 
[bookmark: _Toc1629873]3.3 Headers and Footers (Including Page Numbering)
Headers are situated between the physical top edge of your page and the top margin. If your top margin is set at one inch, your header text will be at one half inch from the top of the page. When you insert a header, by default it will repeat at the top of every page of the document. Headers may include page numbers, very short pieces of text, or small graphics (like a company logo). 
Footers are located between the bottom margin of the page and the physical bottom edge of the page. Like headers, by default they will repeat on every page. 
Page numbers are inserted in either headers or footers. Word has a useful shortcut key for adding page numbers to headers and footers when you are in the Header or Footer panes. It is Alt Shift P held down together.
JAWS also has a convenient way for you to check if you have a header or footer in your document. Press Insert F1 for JAWS Screen-Sensitive Help (we used this earlier for detecting margin dimensions). If there is a header or footer, just before JAWS starts reading the margin dimensions, it will say something like “header: 1” or “footer: 1,” which indicates the existence of a header or footer with page numbering. This book has page numbering in the header. If you are reading the electronic version with JAWS, press Insert F1 now, and you will hear this.
If there is also text in the header or footer, JAWS will read that too. An example of what you would hear if the header has both text and page numbering is: “Header: Freudian Analysis 1.” 
NVDA and Narrator do not have such a tool. You will need to open the Edit control of the Header or Footer submenu and use the Right and Left arrows to detect if there is anything there. Shortcut keys for Header Edit and Footer Edit are Alt N H E, and Alt N O E, respectively.
3.3.1 Header and Footer Insertion
Steps for creating headers and footers parallel each other. The shortcut for opening the Header submenu is Alt N H. For footers, it is Alt N O. To navigate to these dialog boxes via the ribbons:
1. Press Alt to open the Upper ribbon, and press the Right arrow once to get to the Insert tab if starting from the Home tab.
2. Press Control Right arrow to get to the Header and Footer group. You land first on the Header submenu. Press Tab one more time to find the Footer submenu. I will present the remaining steps just with headers because the steps are identical for both. In addition, headers are used more frequently than footers in Word. 
3. On the Header submenu, press Enter to open it. 
4. You first land on the Blank button. Press Enter on this. 
5. This lands you flush left in the Header pane. Type in text here if you want left-aligned text in your header. 
6. Press Tab once and your cursor moves to the center. Your screen reader will usually say 4.25 quote, indicating you are at the exact center of a page that is 8.5 inches wide. Type in text here to insert center-aligned text.
7. Press Tab one more time and your cursor moves to the right side of the Header pane. Type in text here for right-aligned text. Often this will be a page number. If so, use Alt Shift P to insert the page number. If you left and Right arrow, you should hear the page number.
8. Exit the Header pane by pressing Escape and use the Down arrow to return to the main body of your document. 
3.3.2 Different Headers or Footers on the First Page
Often, you may not wish to have headers or footers on the first page of your document, or you may want different header/footer text on page one than on subsequent pages. In both cases, you will need to know how to have a different header or footer on page 1. Steps for headers are:
1. After opening the Header submenu, press Shift Tab three times to get to the Edit control and press Enter (or use the shortcut: Alt N H E to get into this edit field).
2. Press Alt to open the ribbons. This lands you on a Header and footer tab if you are using Word 365 (or a Design tab in other versions of Word). 
3. Press Control Right arrow several times to move to the Options group, and press the Spacebar to check the for Different first page checkbox.
4. With your cursor on the first page of your document, open the Header pane (shortcut key: Alt N H).
5. If you want to leave the header blank, press Escape and Down arrow to return to the main body of the document. 
6. If instead, you want to insert text for your page one header, follow the steps above for doing this. Then press Escape and Down arrow to return to the main text of your document.
7. Now navigate to page two of your document. Insert a header, which will appear on all pages other than the first page. 
8. Repeat the steps for creating a header, inserting whatever text and page numbering you want to appear on page two and beyond.
9. Press Escape and Down arrow to return to the main text.
3.3.3 Removing and Editing Headers and Footers
In theory, you can edit a header or footer by going to the Edit control in the Header or Footer submenu. But in practice, this sometimes works poorly with screen reader programs. It is much easier to entirely remove the header or footer and redo it. Here again, we’ll just talk about headers because the process is the same for footers.
1. Open the Header submenu as above (shortcut: Alt N H, or Alt N O if doing this for footers).
2. Press Shift Tab twice to get to the Remove button and press Enter or Spacebar. 
3. Now redo your header or footer if you want to replace it. 
Shortcuts for removing headers and footers are Alt N H R and Alt N O R, respectively. 
Be sure that your headers and footers have the same font formatting as the main body of your document. Using headers as an example, the easiest way to do this is as follows:
1. Get into the Header pane (shortcut: Alt N H E).
2. Press Control A to select all text in the Header pane.
3. Press Control D to get into the Font dialog box, make your changes, and press Enter. 
4. Press Escape to move out of the Header pane, navigate to another page, and press Alt N H E again to get into that page’s Header pane.
5. Press Insert F to verify that font formatting has changed correctly.
Note that if you have different headers or footers for the first page, you will have to repeat Steps 1 through 3 above for that page. 
[bookmark: _Toc1629874]3.4 Bulleting and Numbering Lists
Often in Word documents, you will want to create lists of items to set them apart from standard text. Bulleting is used if the order or sequencing of the items in the list are not important. Numbering is used if the order matters. A good example is a food recipe. You use bulleting to list the ingredients because their sequence does not matter. You use numbering to list the directions for preparing the recipe because the order matters. 
[bookmark: _Hlk524695073]We’ll start with bulleting, navigating to the dialog box via the ribbons. Steps are:
1. Select the text you want to bullet. 
2. Press Alt to open the Upper ribbon. Use the Left arrow to get to the Home tab if you are not there already.
3. Press Control Right arrow three times to get to the Paragraph group in the Lower ribbon. You land on the Bullets split button. 
4. Press Enter or Spacebar here if you want to bullet the text with the default bullet format, which is a black round dot about half the size of the adjacent text. This will return you to the document and your selection will be bulleted. 
5. If instead, you want to check out other bulleting options, press Alt Down arrow to expand the split button options which appear in a grid.
6. Use the four arrow keys to move through the various choices, and press Enter or Spacebar on the one you want. Other options include hollow dots, check marks, and a few more. 
If you use the shortcut key instead (Alt H U, this opens the Bullets split button and you can use the four arrow keys to move through the options. Press Enter or Spacebar on your choice.
If you want to add an additional bullet in the middle of your list, navigate to the end of the line above and press Enter. A new line with a bullet will appear. If you are at the bottom of the list and you want to add another item, with your cursor situated at the end of the line, press Enter once and a new bullet will appear. If you press Enter a second time, bulleting will end and text will revert to normal formatting.
[bookmark: _Hlk524695743][bookmark: OLE_LINK5]If you want to remove bulleting, there are two ways to do this. First, select the bulleted text. If you navigate to the Bullets split button in the Lower ribbon, if using Word 365, you will hear the type of bullet format you have selected (with earlier versions, you only hear that it is checked). Press Enter or Spacebar to uncheck Bullets. This will remove them. 
Second, you can press the shortcut key (Alt H U), and arrow to the None button. Press Enter or Spacebar and that too will remove bulleting. 
Steps for numbering parallel those for bulleting. 
1. Select the text you want to number. 
2. Press Alt to open the Upper ribbon. Use the Left arrow to get to the Home tab if not there already.
3. Press Control Right arrow to get to the Paragraph group in the Lower ribbon where you first land on the Bullets split button. Press Tab once to get to the Numbering split button.
4. Press Enter or Spacebar here if you want to number the text with the default numbering format, which is 1 period, 2 period, 3 period, etc.
5. If instead, you want to check out other numbering options, press Alt Down arrow to expand the split button options.
6. Use the four arrow keys to move through the various choices, and press Enter or Spacebar on the one you want. Other options include letters, Roman numerals, and a few more. 
If you use the shortcut key instead (Alt H N), this opens the Numbering split button and you can arrow through the options, pressing Enter or Spacebar on your choice.
If you want to add an additional item in the middle of your numbered list, navigate to the end of the line above and press Enter. A new line with the next number will appear. All following items in the list will be correctly renumbered. If you are at the bottom of the list and you want to add another item, press Enter once and the next number in the sequence will appear. If you press Enter a second time, numbering will end and text will revert to normal formatting. 
Finally, if you want to remove numbering, there are two ways to do this. First, select the numbered text. If you navigate to the Numbering split button in the Lower ribbon, if using Word 365, you will hear the numbering format you have selected (with earlier versions, you only hear that it is checked). Press Enter or Spacebar to uncheck numbering. This will remove them. 
Second, you can press the shortcut, Alt H N, and arrow to the None button. Press Enter or Spacebar and that will also remove numbering. 
[bookmark: _Toc1629875]3.5 Headings and Styles
Styles are powerful tools for ensuring consistent document formatting, as well as for aiding navigation. Headings are used to organize and format text. 
Headings distinguish different types of content and help readers find information. You can define headings at different levels (level 1, level 2, etc.) to clearly establish a hierarchical structure of a document. Lower level headings are subordinated to, or nested under, higher levels. Think of a book where all the level one headings are parts of the book, level two headings are chapters within the parts, and level three headings are sections within the chapters.
A style is the full set of font and paragraph format choices that come together to make up the appearance of headings or normal text. Normal text is text that forms the main body of a document. There are other style types (for tables, footnotes, title pages, and others), but I limit discussion here to headings and normal text.
The value of using styles is especially significant if you are preparing a large document. Imagine that you are writing a 15-page term paper or a 75-page consultancy report. You begin by outlining it at several levels. You want to format titles for your sections. You navigate through the text to find the section titles, formatting them one by one. You try to keep straight in your head which one is at which level. Depending on how many titles you need to format and how talented a typist you are, the whole process might take anywhere from 30 minutes to a couple of hours. Unfortunately, you will probably make a few mistakes along the way. Chances are good too that you will later decide to adjust the formatting and you have to repeat the whole tedious exercise again. 
Using headings and styles makes this process quick and easy, both to do once, and to change later. Automating it minimizes formatting errors and inconsistencies. This is true for sighted writers, and doubly so for visually impaired writers. After all, the sighted writer can eyeball documents to detect formatting errors. The visually impaired writer can’t do this, making use of headings and styles even more advantageous. 
Use headings and styles to format any document that lends itself to an outline structure, not just lengthy documents. They can also be used for a short essay or a two-page resume. 
We’ll first discuss how to navigate a document with headings. Then we’ll see how to insert headings into a document. After that, we will cover the power of styles as a formatting tool. 
3.5.1 Navigating Headings With Your Screen Reader
With JAWS, there are two ways to navigate headings in Word documents. First, you can press Insert F6, which gives a list of headings. Use the Up or Down arrow to move through the headings, or first-letter navigate to the heading you want. Press Enter and it will place you in the document on that heading. You can also press Home and End to get to the first and last heading in the list, respectively. This also works with Narrator.
Second, and only with JAWS, you can press Insert Z, which takes you out of Edit mode and places you in a virtual mode. JAWS will say “Quick keys on.” You can then press H to go to the next heading, and Shift H to go to the previous heading. You can also press 1 on the number row to go to the next level one heading, 2 to go to the next level two heading, and so on. Insert Z is a toggle, so press it again to return to Edit mode. JAWS will say “Quick keys off.”
With NVDA, there are also two ways to navigate headings. For both, you must first switch to Browse mode, which is equivalent to the JAWS Quick keys mode. To get a list of headings:
1. Press Insert and Spacebar together to switch to Browse mode. 
2. Press Insert F7, which opens the Elements list. 
3. Press Shift Tab once to get to a series of radio buttons for the types of elements NVDA can navigate in Word documents. These include links, headings, annotations, errors, and charts.
4. Up or Down arrow to Headings.
5. Press Tab once and you are now in the Headings Tree view. You can navigate here by pressing the Up and Down arrows or first-letter navigating.
Unfortunately, presenting the headings this way is confusing because tree views are organized in levels different than those of headings. For level one headings, NVDA will say “level zero” because it is identifying its level in the tree view hierarchy rather than its level in the headings hierarchy. Level one in the tree view hierarchy means it is a level two heading, and so on. Consequently, I prefer using JAWS or Narrator to access headings lists.
You can also navigate headings by activating Browse mode in NVDA or Scan mode In Narrator with Insert and Spacebar, as above. Then you can press H and Shift H to go to the next and previous heading, as well as navigate by heading level with the keys 1, 2, 3, etc. 
Browse mode for NVDA and Scan mode for Narrator are toggles. NVDA makes a noise when you activate it and a different noise when you turn it off. Narrator will say “Scan mode on” and “Scan mode off.”
3.5.2 Adding Headings
This is quick and easy. To add a level one, two or three heading, place your cursor anywhere on the line you want to make into a heading, and press the following keystrokes:
· Control Alt 1: For heading 1.
· Control Alt 2: For heading 2.
· Control Alt 3: For heading 3.
If, for example, you want to change a heading 1 into a heading 2, just place your cursor on the line with the heading 1 formatting, and press Control Alt 2to turn it into a level two heading. 
To remove heading formatting, place your cursor on the heading you want to remove, and press Control Shift N. This removes the heading and changes it into normal text. 
3.5.3 What Is a Style?
A style is the sum of all font and paragraph formatting for a particular piece of text. You can create styles for many different items in your document, but the most important are heading levels and the main body of your text, which is called the Normal style. 
Heading styles help to visually set text apart from the rest of the document. Heading 1 text may be bolded, have a large point size, be a color other than black, and be centered. Before paragraph spacing may be as much as 24 point, serving to visually separate it from the text that precedes it. 
How you decide to format a given heading should not be considered in isolation from the other heading level styles or the Normal text style. Style format decisions need to be considered as an ensemble that creates a visual hierarchy because lower level headings are subordinate to higher level headings. In other words, a level one heading should visually be a “bigger deal” than a level two heading. A level two heading should be a “bigger deal” than a level three heading. And all headings should clearly stand apart from the normal text.
An example of such a hierarchy could be:
· [bookmark: _Hlk86408774]Level one heading: Bold, Times New Roman, 16 point, black on white, center aligned, 24 point Before paragraph spacing, 0 point After paragraph spacing
· Level two heading: Bold, Times New Roman, 14 point, black on white, left aligned, 10 point Before paragraph spacing, 0 point After paragraph spacing
· Level three heading: Bold, Times New Roman, 13 point, black on white, left aligned, 6 point Before paragraph spacing, 0 point After paragraph spacing
· Normal text: Regular, Times New Roman, 12 point, black on white, left aligned, 0 point Before paragraph spacing, 8 point After paragraph spacing
As the above example illustrates, heading level and normal text styles are primarily set apart by point size, bolding, color, alignment, and Before and After paragraph spacing. 
The most important font and paragraph format settings were discussed earlier in this chapter. But once again, they are listed below. 
Font formatting considerations include: 
· Attributes: Bold, italics, underline, or Regular
· Point size
· Font color
Paragraph formatting considerations include:
· Alignment (left, center, justify, right)
· Left and right indentation 
· First line indentation for Normal text only 
· Before paragraph spacing (may be variable with larger point sizes for level one heading, descending downwards for levels 2 and 3, 4, etc., always 0 point for Normal text)
· After paragraph spacing: 0 point for headings, variable for Normal text (see the Paragraph dialog box section above for special considerations related to Normal text)
· Line spacing (single spacing for headings, usually single or double for normal text).
3.5.4 Changing Styles for a Single Document
This process is the same for all heading levels, as well as for Normal text. We will use the level two heading style as an example. Steps are:
1. Navigate to a current level two heading in your document and select the entire line or lines. To select a single line, I prefer pressing Home to get to the beginning of the line an then Shift End to select it. This is safer than pressing Shift Down arrow. This guarantees your cursor focus will remain fully on the line with the level two heading rather than the line below it. If your focus strays from the line with the heading, the remaining steps will not work. 
2. Open the Font dialog box, either navigating there via the Applications key or using the shortcut key (Control D), and make your changes. 
3. With your cursor still on that level two heading, open the Paragraph dialog box, either navigating there via the Applications key or using the shortcut key (Alt H P G), and make your changes. 
4. With your cursor still on the level two heading, open the Styles submenu. The shortcut is Alt H L. If you navigate there via the ribbons, it is in the Home tab. You can press Control Right arrow several times to get to the Styles group. This is the first command in this group. 
5. You land on the Heading 2 button. Do not press Enter or Spacebar here. Instead, press the Applications key. You land on “update heading 2 to match selection.” Press Enter on this. This changes the formatting of all other level two headings in your document to reflect the changes you made on the selected text.
6. To test this, navigate to any other level two heading in the document and press Insert F to confirm that the font and paragraph formatting has changed. 
When you complete the above steps for Normal text, your screen reader will say “Normal text button” when you land in the Styles submenu. When you press the Applications key, you will land on “update Normal to match selection.”
3.5.5 Changing Default Styles for Future Documents
You may not care for the default styles that come with your computer and wish to change them. However, you can only change defaults for new documents, not for previously saved documents. To make style changes in already-saved documents, follow the steps in the previous section. 
To know what your current default styles are for a particular heading level, or for Normal text, open a blank Word document. For Normal text, press Insert F and your screen reader will reveal your default font and paragraph formatting. For a heading level, type in a few words of text and turn it into a level one, two or three heading by pressing Control Alt 1, 2, or 3, and use Insert F again to reveal the default font and paragraph settings. 
Using the level two heading example again, here’s how to change your default style:
1. Open a new blank document. This is critical. If you attempt this in a document that has already been saved, nothing below will work. 
2. Type in a couple of words of text and press Control Alt 2 to make it a level two heading. 
3. Select the text. 
4. Repeat Steps 2 through 6 from the previous section. This changes level two heading formatting for the current document only. 
5. Open the Styles submenu again (shortcut: Alt H L). This lands you on the Heading 2 button. 
6. Press the Applications key and then the Down arrow once to get to Modify and press Enter. This opens the Heading 2 Properties dialog box. 
7. Press Shift Tab four times to get to the Only in this document radio button. Press the Down or Up arrow once to the New documents based on this template radio button.
8. Press Tab twice to get to the OK button and press Enter or Spacebar.
9. To test this, press Control N to open a new blank document. Type in a couple of words, press Control Alt 2 to make it a level two heading, and press Insert F to verify that the default changes have registered. 
3.5.6 Defining Shortcut Keys for Lower Level Headings
Word has predefined shortcut keys for level 1, 2, and 3 headings only. You can add shortcut keys for up to nine heading levels. That said, think hard before adding too many more levels because this will make your document more challenging to read and write. You should rarely go beyond four heading levels. To define a level four heading shortcut key, make sure you are already in a document with three levels of headings. Otherwise, level 4 will not appear in the Styles submenu. Steps are as follows:
1. Position your cursor on a level three heading.
2. Open the Styles submenu. Again, the shortcut key is Alt H L. 
3. Right arrow once to the Heading 4 button. 
4. Press the Applications key, Down arrow once to Modify, and press Enter. This opens the Heading 4 Properties dialog box. 
5. Press Shift Tab three times to get to the Format button and press Enter or Spacebar. 
6. Press the Up or Down arrow to get to the Shortcut key button and press Enter. 
7. This opens an edit box where you type in your shortcut key. Press Control Alt 4 to make this your shortcut for level four headings.
8. Tab to the Close button and press Enter or Spacebar.
9. Press Tab again to get to the OK button and press Enter or Spacebar.
10. To test this out, type some text, press Control Alt 4, and confirm that it creates a level four heading. 
This remains your shortcut for level four headings as long as this copy of Word is on your computer.
[bookmark: _Toc530139638][bookmark: _Toc1629876][bookmark: _Toc40521048][bookmark: _Toc40521221][bookmark: _Toc40521504]3.6 Tables
Use tables when you can present information more clearly and succinctly than with text alone, keeping in mind that you should still summarize main points in the body of your document. 
If the table you are creating contains numbers and calculations, it is better to create the table in Excel first. This is because it is more straightforward to do calculations in Excel and import the data into Word. See Chapter 3.6.3 below on how to do this. If your table is primarily text, creating it in Word is preferable because Word handles text editing better than Excel. Generally speaking, limit your tables to no more than five or six columns. Otherwise, you will have difficulty fitting the table on the page.
[bookmark: _Toc1629877]It is my opinion that, generally speaking, JAWS provides a significantly better experience than NVDA and Narrator when dealing with tables. With JAWS, audio feedback is clearer and more consistent when navigating within tables and more useful information about formatting is also provided. 
3.6.1 Navigating Within and Between Tables
There are several ways to navigate within tables in Word. First, you can use Control Alt and the four Arrow keys to move up and down columns and across rows. Second, you can Press Tab and Shift Tab to move to the next and previous cell. Note that this will also select the cell content. If you want to replace text inside a cell, press Tab or Shift Tab to get into a cell and type over the existing content.
JAWS has an additional way to navigate within a table using what is called a Layered mode. With your cursor inside the table, hold down Insert and Spacebar together. You will hear a click. Press T and JAWS will say “table layer.” Now you can use just the four Arrow keys to move up, down, left, and right in the table. To exit this mode, either Press Escape (a chime will sound) or Press Alt Tab to move away from the window. 
Some other useful keystrokes for moving inside a table are:
· Control Alt Home: Move to first cell, or in other words, to the top left cell.
· Control Alt End: Move to last cell, or in other words, to the bottom right cell.
· Alt Windows Period: With JAWS only, read current column.
· Alt Windows Comma: With JAWS only, read current row.
With JAWS, with cursor focus in a table you can also press Insert F1 for Screen-Sensitive Help. A great deal of useful information about table formatting and keystrokes is provided.
There are several ways to navigate between tables in a Word document. With JAWS, press Insert Z to turn on Quick keys mode. Then Press T and Shift T to move to the next or previous table, respectively. When finished navigating, press Insert Z again to turn off Quick keys mode and return to Edit mode.
With JAWS you can also get a list of tables by pressing Control Insert T. Press the Up or Down arrow to get to the table you want to navigate to, and Press Enter. 
With NVDA and Narrator, turn on Browse and Scan mode s, respectively, with Insert and Spacebar. Then Press T and Shift T to move to the next or previous table. When finished navigating, press Insert and Spacebar again to return to Edit mode. NVDA and Narrator do not have any keystrokes for listing tables. 
[bookmark: _Toc1629878]3.6.2 Creating Tables
Tables may have up to three parts: A title or caption at the top; the body with rows and columns in the middle; and notes on sources at the bottom. 
3.6.2.1 Table Body
The first step is to create the body of the table. To do this, open the Insert tab, press Tab several times to get to the Tables submenu, and Press Enter (shortcut: Alt N T).
This lands you in a grid where your screen reader says “1X1 table,” meaning one column by one row. Press the Right arrow to increase the number of columns and the Down arrow to increase the number of rows. Press Enter or Spacebar when you have the number of columns and rows that you want. As mentioned above, the number of columns should not exceed five or six, given the finite physical width of a page in Word.
After you create the table, your cursor is placed inside the top left cell of the table. Your screen reader program tells you the row number and column number (example: “row 1 of 4, column 1 of 5”). Using the navigation keys mentioned above, you can now move inside the table to add column titles along the top row, row titles down the left column, and your data in the other cells. 
By default, tables inserted into a Word document have thin gridlines around all the cells, thus setting the table apart from the rest of the text. Border gridlines surround the entire table, and horizontal and vertical gridlines surround all the individual cells. The default size and color for all of these are 0.5 point black. 
How can you verify if you have gridlines when you cannot see them? With JAWS, this is easy. With your cursor placed inside the table, press Insert F1 for JAWS Screen-Sensitive Help (we used this earlier for checking margin dimensions). JAWS will start saying lots of stuff. If there are gridlines, you will hear them indicated just after you hear “table padding.” If the defaults are in place, JAWS will say, “Cell border: Surrounding single line with width of 0.5 points. Table border: Surrounding single line with width of 0.5 points.” If you hear no cell or table border information just after “table padding,” this means that no gridlines are present. 
You may wish to change the gridline configuration. You can select the entire table or an individual row and then change the gridline configuration for that selection. Because there are so many variations on how you can do this, I will start by removing all gridlines to make the process easier to understand. Here are the steps: 
1. Place your cursor anywhere in the table. 
2. Press Alt to open the Upper ribbon and use the Right arrow to get to the Table Tools Design tab. Note that when you are in a table and open the Upper ribbon, at the extreme right, two new Table Tools tabs appear—a Design tab and a Layout tab. Do not confuse these with the Design and Layout tabs further to the left on the Upper ribbon. Those concern formatting of the overall document.
3. On the Table Tools Layout tab, press Tab once to get to the Select submenu (shortcut: Alt J L K) and Press Enter. 
4. Down arrow to get to Select Table, and Press Enter.
5. Open the Upper ribbon again, and Press the Left arrow once to get to the Table Tools Design tab along the Upper ribbon.
6. Tab into the Lower ribbon to the Borders and shading button (shortcut: Alt J T O) and Press Enter. 
7. This opens a Tables and borders dialog box where you first land on a list of radio buttons. Press the Up or Down arrow to get to None and Press Enter. This will remove whatever gridlines currently exist. 
8. Now place your cursor anywhere in the table if you want to change gridlines for the entire table. Or place it somewhere in the row you want to change if you want to alter gridlines for just that row.
9. Return to the Select submenu in the Table Tools Layout tab. Down arrow to get to Table or Row, and Press Enter on the one you want to change. 
10. Now return to the Borders and Shading dialog box of the Table Tools Design tab. 
11. Tab to get to Top Border, and check it if you want gridlines to appear for this. Note that you must Press Enter to check or uncheck the checkboxes in this dialog box. Pressing the Spacebar will not work, which is inconsistent with how checkboxes are supposed to work, but is just the way it is here.
12. Tab to get to Bottom Border and check or uncheck it. 
13. Tab to get to Left Border and check or uncheck it. 
14. Tab to get to Right Border and check or uncheck it. 
15. Tab to the OK button and Press Enter or Spacebar. 
Admittedly, this is complicated. If you think you have messed up, the easiest thing is to select the table again, and in the Tables and borders dialog box, press Enter on the None radio button to clear any existing gridlines and start over.
You can add additional rows or columns, or delete them. This is most easily done using the context menu reached via the Applications key. With your cursor located on the row or column where you wish to insert additional rows or columns, press the Applications key, Down arrow to the Insert submenu, and Press Enter. Your choices here are: insert columns to the left, insert columns to the right, insert rows above, and insert rows below. Press Enter on your choice. 
To add more rows at the bottom of the table, navigate to the last table cell at the bottom right. JAWS will say, “Last cell in table. Warning: pressing Tab here adds an extra row.” NVDA and Narrator do not say anything, but pressing Tab here has the same effect. 
The Delete option in the context menu lists four radio buttons: shift cells left, shift cells up, delete entire row, and delete entire column. Press Enter on your choice. 
3.6.2.2 Title or Caption
You should add a title above your table. While it is possible to simply type the text above the table, it is better to use the Captions command in the References tab of the ribbons. This will facilitate consistent formatting and numbering, as well as make the whole process of constructing tables less burdensome. 
To add a caption to a table, first make sure that your cursor is located somewhere in the body of the table. Then:
1. Navigate to the References tab along the Upper ribbon.
2. Press Control Right arrow to jump by group to the Captions group. The first command here is the Insert Captions button. Press Enter on this, which opens a dialog box. The shortcut for this is Alt S P.
3. Type in your table title. By default, the labels Table 1, Table 2, etc., will be added to your title.
4. Tab to the Labels combo box, where your choices are Table or Figure (this dialog box is also used for inserting captions on figures and diagrams). The default is Table.
5. Tab to Position, where your options are Above Selected Item or Below Selected Item. The default is the above position. Do not change this.
6. Tab to the Exclude Label from Caption checkbox, which is unchecked by default. Check this if you do not want the default labels Table 1, Table 2, etc., to appear. 
7. Tab to Numbering. Here you can change the numbering style (Roman numerals, add chapter numbers, etc.) of the default labels, if you choose to keep them. 
8. When finished, Tab to the OK button and Press Enter or Spacebar. 
By default, the table number, with a colon after it, and the table title are placed on the same line in regular text. If you need to alter this, after first creating the caption, press the Up or Down arrow to get back into it, and make whatever changes you need using the Font or Paragraph dialog boxes. 
If you have several tables in your document and insert a new one in the middle or reorder them, table numbering in the captions will not automatically adjust. To refresh, select the entire document with Control A and Press F9.
3.6.2.3 Notes on Sources
The last part of a table is notes on sources, as well as whatever other explanatory notes you may wish to add. Similar to captions, you might decide to “cheat” by simply typing source notes just below the table. However, there is a better way to do this that keeps the notes as part of the table, making it easier to maintain consistent formatting. This involves inserting an additional row at the bottom of the table, merging the cells in that row, and typing in your notes there. You then customize the gridlines to hide them, following steps in Chapter 3.6.2.1 above. On a printed page, the gridlines do not appear to be part of the table, but they actually are. Electronically they appear fainter than the other “non-hidden” gridlines. Steps to add this new row at the bottom of the table with accompanying notes are:
1. At the bottom right of your table, press Tab once to add an additional row. 
2. Press Alt to open the Upper ribbon and use the Right arrow to get to the Table Tools Layout tab. 
3. Press Tab once to get to the Select submenu and Press Enter. 
4. With your cursor still in the row you just inserted, Down arrow to get to Select Row and Press Enter. 
5. Press the Applications key, use the Down arrow to get to Merge cells, and Press Enter. 
Let’s say your table has four columns. Now if you Press the Up arrow once and the Down arrow once to get back into the merged row, JAWS will say “number of columns changed from four to one.” Narrator says “Merged cell, spans four columns.” Unfortunately, NVDA does not clearly indicate the presence of merged cells.
You can now Type in your notes in this merged cell, allowing text to wrap around to additional lines within the row, or pressing Enter to add more notes in the same cell. In both cases, the row height will adjust automatically to accommodate your text. 
You are now ready to hide the left, right, and bottom gridlines for this row, but not the top gridline because this will remain the bottom-most visible gridline in your table. To do this: 
1. With your cursor still situated in the merged cell, press Alt to open the Upper ribbon. 
2. Once again select the row by navigating to the Table Tools Layout tab, pressing Tab to get to the Select submenu, pressing Enter, using the Down arrow to get to Select Row, and pressing Enter. 
3. Open the Upper ribbon again, and Press the Left arrow once to get to the Table Tools Design tab along the Upper ribbon.
4. Tab into the Lower ribbon to the Borders and shading button and Press Enter. 
5. Use the Down arrow to get to Custom.
6. Tab to Top Border and press Enter to check it.
7. Tab to Bottom Border and Press Enter to uncheck it.
8. Tab to Left Border and Press Enter to uncheck it. 
9. Tab to Right Border and Press Enter to uncheck it. 
10. Tab to the OK button and Press Enter or Spacebar. 
The left, right, and bottom gridlines should now be hidden. The top border remains visible, thus making it appear to be the bottom border of the table. 
You may ask whether using captions and hiding gridlines is worth all the effort. If you are inserting just one or two tables in your document, perhaps not. However, if you anticipate having quite a few tables, in the end, this will save you work, as well as help you to avoid formatting mistakes and inconsistencies. 
Word tables can be quite complicated to format correctly. You can create styles and do additional things to make them look professional. My earlier book on formatting Word documents covers some of these. I would advise you to have a sighted colleague check your work to check for mistakes. 
3.6.3 Importing Data from Excel to Create a Word Table
Assuming you are already familiar with Excel (see Chapter 5), this is fairly easy to do, provided that the width of the columns you import from Excel fit within the left and right margins of your Word document. As mentioned above, do not import more than five or six columns from Excel. Steps are:
1. In Excel, select the data range of the table. Limit this strictly to the columns and rows containing the column and row headers and data in the body of the table. Do not select any title you may have created for it (usually in cell A1) because this text is best entered later as a caption. 
2. Press Control C to copy the selected data range. 
3. Open a Word document and press Control V to paste the data if you want the table to appear without gridlines that will go to a printer. 
4. If you want to include printable gridlines, do not press Control V. Instead, press the Applications key, Down arrow to Paste options, Right arrow to Use destination styles, and press Enter. Note that font styles will be consistent with those of the Word document. 
Now do whatever additional table formatting (adding captions, source notes, etc.) you wish, using techniques covered earlier in this section. 
[bookmark: _Toc530139637][bookmark: _Toc1629896]3.7 A Few Special Topics
People occasionally ask me how to generate tables of contents and multi-column documents. These topics are discussed here. But before that, I should talk about sections: what are they, and when do they matter.
[bookmark: _Toc1629895]3.7.1 Sections
Section breaks are most frequently inserted when you wish to change some aspect of page formatting inside your document. Section breaks are more common in longer documents than in shorter ones. Situations where you would insert section breaks include:
· When repaginating inside a document (see the example of tables of contents in Chapter 3.7.2 below). 
· When changing page number formatting. One example could be if you have created an executive summary which uses small Roman numeral formatting (i, ii, iii, etc.) and Arabic numbering (1, 2, 3, etc.) for the main body of the text. 
· When changing header or footer text within the document. 
· When temporarily changing from Portrait to Landscape orientation. You might need to do this if you are inserting a table that is too wide to fit on the page with Portrait orientation. 
· When inserting columns in the text (see Chapter 3.7.3 below). 
There are several types of section breaks. We will use Next Page section breaks for outlining how to insert a new section in a document:
1. Place your cursor at the top of the page where the main body of your text begins.
2. Open the Upper ribbon and Right or Left arrow to the Layout tab.
3. Tab into the Lower ribbon to the Break submenu (shortcut: Alt P B) and Press Enter to open it. 
4. Down arrow to the Next page button and Press Enter. 
Now if you Up Arrow once and Down arrow once, both JAWS and NVDA will say the page number and indicate that you are in section 2. 
3.7.2 Adding a Table of Contents
A table of contents is a useful tool for navigating a document, as well as for giving readers a quick overview of document content. They can be quickly generated once you have inserted headings into your document. See Chapter 3.5.2 on how to insert headings. 
If you are creating a table of contents for a newsletter that will be sent to readers by email, page numbering will not be an issue, and it can be placed just beneath whatever introductory text you generate. It is not possible to generate a table of contents in Outlook. Create your document and accompanying table of contents in Word and copy and paste the final version into the body of an email. 
If the table of contents is intended for a report or book, it should begin on a separate page after your title page and before the text of your manuscript. Follow steps three through five below to generate it. 
To properly situate the table of contents for a manuscript and then generate it:
1. At the bottom of your title page, press Control Enter twice to create a page break after the title page and another one just before the beginning of your text. 
2. Place your cursor on the space between these two page breaks. 
3. Open the upper ribbon and Right or Left arrow to the References tab. 
4. Tab once into the Lower ribbon to the Table of contents submenu (shortcut: Alt S T). Press Enter to open the submenu.
5. Press Enter a second time on the Automatic table one button. A table of contents is now generated with all headings up to level three and corresponding page numbers listed. At the top, the title “Contents” is also inserted. 
You can easily update a table of contents. Do this for any of the following reasons:
· You add or remove text that will change the page numbers. 
· You add or remove headings.
· You change the text in any of the existing headings.
· You change the format of the table of contents. 
To update the table of contents, your cursor can be anywhere in the document. Hitting Tab twice past the Table of contents submenu in the References tab gets you to the Update Table button (shortcut: Alt S U). When you get into this dialog box, you land on a set of radio buttons with two choices: Update Page Numbers Only, or Update Entire Table. Up or Down arrow to the one you want, and press Enter
A few adjustments are now needed. Generally, it is a good idea to limit your table of contents to just level 1 and 2 headings. Level 3 headings can be included if they are not too numerous. Three levels is the default. Level 4, 5, and 6 headings should not appear. I have limited this book’s Table of contents to just the first level because including lower level headings would make it spill onto several pages. 
To limit the heading levels:
1. Open the Table of contents submenu.
2. Tab to the Custom table of contents dialog and press Enter. 
3. Tab to the Show levels edit combo box, and Up or Down arrow to the last heading level you want to appear. 
4. Tab to the OK button and press Enter. 
5. If you have already created a table of contents, you will be asked if you want to replace the existing table. Press Enter or Spacebar to confirm. If you have not yet created it, do so now, using the steps outlined above. 
6. In your document, navigate to the Table of contents and Verify that only the correct heading levels are shown. 
In addition to the Show levels edit combo box, there are two checkboxes worth mentioning in the Custom table of contents dialog:
· Show page numbers checkbox: This is turned on by default. Uncheck it if your table of contents is intended for an electronic newsletter to be contained in the body of an email message. It will not include page numbers. 
· Use hyperlinks instead of page numbers checkbox: This is checked on by default, and you should always keep it checked. Note that the wording is a bit deceptive. If you keep the Show page numbering checkbox checked, page numbering will still be displayed. 
An additional adjustment needs to be made for manuscripts. Because your table of contents follows the title page, and the table of contents also takes up at least one page, your manuscript text will begin on page 3 or 4. This will be reflected in the pagination of the table of contents. You will need to repaginate the document so that the main text starts on page 1. Consequently, you must insert a section break and then repaginate beginning from this point. 
Thus, first insert a Next Page section break as outlined above. Now, with your cursor still at the top of this new section, there are two ways to repaginate. If you are only concerned with having page numbers appear in your header or footer for the main text and not on the title page or table of contents itself, do the following:
1. Open the upper ribbon and navigate to the Insert tab.
2. Hit Control and use the Right arrow to the Header and Footer group.
3. Tab to the Page Number submenu and press Enter (shortcut: Alt N N U). 
4. Down arrow to Page Number Formats and press Enter. 
5. Tab to the Continue from Previous Section check box and hit the Spacebar to uncheck it. 
6. Tab to the Start At edit spin box and hit the Up Arrow to 1.
7. Tab to the OK button and press Enter. 
Now Up arrow once and Down arrow once, and your screen reader will say, “page 1, section 2.” 
Finally, update the table of contents, and it should be correctly paginated. 
3.7.3 Multi-Column Formatting 
You may wish to use multi-column formatting to prepare a newsletter or flyer. You can use it for an entire document or a section of a document. Because text navigation and editing can be a bit complicated in a multi-column environment, it is better to convert your text towards the end of the document preparation process.
Steps for converting standard text to multiple columns are:
1. Select the text that you wish to convert. Assuming this is a fairly large amount of text, use the Extended text selection process (see Chapter 3.8.6 below) to select the text. 
2. Navigate to the Layout tab of the Upper ribbon.
3. Tab to the Columns submenu (shortcut: Alt P J) and press enter. 
4. To accept default formatting, Down arrow to the number of columns you want and press Enter. 
The default formatting includes automatically calculated column width, and blank space between columns. For example, if you select two columns on a standard 8.5 by 11-inch page with one-inch left and right margins, each column will be three inches wide with one-half inch blank space between columns, totaling 8.5 inches. If you wish to alter any of these parameters, repeat steps one through three above, and then:
1. Down arrow to More, and press Enter. This opens a dialog box.
2. Up arrow to the number of columns you want. 
3. Tab to Line Between and press the Spacebar if you want a narrow line to appear between the columns.
4. Tab to Width and change it if you want.
5. Tab to Spacing (this is the space between columns) and change it if you want. 
6. Tab to the Checkbox which is checked by default. If you uncheck this, you will need to press Shift Tab to go back an manually adjust the various column widths. Probably, you will rarely uncheck this checkbox.
7. Tab to Apply To, where your choices are Entire Document, Selected Text, or Section, depending on how you have highlighted the text. Up or Down arrow to the appropriate selection.
8. Tab to the OK button and press Enter.
A few other important points to highlight. First, if you select text (rather than the entire document) and insert columns, section breaks will automatically be inserted at the beginning and end of the multi-column text. If you want the multi-column text passage to appear on separate pages than the text before and after it, press Control Enter where the new sections begin and end to insert page breaks.
Within the multi-column text, you can insert a column break if you want to start a new column before it would naturally wrap back to the top of the next column to the right. To do this:
1. In the Layout tab of the ribbons, Tab to the Breaks submenu and press Enter. The shortcut key is Alt P B.
2. Down arrow to the Column button and press Enter.
JAWS has a few keystrokes that are helpful when formatting columns. With your cursor in one of the columns, press Insert F1 for JAWS Screen-Sensitive Help. JAWS will say something like: ”The cursor is in text column 1. The section contains 2 newspaper style columns which are 3 Inches wide. The columns are evenly spaced. The gap between columns is 0.5 Inches wide. There is a vertical line between the columns. The document has 3 sections. The cursor is in section 2.”
Also, be sure that breaks are set to be revealed in JAWS Quick Settings. This is a default setting, but it is good to verify. To do this:
1. While in Word, press Insert V to access Word Quick Settings.
2. In the edit box where you land, type in “break.”
3. Down arrow once to the Page, section, and multiple column breaks checkbox and check it.
4. Tab to the OK button and press Enter. 
JAWS will now detect page, section, and column breaks while reading through the document. This is particularly helpful in revealing when a new column starts, and verifying that section breaks are correctly inserted at the beginning and end of multi-column text passages.
NVDA reveals this information by default as you Up and Down arrow through the document. When it encounters the beginning of a multi-column text section, it will say something like “Section two, one of two columns.” At the end of the multi-column section, it will say “Section 3, one of one columns,” indicating a return to standard text. 
Narrator does not announce any information when you enter or exit multi-column text passages. 
You can also quickly navigate to section breaks by using the Windows special character. Press Control F to open the Find command, type in the special character which is “^B” minus the quotes, and press Enter. Press the Spacebar to proceed to the next section break. The keystroke for the caret symbol is Shift 6 on the number row. 
Unfortunately, none of the screen readers have keystrokes for toggling between columns. Just use standard navigation and reading keys for moving by paragraph and Say all mode. Note that if you Down arrow to read line by line, when you reach the bottom of a column, Down arrowing again will not move you to the top of the next column. It will instead move you to the first line of the next section in standard text. Only paragraph and Say all navigation will move you to the top of the next column. 
Finally, you may wish to put a border around your columns. This is especially appropriate if you choose to put a line between columns. It would look strange to have only a line between the columns but not around them. To add borders:
1. With your cursor situated in the section with the multi-column text, go to the Design tab of the Upper ribbon.
2. Tab into the Lower ribbon to Page borders and press Enter.
3. Down arrow to the Box radio button.
4. Tab through and you should hear that the top, bottom, left, and right borders are checked.
5. Tab to Apply to and Down arrow to “This section.”
6. Tab to the OK button and press Enter.
You can also select various customizations in this dialog box, such as changing the line format, width and color.
[bookmark: _Toc1629865]3.8 Additional Tools for Text Reading, Selection, and Editing 
You may already be familiar with the above keystrokes. However, you might be less familiar with some of the tricks and tips in this section, so read on. 
3.8.1 The Find and Find and replace Commands
The Find command is useful for searching for specific pieces of text. Press Control F and type in the word or words you want to search for. Press Enter and Word will jump to the first occurrence of the word from your cursor position. Press Escape to return to the text if this is the occurrence of the word you were looking for. If not, press the Spacebar to jump to the next occurrence, and each subsequent occurrence. 
The Find and replace command is a great time-saver if you have to replace numerous occurrences of a word, phrase, or code with something else, or you need to delete it. The shortcut key is Control H. A few examples help to illustrate its utility. 
The screen reader program “JAWS” should be written in all caps. But if you have mistakenly written it with only the first letter capitalized, and you have repeated this many times in your document, it will be tedious to find every occurrence and manually correct it. Instead, do the following:
1. Press Control H, which lands you in the Find edit field. Type in the incorrect “Jaws” (minus the quotes).
2. Tab once to the Replace field and type in the correct “JAWS” in all caps, minus the quotes.
3. Tab several times to the Replace all button, and press Enter or the Spacebar. Your screen reader will say “All done. We made 46 replacements,” or whatever the correct number is. 
4. Your focus is on an OK button. Press the Spacebar to finish. 
5. Press the Escape key to exit the Find and replace dialog. 
Here’s another example, and one I use frequently. If you copy and paste text from the Internet into Word, it often comes in with lots of unwanted hard returns between lines. The symbol for the hard return is caret P. Press Shift 6 on the number row to type the caret symbol. To remove the extra hard returns, type in “caret P” twice in the Find field, type it in once in the Replace field, Tab to Replace all, and press Enter or the Spacebar. This will remove the unwanted hard returns while preserving those for separating paragraphs. Repeat this until you are down to zero replacements. Press the Escape key when finished.
To entirely delete multiple occurrences of some text, type the text in the Find field, leave the Replace field empty, and press the.
Note that after invoking either the Find or Find and replace command, pressing Control Page up or Control Page down to go to the previous or next page no longer works. You will instead hear “previous occurrence” or “next occurrence.” To remedy this, press Control G to invoke the Go to page command. Now type in a page number and press Enter and Escape. Control Page up and Control Page down will once again work for navigating to the previous and next page in your document. 
3.8.2 Skim Reading 
Often, it is not worth your time to read every word in a document. You may want to get a quick general impression of a document before reading it in-depth. You can save yourself a lot of time and be more efficient if you learn how to skim read.
Sighted readers often skim read by glancing in a few key places on the page and moving on. But how can screen reader users accomplish the same thing? The basic idea is to jump from paragraph to paragraph, listening to just enough text to get a general sense of the content of the document. There are several ways you can do this. 
Here is one way. The keystroke to jump to the next paragraph and read it is Control Down arrow. To skim read, hold down Control and don’t let it up. Now Down arrow to hear the first few words of the next paragraph. Once you have a quick sense of its content, use the Down arrow to move to the next paragraph, listen a bit, and so on. Obviously, when you arrive at an important paragraph, listen all the way through. Because Control Down arrow is a Windows keystroke, it works with all three screen readers. 
With JAWS and Narrator, another way to achieve the same result is to use a combination of Quick keys mode and Scan mode, respectively and P (for paragraph). With JAWS, press Insert and Z together to turn on Quick keys mode. Now press the letter P to jump to the next paragraph, read a bit, press P again, read some more, and so on. 
With Narrator, press Insert and Spacebar together to turn on Scan mode. Now press the letter P to jump to the next paragraph, read a bit, press P again, read some more, and so on. 
NVDA does not support first letter paragraph navigation with P, so only the Control Down arrow technique will work. 
JAWS also has a Skim reading tool. Pressing Control Shift Insert Down arrow displays a dialog with options for indicating how skim reading is performed, including reading the first line or first sentence of every paragraph. The advantage of this tool is that you can start it up with a single keystroke and listen continuously without having to press any other keystrokes. The disadvantage is that you have to listen to entire lines or sentences before moving to the next paragraph. If speed is your objective, using this JAWS utility will probably be significantly slower than the other methods. 
3.8.3 Go To Command
If you are in a large document with many pages, the Go To command will help you to quickly navigate to a given page. Press either Control G or F5 to open it, type in the page number you want to navigate to, and press Enter. Now press Escape to exit the dialog box and you should now be situated on that page. 
The Go to command default is page, but you can also use the Go To command to navigate to other elements in your document, including bookmarks, which are discussed in the next section. 
3.8.4 Bookmarks
Insert bookmarks in documents so you can quickly navigate to important passages. You need to know how to create bookmarks, as well as how to navigate to them once you have created them. 
To add a bookmark:
1. Navigate in your document to the place where you want to insert the bookmark. 
2. Press the shortcut key Alt N K. The Bookmarks command is situated in the Lower ribbon of the Insert tab, but is difficult to find. Alternatively, you can press Control Shift F5.
3. This lands you in an edit field. Type in the name of your bookmark. The name cannot have any spaces between words. Type in a single word, or if you want it to have more than one word, place an underscore between the words (example: world_news). You also cannot repeat the same name in your document: each bookmark name must be unique. 
4. Press Tab once to get to the Add button and press Enter or Spacebar. 
Once you have created bookmarks use the Go To command to navigate to them. The steps are:
1. Press Control G or F5.
2. By default, the Go To command is set for Pages. To change this, press Shift Tab once, and Down arrow to Bookmarks. 
3. Press Tab once and you land in a combo box with your list of current bookmarks.
4. Use the Down arrow or first-letter navigate to get to your bookmark choice, and press Enter. 
5. Press Escape to move out of the dialog box and you should land at your bookmark location. 
With JAWS, there is another way to navigate to bookmarks which is quicker than the above method. Turn on Quick keys mode by pressing Insert Z. Now press B and Shift B to go to the next or previous bookmark. 
To delete bookmarks if you no longer want them:
1. Press Alt N K or Control Shift F5 to get into the Bookmarks dialog box. 
2. Up or Down arrow to the bookmark you want to delete.
3. Tab twice to the Delete button and press Enter or Spacebar. 
3.8.5 Highlighting Text and Accessing It With JAWS
An alternative to bookmarking is highlighting. Many sighted students use a colored marker (usually yellow) to highlight text that they want to refer back to while studying. Unlike with bookmarks, you can highlight large segments of text. And then use the JAWS Skim Reading tool to quickly navigate to those passages, as well as create a summary document containing all or some of the highlighted text. Unfortunately, NVDA and Narrator do not have similar tools.
Highlighting text is easily done in Word. First, select the text you want to highlight. Then navigate to the Text highlight split button in the Font group of the Home tab. The default is yellow. Press enter or Spacebar to accept the default, or Press Alt Down arrow to expand the split button and pick another color. The ribbon shortcut key is Alt H I. 
Highlighting changes the background color for the selected text. From here on, I will assume you choose the yellow default background. If you Press Insert F to check formatting, it should say “default on yellow” rather than the usual “default on default.” Note that it may not say this immediately, but after a few tries, JAWS will eventually indicate that the background color has changed. 
Once you have highlighted text, you can now use the JAWS Skim Reading tool to quickly access your highlights. Steps are as follows:
1. Press Insert F2. This opens the JAWS Manager.
2. Press S several times to get to the Skim Reading tool and press Enter.
3. Down arrow to the Use rule type: attribute and color rule.
4. Tab to the Color or attribute rules: background color” combo box and press Y to select yellow. 
5. Tab to the Speak unit combo box and choose between lines, sentences, or paragraphs containing text. Which of these you choose depends on how you have highlighted the text. If you have primarily highlighted individual lines or sentences, choose one of those in the combo box. If you have tended to highlight entire paragraphs, choose that one. Experiment a bit for best results. 
6. Tab to the Start skim reading button and press Enter or Spacebar to have the highlighted text read back to you.
7. Far more useful, tab one more time to the Create summary button and press Enter. 
This final step presents a pop-up entitled “Skim Reading Results” with each of the highlighted text segments appearing as links. Press Enter on any of these links to get back into the Word document at that point. If you want to create a separate document with all the highlighted text:
1. In the Skim reading results pop-up, press Control A to select all the text.
2. Press Control C to copy it to the clipboard.
3. Open a new Word document with Control N.
4. Paste the text only with Alt H V T. Don’t do a simple paste because this will keep the link formatting which is no longer useful when saved in a new document. Each former link will be numbered. 
After you have skim read highlighted text, JAWS will remember this and create a rule so you don’t need to repeat all the steps above to define your skim reading parameters again. From now on, when you open the Skim Reading tool you will immediately land on a combo box entitled “Rules history: star – yellow.” You can then shift tab back to the Create summary button or the Start skim reading button to perform these actions. 
To delete these rules if you no longer need them, return to the JAWS Skim Reading tool and Tab a number of times to the Delete rule or Delete all rules buttons. 
To see how JAWS reads this information, several blocks of text have been highlighted in this section (including this paragraph). Try the various tools above to check it out. 
3.8.6 Extended Text Selection 
Sometimes you need to select a large block of text, perhaps several pages, and repeatedly pressing keystrokes for selecting smaller segments of text is inefficient. Both JAWS and NVDA have an Extended text selection command that makes this process much quicker and easier than trying to select a large number of lines or paragraphs. 
To perform Extended text selection with JAWS:
1. With your cursor situated at the beginning of the text you wish to select, press Control Windows K, which is the keystroke for creating a temporary placemarker. JAWS will say “marking place.”
2. Place your cursor at the end of the text you wish to select, and press Insert Spacebar, and then M. Be sure to hold down the Insert and Spacebar together until you hear a click. Then press M. Don’t try to hold down all three keys together. JAWS will say “selecting between marked place and current position.”
3. The text is now selected, and you can copy it with Control C, cut it with Control X, or delete it with the Delete key. If you copy or cut the selected text, you can then navigate to where you want to paste it and press Control V.
With NVDA: 
1. With your cursor situated at the beginning of your text selection, press Insert F9. NVDA will say “start marked.”
2. Place your cursor at the end of your text selection, and press Insert F10. NVDA will tell you how many characters have been selected. 
3. You can now copy, cut, paste, or delete your selection.
Here’s another way that works with all three screen readers because it is a Windows process. However, audio feedback may not be very good. 
1. Place your cursor at the beginning of your selection and press F8. JAWS will say “extended selection mode on.” Narrator won’t say anything, but it is on.
2. Navigate to the end of the text you want to select.
3. Use standard keystrokes to copy, cut, or delete the text.
[bookmark: _Hlk532797468]3.8.7 Paste Text Only
Often when you copy and paste text from one application to another, simply pasting with Control V will import undesired formatting from the original source. This is especially true when copying text from a website into a Word document. You may very well import font styles, sizes, and colors that are very strange. Using the Paste text only command can help avoid problems like this. 
[bookmark: _Hlk62022834]Let’s say you are on a web page and wish to copy text from there and paste it into a Word document. First, select the text and copy it as you normally would by pressing Control C. Now press the Applications key, Down arrow twice to Paste options, Left arrow once to Paste text only, and press Enter. Alternatively, use the shortcut key, which is Alt H V T. 
3.8.8 Word Count
Instructors often impose a word count limit on assignments. Newspapers specify word limits for article submissions. To obtain the word count, go to the Review tab of the Upper ribbon, press Tab three times to get into the Lower ribbon to Word count, and press Enter. This reveals the number of pages in the document, the word count, and several other statistics. The ribbon shortcut is Alt R W.
To get the word count for a segment of text rather than the entire document, select the text and use the keystrokes above to get a word count for just that text.
An alternate method is to press F6 twice from inside the document to navigate to the Status bar. If you do not immediately hear the word count, Down arrow once or twice to hear it. Then press F6 two more times to return to the document text.
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Outlook is the Office Suite program for reading and sending email messages. You can also save contacts, schedule appointments and meetings, and create custom folders for storing messages. While many alternative programs exist (the Windows Mail app, webmail, email on your smartphone, among others), I find that Outlook is easier to use, more efficient, and more consistent and predictable than these alternatives. 
After installing Microsoft Office, you will need to load your existing email account or accounts into Outlook. Unfortunately, when I try to do this for my students, I often fail. While this process may not be completely inaccessible, it often flunks the usability test. A call to the Microsoft Disability Desk is often the best choice for getting this job done. Before you call, be sure you know both your email address and password. If you have forgotten your password, the Disability Desk should be able to help you create a new one. 
4.1 Message Basics
4.1.1 Reading and Deleting Messages
When you first open Outlook, focus goes to the top message in the list of messages in your Inbox. By default, messages are arranged chronologically, with the most recently received message at the top of the list and the oldest one at the bottom. Down arrow or Up arrow to a row with information for each message. This includes the name of the sender, the subject, the date, and size of the message. If one or more files are attached to the message, this too will be indicated. 
Press Enter to open a message. Focus will be placed at the top of the body of the message. Use standard reading keystrokes to read and navigate through the body of the message.
To access other fields in the message, press Shift Tab. This will enable you to access the Subject, Date, To, CC and Date fields. Ordering is not consistent between the various versions of Outlook, or at least I have not been able to detect any pattern. However, if there are attachments, it is always the case that a single Shift Tab, starting from the top of the message body, brings you to the list of attachments (more on attachments below). 
Why is information in some of these other fields useful? Beyond just yourself, it is good to know who else has received the message, whether in the To or CC field. If the message was sent just to you, or to you and just a few others, chances are good that the sender is expecting you to reply. But if you are just one in a large group of recipients, or it has been copied to you, then you are usually being sent the message for purely informational purposes, and probably no response is expected from you. 
When finished reading the message, press Escape once. This will usually return you to the Inbox. I say “usually” because there are times when pressing Escape tosses you out of Outlook and places focus in another previously opened window. This often happens when you have been working with a message with attached files. When this happens, pressing Alt Tab once usually returns focus to the Inbox. 
If you now want to delete the message from the Inbox, simply press the Delete key and it will be moved to your Deleted items or Trash folder. You will not be asked for a confirmation. Be diligent in deleting messages you no longer need. If thousands of messages accumulate in your Inbox, your efficiency in finding the messages you actually need will suffer.
Also, be cautious about getting on lots of commercial mailing lists. In extreme cases, I have had students who received 40 or 50 messages per hour, most of which were total garbage. Their ability to find the one or two messages that actually mattered was severely hampered. In such cases, consider creating a new email account and no longer using this problematic one. Alternatively, you could unsubscribe from unwanted bulk email lists, but this is time-consuming. For some of these lists, senders purposely make it difficult to find out how to unsubscribe. 
4.1.2 Preparing Messages
You will usually initiate the process of preparing a new message from your Inbox. However, you can also do this from another folder containing lists of messages. These include your Sent items, Deleted items, Drafts folders, and any custom folders you have previously created. 
To prepare a new message:
1. Press Control N which will place your cursor in the To field.
2. Type the email address of a recipient. If you want to address the message to more than one recipient, place a semi-colon after each address to separate them. 
3. Tab to the CC field, and type in addresses for those to whom you want to copy the message.
4. Tab to the Subject field and type in text that reflects the content of the message.
5. Tab to the Message body field and compose your message. 
6. Press either Alt S or Control Enter to send the message.
Note that the very first time you press Control Enter to send a message, a dialog box will open asking if you want to use this keystroke as a shortcut for sending messages. Tab to the Don’t show this message again checkbox and press the Spacebar to check it. Then Tab to the Yes button and press Enter. This dialog box will no longer pop up. 
After the message is sent, focus is returned to the folder where you began preparing the message. At any point in preparing the message, you can press Shift Tab to navigate back to the various fields. I mentioned above that, when tabbing and shift tabbing through a message you have received, the order is inconsistent. However, when you are preparing a message, the Tab order is consistent and predictable. 
Here’s some advice on email etiquette. Take time to put text in the Subject field that meaningfully reflects the content of your message. For example, if you are on a technology discussion list, don’t type in vague stuff like “A Question,” or “Problem with Outlook.” Be specific instead by typing “Problem Creating Outlook Folders.” If you consistently type in vague text on the Subject line, recipients will think you don’t know what you are doing or are just lazy. And if you can’t take the time to type in something thoughtful, why should recipients waste their time opening and reading your messages?
4.1.3 Replying To and Forwarding Messages
There are two ways to reply to a message you have received – replying to just the original sender or replying to the original sender and all other recipients. To reply to just the sender:
1. Open the message and press Control R.
2. This lands you in the body of the message and the subject starts with RE: to indicate that this message is a reply. Type in your message. 
3. Press Alt S or Control Enter to send the message.
To reply to the sender and all other recipients, press Control Shift R and repeat steps 2 and 3 above. This is called Reply to all.
Now for some sage advice on using Reply to all. Before sending, and especially if you think your message is sensitive or potentially negative in some way, always Shift Tab to verify the addresses in the To and CC fields. If you are a veteran emailer, you inevitably know of horror stories where you either sent a message to an unintended recipient, or you received a message that was clearly not meant for your ears or eyes. Just thinking about this dredges up bad memories and nausea. In best case situations, such faux pas were just mildly irritating. Unfortunately, I also know of situations where the results were extremely ugly. So always doublecheck before sending. Even better, if you ever think that a message could be remotely offensive, don’t send it. Even if you are diligent in doublechecking your addressees, remember that those same addressees might not be as careful as you, and could cause problems in the next round of replies. If you really feel like you need to vent some pent-up frustration to somebody, use old-fashioned technologies like the telephone instead. Email is an effective communication tool for many things. Resolving interpersonal conflicts is not one of them. 
After receiving a message, you may wish to forward it to other people. To do this:
1. Arrow to the message in your message list or open the message.
2. Press Control F which places focus in the To field.
3. Type in the email address or addresses of the intended recipients. 
4. If you want to add a message from yourself, Tab to the message body and type it in.
5. Press Alt S or Control Enter to send the message.
The Subject field will begin with FW: to indicate it is a forwarded message. 
4.1.4 BCC Field 
Use the Blind carbon copy, or BCC field to hide addresses among recipients. This is most frequently done for privacy and confidentiality purposes. As you know, it is inappropriate to share other people’s phone numbers without their permission. The same goes for email addresses. If you have ever received a message that said, “From John Smith to John Smith,” this is an indication that the sender used the BCC field to prepare it. 
The BCC field does not appear by default. You will need to add it. To do this, you need to be in the window for preparing a message. Steps for adding the BCC field are:
1. Press Control N to prepare a new message. 
2. Press Alt to open the Upper ribbon, and Right arrow to the Options tab.
3. Tab to the BCC button and press Enter. The shortcut key is Alt P B.
The BCC field now appears between the CC and Subject fields. Any addresses you insert here will not be seen by the recipients. The BCC field will now appear in all future messages. To remove it, repeat the steps above. 
4.1.5 Issues Related to Selecting Addresses
There are various ways you can enter email addresses in the To, Cc and BCC fields. If you have no previous history of exchanging emails with a particular recipient, you will need to type in the full address. If you have some previous history of exchanging messages with a recipient, typing in the first letter or first several letters of that person’s address may auto-populate the address field with that person’s address. If you hear the desired address as you are typing, either press Enter or the Tab key to input that address. After doing this, it is a good idea to Tab to the next field, and then Shift Tab back to verify that the correct address has been entered. 
Let’s say that you have several addresses in memory that begin with the letter M and you want to send a message to Mary Jones. If you press M and hear the address of somebody else, press the Down arrow key to see if Mary Jones is in the list. If she is, press Enter or Tab to insert that address. If her address does not appear, press Alt K and this will usually extend the list to more addresses beginning with the letter M. 
Auto-populating of addresses, as well as getting a full list of addresses, used to work reliably in Outlook. In the last few years, this seems to have broken. Sometimes addresses for people you seldom communicate with appear, while regular correspondents fail to appear in the list. Pressing Alt K may extend the list, but with no guarantee of finding the desired address. 
To ensure that you don’t lose addresses, it is a good idea to diligently add addresses to your Contacts folder. They are not automatically added just because you have a history of exchanging messages with a person. See Chapter 4.6 on how to add contacts. 
There are several ways to access addresses in your Contacts folder for preparing messages. The two ways I prefer involve first navigating to the Contacts folder. The quickest way to get there is to press Control 3 from anywhere in Outlook. Once in the Contacts folder, you can use the following technique if you have a Microsoft 365 account. 
1. First-letter navigate to the last name of the person whose address you want to use. Note that you can only press that first letter once, and will then need to Down arrow through other last names beginning with that letter until you find the contact you want.
2. Press Enter to open the contact dialog.
3. Press Alt H E to address a message to that person. You land in the Subject field, with the address already inserted in the To field.
4. Complete the message and send it. 
If this does not work for you:
1. Repeat steps 1 and 2 above.
2. Tab to the Email edit field.
3. Select the email address and copy it with Control C.
4. Escape out of the Contact dialog and return to the Inbox.
5. Press Control N to prepare a message.
6. Press Control V to paste the address in the To field. 
7. Complete the message and send it. 
I have found that my iPhone more reliably remembers the full list of recipients with whom I have a history of corresponding. If the above steps don’t work, I search my native Mail app or Outlook app there and usually find the address I am looking for. This works despite the fact that I do not regularly enter email addresses into my iPhone contacts.
4.2 File Attachments
People often have the impression that dealing with attachments is complicated and confusing. This may especially be the case for saving them and attaching them to a new message which can involve navigating to the ribbons and opening a sometimes confusing dialog box. 
While that is one approach, I am going to ignore that and show you a simpler and quicker way that involves selecting, copying and pasting files. In this section, I will cover opening attached files without saving them, a short detour on disabling Protected view, saving attached files you have received, and attaching files to a message you are preparing. I will also talk about dealing with multiple attachments. 
4.2.1 Opening Attachments
To open an attached file without saving it:
1. Open the email message with the attachment.
2. Press Control Home to place your cursor at the top left of the message field. 
3. Shift Tab once to place focus on the attached file and press Enter (note that pressing the Spacebar will not work).
4. You first land on a Save button. Tab twice to the Open button and press Enter or Spacebar.
The attached file now opens in a separate window and you can read through it. When you are finished with it, press Alt F4 to close the window. If this is the first time you are opening a Word, Excel, or PowerPoint file, you will hear that the file is in Protected view. You will need to disable this before you can read or edit the file.
4.2.2 A Short Detour About Disabling Protected View
Files from the Internet, email attachments, and from other potentially unsafe locations can contain viruses and malware that can harm your computer. Protected view is intended to help protect your computer. Ultimately, your best defense is to only open or save attachments from people you trust. Never open or save a file from somebody you don’t know. 
For any Word, Excel or PowerPoint files you receive as attachments, you will need to disable Protected view in each of those applications so that attached files you attempt to open or save to your computer behave properly. You can disable Protected view one file at a time, or you can do it permanently. Procedures are identical in each of these Office applications. 
To disable Protected view one file at a time:
1. Open the email message with the attached file.
2. From the top of the body of the message, press Shift Tab once to place focus on the attachment, and press Enter.
3. Press Control S or F12, as if you were intending to save the attached file. Your screen reader will say, “Saving is disabled in Protected view. If you trust the source of this file, and would like to save, click enable saving.”
4. Tab once to the Enable saving button and press Enter. 
To disable Protected view permanently, and using Word as an example. 
1. Open Word and press Alt F T to open the Options dialog which contains a list of categories.
2. Down arrow or press the letter T to get to the Trust center category, but do not press enter.
3. Tab to the Trust center settings button and press enter or spacebar.
4. Press the letter P for Protected view, but do not press enter.
5. Tab to each of the following three checkboxes and press the spacebar to uncheck them: Enable Protected view for files originating from the Internet; Enable Protected view for files located in potentially unsafe locations; and Enable Protected view for Outlook attachments.
6. Tab to the OK button and press enter or Spacebar.
7. Tab to a second OK button and press enter.
8. If you started this procedure while in a file that you opened in Protected view, press Alt F4 to exit the file and then reopen it. 
Protected view is now permanently disabled for this application. Note that disabling Protected view exposes you to a greater degree of vulnerability to viruses and malware. Your best defense against malicious viruses is to never open or save an attachment from somebody you do not know. Take no chances: delete the message instead. 
4.2.3 Saving Attachments
The quickest and easiest way to save an attachment from a message you have received is to use the copy and paste method. Steps are:
1. Open the message with an attachment.
2. Shift Tab once to land on the attached file. This selects it.
3. Press Control C to copy the file to the Clipboard.
4. Navigate to where you want to save it and press Control V to paste it there.
4.2.4 Attaching Files
Attaching files from your Documents folder or some other folder on your computer to a message you are preparing simply involves reversing the save process in the previous section. Steps are:
1. In the folder on your computer where the file is located, Up or Down arrow to, or first-letter navigate to the file you wish to attach. Either of these selects the file.
2. Press Control C to copy it to the Clipboard.
3. Open Outlook and prepare a message, following the steps enumerated in Chapter 4.1.2 above, inserting one or more addresses in the To field.
4. With your cursor situated in the body of the message, press Control V to attach the file. Note that you must be in the message body for this to work. 
5. Shift Tab once to verify that the attachment is there.
6. Press Alt S or Control Enter to send the message.
Be sure to include text in the Subject field, body of the message, or both, referencing the attachment so recipients are aware it is there. Also note that you can attach multiple files. If they are all located in the same folder, you can select and copy them using the same file selection keystrokes outlined in Chapter 2.6.2. If the files are not all located in the same folder, you will have to select them separately. 
4.2.5 Multiple Attachments
You may receive messages with multiple attachments or wish to attach more than one file to a message. To access multiple attachments in a message you have received, open the message and press Shift Tab once. Focus will be placed on the first attached file. You will hear the file name and “one of five attachments,” or whatever the total number of attachments is. Press the Right arrow to move to the second attachment, and so on. Once you have placed focus on an individual file, you can open it or save it using the steps identified above.
You can also save all the attachments to your computer. It is advisable to create a new folder and save them there. If instead, you simply save them to your Documents folder, they will scatter around in the alphabetical list of files. You probably want to keep them together, at least at first. Steps are:
1. Open the message with multiple attachments.
2. Shift Tab once to place focus on the first attachment.
3. Press Control A to select all the files. Note that you may not hear anything after you do this, or what you hear is inconsistent, but don’t worry.
4. Press Control C to copy the files to the Clipboard.
5. Navigate to the folder where you want to save them and press Control Shift N to create a new subfolder. 
6. Type in an appropriate folder name and press Enter.
7. Press Enter again to place focus inside the new folder.
8. Press Control V to paste the files in the new folder.
If you want to attach multiple files to a message you are preparing:
1. Follow the steps in Chapter 2.6.2 for selecting consecutive or non-consecutive files.
2. Press Control C to copy them. 
3. In the body of an email message, press Control V to paste the files.
4. Press Shift Tab once to verify that the files are there. 
5. Press Alt S or Control Enter to send the message.
4.3 Navigating Folders Using the Tree View
So far in this chapter, I have only talked about the Inbox folder. But there are other important folders you will want to access, including Sent items, Deleted items or Trash, Drafts, Calendar, Contacts, Outbox, and custom folders that you create yourself. There are more folders, but these are the most important. You navigate to these through a tree view.
The tree view presents a hierarchical view of the folder structure of your email account or accounts. The folder hierarchy is displayed as levels 0, 1, 2, etc. as you arrow from left to right. Right arrow to open or expand a folder, Left arrow to close or collapse a folder, and Up and Down arrow to move within a folder level. 
The precise nature of your folder structure varies according to your account provider (Gmail, Comcast, etc.), as well as your account type - IMAP or POP3 
IMAP (Internet Message Access Protocol) is a method of accessing email messages that downloads them to your computer, but also leaves copies on the server. If you delete a message on your computer, this will be reflected on the server. 
Another popular email protocol is called “POP3.” With POP3, messages are downloaded to the computer, but any actions you take on the computer will not be reflected on the server. The advantage of using an IMAP mail server is that users can check their mail from multiple devices (computers and smartphones) and always see the same messages. In essence, this synchronizes your messages on all your devices. POP3 does not.
Whichever provider and account type you have, the important thing for you is to understand the logic of your tree view structure. Because it is a very common arrangement, I will use the example of a Gmail IMAP account. 
The Outlook Tree View can be accessed in two ways. You can either press Control Y or Shift F6 to open it. We will now take a tour using Control Y for a fictitious account called john.smith@gmail.com.
1. Starting from your Inbox, press Control Y, your screen reader will say “Go to folder dialog tree view, the number of unread messages, inbox.” After “inbox,” you may also hear “closed” if you have created some custom folders (more on this later). 
2. Up arrow once. You will hear level 0 john.smith@gmail.com open, indicating that the account folders are still visible and expanded, but that you have shifted left to level 0. 
3. Left arrow one more time. You will hear john.smith@gmail.com closed, indicating that the account folders are now collapsed. You are at level 0 and as far left as you can get.
4. At level 0, if you Up arrow, you will hear “To-Do List.” If you Down arrow, each account you have loaded into Outlook will be listed in the level 0 column.
5. Arrow back to john.smith@gmail.com closed.
6. Right arrow once and you will hear “level 1 john.smith@gmail.com open,” indicating that you have shifted right to level 1. 
7. Down arrow through the level 1 column for this email account. Folder names you will hear are Gmail closed, Calendar, Contacts, Drafts, Outbox, and numerous others. 
8. Up arrow back to Gmail closed.
9. Right arrow once and you will hear “Gmail open.”
10. Down arrow once and you will hear “Level 2 Drafts,” indicating that you have shifted to the level 2 column where folders of Gmail are listed. Important folders here are Drafts, Sent items, Trash, and Spam. 
Let’s stop our tour momentarily at this point. If you have a Gmail IMAP account, it is critical that you know about opening or expanding this level 2 area. Otherwise, you will not be able to access these important folders. In addition, and this is a confusing thing about this folder structure, you may have redundant Drafts and Deleted items folders at level 1 of the tree view. I do not know why these duplicate folders exist. They appear to be there only to complicate your life. So, let’s say you save a draft message and then go to this redundant level 1 Drafts folder where you will find nothing. If you do not know that your draft message invariably goes to the level 2 Drafts folder, you will think that it has disappeared, and you will freak out. 
While this folder structure may seem unnecessarily complicated, with some practice you will soon get used to it.
Once your level 1 and 2 folders are expanded, you can use first-letter navigation to move quickly, and then press Enter to get into that folder. For example, starting from the Inbox, press Control Y and then S to quickly navigate to Sent items. Press Enter to get into that folder. Press Control Y again, and then C to navigate to the Calendar or Contacts folder, and so on. 
Here are a few other useful keystrokes for moving around quickly between folders:
· Alt Left arrow: Move back to the previous folder you were in.
· Alt Right arrow: Move forward one folder.
· Control 1: Move to the last folder you were in with a list of messages. This could be the Inbox, Sent items, Deleted items/Trash or Drafts folders. 
· Control 2: Move to the Calendar folder.
· Control 3: Move to the Contacts folder.
· Control Shift I: Move to the Inbox.
4.4 Custom Folders
You can create your own folders for organizing and easily retrieving important messages. After creating a custom folder, you can easily move or copy messages to it. This is preferable to leaving them in your inbox where they will be harder to find as the number of messages grows. You can also create rules for automatically moving messages to one of these custom folders.
4.4.1 Creating and Managing Custom Folders
Where you start the process of creating a custom folder determines where it will show up in the tree view. If you start from inside your Inbox, the custom folder will become a level 2 folder situated to the right of your level 1 Inbox. If you open the tree view from your Inbox, you will hear “Inbox closed,” indicating that you have one or more level 2 folders currently collapsed to the right of your level 1 Inbox. 
If you start the process from inside level 0 where the name of your account is, your custom folders will appear at level 1, the same level where Inbox, Gmail closed, etc. appear. In the example below, we will start from inside the Inbox.
1. From inside the List view of your Inbox messages, press Alt to open the Upper ribbon and Right arrow to the Folder tab.
2. Tab once to the New folder button and press Enter (shortcut key is Control Shift E). 
3. Type in the custom folder name and press Enter. 
There are several ways to copy or move messages from a folder with lists of messages (Inbox, Sent items, Drafts, Deleted items/Trash) to the custom folder. I will show just one way. Using the Inbox as an example, here are the steps:
1. In the Inbox message list, arrow to a message to select it. To select multiple continuous messages, arrow to the first message, hold down the Shift key and arrow down to select additional messages.
2. Press Control C to copy them or Control X to cut them. Most of the time, you will want to cut them because one reason for having custom folders is to clean out Inbox clutter.
3. Press Control Y to open the tree view. You will either hear “Inbox closed” or “Inbox open,” depending on whether the level 2 folders associated with it are collapsed or expanded. 
4. If you hear, “Inbox closed,” Right arrow to expand it, and Down arrow or first-letter navigate to the custom folder. If you hear, “Inbox open,” Down arrow or first-letter navigate to it.
5. Press Enter to get into the custom folder.
6. Press Control V to paste the message or messages into the custom folder.
You can perform four actions on existing custom folders – rename, copy, move, and delete. To do any of these, your focus must be inside the folder. 
To rename a custom folder:
1. Starting from inside the folder you want to rename, press Alt to open the Upper ribbon and Right arrow to the Folder tab.
2. Tab several times into the Lower ribbon to the Rename folder button and press Enter.
3. Type in a new name for your folder and press Enter. The renamed folder will now reposition itself alphabetically in the tree view within its level.
Why would you want to copy or move a folder? The only reason I can think that you might want to copy a folder is if you had more than one account added to Outlook and you wanted to copy it to one of those other accounts. You might want to move a folder if you would like it to be situated at a different level in your folder structure. For example, you might decide that you want to move a folder from level one to make it a level two subfolder of your Inbox. I will only describe the steps for moving a folder.
1. Starting from inside the folder, press Alt to open the Upper ribbon and Right arrow to the Folder tab.
2. Tab several times into the Lower ribbon to the Move folder button and press Enter.
3. You land in a dialog box with the tree view. Arrow to, or first-letter to the folder for which you would like to make this folder a subfolder.
4. Tab to the OK button and press Enter. 
You can delete a custom folder and all its contents if you no longer need it. If you do not want to delete some of the messages contained in this folder, copy or move them to another folder before deleting it. To delete a custom folder:
1. Starting from inside the folder, press Alt to open the Upper ribbon and Right arrow to the Folder tab.
2. Tab several times into the Lower ribbon to the Delete folder button and press Enter.
3.  You will be asked to confirm that you want to move the folder to the Deleted items folder. Press the Spacebar on the Yes button to confirm. This folder now becomes a subfolder of the Deleted items or Trash folder.
4.4.2 Creating Rules for Moving Messages to Custom Folders
You can create rules for automatically moving messages to designated folders. For example, if you are a member of a discussion list with a fairly high daily volume of traffic, it can be quite useful to automatically move messages from that list to a custom folder so you can read them later. This will avoid cluttering up your Inbox.
You can set several types of rules for moving messages. As an example, I will set a rule for moving all messages from such a discussion list to one of my custom folders. This is the most frequent use of rules in Outlook. Steps are:
1. In your Inbox, place focus on a message from the relevant sender.
2. Press the Applications key, Down arrow to the Rules submenu and press Enter.
3. You land on the Always move messages from [name of sender] button. Press Enter on this.
4. This immediately places you in a tree view of your Outlook folders. Navigate through the tree view to the custom folder where you want all messages from this sender to be moved.
5. Tab to the OK button and press Enter. 
All previous and future messages from this sender will now be automatically moved to this custom folder. 
There are numerous other types of rules you can create. To explore these, in the Rules submenu mentioned in step 2 above, Down arrow to Create rule, and press Enter. This opens the Create rule dialog box where there are a series of checkboxes for designating other types of rules, including sound notifications for alerting you when a message has been moved as a result of a rule. 
If you decide to delete an existing rule, do the following:
1. Starting from one of the folders in the relevant account, open the Info tab in the File Tab, Tab to Manage rules and alerts, and press Enter (the shortcut key is Alt F I R).
2. Tab several times to a list box which displays the existing rules, and Down arrow to the rule you want to delete. 
3. Press the Delete key. You are asked to confirm that you want to delete the rule. Press Enter or the Spacebar to confirm. 
Note that as you tab through, a Delete button appears before the list box. You can use this button to delete a rule, but only if the rule you are looking for is the most recently created one. If you have created more than one rule, it is more straightforward to ignore this button and proceed to the List box mentioned above. 
Be careful about creating rules for moving messages from a sender who is important to you. If you do this, you will need to remember to regularly visit this folder. I never do this because I don’t trust myself to remember. But you might be different. You might think about creating a priority or VIP custom folder and then define rules to automatically move messages from a set of important senders to that folder.
4.5 Sorting or Arranging Messages 
By default, messages are arranged or sorted chronologically, with the most recent messages received at the top of the list and the oldest ones at the bottom. You can rearrange the messages in many different ways. I often rearrange them by “from,” so they appear alphabetically with sender addresses beginning with the letter A at the top of the list and those beginning with Z at the bottom. I can then first-letter navigate, or quickly press the first several letters of the name of the sender I want. If I want to find a message from John Smith that I received about three weeks ago, it is quicker to rearrange by sender rather than Down arrow a bunch of times to find it. To rearrange messages in this way in your Inbox:
1. From within the Inbox, press the Alt key to go to the Upper ribbon.
2. Right arrow to the View tab.
3. Tab into the Lower ribbon several times to the Arrange by button and press Enter or the Spacebar. You land on the Date button which is for arranging messages chronologically. 
4. Right arrow once to the From button and press Enter. You can also simply press the F key. Messages are now arranged alphabetically from A to Z by sender.
5. Press Home to verify that the A messages are on the top of the list and the Z messages are at the bottom. If an email address starts with a number, it will be above the A messages in the list. 
This only rearranges messages in the folder you are currently in, not other message list folders. When you are finished finding the messages you were looking for, return the list to the default chronological order by repeating steps one through three above, and pressing Enter on the Date button, or pressing the D key.
The ribbon shortcut key combination for changing the sort order to the From view is Alt V A B F (for view, arrange by, and from). To change it back to the Date view. Press the sequence Alt V A B D. 
Admittedly, this is a whole bunch of keystrokes. Because I use this command several times a day, I have added this to the Quick Access toolbar to speed things up. See how to add commands to the Quick Access toolbar in Chapter 10.3.2.
Many other choices exist for sorting messages (by recipient, subject, size, attachments, etc.). If I am in my Sent items folder, I will sort by “To,” that is, who I sent messages to. Occasionally, I will sort by subject if I want to isolate a message thread. I don’t find any of the other sort options particularly useful.
4.6 Creating Contacts
You can create contacts for individual email addressees as well as for groups of people. In this section, I discuss two ways to do each of these. 
4.6.1 Individual Contacts
I used to be pretty sloppy about maintaining email addresses in my Contacts folder. When I typed in the first few letters of an address in the To field, the entire address reliably appeared so that I did not need to type in the full address. I would then either press Enter or the Tab key to lock it in. For several years now, having the addresses I want to appear has become less dependable. Consequently, I have become more diligent about maintaining my Contacts list. It’s not very time-consuming, and also preferable to losing addresses and then having to ask somebody else for them. 
There are two ways to create a new contact. You can create one from scratch, or you can grab it from a message you have received. The latter way is faster and easier.

To create a contact from scratch:
1. Open the Contacts folder by pressing Control Y, pressing C until you hear Contacts, and then pressing Enter. You can get there more quickly by pressing Control 3.
2. Press Control N to open the New contact dialog box.
3. Type in the full name of the contact. This is a required field.
4. Tab past two unrequired fields (company and job title) to the File as edit combo box. By default, the contact is filed with the last name first. You can change this to first name first, or type something else in. This last possibility could be useful if the contact is a name of a person or a company with three words or more, and you want to make sure it is listed with the correct word first. 
5. Tab several times to the Email edit field and type in the email address. 
6. Tab one more time to the Display as edit field and type in the address as you would like it to appear when addressing a message. This is useful because when addresses autofill correctly, they will do so based on what you type in here. 
7. To save the contact, press the Escape key once and you will be asked whether you want to save your changes. Press the Spacebar to confirm. 
There are many more fields you could fill in, but I limit myself here to the email address.
If you have received a message from somebody, it is faster and easier to create a new contact by getting the address from a message. To do this:
1. Open a message sent to you by the person whose address you want to add to your Contacts list.
2. Shift Tab to the From field where that person’s name and/or email address appears. Note that, even if all you hear is the person’s name, what we are about to do will still work.
3. Select the name or email address You can do this by pressing Control A, or by pressing Home to get to the start of the From field and then pressing Shift End to select the address.
4. Press the Applications key, Down arrow to Add to Outlook contacts, and press Enter.
5. You land in the Full name edit field that is pre-populated with the person’s name. Edit it if it does not appear as a full name.
6. Press the Escape key and you will be asked if you want to save the contact. Press Enter or the Spacebar to confirm. 
Alternatively, you can save and close the contact by pressing Alt S. It’s that easy. The Email edit field and Display As fields have already been filled. You are returned to the address field in the message where you first selected the address. Press Escape to exit the message.
Not only is this fast, but you do not have to worry about typing in names and email addresses correctly. I have a friend with a last name that is impossible to spell, at least for me. It would take me forever to type in her name and email address correctly. But I don’t have to worry about this if I create her contact from a message I have already received from her. 
4.6.2 Creating Contact Groups in Outlook
You can create a single contact for a group of people, thus saving you the time of having to find a bunch of individual addresses and laboriously entering each one into the To field. Use the method below for small groups of five to ten people. The groups should be stable. Members should rarely enter or leave the group. This is because making changes to an existing Contact group is complicated. For larger and more fluid groups, I recommend using the Excel method described in the next section.
There is a hard way and an easy way to create a Contact Group. I will only cover the easy way. 
If you have already sent a message to all the people you want to be in the Contact group, navigate to this message in your Sent items folder. Alternatively, if you have received a message that contains all these email addresses in your inbox, prepare a Reply to all message to them, replacing the original Subject field text with “Test – please disregard.” Send the message and navigate to it in your Sent items folder. If you have neither of these, address a message to all of these people, type “Test – please disregard” in the Subject field, send it, and navigate to it in your Sent items folder. Remaining steps are:
1. Open the message and Shift tab to the To field where all these addresses are contained.
2. Press Control A to select all the addresses, and Control C to copy them to the Clipboard.
3. Press escape to get out of the message.
4. Press Control 3 to get into the Contacts folder.
5. Press Alt to go to the Home tab of the Upper ribbon of your Contacts folder.
6. Tab twice to the New Contact Group button and press Enter.
7. In the Untitled Contact Group edit field, type in the name you want to give to the Contact group. 
8. Tab once to Members list and press Enter.
9. Tab several times to Select members contacts and press Control V to paste in the addresses.
10. Tab to the OK button and press Enter. 
11. Press Escape and you will be asked if you want to save your changes. Press the Spacebar to confirm. 
12. To test this, prepare a new message, typing in the first few letters of the Contact group name and confirm that the To field autofills with it. 
4.6.3 Creating Contact Groups from Excel 
To address Outlook messages to larger groups, and where members frequently join or leave the group, it is easier to keep a list of the email addresses in Excel rather than using Outlook contact Groups. You can then copy the addresses from Excel and paste them into one of the Outlook address fields. Only minimum knowledge of Excel is needed. Steps are:
1. Open the Excel file with the relevant email addresses listed in one of the columns. 
2. Move your cursor to place focus on the cell with the first address. 
3. Press Control Shift Down arrow together to select from this address to the last address in the column. Alternatively, you can press Shift Down arrow repeatedly to select each individual address.
4. Press Control C to copy the addresses. 
5. Alt Tab to the Outlook Inbox if it is already open. Otherwise, open Outlook. 
6. Press Control N to prepare a new message.
7. Press Control V to paste the addresses in the To field. Alternatively, Tab to the BCC field and press Control V if you want to paste them there (see Chapter 4.1.4 on how to add the BCC field to messages). Note that semi-colons are automatically placed between the addresses to separate them. 
8. Prepare the rest of the message. When finished, press Alt S or Control Enter to send it.
4.7 The Outlook Calendar 
You can use the Outlook Calendar for scheduling events. In this section, I will use the following nomenclature. An event is a collective term for appointments and meetings. An appointment is an event that you schedule for yourself only. A meeting is an event that you schedule with others. In some work settings (like the Carroll Center for the Blind where I work), use of the Outlook Calendar is required for scheduling meetings. You can also synchronize (“sync” for short) events with your smartphone if you have one. I will first cover how to access the Calendar to see what events you have on it. After that, I will discuss how to schedule events. 
4.7.1 Accessing the Calendar
You can either navigate to the Calendar folder via the tree view, or by pressing Control 2. There are four Calendar views that appear differently on the screen for sighted users. These are:
· Day view: the screen is filled with a single day with lines for 30 minute increments (8:00 Am to 8:30 AM, 8:30 AM to 9:00 AM, etc.). The shortcut key for this view is Control Alt 1.
· Work week view: the screen contains five panes for Monday through Friday, each of which has lines for 30 minute increments. The shortcut key is Control Alt 2.
· Full week view: the screen contains seven panes for all days of the week, each of which has lines for 30 minute increments. The shortcut key is Control Alt 3.
· Month View: A grid is presented with five rows of seven days (Sunday through Saturday). No time increments are visible within the days. The shortcut key is Control Alt 4.
For screen reader users, navigating the Day, Work week, and Full week views is exactly the same. Within a day, up and Down arrow to go back and forward by 30 minute increments. Left and Right arrow to go back a day and forward a day. 
For the Month view, moving by single days is the same as for the other views: Left and Right arrowing goes back a day and forward a day. However, up and Down arrowing goes back a week and forward a week. And pressing Page up and Page down goes back five weeks and forward five weeks. 
In any of these views, you can press the Tab key to go forward to the next event, and Shift Tab to go back an event. When you do this, you will hear the name of the event, time and date, and name of the organizer. If it is a recurring event, this will also be indicated. 
If you wish to delete an event, you can press the Delete key after tabbing to it. No confirmation request will be heard. It will simply disappear, so be careful before doing this. 
If you press Enter after tabbing to an event, you will be placed in the event’s dialog box and you can edit it. When finished editing, press the Escape key and then press Enter to confirm you want to save the revisions. 
I mentioned above that the within-day default time increment is 30 minutes. You can change this if you like. My personal preference is 60 minutes, which saves me a lot of arrowing around. To do this:
1. While in the Calendar folder, press Alt to open the Upper ribbon, and Tab to the View tab.
2. In the Lower ribbon, Tab to the Time scale submenu and press Enter.
3. You first land on 60 minutes. Other options are 30, 15 and 10 minutes. Press Enter or the Spacebar on your choice.
4.7.2 Creating Appointments
As mentioned above, an appointment is an event you schedule for yourself only. There are several ways to do this. I will cover three of them.
1. Open the Calendar folder and press Control Alt 1 to access the Day View. You could also pick the Work week or Full week view, but I will stick with the Day view here. 
2. Navigate to the day and time for the meeting by Left and Right arrowing to move by day, and Up and Down arrowing to move by time increments within a day. As an example, I will schedule an appointment on May 23 at 1:00 PM.
3. Press Control N which opens the Appointment dialog box.
4. You first land in the Title edit field. Type in the name of your appointment.
5. Tab to the Start date field which is already populated with the date you navigated to in the Day View.
6. Tab to the Start time field, already populated with the date you navigated to in the Day View.
7. Tab to the End date field, already populated with the same day.
8. Tab to the End time field, populated with the time 30 minutes after the start time. If you want to change this, you can Down arrow by half hour increments. If the time is other than a 30 minute increment, you can type it in, for example 145 for 1:45 PM. You do not have to type in the colons. Outlook is usually smart enough to guess whether the time is AM or PM. But you can also type in P or A for PM or Am, as in 145p for 1:45 PM. 
9. Tab past the Recurring button (which is present in Outlook 365 only, and I will deal with recurring events later) to the Location edit combo box. Type in a location if you like. Note that this is optional for appointments.
10. Tab to the Edit field where you can type in notes. This is also optional. Note that you must Press Shift Tab to get out of this field. Pressing the Tab key will only Insert tabs into the text here. 
11. Press either Alt S or the Escape key. If you press the Escape key, you will be asked if you want to save your changes. Press the Spacebar to confirm. The appointment is now entered in your Calendar.
There are two other ways to access the Appointments dialog box. With both of these you will need to manually type in date and tine information. If you are already situated in the Calendar folder, do the following:
1. Press the Applications key, Down arrow to New appointment and press Enter. 
2. You land in the Title edit field. Type in the name of your appointment.
3. Tab once to the Start date edit field. It is prepopulated with today’s date. If the appointment is not for today, type the date in MM/DD/YY format. If the date is not too far off in the future, you can also Down arrow day by day to the desired start date.
4. Tab to the Start time edit field, and type it in, for example typing 315p for 3:15 PM.
5. Follow steps 6 through 11 above to fill out the rest of the appointment information and save it. 
From anywhere in Outlook, you can press Control Shift A to get into the Appointments dialog box. Once again, you first land in the Title edit field. Complete the steps enumerated above to create an appointment. 
4.7.3 Scheduling Meetings
In essence, scheduling a meeting involves creating an appointment and converting it into an email that you send to invitees. You can do this in three ways. I will cover these in the same order I covered appointments above. 
The first way:
1. Complete steps one through eight above.
2. Tab to the Location edit combo box. While technically optional, common sense dictates that you should identify a location so invitees know where the meeting will take place.
3. Tab to the Notes Edit field. This will become the message body for the email invitation. You might type in welcoming remarks, insert the meeting agenda, or other pertinent information. Or you might leave this field blank if invitees already have the information they need for the meeting.
4. Press the Alt key to open the ribbon menu. You land on the Appointments tab. 
5. Tab into the Lower ribbon to the Invite attendees button and press Enter. 
6. You land in the Required field. Type in the email addresses of those you wish to invite. These addressees will appear in the To field of the email message you are about to send. 
7. Tab to the Optional field and type in addresses of those for whom attendance is optional. Most of the time, you will probably not use this field. These addressees will appear in the CC field.
8. Continue tabbing. All the fields are populated with the date, time, location and message field information you have already entered. 
9. Press Control Enter or Alt S to send the email message to invitees. Meeting information will now be placed in your Outlook calendar. 
If you are already in the Calendar folder:
1. Press the Applications key, Down arrow to New meeting request and press Enter.
2. You land in the Title edit field. Type in the name of the meeting
3. Tab to the Required field. Type in the email addresses of those you wish to invite.
4. Tab to the Optional field and type in addresses of those for whom attendance is optional. 
5. Tab to the remaining fields to type in start dates, start and end times, and message body text.
6. Press Control Enter or Alt S to send the email message to invitees. Meeting information will now be placed in your Outlook calendar. 
Finally, from anywhere in Outlook, you can press Control Shift Q and follow the same steps as directly above to prepare and send an email invitation. 
4.7.4 Responding to Meeting Requests
If you receive an Outlook meeting invitation, there are several methods for responding to the meeting organizer. The quickest and easiest is to:
1. Arrow to the email in your inbox without opening it. Your screen reader says “meeting request” to indicate that it is not a standard email message. 
2. Press the Applications key, Down arrow to Accept, and press Enter. Other choices are Tentative and Decline. 
3. After pressing Accept, you land on an OK button. Press Enter on this if you wish to send a confirmation without writing a response message. 
4. Otherwise, tab twice to a set of three radio buttons where you can arrow up or down to select one of two additional choices: Edit the response before sending, or Don’t send a response. If you choose the first of these, you will be placed in an edit box where you can type the text of a response and send it. If you choose the second option, the meeting will be moved to your Calendar and the organizer will not be notified. You might choose this option if, say, this is a mandatory meeting called by your boss and you do not want to clutter his or her Inbox with an unnecessary confirmation message. 
Once you have accepted the invitation, the meeting information will be moved to your Outlook Calendar. 
Alternatively, from inside the message you can Shift Tab several times to the Accept button and press Enter. 
If the meeting location and/or date and time are not mentioned in the subject or body of the invitation message, Shift Tab a couple of times to hear the meeting location. Shift Tab one more time to hear the proposed date and time. 
4.7.5 Recurring Events
To schedule appointments or meetings that repeat on a regular basis, you can schedule them recurrently rather than one by one. To save space, I will only cover this using the Control Shift Q quick key option for scheduling meetings. I will set a recurrence patteron of one meeting every week. 
1. Press Control Shift Q to get into the Create Meeting dialog box.
2. Fill in meeting name, invitees, start and end date and time, location and the message body fields as outlined above. 
3. If using Outlook 365, and assuming you have filled in the information above and your cursor is located in the Message body edit field, Shift Tab back to the Make recurring button and press the Spacebar to open the Recurrence dialog.
4. If you are instead using Outlook 2019 or an earlier version, from any location within this dialog, press Alt to open the Upper ribbon. You land on the Meetings tab. Tab into the Lower ribbon to the Recurrence button and press Enter to open this dialog.
5. Tab to the Recurrence pattern radio button which is weekly by default. You can up or Down arrow to other choices which include monthly, yearly, and daily. We will stick with weekly for this example. 
6. Tab to the Recur every edit box which is set at 1 by default. You could type 2 or 3 over this if you wanted your meeting to recur once every two or three weeks. We will stick with 1 here.
7. Tab through the Recurrence pattern checkboxes for each of the seven days of the week. Press the Spacebar for those days you want checked. 
8. Tab to the Range of recurrence End by radio buttons and up or Down arrow to your choice. These are: End by – Gives you the option to pick a terminal date; End after Gives you the option to pick a total number of occurrences; and No end date – Although this sounds like forever, it expires after one year, beyond which you will need to create the appointment/meeting again. 
9. [bookmark: _Hlk63430870]If you choose End by, when you Tab once, a default date calculated as ten occurrences from and including the start date is specified. Type in a new date if this is not the one you want. If instead you choose End after, when you Tab once, a default of ten occurrences is specified. Type in a different number if you want. 
10. Tab to the OK button and press Enter.
11. Press Alt S or Control Enter to send the meeting invitation to the invitees.
What about scheduling recurrent events with a monthly pattern of some sort? I am a member of the Visually Impaired and Blind User Group (VIBUG), a Boston area group that meets from 1:00 to 3:00 PM on the second Saturday of every month. To set up this recurrence pattern. 
1. Repeat steps one through four above to set the start date and time of day, and get to the Recurrence dialog. 
2. Tab to the Recurrence pattern radio button, and Down arrow to monthly
3. Tab once to where you have a choice of two radio buttons – day or The. “Day” means some specific day of the month, for example, the 12th or 15th. “The” means the third Thursday or second Saturday of the month. For this example, we want to choose “The,” so Up or Down arrow to The.
4. Tab once to an edit combo box, whose choices are, first, second, third, fourth, and last. For this example, Down arrow to Second. 
5. Tab once to a combo box listing the days of the week, and Down arrow to Saturday.
6. Tab once to an edit box where a default of one is present, indicating that this event will occur every month. If the event were to be scheduled every two or three months, you would instead type 2 or 3 here.
7. Repeat steps eight through eleven above to set terminal dates, save the appointment, and send the invitation if you are organizing a meeting.
If the recurrence pattern were every second and fourth Saturday of the month, you would need to create these as two separate events. It is not possible to create it as a single recurrent event. 
4.7.6 Canceling Appointments and Meetings
Steps are slightly different for canceling appointments and meetings, as well as for recurrent events. 
To cancel a single appointment, Tab or Shift Tab to it in one of the Calendar views, and press the Delete key. There is no prompt to confirm. The appointment is simply deleted from your Calendar.
To cancel a recurrent appointment:
1. Tab or Shift Tab to the appointment in one of the Calendar views, and press the Delete key. 
2. You land on an OK button where you receive the following prompt: “Do	u want to delete all occurrences of the recurring appointment, or just this one?”
3. To delete just this occurrence, press the Spacebar.
4. To delete the entire series, Tab twice to the Delete this occurrence radio button, and Up or Down arrow once to the Delete the series radio button and press Enter.
The above process can be confusing because the first time you Tab, you land on the Cancel button. However, this is for canceling this process, not for canceling the event itself. 
The process for cancelling meetings is slightly more complicated because of the need to alert invitees of the cancellation.
To cancel a single meeting:
1. [bookmark: _Hlk89955240]Tab or Shift Tab to the meeting in one of the Calendar views, and press the Delete key. 
2. Press the Escape key. You will receive the prompt: “Do you want to cancel this meeting?” 
3. Be careful here. You land on a rather deceptive OK button. Pressing the Spacebar here will not cancel the meeting. 
4. To actually cancel the meeting, Tab twice to the No, don’t cancel radio button, Up or Down arrow once to Yes send a cancellation radio button and press Enter. 
To cancel a single meeting in a recurrent series of meetings:
1. [bookmark: _Hlk90033567]In one of the Calendar views, Tab or Shift Tab to the meeting you want to cancel and press the Delete key. 
2. Press the Escape key. You receive the prompt: “Do	u want to delete all occurrences of the recurring appointment, or just this one?”
3. To delete just this occurrence, press the Spacebar.
4. Be careful here. You are not finished. Press the Escape key once. You land on an OK button. 
5. Tab twice to the No, don’t cancel radio button, Up or Down arrow once to Yes send a cancellation radio button and press Enter. 
Meeting invitees will now receive an email alerting them to the cancellation.
To cancel an entire series of recurrent meetings:
1. In one of the Calendar views, Tab or Shift Tab to any of the meetings in the series, and press the Delete key. 
2. Press the Escape key. You receive the prompt: “Do you want to delete all occurrences of the recurring appointment, or just this one?”
3. Tab twice to the Delete this occurrence radio button, and Up or Down arrow once to the Delete the series radio button and press Enter.
4. Press the Escape key once. You land on an OK button and are asked if you want to cancel this meeting.
5. Tab twice to the No, don’t cancel radio button, Up or Down arrow once to Yes send a cancellation radio button and press Enter. 
Invitees are now sent an email alerting them that the series of meetings has been canceled. 
4.7.7 Dismissing Event Reminders
Once you have one or more appointments or meetings in your Calendar, When you open Outlook, reminders will pop up for events coming shortly, as well as for past events. If you do not dismiss these, repeated reminders will soon annoy you as more and more past events accumulate. If you wish to dismiss them, as soon as they pop up, Tab to the Dismiss button for an individual event, or the Dismiss all button for multiple ones, and press the Spacebar to dismiss them. 
4.8 Other Folders
So far in this chapter, I have discussed the Inbox, Sent items, and Contacts folders. Other important folders worth covering are Drafts, Spam or Junk, and Deleted items or Trash. Press Control Y to access them via the tree view, navigating it as outlined in Chapter 4.3.
4.8.1 Drafts Folder
If you have started preparing a message but don’t have time to finish and send it, you can save it to the Drafts folder by pressing Escape. You will then be asked if you want to save your changes. Press Enter or the Spacebar on the Yes button to save it to the Drafts folder. Later, you can navigate to the Drafts folder to complete the message and send it. 
As mentioned in Chapter 4.3 above, if you are using a Gmail IMAP account, you may encounter two Drafts folders: an empty superfluous one at level 1 of the tree view, and the “real” one at level 2 after you open the Gmail folder. This level 2 folder is where you will find your draft messages. 
I try to avoid using the Drafts folder for several reasons. For many people, including me, the Drafts folder functions poorly. When I go into a draft message, make my revisions, and attempt to send it, all too often, I get the message, “The operation can not be performed because the message has been changed.” The only way I can get away from this message is to close Outlook and reopen it. Although I am not sure, this may be a problem unique to Gmail accounts. Be sure to see if this behavior occurs on your own computer before investing much time in composing drafts.
When this happens with my Gmail account, to complete the draft message and send it, I have to perform a strange workaround. Rather than opening it and making revisions, I press Enter on the draft message and immediately press the Escape key without pressing any other keys. I then press Enter again, make my revisions, and send it. This works most of the time, but I don’t entirely trust that it will, so generally avoid using this folder altogether. 
I also find editing messages a bit awkward. The Spellcheck utility in Outlook is less consistent than in Word, at least for me. Because of these problems, I prefer to prepare the body of my messages in Word and save them there, especially if they are long messages and proper formatting is important. When I am ready to send the message, I address a new message, type in a subject, copy and paste the text from my Word document into the body of the email message, and send it.
One other thing you should keep in mind if you are going to use the Drafts folder. Because you have not yet sent the message, the newest draft message you have started will not necessarily be at the top of your Drafts folder list. Be sure to not keep an excessive number of drafts, or you will have a hard time finding the one you just started. Delete all draft messages that you no longer need. If you have already addressed the draft message, you can sort messages by “To,” that is, who the message is being sent to, and then first-letter navigate to the intended recipient. 
4.8.2 Deleted Items or Trash Folder
When you press the Delete key on a message, it is moved to the Deleted items or Trash folder. It is not permanently deleted. If you want to retrieve a deleted message, navigate to the folder via the tree view, and copy or move it back to the desired folder.
As with Drafts, there may be a superfluous Deleted items folder at level 1 of the tree view, and a “real” one at level 2 of your Gmail folder. 
You can empty the Deleted items folder using the following steps:
1. Press Alt F I to open the Info tab. 
2. Tab once to a combo box listing the accounts you have installed in Outlook. Arrow up or down to the account for which you want to delete all messages.
3. Tab to the Tools settings submenu and press Enter.
4. Down arrow to Empty Deleted items folder and press Enter. Your screen reader will say, “Everything in the Trash folder will be deleted. Continue. Yes button.” Press Enter or the Spacebar to confirm.
To save some keystrokes, I prefer instead to define a quick key for doing this in the Quick Access toolbar (see Chapter 10.3.2 on how to do this). 
4.8.3 Spam or Junk Folder
Outlook will automatically divert messages it determines to be nuisance emails to your Junk or Spam folder. Gmail accounts call this folder “Spam” while other account types may call it “Junk.” On occasion, Outlook mistakenly places messages there that you actually want in your Inbox. It is a good practice to visit your Junk or Spam folder every few days to doublecheck if important messages have not been mistakenly diverted there. You should also delete all unwanted messages to clean up this folder. 
For senders whose messages you do not want diverted to the Junk folder, Options exist for preventing this. You can also block certain senders whose messages you don’t want landing in your Inbox. You can do this from the Inbox, Deleted items or Junk folder. Steps are:
1. Up or Down arrow to a message from a relevant sender.
2. Press the Applications key, Down arrow to the Junk submenu, and press Enter to open it. This submenu is referred to as “Junk” even if your account type calls it “Spam.”
3. Down arrow to the appropriate option and press Enter. Choices are block sender, never block sender, never block sender’s domain, and never block this group or mailing list. If you are in the Junk folder, “not junk” is another option. If you choose this last option, you will be asked for confirmation to move the message back into the Inbox. 
While this is useful, I have not found it to be an airtight guarantee that such designations will stick in the future. For senders I do not want to block, overkill may be a wise strategy. Select all three options: never block sender, never block sender’s domain, and never block this group or mailing list. Try the Not Junk option also. Even then, don’t assume it will always work. The best strategy is to visit this folder every few days to be sure that messages from individual senders and mailing lists who matter to you are not being diverted there. 
4.9 Other Useful Tools
4.9.1 Turning Off the Reading pane
The Reading pane can cause message lists to misbehave in a couple of ways. It can visually hide parts of messages, causing them to read incorrectly. Down arrowing can make the unread message labels disappear even though you have not opened these messages. If you encounter these problems, you will want to be sure that the Reading pane is turned off. To do this:
1. Press Alt to open the Upper ribbon, and Right arrow to the View tab.
2. Tab to the Reading pane submenu and press Enter (the shortcut key is Alt V P N).
3. Down arrow to Off and press Enter or the Spacebar to uncheck it. If it is already unchecked, pressing Enter or the Spacebar will not uncheck it. 
4.9.2 Turning Off New Message Notifications
By default, whenever a new message arrives in your Inbox, your screen reader will announce the sender and subject. This may be distracting and can violate your privacy if people nearby hear the announcement. To turn this off:
1. Press Alt to open the Upper ribbon, Left arrow to the File Tab, Down arrow to Options and press Enter (shortcut key Alt F T).
2. In the Category list, Down arrow once to Mail.
3. Tab several times to the Message arrival sound checkbox which is checked by default. I like to keep this one on. You will hear a “boing” when messages arrive, but no more that that.
4. Tab to Show an envelope icon in the Taskbar checkbox and press the Spacebar to uncheck it. 
5. Tab to the Display a desktop alert checkbox and press the Spacebar to uncheck it.
6. Shift Tab back to the OK button and press the Spacebar. You could Tab instead, but this is an extremely lengthy dialog box. Shift tabbing is much faster.
4.9.3 Creating a Signature
A signature is text that appears at the bottom of every message you send. In a job setting, signatures are commonly used to display contact information. People sometimes add signatures with a few lines of a favorite song lyric or to provide some other personal touch. I don’t much care for this latter type of signature. They are often a bit too smarmy for my taste. Constant repetition from the same person gets old fast. Never use such signatures in professional and academic settings.
While it is possible to format text and insert it into the Signature dialog box, it is much easier to first prepare it in Word. Here are the steps:
1. Prepare your text in Word, press Control A to select all, and press Control C to copy the text to the clipboard.
2. Open Outlook, press Alt to open the Upper ribbon, Left arrow to the File Tab, Down arrow to Options and press Enter (shortcut key Alt F T).
3. In the Category list, Down arrow once to Mail.
4. Tab several times to the Signatures' button and press the spacebar. This opens the Signatures dialog box.
5. Tab to the New button and press the spacebar. Focus is placed in the Name edit field. 
6. Type in a name for your signature (for example, “Work” if you are creating it for your job), and press enter.
7. Tab to the 'new messages' combo box. Down arrow to the name of your new signature. There is often a delay here, so you may need to Down arrow several times until you hear it. This will insert the signature at the bottom of all new messages you prepare.
8. Tab to the 'replies and forwards' combo box. Down arrow to the name of your new signature. Here too, there might be a slight delay. This will insert the signature at the bottom of all replies and forwarded messages you prepare.
9. Tab multiple times to the Edit Signature edit field. It is just before the OK button.
10. Press Control V to paste your signature from the Clipboard.
11. Tab to the OK button and press the spacebar. Focus will be back in the Options dialog box. 
12. Press the Escape key to exit this dialog.
To test that your signature has been added, press Control N to prepare a new message. Tab to the body of the message and Down arrow. The signature should now appear at the bottom of the message.
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Excel is a powerful application for organizing, manipulating, and analyzing data. It is an essential tool in many work and academic environments, and can be used for managing personal information. Just a few examples of common uses include:
1. Budget preparation and monitoring
2. Tracking inventory
3. Tabulating and analyzing survey data
4. Maintaining contact lists
I often advise my trainees to use Excel for anything that involves crunching numbers or making lists. While it is possible to do these things in Word, Excel is more flexible and powerful for performing these tasks. 
While reading this chapter (as well as when working in Excel), you should set your screen reader punctuation level at most or all. Setting it at some or none will fail to detect a number of punctuation marks like parentheses, colons, and a few more that are important in the syntax for creating formulas. To change punctuation levels for the three screen readers, see Chapter 8.1.1 for JAWS, 8.2.2 for NVDA, and 8.3.1 for Narrator.
5.1 The Basics
5.1.1 Terminology
A spreadsheet is a document that stores data in a grid of horizontal rows and vertical columns. Rows are usually labeled using numbers (1, 2, 3, etc.), while columns are usually labeled with letters (A, B, C, etc.). Individual row/column locations, such as C3 or B12, are referred to as cells, and each has a cell coordinate. For example, cell A3 is located in the first column and third row, cell E10 is located in the fifth column and tenth row, and so on. “Spreadsheet” is a generic term for any such document or file, including, but not limited to Excel. 
An Excel file is called a workbook and may be composed of anywhere from one to a large number of sheets or worksheets. Think of a sheet as a page.
Until you rename them, they are assigned the generic names “Sheet1, Sheet2, Sheet3, etc.” Worksheets are where information is entered and manipulated in a workbook. 
When you first open a new blank Excel file, and press Insert T to hear its title, you will hear “Book1, Sheet 1, A1.” 
A blank spreadsheet is a vast area with thousands of columns and over one million rows. Columns and rows are labelled with letters and numbers, respectively. A cell reference or cell coordinate is expressed as its letter and number combination. For example, cell A1 is located in the first column and first row, cell C5 is located in the third column and fifth row, and so on. A “data range” refers to a group of contiguous cells. For example, the data range from B2 through B9 refers to the cells containing B2, B9 and all the cells in between in this column. A data range can also be a rectangular block of cells. The data range of B2 through F9 includes the rectangular block of cells with B2 located at the top left, B9 at the bottom left, F2 at the top right, and F9 at the bottom right. 
Three types of data can be entered in cells: text, numbers, or formulas. Numbers may be expressed as simple numbers, currency, dates, percentages, or in several other formats. Formulas are calculations referencing cell references or numbers from elsewhere on the spreadsheet. For example, if numbers are contained in columns A and B, a formula can be typed in column C to total the numbers in the respective rows of columns A and B. However, in composing the formula, you would usually not type in the actual numbers in those cells, but rather the corresponding cell coordinates. 
Formulas can be very simple or quite complex. More on formulas below. 
5.1.2 entering Data and Navigating Spreadsheets
Use the arrow keys to move one cell at a time among the column’s and rows of the spreadsheet. The Up and Down arrows move up and down columns. The left and Right arrows move across rows. 
After typing data in a cell, pressing any of the arrow keys will conserve that data in the cell and move the cursor focus to the next cell in the direction that you just arrowed. You can also press the Tab key to move one cell to the right, equivalent to pressing the Right arrow key. In addition, pressing the Enter key will conserve the data and move the cursor one cell below. If you type in data and press the Escape key, none of the data you just typed will be conserved. If you sense that you have made a typing error, immediately press the Escape key to prevent replacing correct data with the mistaken keystroke. Failing to do this is a common frustration for beginners. 
From anywhere on a spreadsheet, pressing Control Home moves the cursor focus to cell A1, the top left corner of the spreadsheet. Pressing Control End places the cursor focus on the cell that is the intersection of the right-most column with at least one cell containing data, and the bottom-most row with at least one cell containing data. For example, if the right-most cell with data is F32 and the bottom-most cell with data is A 47, pressing Control End will place cursor focus on cell F47. This keystroke is especially useful for exploring a spreadsheet that you did not prepare yourself. If pressing Control End lands the cursor in cell F47, you know that all data in the sheet are located between A1 and F47. There are no data to the right of column F, nor below row 47. 
While using the four arrow keys to navigate one cell at a time is useful for navigating in small areas, you can navigate quickly over large blocks of filled and unfilled cells by pressing the Control key in combination with the four arrow keys. This is referred to as “navigating by region.” A region is a range of cells that contain data and are bordered by blank cells. It is synonymous with a data range. 
5.1.3 Simple Formulas
There are three categories of formulas:
· Those containing operators which are the keys for adding, subtracting, multiplying, and dividing data from two or more specified cells.
· Those containing functions for making calculations over a range of data. 
· And those containing a combination of operators and functions.
Let’s begin by typing the numbers 1000 in cell A1 and 250 in cell A2. Don’t type in a comma separator in 1000. Under this data, we will input several of the simplest and most common formulas. 
All formulas begin with the equal sign, signaling to Excel that a formula is being entered in the cell. The equal sign is located two keys to the right of the zero key on the number row of your keyboard. When you type the equal sign, your screen reader will say “type in a formula and press Enter.” We will start with simple formulas using operators for adding, subtracting, multiplying, and dividing two numbers. 
1. Addition: In cell A3, type in “=A1+A2,” minus the quotes, and press Enter to go down one row. Press Shift Equal (again, two keys to the right of zero on the number row) to make the plus sign. Up arrow once and you will hear “1250 has formula A3.” Your screen reader first says the result, then indicates this is a formula so you know it is not just a typed-in number. Then you hear the cell coordinate.
2. Subtraction: In cell A4, type in “=A1-A2,” minus the quotes, and press Enter. The dash is one key to the right of zero on the number row. Up arrow once and you will hear “750 has formula A4.” 
3. Multiplication: In cell A5, type in “=A1*A2,” minus the quotes, and press Enter. Press Shift 8 on the number row to make the asterisk sign. Up arrow once and you will hear “250000 has formula A5.”
4. Division: In cell A6, type in “=A1/A2,” minus the quotes, and press Enter. The Slash key is just below the semicolon on the Home row. Up arrow once and you will hear “4 has formula A6.”
Now we will cover formulas using some of the most frequently-used functions, including those for calculating the sum and average of values in a column, and finding the minimum and maximum values in that column. These formulas have a three-component structure: the equal sign, short text indicating the function to be calculated, and the data range upon winch that function will be performed. Because we have data in all the cells from A1 through A6, we will use this data range. To make it easier to read the text, I will put the formula on its own line and then explain it on the next line.
In cell A7, type:
=sum(A1:A6)
This totals the values in the column from cell A1 through cell A6. The three components of the formula are: 
· The equal sign indicating that this is a formula.
· The text of the function “sum” indicating that this is the calculation to be executed.
· The data range, written beginning with a left parentheses, the first cell in the data range, a colon indicating “through,” the last cell in the data range, and a right parenthesis ending the designation of the data range.
In cell A8, type:
· =average(A1:A6)
This calculates the average value (also knows as the mean) of the data range from A1 through A6.
In cell A9, type:
· =min(A1:A6)
This identifies the minimum value in the data range from A1 through A6.
In cell A10, type:
=max(A1:A6)
This identifies the maximum value in the data range from A1 through A6.
Excel has a vast variety of available functions that can be used to make calculations. A good starting point for learning more about functions and formulas is:
Overview of formulas in Excel
Here you can find introductory information on formula basics, descriptions of the most commonly used functions, how to construct more complex or advanced formulas and functions, and additional reference materials and tutorials.
5.2 Constructing a Table
5.2.1 Building Blocks for a Basic Data Table
Let’s put together a table with monthly expenses for the Smith family. You usually start by putting in a name or title at the top left of the worksheet in cell A1. Then you put text down column A and across row 2. Then you enter data in the middle of the table. Let’s get started.
1. In cell A1, type “Monthly Expenses for the Smith Family for the Year,” minus the quotes. 
2. Type “Expense” in cell A2, minus the quotes.
3. In column A, from cells A3 to cell A10, list the following eight expense categories: Water, Electricity, Groceries, Cell phone, Cable, Rent, Transportation, and Entertainment. 
4. In cell A11, type “Monthly Total,” minus the quotes. We will eventually sum the monthly columns along row 11. 
5. In row 2, starting in cell B2, type in the months of the year across this row, with January in cell B2, February in cell C2, and so on until December in cell M2.
6. In cell N2, type “Annual Total,” minus the quotes. We will eventually sum the rows to calculate the annual amount for each type of bill 
Not counting the name of the table at the top, most basic data tables are composed of three parts:
· Row headers: Text going down the left column. In this case, the types of bills. “Electricity” is a row header because the data along that row relate to electricity bills. 
· Column headers: Text going across the top row of the table. In this case, each of the twelve months and the last column totaling the year. “January ” is a column header because all the cost data down the January column relate to bill costs for that month. 
· Table body: To the right of the first column and under the top row is where data appear. If data are numeric (simple numbers, dollars, percentages, etc.), they are referred to as “values.” In this table, each monthly bill expense will be entered. 
5.2.2 Define Names – A Feature That Makes Using Excel Much Easier
After you have typed in your row and column headers, it is time to introduce an Excel feature that greatly improves readability of tables for screen reader users on the PC. When I show this feature to a screen reader user who has been struggling with Excel for a long time, he or she usually has one of those head-slapping “I wish I had known about this years ago” moments. 
Sighted users can easily interpret Data in the body of a table. Let’s say the number 750 appears in cell E8 of this table. With a quick glance, a sighted user can determine that this number corresponds to the cost of rent for April. However, a screen reader user would need to Up arrow several times to the top of the column to find April, Down arrow back to 750, and then Left arrow back to column A to figure this out. This is time-consuming in even a small table like this one. It is much worse with larger tables. 
Using the Define Names feature largely eliminates this problem. As you move cell by cell along a row, you will hear the column header and content for each cell,. As you move cell by cell up or down a column, you will hear the row header and content for each cell. With the JAWS Eloquence voice, column and row headers are spoken in a lower pitch than the cell data. 
To activate this feature correctly, you must start with your focus in the cell that is the intersection of the row and column headers you want read as you move around in the body of the table. Most of the time, this will be the cell in the top left corner of your table. This does not mean the name or title you gave the table, located in the row above in cell A1. 
In this table, the types of expenses are listed down column A and the months of the year are listed along row 2. The top left cell of the table is cell A2, so this is where your cursor must be situated in order to begin the process of defining names. Steps are:
1. As explained above, navigate to the cell that is the intersection of the column and row headers you want read as you navigate inside the table. In this case, move to cell A2.
2. Press the Applications key, Up arrow twice to Define Name, and press Enter. 
3. Type in the word “title,” minus the quotes, and press Enter. 
4. To test it out, move around inside the table. As you move right and left, you should hear the column headers and cell content. As you move up and down, you should hear row headers and cell content. 
This is an Excel feature, so works equally well with any of the screen readers covered in this book. When you save the file, title reading will also be saved. 
While you can activate this feature at any time, I get it going as early as possible when constructing a table. It makes all subsequent actions (data entry, navigation, creating formulas, editing, etc.) much easier and less prone to error. 
For some tables, you may not want to hear both column and row headers as you navigate, but just one or the other. For example, think of a bus schedule where the stops are listed along row 2,and down column A are the times of the first bus in the morning. In this case, hearing the row headers (that is, the time of the first bus) and times in the middle of the table as you up and Down arrow, would only be confusing. In this case, you would only want column headers read to you as you move left and right along rows. To hear only column headers:
1. Navigate to the leftmost cell in the row where the column headers are located (usually the top row of the table, not counting the row with the table name).
2. Press the Applications key, Up arrow twice to Define Name, and press Enter. 
3. Type in the single word “columntitle,” minus the quotes and with no spaces between column and title, and press Enter. Note that this is not case-sensitive. If you like, you can instead write it as “ColumnTitle,” with the C and T capitalized so your screen reader says it normally. 
4. To test it out, move around inside the table. As you move right and left, you should hear the column headers and cell content. As you move up and down, you should only hear cell content, and no row headers. 
To only hear row headers:
1. Navigate to the cell just above the topmost row header you want read, usually near the top of column A. 
2. Press the Applications key, Up arrow twice to Define Name, and press Enter. 
3. Type in the single word “rowtitle,” minus the quotes and with no space between row and title, and press Enter. Here too, use upper case for R and T if you prefer it to read normally. 
4. To test it out, move around inside the table. As you move up and down, you should hear the row headers and cell content. As you move left and right, you should only hear cell content, and no column headers. 
You also need to know how to delete these for a couple of reasons. First, if you mistakenly start the above steps from the wrong cell, table reading may become incomprehensible. You must first delete any previous title reading designations before you can correct them. Second, sometimes in the course of editing spreadsheets, you may delete some rows or columns. This may cause title reading to no longer work. Here too, you will need to delete whatever you first put in before you can redo them. You can start this process from anywhere in the spreadsheet. Steps are:
1. Press Alt to open the Upper ribbon, and Right arrow to the Formulas tab.
2. Tab into the Lower ribbon about ten times to the Name manager button and press Enter. The shortcut key is Control F3.
3. You land in a combo box where any Define name settings you have created for that file are listed. Assuming you only have one, your cursor focus lands on it. 
4. Press the Delete key. You are asked for a deletion confirmation.
5. Press the Spacebar to confirm, and Escape to return to your spreadsheet. 
It is also possible to define column and row headers for several tables on the same sheet. You will need to do this to avoid confusion. If, for example you have defined names for a table beginning near the top left of the sheet, and you then add more tables below or to the right of this first table, the column and row headers of the first table will be read as you navigate within these other tables. You will then hear the wrong column and row headers read. 
To define names for the first table on a worksheet with two tables, you need to specify the data range of that table. The column and row headers specified will only be operative within this data range, and will not interfere with reading column and row headers for any tables outside this data range. 
Using our current table as an example, the top left corner of the data range is cell A2. Because the furthest right column is column N, and the bottom row is row 11, cell N11 is the bottom right cell of the data range. Steps for defining names for this data range are:
1. Navigate to cell A2, the top left cell of the data range. 
2. Press the Applications key, Up arrow twice to Define Name, and press Enter. 
3. Type in “title..N11” here. After the word title, you type in two periods and then the bottom right cell coordinate of the data range. Now press Enter. 
4. To test it out, move around inside the A2-N11 data range where you will hear column and row headers. Now move the cursor outside this data range (to the right of column M or below row 11), you will no longer hear these column and row headers spoken.
Let’s now say there is a second table on this worksheet whose top left corner is in cell A15 and bottom right corner is in cell G23. To use the Define name feature to read this table’s column and row headers, repeat the above steps, substituting A15 as the start point in step 1, and cell G23 as the bottom left cell coordinate in step 3.
Finally, the same name cannot be repeated in a single file. If you are working with multiple sheets, you cannot use the word “title” on more than one of these sheets. If you attempt to do this, you will hear the following error message: “This name already exists. Names should be unique.” To get around this, instead type in “title1, title2, etc.” without the quotes or any spaces. 
In conclusion, the Define names feature is a great tool for making Excel sheets more readable. Use it whenever you create tables yourself, as well as when you receive a file from somebody else. The only piece of bad news is that they don’t always work for files you get from sighted people. This is because sighted folks sometimes insert lots of blank columns and rows to visually separate data categories. This makes it hard or impossible to find a cell at the top left corner that forms the intersection of the column and row headers you want to designate as titles. QuickBooks, a popular financial management application, generates balance sheets, profit and loss statements, and other standard accounting reports in Excel format that have this problem. 
5.2.3 Data Entry and Copying Formulas
Now it’s time to add some values in the body of the table. Beginning in cell B3, and going down to cell B10, type in numbers for each of the January expense types. Just type in numbers. Don’t worry about expressing them in dollars. That will come later. 
Remember that after typing in a number, you can either press Enter or the Down arrow key to go to the cell below. 
When finished, make sure your cursor focus is on cell B11, just one cell to the right of where you typed the word “Total.” 
In cell B11, we will sum the January column. When you are new to Excel, it can be a bit challenging to enter formulas. You should type slowly because you may not be accustomed to using several keys (left and right parentheses, the equal sign, and a few others). Excel is extremely unforgiving about any typing errors. Also note that there are never any spaces in formulas. Even if you are a proficient typist, entering formulas can be a painstaking process. However, the good news is that you won’t have to type too many of them. As we will see below, for the current table, you will only need to type in two of them. All the remaining formulas will be copied and pasted.
First, be sure you know the addresses of the first and last cells of the data range you want to sum. Here the first cell is B3 and the last one is B10. In cell B11, type:
=sum(B3:B10)
And press Enter. 
You can now copy the formula and paste it across row 11 to sum the columns for the other months, and the final total column. When copying and pasting files, folders or text, the order of operations is select, copy and paste. When copying formulas in Excel, the order is slightly different. First, you copy the formula. Second, you select a range of cells. And third, you paste the formula to those cells. Therefore, do the following.
1. In cell B11, press Control C to copy the formula. 
2. Right arrow to C11.
3. Press and hold down the Shift key and Right arrow to N11, the bottom cell of the last column in the table.
4. Press Control V to paste the formula. 
This works because Excel automatically adjusts the formula’s cell coordinates correctly as you paste across the row. For example, Right arrow a couple of times to cell D11 which is the formula for summing the March column. Press F2, the keystroke for editing individual cells, and press the Up or Down arrow key to read the formula. It should say:
=sum(D3:D10)
After pressing F2, you can also use the Left and Right arrows to read individual characters within the cell. When finished, press Escape to exit the cell edit mode. More on F2 later in this chapter. 
You can follow a similar process to sum a row and then copy and paste formulas down the relevant column. Once again, be sure you know the addresses of the first and last cells of the data range you want to sum. This time, we will start by summing the first bill category row (water), inputting the formula in cell N3. The first cell is B3 and the last one is M3. In cell N3, type:
=sum(B3:M3)
And press Enter.
Now do the following to copy the formula in cell N3 and paste it down column N to sum each bill category row for the year:
1. In cell N3, press Control C to copy the formula. 
2. Down arrow to cell N4.
3. Press and hold down the Shift key and Down arrow to N11, on the last row of the table.
4. Press Control V to paste the formula. 
When you are constructing a simple rectangular table like this one, and want to total all the rows and columns, it is this quick and easy. And you can do this early or later in the process of putting the table together. As data is inputted in the body of the table for each bill, the totals in the bottom row and furthest right column will automatically be recalculated. 
5.2.4 Number Formatting In Cells 
There are various ways that simple number formatting can be converted to other formats such as currency, percentages dates and time. We will use the Smith budget table as an example and format its numbers as dollars with two decimals. Initially, we will only do this for cell B3 – the top left cell of the data range containing numbers. Steps are:
1. With cursor focus on cell B3, press the Applications key, Up arrow to Format cells, and press Enter.
2. This opens a multi-page dialog box where you land on the Numbers tab.
3. Tab once to the Categories combo box, and Down arrow to Currency.
4. Tab once to the Decimal place Edit spin box whose default setting is two decimals. If you wanted to change this to zero, you would type this in. While in theory, you can arrow to zero, I have found that this works poorly, so it is better to type it in if you wished to change the number of decimals. 
5. Tab once to the Symbol combo box to select the type of currency. While there are more than 500 symbols to choose from, you land on dollars most of the time. If you land elsewhere in this combo box, press the Home key to get to the top of the list and Down arrow to Dollars which is second in the list. 
6. Tab to the Negative numbers list box which has four options: preceded by a minus sign; displayed as red; surrounded by parentheses; or both displayed as red and surrounded by parentheses. Sticking with the default (preceded by a minus sign) is best for accessibility. 
7. Tab to the OK button and press Enter to make changes.
Obviously, you would not want to make this change one cell at a time, but for multiple cells. Here are two alternatives. One way is to select the data range of cells for which you want to change the number formatting. For this spreadsheet, the top left cell of the data range with numbers is cell B3, and the bottom right one is cell N3. Here’s a super quick way to change the number formatting of this data range to dollars with two decimals:
1. With your cursor in cell B3, press Shift Control and End together. This will select all cells from B3 to N11, as well as all cells within this rectangular block.
2. Press Control Shift 4 on the number row to change the cell format to dollars with two decimals. This is a convenient shortcut key that I use all the time. 
Even faster, if all the cells with number values in the sheet are to be converted to dollars with two decimals, and are all contained in a single data region starting in cell A1, you can simply press Control A to select all cells from A1 to the bottom right cell in that data region. Then press Control Shift 4 to convert to dollars with two decimals. This will not affect the formatting of cells in this data range which currently contain words rather than numbers. If you later insert numbers in currently empty cells in this data range, they will appear as dollars with two decimals. 
There are twelve number format categories listed in the Category combo box of this dialog. Other than Currency which I already covered, the most commonly used ones and options for changing their formatting are:
· Numbers: decimal places, adding comma separators between thousands, and negative number formatting.
· Date: numerous options for displaying month, day, and year.
· Time: numerous options for displaying hour, minute, second, and A.M. or P.M.
· Percentage: number of decimal places.
· Special: Use this for columns containing ZIP codes to make them read properly. If you do not, the ZIP code will read like any other five-digit number (for example, “forty-four thousand three-hundred and thirty two”) rather than as individual numbers. Also,  for any ZIP code beginning with zero, the zero will disappear from the cell. For example, my ZIP code is 02072. Without this special formatting, only 2072 would appear in the cell, even though I typed a zero at the beginning. 
Below is a summary of shortcut keys that can help you out:
· Control 1: Open Cell format dialog. 
· Control Shift 4: Format as dollars with two decimals.
· Control Shift 5: Format as percentages with no decimals.
· Control semi-colon: Format cells with todays date in MM/DD/YYYY format. 
5.2.5 Merging and Centering Cells
We now come to what I consider to be the last step in creating a simple data table in Excel. Centering the name of the table just above its top row is something you may wish to do if you are planning to share the file with sighted users. This involves merging cells, that is, converting two or more cells into a single one. To merge and center the name of this table, do the following:
Go to cell A1 where the name of the table (“Monthly Expenses for the Smith Family for the Year,”) appears. 
1. Hold down the Shift key and Right arrow to cell N1, the rightmost column of this table. 
2. Press Alt H M to open the Merge submenu. You land on the Merge and center button. Press Enter on this.
Your screen reader will now say “merged cells A1 through N1.” If you press Insert F to hear about cell formatting, among other things, you will hear that its contents are horizontally centered. And if you Right arrow once, your cursor will land on cell O1 because cell A1 now extends to column N. 
The three other options in the Merge submenu are:
· Merge across: Merge cells horizontally with left-aligned content.
· Merge: Merge cells vertically. Cell content will be vertically aligned along the bottom of the cell. 
· Unmerge: Undo merging of previously merged cells. 
5.3 Editing Basics
Basic editing actions include selecting cells, data ranges, entire rows, columns, and sheets, as well as deleting, copying, moving and pasting them. Selecting, copying and pasting formulas were covered above in Chapter 5.2.3 and will not be repeated here. 
5.3.1 Editing Individual Cells 
To edit data within individual cells, press F2. When you press the Up or Down arrow key, your screen reader will say the entire cell contents. This is especially useful for reading formulas. After pressing F2, you can also use the Left and Right arrows to read individual characters within the cell, as well as use standard text editing keystrokes to delete or insert characters. Note that when you press F2, focus is placed on the right side of the cell. If you wish to keep changes after editing the cell content, press Enter. If you don’t want to keep changes, or you just want to get out of the cell, press the Escape key.
Often the quickest way to change cell content is to simply type over existing content and then press Enter, Tab, or arrow away from it. It is not necessary to select cell content before replacing it. 
5.3.2 Selecting and Editing Data Ranges
Similar to selecting text in other applications, like Word, several selection keystrokes involve combining the Shift key with navigation keystrokes. Below are a number of them. 
· To select a single cell, simply place your cursor focus on it.
· To select an entire row, press Shift Spacebar.
· To select an entire column, press Control Spacebar.
· To select multiple contiguous cells across a row one by one from left to right, hold down the Shift key and press the Right arrow repeatedly until you get to the end of the selection. Note that the Shift key must be held down from start to finish.
· To select multiple contiguous cells down a column one by one, hold down the Shift key and press the Down arrow repeatedly until you get to the end of the selection. 
· To select a rectangular block of cells. Starting with focus on the top left cell of the rectangular data range, press Shift Right arrow to select across a row, and Shift Down arrow down the right-most column to the cell at the bottom right of the data range. As you arrow along, your screen reader will read the content and address of the first and last cell in the data range you are selecting. 
· To execute zthe above three operations with fewer keystrokes: hold down the Shift Control and Right arrow keys to select across a row from the leftmost cell to the rightmost cell; hold down the Shift Control and Down arrow keys to select down a column from the top-most cell to the bottom-most cell; and use these two keystrokes to select from the top left corner cell to the bottom right cell in a rectangular data range. 
· Control A selects an entire data region, that is, a block of contiguous cells containing data.
Note that, in making any of the above data range selections involving the Shift key, you must hold down the Shift key throughout the process. If you lift it in mid-process and continue arrowing, the previously-selected cells will become unselected and you will need to start over.
After making any of the selections above, you can:
· Copy the cells to the Clipboard with Control C.
· Cut the cells to the Clipboard with Control X.
· Paste the cells from the Clipboard with Control V.
· Delete the cells with the Delete key. 
5.3.3 Inserting and Deleting Rows and Columns
You can insert and delete rows and columns via the Applications key. Here you can Down arrow to find the Insert and Delete commands. You can also use ribbon shortcut key combinations which are far more efficient. If you are going to work much with Excel, it is worth memorizing the shortcut keys. The ribbon shortcut key combinations all begin with Alt H because they are located in the Home tab of the ribbons. They are:
· Alt H I R: Insert row.
· Alt H I C: Insert column.
· Alt H D R: Delete row.
· Alt H D C: Delete column.
Remember that for ribbon keystroke combinations, press the keys one at a time. Do not try to hold them down together. 
Returning to the Smith Family Budget table, let’s say we want to insert a new row in the middle of the table. If your cursor is anywhere in row 5 and you press Alt H I R, row 5 will now become blank. That row’s previous content and everything below it will be moved down one row. If your cursor is anywhere in column B and you press Alt H I C, column B will now become blank. That column’s previous content and everything to its right will be moved one column to the right. Pressing Alt H D R will remove a row and move all rows below it up one row. Pressing Alt H D C will remove a column and move all columns to its right back one to the left.
To insert or delete multiple rows below where your cursor is currently positioned, press Shift Down arrow to select as many rows as you want, and then press Alt H I R or Alt H D R. If instead, you want to insert or delete rows above your current cursor position, you can press Shift Up arrow and then the same shortcut keys. 
To insert or delete multiple columns to the right of your cursor, first press Shift Right arrow to select them, and then press Alt H I C or Alt H D C. You can press Shift Left arrow if you want to select multiple columns to the left and then insert or delete them. 
If you have already put formulas for totaling rows or columns in your table, when you insert or delete rows and columns in the middle of your table, these formulas will automatically adjust correctly. For example, if I insert a new blank row 5, and the previous formula summing column B was:
=sum(B3:B10)
It will move down one row and become:
=sum(B3:B11)
But be careful. If you insert a new blank row just above the row with the sum formula, the formula will not automatically adjust. You will need to change it manually. This behavior is the same when you insert columns. 
If you have one or more formulas in existing rows and then you insert new rows, it is often a good idea to copy and paste one of the existing rows in to the new blank one. Then just change whatever you need to change in the new row while retaining the copied formulas. This is easy to do, saves time, and avoids mistakes. Steps are:
1. Press Alt H I R in a cell where you want to insert a new blank row.
2. Up or Down arrow to a cell in one of the other rows already containing data and formulas. Press Shift Spacebar to select the entire row.
3. Arrow back to the blank row and paste it with Control V.
4. Edit the new row data as needed without changing the copied formulas. 
5.4 Sorting Data
Sorting data is quick and easy in Excel. You can sort columns alphabetically, numerically and by date. I will start with sorting alphabetically.
If you are maintaining a list of contacts, you will often want to sort alphabetically by last name. Keep this in mind when first preparing your data table. Either input last names first, as in “Smith, John,” or create separate first and last name columns. If you input names in a single column and begin with first names, you will not be able to sort the data by last name. Assuming you have created a last name column, steps for sorting alphabetically are:
1. In the last name column, place your cursor on any of the cells containing a last name. Do not place it on the “last name” column header.
2. Press the Applications key, Down arrow to the Sort submenu, and press Enter. 
3. You first land on A to Z. Down arrow to see the two other choices, which are Z to A, and by color. Avoid sorting by color because it is generally inaccessible.
4. Press Enter on A to Z and the column and its associated row data will now be sorted alphabetically with last names beginning with A at the top of the column.
To speed up this process, you can first press the Applications key and then press the letter O to get right into the Sort submenu.
If there are any blank cells in this column, their associated row data will be moved to the bottom of the table. 
To sort numeric column data, steps are pretty much identical. The only difference is that when you open the Sort submenu, choices are Smallest to largest and Largest to smallest. If, for example, you had a column with rankings (1 as best and 50 as worst), it would make sense to sort smallest to largest. In the Smith family budget table, you might want to sort the Annual total column largest to smallest so that the highest cost items appeared at the top of the table.
If there are any blank cells or text data in this column, their associated row data will be moved to the bottom of the table. For example, if you inputted “not available” in several cells in this column, all associated row data would be moved to the bottom after sorting. 
To sort by date, here too, steps are identical, the only difference being that choices are oldest to newest and newest to oldest.
As above, for any blank cells or text data in this column, their associated row data will be moved to the bottom of the table. Because of the way dates are coded in Excel, sorting by date only works for data after the year 1900. 
When sorting column data, there are a couple of potential complications to guard against. When sorting alphabetically, it is possible that the row containing column headers could find its way into the middle of the table. For example, if row 2 contained column headers and you sorted by the Last name column, this row’s data could wind up in the middle of the table with the L in Last name causing it to move there. 
If the last row contains formulas for summing the columns and you then sort numerically, this last row will be moved to the top of the table, just below the row containing the column headers. This would happen with The Smith family budget table. 
Inserting a blank row between the column headers row and the first row with data will avoid the first problem. If the column headers are contained in row 2 and the actual data begins in row 3, with your focus somewhere on row 3, press Alt H I R, making row 3 blank and shifting all the data rows down one row. Sorting alphabetically will now work correctly. 
To correct the second problem, insert a blank row between the bottom row where any sum formulas are located, and the data row just above it. Sorting numerically will now work. 
5.5 Multiple Worksheets
So far, all our work has involved a single worksheet. However, you can have multiple worksheets in a single file. With large datasets and multiple tables, it quickly gets unwieldy to place them all on a single worksheet. Printing them in hard copy can also be a nightmare. If you have detailed company sales data for a year and want to present it on a monthly basis, it probably makes more sense to create twelve worksheets rather than put all twelve tables on a single worksheet. 
To navigate an Excel file with multiple worksheets, press Control Page down to go to the next worksheet and Control Page up to go to the previous worksheet. This is a Windows keystroke so works with all three screen readers. 
With JAWS, you can get a list of worksheets by pressing Control Shift S (think of S for “sheets”). You can then Down arrow or first-letter navigate to a worksheet, and press Enter to open it. This is very useful for efficiently navigating a file with many worksheets. It is also helpful to see the order in which the worksheets are presented in case you want to reorder them. 
To get a list of worksheets using NVDA, do the following:
1. Press Insert F7 to open the Elements list.
2. Shift Tab once and Down arrow to the Sheets radio button.
3. Tab once to the list of worksheets. 
4. As with JAWS, either Down arrow or first-letter to a worksheet and press Enter to open it. 
Getting a list of worksheets is not possible with Narrator. 
There are a number of actions you can perform with multiple worksheets, including inserting, deleting, renaming, and moving and copying them. JAWS has a context menu for managing worksheets where you can conveniently access all these commands. With NVDA and Narrator, you will need to find each of these commands in the ribbons. 
To open the Manage worksheets context menu, press Shift Insert S. I try to remember “SIS” - short for “sister.” In the order in which they appear as you Down arrow here, The most important commands are:
· Insert: When you press Enter, the first item is Worksheet. Press Enter again and a new worksheet will open with focus on cell A1. This worksheet appears one worksheet before the one where you started this operation.
· Delete: When you press Enter, you will be asked to confirm if you want to delete the current worksheet. Press the Spacebar on the Yes button if this is your intention.
· Rename: Generic worksheet names are Sheet 1, Sheet 2, etc. You should rename them if you plan on creating more than just a few worksheets. Otherwise, you will quickly lose track of which one is which. Press Enter here, type in a short name and press Enter again. If you then press Insert T, your screen reader will read the filename, followed by “Excel,” and the worksheet name at the end. 
· Move or copy: In this dialog, you first land on Move. After you have created a series of worksheets, use the Move command to reorder them. When you Down arrow to a worksheet in the list, pressing enter will insert the current worksheet just before it. The bottom item on the list is “Move to end.” Press Enter here if you want to place the current worksheet last. If instead you want to create a copy of the current worksheet, Tab once to the Copy checkbox and press the Spacebar. Then Tab one more time to the OK button and press the Spacebar. The copy will have the same name as the original worksheet, followed by the number two in parentheses.
· Select all sheets: Use this command if you want to copy multiple worksheets to a different file. This avoids having to copy them one at a time. 
Ribbon shortcut keys for the above commands that you can use with NVDA and Narrator are: 
· Shift F11: Insert new worksheet.
· Alt H O R: Rename worksheet.
· Alt H O M: Move or copy worksheet.
· Alt H D S: Delete worksheet.
The Paste link command allows you to copy and paste a formula from one worksheet to another. For example, let’s say you have monthly profit data on twelve separate worksheets. You can insert a summary worksheet with links to the total monthly profits formula in each of the monthly worksheets. If you make changes in any monthly worksheet that results in the total profit for that month changing, the change in the monthly total profit formula will be fed through to the summary worksheet. Continuing with this example, to paste a link from one worksheet to another, do the following:
1. Place your cursor on the cell in the monthly worksheet containing the total profits formula for that month, and press Control C to copy it. 
2. Navigate to the summary worksheet and place focus on the cell where you want to paste the formula. 
3. Press the Applications key and Down arrow to Paste options, but do not press Enter.
4. Instead, Left arrow once to the Paste link button and press Enter. 
The syntax of this formula contains: the equal sign, the worksheet name from which the formula is being copied surrounded by apostrophes, the exclamation sign, and the address of the cell being copied. For example, if the total profits formula was contained in cell E26 of the February worksheet, the Paste links formula in the summary worksheet would be:
=’February’!$E$26
Consider creating a summary worksheet for a file containing a large number of worksheets, and use the Paste links command to present data on this worksheet. It is a more convenient and effective way to communicate the most important data to colleagues, versus having these data scattered across a large number of worksheets. 
5.6 Filtering
Filtering allows you to temporarily hide some data in a dataset so you can zero in on those data that you want to examine more closely. This is especially useful for working with large datasets. Let’s say that you are the Eastern Massachusetts regional manager of a retail chain that operates throughout New England. The database you are working with contains 20,000 records with information on each store, employee, and transaction over the last year. If your goal is to focus on just the stores in the Boston area, filtering would allow you to temporarily narrow the visible data. Instead of having to wade through 20,000 records, most of which are not relevant, filtering would allow you to reduce the dataset to a more workable number of transactions. If you are only interested in analyzing data for the last three months, you could further narrow down the dataset using filtering. And if you want to focus on just a few products or employees, you could perform additional filtering. 
I will demonstrate using an example with far fewer entries. In this section and the next one on pivot tables, I will reference the file that accompanies this book entitled “Quarterly Sales By Employee.xlsx.” You may wish to open it to follow along and repeat the steps.
This worksheet contains quarterly sales data for employees in five electronics stores in the Boston area. Column headers in this workbook go across row 2 and include: 
· Store (column A): The five stores (Boston, Cambridge, Quincy, Watertown, and Newton).
· Employee (column B): The first names of three employees in each of the stores, for a total of 15 employees.
· Quarter (column C): Quarters one through four of a particular year.
· Product (column D): Three products sold in each of the stores, including iPhone SE, Samsung TV, and HP laptops.
· Quantity (column E): The number of each of these products sold by employee in a particular quarter.
· Price (column F): The unit price in dollars for each of the products.
· Sales (column G): The formula for price times quantity expressed in dollars.
As an example, we will filter to narrow focus to just the Cambridge and Newton stores for the first quarter, and iPhone SE sales. 
To turn on filtering, your cursor must be somewhere on the row containing the column headers (in this case, row 2). In addition, there can not be any blank rows between this row and the data rows. So, here goes:
1. With your cursor on the column headers row (in this example, row 2), press Control Shift L. If you now Left or Right arrow, JAWS and Narrator say “No filter applied auto filter drop-down.” NVDA does not say anything. 
2. Place your cursor on the cell containing the column header you first want to filter. We will start in cell A2 where the column header “Store” appears. 
3. Press Alt and Down arrow together. JAWS says “Type words to search for.” NVDA says “unknown.”
4. Shift tab three times until you hear “tree view. Select all checked.” Under this are listed all the items or values present in the column you are filtering by. In this case, these are the five stores identified above. 
5. Down arrow and press the Spacebar to uncheck all items that you want the filter to hide. We will uncheck Boston, Quincy, Watertown, while leaving Cambridge and Newton checked. 
6. When finished checking or unchecking items, Tab once to the OK button and press Enter. Be sure to Tab only once. You can easily Tab past it because you first hear “type words to search for” before hearing “OK button.”
7. Down arrow in this column. You will notice two things: only the rows with the stores you left checked will appear. The unchecked rows are hidden. In this case Rows A3 to A38 and A75 to A146 are skipped over as you Down arrow. Also, as you Down arrow, your screen reader will say “adjacent to hidden cells,” at the boundary between the hidden and unhidden rows. 
8. To further filter by quarter, go to cell C2 where the column header “Quarter” appears. 
9. Repeat steps three and four above. 
This time, press the Spacebar to uncheck the Select all checkbox. Down arrow to the first Quarter and check this checkbox. All other quarters you want hidden are already unchecked.
1. Tab once to the OK button and press Enter. 
2. For the final filter, go to cell D2 where the column header “Product” appears. 
3. Repeat steps three and four above. 
4. Again, press the Spacebar to uncheck the Select all checkbox. Down arrow to iPhone SE and check this checkbox. The other products are already unchecked.
5. Tab once to the OK button and press Enter. 
Once you have filtered to focus in on the data you want to analyze, you can select the entire worksheet by pressing Control A, and then copying and pasting the data into a new worksheet. Only the unhidden rows will be pasted into the new worksheet. Extracting the data this way from a larger dataset is preferable to attempting to continue working with it in the initial worksheet, especially if the dataset is large. 
In the above example, for some columns, I left the Select all checkbox checked and for others I unchecked it. If there are only a few items in the list, the decision to check or uncheck the Select all checkbox is fairly trivial. However, if the number of items listed is large. This is no longer a trivial decision. For example I once had a client who wanted to filter a column of vendors from whom his state agency had procured goods and services. There were over 700 vendors listed, and he was interested in displaying the data for just three vendors. It was important that he unchecked the Select all checkbox. After doing that, he was also able to first-letter navigate to quickly find the checkboxes for his three vendors. 
When you are finished filtering in the initial worksheet, from anywhere in that worksheet, you can press Control Shift L again, and all the hidden rows will reappear.
5.7 Pivot Tables
Pivot tables are useful for reorganizing relevant data fields into tables so you can zero in on the information you are interested in analyzing. They are called “pivot tables" because, from a visual perspective, dragging and dropping selected data columns from an initial data table “pivots” these into a new table.
I have used pivot tables for organizing conferences. I needed to track how many people had registered, how much they had paid, add up voluntary donations to the organization, their lunch choice, whether they preferred receiving the agenda electronically, in Braille, or large print, and several other things. I also used pivot tables to present results of a survey with ten or fifteen questions about the accessibility of voting machines. Without resorting to pivot tables, figuring out how to organize and report results would have been messier, much more time-consuming, and prone to computational error. An added bonus to using pivot tables is that, after initial construction, they are quick and easy to update as you add new data. In the conference example mentioned above, I was able to regularly update and report figures as new registration information came in prior to the conference. 
5.7.1 Creating Pivot Tables
A generic table consists of up to three parts. Using the simple example of the Monthly Expenses table from earlier in this chapter, and using pivot table nomenclature, these are:
· Row labels down the leftmost column where the different bill types are listed.
· Column labels along the top row of the table. In this case, the months of the year.
· Values, the actual data in the table, in this case, the dollar amounts of each bill. 
· These are the building blocks for constructing pivot tables. Pivot tables can have row labels and values, column labels and values, or both row and column labels and values. All must have values, and values must be numeric (quantities, dollars, percentages, etc.).
In this section, I will reference the quarterly sales by employee worksheet used in the previous section on filtering. I will construct several pivot tables from these data. The first one will be total sales by quarter for each of the stores. This will involve designating Store names as row labels, quarters as column labels, and sales amounts as values. Steps for creating this pivot table are:
1. Select the data range that includes the column header row and the data. In this workbook, the data range is A2 through G182. With your cursor focus on cell A2, a quick way to select this data range is to press Shift Control End. 
2. Press Alt to open the Upper ribbon, Right arrow once to the Insert tab, tab once into the Lower ribbon, and press Enter on the Pivot table button (the shortcut key is Alt N V).
3. You land in a dialog box where the selected data range is indicated. Assuming the data range is correct, press Enter here.
4. You now land on cell A3 in a new blank worksheet. Do not navigate away from this cell. Otherwise, the next step will not work. 
5. Press F6 a couple of times until you hear “pivot table fields, find words to search for.” 
6. Tab once where you will find all your column headers listed.
7. Down arrow to the first of these that you want to be part of your pivot table, either as a row label, column label, or value. In this case, you first land on “store,” which is the variable we want to use as a row label. 
8. Press the Applications key, Down arrow to Add to row labels, and press Enter. This returns you to the list of column headers. The checkbox for “store” is now checked. 
9. Down arrow to the next column header in the list that you want to be either a column label or value. In this case, it is “Quarter,” which will be the column label.
10. Press the Applications key, Down arrow to Add to column labels, and press Enter. Here again, you are returned to the list of column headers, and the checkbox for “Quantity” is now checked. 
11. Down arrow to the column header in the list that you want to be included for values. In this case, it is “Sales.” 
12. Press the Applications key, Down arrow to Add to values, and press Enter. You are returned to the list of column headers, and the checkbox for “Sales” is now checked. 
13. The pivot table is now ready to view. Press F6 four times until you have returned to the worksheet. You will know when you are there because you land in cell A3 every time. In this case, you hear “Sum of sales A3.”
Note that the order in which you add row labels, column labels and values does not matter. Simply add them in the order they appear as you Down arrow through the list. 
The table appears as follows:
· The five stores are listed down column A. 
· The four quarters are listed across row 4.
· The values appear in the body of the table. For example, the value of first quarter sales in the Boston store is contained in cell B5. 
· Grand totals by quarter appear across the bottom row of the table.
· Grand totals by store appear down the last column of the table.
· The grand total for all stores and all quarters appears in the bottom right cell. 
Note that the values only appear as simple numbers. Press Control A to select the entire table, and press Control Shift 4 to quickly change their format to dollars with two decimal places. Also note that you should rename the worksheet using the steps outlined in Chapter 5.5 so you don’t confuse it with other pivot tables you will be creating on other sheets. 
I frequently create pivot tables whose purpose is simply to count things. I mentioned above that I used pivot tables for planning a conference. I created pivot tables to count up the number of lunch choices, preferred agenda format (email Braille, large print), and a few more items. For these tables, I designated lunch choice and preferred agenda format as row labels. To add values, I inserted a column called “Quantity,” that I filled with the number 1 for all the entries. 
5.7.2 Filtering Pivot Table Data
You can filter pivot tables to narrow your focus. Using the table we have just constructed, let’s say we are only interested in sales of the Boston store in the first quarter. We can filter this table as follows:
1. Navigate to cell A4 which contains the text “row labels,” and press Alt Down arrow to open the Filter dialog. 
2. Shift Tab to the tree view where you land on the Select all checkbox which is checked. Press the Spacebar to uncheck it, thus unchecking all the store names underneath it in the list. 
3. Down arrow to the Boston checkbox and press the Spacebar to check it. If you wanted to include other stores, you would Down arrow to them and check them too. 
4. Tab once to the OK button and press Enter. The other store rows are now hidden. 
5. To filter the quarters, navigate to cell B3 which contains the text “Column labels,” and Down arrow to open the Filter dialog.
6. Shift Tab to the tree view where you land on the Select all checkbox which is checked. Press the Spacebar to uncheck it, thus unchecking all the quarters underneath it. 
7. Down arrow to the first quarter checkbox and press the Spacebar to check it. 
8. Tab once to the OK button and press Enter. The other quarter columns are now hidden and only the Boston first quarter sales values appear. 
A wide variety of pivot tables can be constructed with a dataset such as that contained in the original worksheet. These might include:
· Total sales by employee
· Total sales by product.
· Product sales by store. 
· Product sales by quarter.
These could be filtered to narrow in on subsets of products, employees, quarters, or stores. 
5.7.3 Refreshing Pivot Tables
Once you have created a set of pivot tables, it is quick and easy to update them as new data is inserted in the initial data table, and as long as you use the following trick. If you want to insert new rows, insert them somewhere in the middle of the table rather than under the bottom row. Similarly, insert new columns between existing columns, rather than after the last one. The data range captured for recalculating the pivot tables will automatically adjust. Once you have inserted the new data:
1. Navigate to any of the sheets containing a previously-created pivot table.
2. Place your cursor on any cell with data in it. 
3. Press the Applications key, Down arrow to Refresh, and press Enter.
All pivot tables are now updated with the new data incorporated in the calculations. 
By contrast, if you add new rows below or new columns to the right of the existing ones, refreshing is more time-consuming. If at all possible, avoid doing this because you will need to repeat the steps below for each pivot table that you want to refresh.
Let’s say I have added data for a sixth store. The previous data range was A2 through G182, and now has been extended to G219. Also let’s say the name of the sheet is “data.” Steps for refreshing an individual pivot table are:
1. Navigate to the sheet containing one of the pivot tables you wish to update and place your cursor somewhere in this table.
2. Press the Alt key to open the Upper ribbon, and Right arrow to the Pivot table analyze tab. Note that this tab only appears when your cursor is situated in a pivot table. 
3. Tab into the Lower ribbon to the Change data source split button and press Enter. 
4. You land in an edit field where you type in the sheet with the raw data and the data range. The syntax is: the name of the sheet followed by the exclamation mark and then the new data range. In this case, type “data!a2:g219”without the quotes. 
5. Tab to the OK button and press Enter. 
This pivot table is now refreshed with calculations incorporating the new data. Unfortunately, you will need to repeat these steps for all previously-created pivot tables that you wish to refresh. In light of this, it is preferable to insert the rows for the sixth store somewhere in the middle of the data table rather than below the bottom row. 
5.8 Visual Considerations and Printing Worksheets
5.8.1 Adjusting Column Width
You can manually adjust column width or automatically resize columns to fit the data. The automatic option is called “autofit.” If you are sharing spreadsheets with sighted people, it is important to know if your column widths are correct. Otherwise, they may be unable to see data in some of the cells. JAWS calls this issue “cell text visibility,” and I will use this term here. 
If a column is not wide enough to accommodate the content of a particular cell, and the cell to its right also contains content, what you hear using a screen reader program and what visual users see is different. And this also differs between cell content that is text or numbers. 
With respect to cell content that is text, screen reader programs will read all cell content, regardless of whether the column in which it is contained is wide enough, and even if there is content in the cell to its right. If there is content in the cell to the right, sighted users will only see the text that fits within the current column width. If a sighted user places focus on a particular cell, that cell’s full text becomes visible in the Formula bar, a long thin rectangle near the top of the screen and under the ribbons. The Formula bar extends to the right edge of the screen. 
If a cell text visibility problem exists, NVDA indicates this by default. The JAWS default is to not indicate it, but a setting can be changed for individual sheets. Narrator does not currently have a way to identify cell text visibility problems.
For JAWS, turning on the setting to detect cell text visibility problems is done in Quick Settings. See Chapter 8.1.4.1 on how to do this. Unfortunately, it can only be changed for one file at a time, and cannot be switched to become the default setting. In addition, I have found that JAWS does not reliably indicate when there is no longer a cell text visibility problem. In my opinion, this is one area where NVDA does a better job than JAWS. NVDA identifies this problem without having to change a setting, and is also more reliable in telling you when you have fixed it.
If a column is not wide enough for the text content in cell A7, and there is content in cell B7 to its right, JAWS and NVDA will identify this as a cropped cell. NVDA will say “cropped at A7.” If cell text visibility detection is turned on, JAWS will say “cropped right at B7.” If there is no content in cell B7, NVDA will say “overflows A7.” JAWS will say “overlaps near B7,” or whichever cell the text extends to on that row. 
With respect to numeric data with cell text visibility problems, what your screen reader says and what sighted users see may differ depending on software versions. With my current versions of JAWS, NVDA, and Excel, data are expressed using scientific notation. For example, the number five billion is expressed as “5E+09.” Sighted users may instead see the cell filled with the symbol for numbers. Narrator users hear the full number even though it is not visible.
Commands for changing column width are located in the Cells group of the Home tab but are hard to find. Instead use the shortcut keys, which are Alt H O W for adjusting manually and Alt H O I for autofit. While it is usually better to autofit rather than guess at a manual width, the manual command allows you to detect the current column width. However, its meaning is not immediately clear. Press Alt H O W, and you will hear something like 8.11. The default column width is specified as a number of characters. So this means that 8.11 characters in the current font can fit within the width of the column. Back in typewriter days, individual character size was fixed so that either 10 or 12 characters fit within one inch. Nowadays, fonts are proportional, meaning that letters like M take up more room than letters like I. Thus, expressing column width this way is of limited value. 
Changing workbook views allows column width to be expressed in inches. Steps for doing this for an individual file are:
1. Press Alt to open the Upper ribbon, and Right arrow to the View tab.
2. Tab into the Lower ribbon to the Workbook submenu and press Enter. You land on the Normal view which is checked by default.
3. Tab to the Page layout view and press Enter. 
4. Press Alt H O W, and column width should now be expressed in inches. 
This setting will be retained when you save the file. 
You can change the default view to the Page layout view as follows:
1. Press Alt F T to open Excel options, where you land on the General category.
2. Tab to the Default view for new sheets combo box, and Down arrow to Page layout. 
3. Tab to the OK button and press Enter. 
So finally, after all this, how do you go about changing column width? To change it manually, press Alt H O W, type in a new column width value, and press Enter. If you have changed to Page layout view, express the value in inches. It is not necessary to type the quotation mark for inches. 
To autofit a column:
1. Press Control Spacebar to select the column.
2. Press Alt H O I to autofit.
3. If you want to find out what the new column width is, press Alt H O W to see it, and then the Escape key when you are done. 
You could also select multiple columns by pressing Shift Right arrow several times across a row, then Control Spacebar to select the columns, and then you could either change column width manually or autofit them, as outlined above. However, with regard to autofitting this way, keep in mind that a table with lots of different column widths is unsightly. It is more appropriate to have a wider column where the row headers are located (Usually column A), and uniform widths for the remaining columns to the right.
5.8.2 Text Wrapping
You can wrap text so that it appears on multiple lines in a cell. You can format the cell so the text wraps automatically, or you can insert a manual line break. To wrap text automatically, select the cell or cells that you want to wrap, and press Alt H W. 
Data in the cell wraps to fit the column width, so if you change the column width, data wrapping adjusts automatically to shift text between lines.
You can manually insert a line break within an individual cell. To do this, navigate to the position in the cell where you want to add the line break, and press Alt Enter. 
In cells with wrapped text, JAWS indicates this by saying “multiline cell.” Neither NVDA nor Narrator say anything to indicate the presence of text wrapping.
If text wraps to add new lines to an individual cell, the height of the entire row adjusts to accommodate this change. Content in other cells on this row are vertically aligned to the bottom of the cell. 
To hear the height of the current row, press Alt H O H. To find out how many lines are in the current cell, press F2 and Down arrow to read line by line. 
5.8.3 Headers and Footers
Headers and footers can be added to appear at the top and bottom of printed pages, respectively. Information commonly inserted in headers and footers include file and worksheet names, date and time the file was last revised, and page numbers.
There are quite a few built-in options that can be inserted. To insert a header or footer:
1. In the Insert tab, press Control Right arrow to move to the Text group, and press Enter to open the Text submenu. Tab to the Header and footer button and press Enter. The shortcut key is Alt N H 1.
6. You first land in the Center section of a blank Header pane. Press Tab and Shift Tab to move between the left, center, and right sections of this pane. You can also press Page down and Page up to toggle between the header and Footer panes.
7. While in either the Header or Footer pane, press Alt to open the context-specific Header and footer tab. 
8. Tab into the Lower ribbon where you will find an array of built-in fields, including: page number, number of pages, current date, current time, file path, file name, and sheet name. There are also a Header submenu and Footer submenu with additional built-in options you can select. 
9. Press the Escape key when finished adding your built-in choices. 
With JAWS, you can press Insert F1 for Screen-sensitive help to detect the presence of headers or footers. If, for example, there were a header containing the filename, JAWS would say “header:,” followed by the filename. With NVDA and Narrator, you will need to use the header or footer Edit command to see what appears in the Header or Footer panes. The shortcut keys to quickly get there are Alt N H E for the Header pane, and Alt N O E for the Footer pane. Once you are there, Tab to hear what appears in the left, center and right areas of the pane 
To remove a header or footer, the shortcut keys are Alt N H R and Alt N O R, respectively. I find that if I need to edit a header or footer, it is easier to remove the existing one and start over, rather than try to edit it. 
5.8.4 Formatting Tables
If you intend to share your worksheets with sighted people, you can make them more visually appealing by using table styles which adds a number of visual elements, including bolding column and row headers, and varying background shading of alternating columns or rows. You can also add borders around entire tables, selected rows, columns or cells to make them stand out. If you have never done this before, ask experienced sighted Excel users about appropriate table formatting choices. 
5.8.4.1 Table Styles
It is easy to select a table style, but understanding the pattern of the table styles is not readily apparent without a few workarounds. 
To illustrate, I will use the example of a quarterly sales table of a retail store, where the name of the table “Quarterly Sales of the Acme Company ” appears in cell A1, its various products are arrayed down column A, beginning in cell A2 where the column header “Product” is written, and the various products appear from cells A3 through A9, and the four quarters are enumerated in cells B2 through B5. The word “Total” appears in cell A10 and cell F2. Column and row totals will be summed in rows 10 and column F, respectively. Therefore, the table’s data range begins in A2 at the top left corner and F10 at the bottom right corner. The table name in cell A1 is not part of the table. 
Steps for selecting a style for this table and then adapting it to your wishes are:
1. [bookmark: _Hlk69719688]Select the table’s data range, which in this case is A2 through F10. To do this quickly, with your cursor in cell A2, press Shift Control Right arrow to select across to cell F2, and while continuing to hold down the Control and Shift keys together, Down arrow once to cell F10. Your screen reader will say the content and coordinate of the top left cell and then the content and coordinate of the bottom right cell.
2. Press Alt H T, which is the ribbon shortcut key to get into the Format as table submenu. 
3. This opens a table styles gallery. Right arrowing here presents a series of colors, including white and black/grey, white and blue, white and orange, white and grey, white and yellow, white and blue (lighter shades than the first set of blue and white options), and white and green. Down arrowing presents various shade levels of those colors (light, medium and dark). Arrow to a color and shade that appeals to you and press Enter to choose it. 
4. You land in a dialog box where the cell range chosen is repeated. Tab once to the My table has headers checkbox and press the Spacebar if you want the top row to serve as the column header row. This will bold the column headers.
5. Tab to the OK button and press Enter.
This data range is now a formatted table. To get a sense of the characteristics of the table style you have chosen, beyond just its color and shading, and with your cursor placed somewhere in this data range:
1. Press Alt to open the Upper ribbon, and Right arrow to the Table tools table Design tab. This is a context-specific tab. It will only appear if your cursor is situated in the table’s data range. The shortcut key to get to it is Alt J T.
2. Press Control Right arrow to navigate to the Table styles options group in the Lower ribbon.
3. In this group, Tab through the various options to see which of the following checkboxes are checked or unchecked: header row, totals row, banded rows, first column, last column, and banded columns. If banded rows or columns are checked, this indicates that alternating rows or columns are shaded with the color selection you made. Check first column if you want to bold it. If header is checked, that row will be bolded. If totals are checked, a totals row will be added. 
4. Press the Spacebar on any of these if you wish to check or uncheck them. Unfortunately, modifying a single one throws you back into the table. You have to repeat the above steps to get back here and continue modifying them one by one. 
5. Repeat these steps until you have the desired formatting.
Note that checking the Header row and First column checkboxes will bold their cell content. In JAWS, they will also be read similarly to when the Define names command is used to speak column and row headers as you navigate within the table. However, headers are not consistently read with NVDA and Narrator. Therefore, to be sure they read properly, you should still use Excel’s Define name command for reading column and row headers (see Chapter 5.2.2 above).
To turn off table formatting so that the data range reverts to its original formatting, do the following:
1. Select the data range of the table. 
2. Press Alt H E F to clear formatting. 
3. Press the Applications key, Up arrow to the Table submenu, Down arrow to Convert to range, and press Enter. 
4. You are asked whether you want to convert the table to a normal range. Press the Spacebar on the Yes button to confirm.
If you add banded rows or columns, you wan to be sure they have sufficient color contrast with the cell content. The Excel Accessibility Checker is a useful tool for doing this. Access it as follows:
1. Press Alt, Right arrow to the Review tab, Tab to the Check accessibility split button, and Press Enter.
2. Tab to Inspection results. If you hear “no accessibility issues found,” then your table style choice is OK. However, if you hear “warnings,” then Down arrow through the results, presented in a tree view. This will reveal the problem, saying “hard to read text contrast,” and naming the sheet where the problematic table appears. 
3. If this happens, clear the table style, choose another one, and run the Accessibility Checker again.
Here are a few hints and caveats about the process of adding table styles:
· When you open the file, if you hear that it is in compatibility mode, this means that the file was originally saved in the older 1997/2003 Excel file format rather than the newer one beginning with Excel 2007. Turn this off for more dependable outcomes. Also note that the Accessibility Checker will not work in compatibility mode. Press Alt F I to get to the Info tab, Tab to the Compatibility mode convert button and press Enter. You will be asked to save it, which you should do. 
· Navigating to the table Design tab on the Upper ribbon requires pressing the Right arrow quite a few times. If you are going to navigate there several times to modify format options, use the shortcut key which is Alt J T. Then press Control Right arrow to more quickly navigate back to the Table styles options group in the Lower ribbon.
· Don’t check the Total row checkbox. It gives unreliable results. 
· If you are going to add shading, select either banded columns or banded rows for easier readability for sighted readers.
· As of the writing of this book pressing Insert F gives more dependable information about font color with NVDA and Narrator than with JAWS. However, none of the screen readers are very dependable for identifying format information. 
5.8.4.2 Adding Borders
You can also format tables by surrounding the entire table, as well as cells within it, with borders of varying thickness. I should first clarify the difference between borders and gridlines. Borders of varying thickness may be added to make tables and/or parts of those tables stand out on the computer screen and on printed pages. Gridlines are thin horizontal and vertical gray lines that visually differentiate boundaries between cells on your computer screen. If you add borders, they will appear on both your computer screen and printed pages. Gridlines appear on your computer screen but not on printed pages, unless you change a setting to make them appear when printed.
As an example, lets format the table discussed above by adding thick borders on the top, bottom, left, and right edges of the entire table, another thick border below the column header row to set it apart from the other rows, and thin gridlines around the remaining cell edges in the table. Steps are:
1. To add thick borders around the entire table, select the table’s data range: A2 through F10. 
2. Press the Applications key, Up arrow to Format cells, and press Enter. This opens a multi-page dialog box. Press Control Tab until you get to the Borders page. 
3. Tab once to a series of radio buttons for adjusting border line thickness. Down arrow to the Thick radio button. 
4. Tab to the Outline button and press the Spacebar. Now Tab through and you should hear that the top, bottom, left and right checkboxes are checked. Because you initiated this process by selecting the entire table, this choice will add thick borders around the entire table while leaving gridlines around all the interior cell edges.
5. Tab to the OK button and press Enter.
6. To now add a thick border to the bottom edges of the column header cells, select the cells in row 2 (cells A2 through F2). 
7. To get to the Borders dialog more quickly, press the Applications key, and then F. Your focus should immediately land on the Borders page of the Format cells multi-page dialog box. 
8. Tab once. Your focus should still be on the Thick radio button. 
9. Tab to the Outline button and press the Spacebar. As you continue tabbing, you should again hear that the top, bottom, left, and right checkboxes are checked. The edges around the entire row will be thick, while the interior vertical edges will remain as gridlines.
10. Tab to the OK button and press Enter.
11. To also print the gridlines of the remaining cell edges, press the Alt key, Right arrow to the Page Layout tab, press Control Right arrow until you get to the Sheets group. You first land on the View gridlines checkbox. Tab one more time to the Print gridlines checkbox and press the Spacebar to check it. When I tabbed to this command on my computer, my screen reader only said “print.” But when I tabbed past it, and Shift tabbed back to it, it said “gridlines print.”
To remove borders:
1. Select the desired data range.
2. Press the Applications key, and then F. Your focus should immediately land on the Borders page of the Format cells multi-page dialog box if you were there previously. If you land elsewhere, press Control Tab until you get there.
3.  Tab to the None button, and press the Spacebar to check it.
4. Tab to the OK button and press Enter.
Adding borders correctly may require a fair amount of trial and error. JAWS has an extremely useful keystroke for revealing the border pattern of individual cells. After making border changes, spot-check them by navigating to a few cells and pressing Alt Shift B to check their border formats. For example, after I made the changes above, when I pressed this keystroke with my cursor in cell A2, JAWS said “Black thin gridline right edge, thick black continuous left, bottom and top edge borders of active cell.” Spot-checking a few other cells in the table confirmed that I had formatted borders as intended. However, when I tried to mix things up a bit by adding borders of varying thickness, results were unreliable. Therefore, I would recommend that if you try to add borders, don’t attempt anything too elaborate. If using JAWS, continuously check your work with the Alt Shift B keystroke. Unfortunately, I am unaware of any reliable way to check border formatting with NVDA or Narrator.
Finally, you may wish to bold the cell content of selected rows or columns, such as column and row headers, or total rows or columns. This is easy. Simply select the data range, and then press Control B to bold it. 
A final observation: formatting Excel tables is finicky and temperamental. Screen reader feedback may be less than reliable. Consequently, the only way to be absolutely sure that you have formatted your table as intended is to have a sighted person look it over.
5.8.5 Printing
You can print individual worksheets, all worksheets for a multi-sheet file, or a selected data range or print area in a worksheet. To print a data range in a worksheet rather than the entire worksheet, first select the block of cells using the keystrokes discussed in Chapter 5.3.2 above. Steps for printing are:
1. Press Control P to open the Print dialog.
2. Press Tab to the Print what combo box, and Down arrow through the choices, which are: active sheets, entire workbook, and selection. Press Enter on your choice. 
3. If you are ready to print, press Tab to the Print button and press Enter. Otherwise, press the Escape key. 
If your data selection is too large to fit on a single page, you need to consider how it will be arranged on multiple pages. Elements to consider include page size, font size, margin dimensions, and column and row height. Here are the Excel default settings, and I will use them in this section:
· Page size of 8.5 inches wide by 11 inches high in portrait mode. 
· Calibri font with 11 point size.
· Top and bottom margins of 0.7 inches, and left and right margins of 0.75 inches.
· Column width of 0.7 inches and row height of 0.2 inches.
· No headers or footers, presence of which can effect the number of rows that fit on a page.
Based on this configuration, eight columns and 47 rows of data can fit on a single page on my computer. I am not prepared to say that this is universal, but it will work for illustrating what follows in this section. 
If a worksheet has more columns and/or rows of data than will fit on a single page using this configuration, you need to know a few techniques for printing. JAWS in particular, has some useful tools to aid in the printing process.
Let’s say we have a worksheet that has 15 columns (from column A to O) and 65 rows. All this data will not fit on a single page. With JAWS, pressing Control Shift B brings up the Cells and page breaks list. This identifies where horizontal and vertical page breaks occur. In this case JAWS identifies the horizontal page break at A48, meaning that row 48 will be the first row on the second page. Down arrow once and JAWS indicates a vertical page break at cell K1, meaning that column K will be the first column on the second page.
Pressing Insert F1 brings up JAWS Screen-Sensitive Help. Among other things, JAWS reads the following print-related information: 1 horizontal full page break, 1 vertical full page break, and 4 portrait pages can be printed from this worksheet.
The data ranges and default order of printing will be:
· A1 to J47 on page one.
· A48 to J 65 on page 2.
· K1 to O 47 on page 3.
· K48 to O 65 on page 4.
If you print a data range with horizontal page breaks, you will want to be sure that column headers appear on every page. Otherwise, readers will have difficulty interpreting data on page two and beyond. Likewise, If you print a data range with vertical page breaks, you will want row headers to appear on every page. And If you print a data range with both horizontal and vertical page breaks, both column and row headers should appear on each page. To do this:
1. Press the Alt key to open the Upper ribbon, and Right arrow to the Layout tab.
2. Tab into the Lower ribbon to the Print titles button and press Enter. The shortcut key is Alt P I. 
3. Tab to Rows to repeat at top. If your print selection will have one or more horizontal page breaks, type here the row number or numbers of your column headers. If column headers are in row 2, type in here “2,” minus the quotes. If column headers are in two rows, say two and three, type “2:3” here, minus the quotes. The colon indicates rows two through three. 
4. Tab to Columns to repeat at left. If your print selection has one or more vertical page breaks, type here the column letter or letters of your row headers. This is nearly always just Column A, so type “A” here, minus the quotes.
5. Tab to the Grid lines checkbox, and press the Spacebar to check this if you want narrow grid lines to appear between cells. This is one way to make table reading clearer for sighted viewers.
6. Tab to the Down then over radio button. This indicates the order of how data ranges will be printed. Leaving it this way results in the print order indicated above. Down arrow once to the Over then down radio button if you wish to change the page printing order.
7. Tab to the OK button and press Enter.
If possible, try to avoid data spilling onto lots of printed pages. An excessive number of vertical and horizontal page breaks can make it hard to understand the information if it is carved up into lots of slices. You should also avoid printing pages with just one or two columns or rows. If you find yourself in such a situation, there are a few things you can do. First, if the page is not wide enough to accommodate all your columns, switch from the default portrait mode to landscape mode by pressing Alt P O, Down arrowing to the Landscape button, and pressing Enter. Two or three more columns will now fit on a page, but with about twelve fewer rows. 
Second, you can adjust margin dimensions to make them narrower, thus allowing more columns to fit on a page. To do this, press Alt P M, Tab to the Narrow margins button and press Enter. This changes the left and right margins from the 0.7 inch default to 0.25 inches, thus adding a bit less than one inch for fitting columns. This may not sound like much, but sometimes every little bit counts. 
Third, you can use the Scale to fit feature in the Print dialog. Steps are:
1. Press Control P to open the Print dialog.
2. Tab to the Scale to fit combo box and Down arrow through the choices, which are: no scaling, fit sheet to one page, fit all columns on one page, fit all rows on one page, and custom scaling options where you can designate a percentage for decreasing the size of characters on the printed page. 
3. After making your choice, Tab once to get out of the combo box and lock in your choice. There is no OK button here. 
4. If you are ready to send your work to the printer, Tab to the Print button and press Enter. 
Scaling to fit does not change the point size in your electronic file, but it does change the point size of the text sent to the printer. You can calculate the point size of what is printed by pressing Alt P X. This indicates the percent of scaling. The default is 100 percent for no scaling. If you have introduced scaling, it might now say 75 percent. If the default font size is 11 point, 75 percent of this equals an 8.25 point size. You then need to judge if this is large enough to be easily visible to sighted readers. If you opt for custom scaling, with the 11 point default, you probably shouldn’t go much below 70 percent. The best strategy is to ask sighted people who will be using the print out if they are able to read it.
5.9 Additional Tools and Features
Excel has many more tools and features. Some of the most useful ones are described in this section. Two features unique to JAWS – monitor cells and chart reading – are also described. 
5.9.1 Hiding and Unhiding Columns and Rows
In large sheets, using this feature aids efficient navigation by temporarily hiding columns or rows so you can quickly skip over them to get to columns or rows that interest you. Let’s say it’s now December and you want to input data for that month’s bills. You would like to temporarily hide all the columns from January through November. If you do this, only three columns will remain visible: column A with the bill names, the December column, and the Annual Total column. 
Steps for hiding the February through October columns (columns B through L) are:
1. With your cursor anywhere in Column B, hold down the Shift key and Right arrow to select across to column L.
2. Press Control Spacebar to select these columns.
3. Press the Applications key, Up arrow twice to Hide, and press Enter.
In column A, you will now hear “adjacent to hidden cells.” Right arrow once and you will be in column M, again hearing “adjacent to hidden cells.” This indicates that columns B through L are hidden. 
When you are ready to unhide columns B through L, do the following:
1. With your cursor on Column A (the column just to the left of the hidden columns), hold down the Shift key and Right arrow once to column M (the column just to the right of the hidden columns).
2. Press Control Spacebar to select these two columns.
3. Press the Applications key, Up arrow once to Unhide, and press Enter.
You can follow a similar process to hide and unhide rows. Remember that selecting multiple rows involves holding down the Shift key, Down arrowing, and then pressing Shift Spacebar to select them. After selecting rows, steps for hiding and unhiding them via the Applications key are the same as for columns.
5.9.2 Comments
Similar to Word, you can easily add comments to Excel workbooks while reviewing work with collaborators. You might also insert comments to explain how a formula was calculated or identify data sources. Comments are cell-specific, so start with your cursor focus on the relevant cell. Now press Shift F2, type in your text, and press Enter. Alternatively, you can press the Applications key, Up arrow several times to New comment, and add your comment from there. 
JAWS indicates that a cell has an associated comment by saying, “has comment, contains note.” NVDA says “has comment,” and Narrator says “contains note.” 
Excel 365 has added a feature for inserting notes. In theory, these are different from comments in some way. However, as of the writing of this book, I don’t think that any distinction is helpful, at least for screen reader users. Regardless of whether you insert a comment or a note, the screen readers say the same thing. 
While it is theoretically possible to reply to a comment, I was not able to figure out how to do this. I suggest sticking with comments for now. If you want people to reply to your comments, figure out a workaround of some sort, rather than attempting to reply to a comment within the comments feature framework. 
To delete a comment, place your cursor on the associated cell coordinate, Up arrow to Delete note and press Enter. Note that it might say “delete comment” in earlier versions of Excel. 
With JAWS you can press Control Shift Apostrophe to get a list of comments. You can then Down arrow through them to hear them, as well as press Enter on a comment to navigate to the associated cell. If your cursor focus is on a cell containing a comment, you can press Alt Shift apostrophe to hear it, as well as its author. 
At this time, neither NVDA nor Narrator have keystrokes for accessing a list of comments. While it is theoretically possible to get a list of comments in Excel itself, this does not give a list that is accessible.
5.9.3 Removing Unwanted Verbosity 
You may want to disable several Excel settings options that create confusing and distracting verbosity. Repeated prompts like “Quick analysis lens” or “Paste recovery options” can throw you off-track. When you type formulas beginning with a letter, you may hear things like “=A abs,” or “=B bottox,” which may confuse you. You can Eliminate this unwanted verbosity in the Excel Options dialog. Note that each of the category dialog boxes are extremely lengthy. Consequently, after making desired changes, it is much quicker to Shift Tab back to the OK button rather than Tab forward to it. Note also that the various settings are organized in groups, and as you tab through them, yu must listen to the name of the group before hearing the dialog element. If you tab through too quickly, you can easily skip over the one you are looking for. 
Steps for making three changes I would suggest are as follows:
1. Press Alt F t to open the Excel Options Categories dialog.
2. You first land on the General Category. Tab to the Show quick analysis options checkbox (located in the User interface options group of this category) and press the Spacebar to uncheck it. 
3. Shift Tab to the OK button and press Enter. 
4. Press Alt F t to reopen the Excel Options Categories dialog.
5. Down arrow or press F to navigate to the Formulas Category.
Tab to the Formula autocomplete checkbox (in the Working with formulas group of this category), and press the Spacebar to uncheck it.
6. Shift Tab to the OK button and press Enter. 
7. Press Alt F t to reopen the Excel Options Categories dialog.
8. Down arrow or press A to navigate to the Advanced Category.
Tab to the Show paste options button when content is pasted checkbox (in the Cut, copy and paste options group of this category),  and press the Spacebar to uncheck it.
9. Shift Tab to the OK button and press Enter. 
5.9.4 Monitor Cells With JAWS
To facilitate quick navigation to especially important areas of a large worksheet, you can designate up to ten monitor cells or data ranges. You can set these up with shortcut keys or via Quick Settings. To do this using shortcut keys, navigate to the cell you want to tag as a monitor cell. If it is a data range, set the data range first. Then press Insert Shift 1 to tag it as monitor cell one, Insert Shift 2 to designate it as monitor cell 2, and so on. If you designate cell A5 as the first monitor cell, JAWS will say “setting monitor cell 1 to A5.” You can easily reassign monitor cells. For example, if you place the cursor on cell A14 and press Insert Shift 1, JAWS will warn you that this monitor cell is already assigned and ask if you want to replace it. Pressing Enter will confirm the reassignment of this monitor cell number.
Once assigned, you can read monitor cells individually or in a list. Press Alt Shift 1 to read monitor cell one, Alt Shift 2 to read monitor cell 2, and so on. Note that this only reads the cell content. It does not navigate to that cell. 
To open a list of monitor cells, press Control Shift M. I especially like this feature because you can see all your monitor cell coordinates and content together. Also, if you Down arrow to one of them and press Enter, it will navigate to that monitor cell.
You can also assign monitor cells, reassign them, and remove assignments in Quick Settings (see Chapter 8.1.4.3).
5.9.5 Creating Charts and Reading Them with JAWS
Charts are visual presentations of data that are often more effective for communicating results than tabular presentations. They are easy to create. But you might assume that they are inaccessible to screen reader users. Fortunately, JAWS has a very nice chart reading feature to make them accessible. 
Among the most commonly used chart types are:
· Pie charts: Used to represent each data item as a percentage share of a total value. Each item is represented as a slice of a pie. 
· Column charts: Typically used to compare several items in a specific range of values, such as comparing sales volumes of several retail stores. The numerical values appear as vertical columns. 
· Bar charts: Used to display the same data as column charts, but as horizontal bars instead of vertical columns.
· Line charts: Often used to present trends over time. Monthly stock or commodity prices are examples. 
I will demonstrate by creating a pie chart showing the number and percentage shares of annual tourist visits to New England from four countries. If you are using JAWS and want to try it yourself, open the practice file entitled, “New England Tourist Visits.xlsx.”
The countries are listed in cells A2 through A5. The corresponding numbers of tourist visits are listed in cells B2 through B5. The Steps for creating the pie chart are:
1. Select the data range containing the data, in this case A2 through B5. 
2. Press the Alt key to open the Upper ribbon. If you first land on the Home tab, Right arrow once to the Insert tab.
3. The Charts group is fairly deep into the Lower ribbon, so press Control Right arrow several times until you land on the Charts group, the first item here being the Recommended charts button.
4. Tab several times to the Insert pie or donut chart submenu, and press Enter.
5. You first land on the 2D pie button. This is a two-dimensional pie chart. There are several other choices here that you can arrow through, including a 3D pie chart which adds shading to give it a three-dimensional effect. We will stick with the 2D pie chart, so press Enter on that.
6. The chart is now visible to the right of the data. 
At this point, depending on your version of JAWS, sometimes it immediately begins reading the entire chart content, other times it does not. In any event, press Escape now. 
To access the chart and have it read to you, press Control Shift O which brings up a list of objects. “Objects” include charts, pictures, and illustrations. After pressing Control Shift O, you will hear something like “Chart 1, chart title E2 M17,” where cell E2 is the top left cell and M17 is the bottom right cell of the range where the chart has been inserted in the worksheet. This is the default chart title. 
Press Enter on it to select it (note that you must press Enter, Spacebar will not work), and JAWS will now start reading the chart’s content to you. JAWS may read the chart continuously or just the first line. If it stops reading after the first line, you can Down arrow to read it one line at a time, or you can press Insert Down arrow to read it continuously. Here’s what you will hear for this chart: “Chart Title, Description: Pie. Displays the contribution of each value to a total., legend: Series1 has 4 slices, slice 1 CATEGORY=England, value=40000, contributes 27 percent, slice 2 CATEGORY=France, value=30000, contributes 20 percent, slice 3 CATEGORY=Italy, value=20000, contributes 13 percent, slice 4 CATEGORY=Canada, value=60000, contributes 40 percent, This sheet contains only the chart.”
You can move, copy or edit charts. Let’s say you would like to change the data range where it appears visually on your worksheet. Do the following:
1. Press Control Shift O to access the list of objects. 
2. If the pie chart is the only object in your worksheet, you land on it. If not, Down arrow to it, and press Enter to select it. 
3. Press Control X to cut it to the Clipboard. 
4. Navigate to the cell where you want its top left corner to appear and press Control V to paste it there. 
You could also copy the chart by pressing Control C instead of Control X and paste it in a Word document. 
Finally, you can add chart titles, X and Y axis titles, table legends, and data legends. To do this, first select the chart by pressing Control Shift O, and Enter to select it. You can then press Alt to open the Upper ribbon, and Right arrow to the Chart Layout tab of the ribbon. Here you can Tab into the Lower ribbon to Chart title, Axis titles, Legend, or Data Labels to add or change these.
5.10 Strategies for Deciphering “Difficult” Spreadsheets
Unfortunately, some spreadsheets you receive from sighted people will not be laid out in a tidy rectangular block and may be difficult to decipher. Among accountants, the convention is to add lots of empty cells between the data. Spreading things out like this visually separates categories and sub-categories. However, this makes it difficult for screen reader users to interpret data. In addition, choosing the best cell to initiate the Define names command can be challenging, and will probably yield less-than-perfect results. 
The practice file entitled “Temple Income and Expenses.xls” is an example of a “difficult” spreadsheet. I received a version of this spreadsheet from a student who serves on a budget committee at her temple. She was having trouble figuring it out.[footnoteRef:5] The first clue that something funny was going on was when I pressed Control Home. Rather than landing in cell A1, I landed in cell C3 instead. I correctly guessed that the spreadsheet author was using the Freeze panes command. This is the sighted equivalent of the Define names command. It is used to “freeze” column and/or row headers so they can be visible no matter where the cursor is located in a spreadsheet. This is useful for sighted users in large spreadsheets. For example, if the cursor is located in cell O187, without freezing the appropriate columns and rows, it will not be possible to interpret the data in that cell without doing a lot of time-consuming navigation. This is because the cursor is located too far down, as well as too far to the right, to see the associated column and row headers.  [5:  For demonstration purposes, I have modified the sheet by deleting several columns with a number of budget sub-categories. ] 

To verify whether Freeze panes is turned on, and to disable it if you want to do that, the Freeze panes submenu is located in the View tab of the ribbon. To disable it, press the shortcut Alt W F, and, assuming it is checked, press Enter to disable it. Whether you disable it or not, you will still be able to navigate in the range that is frozen by arrowing or Control arrowing. 
Pressing Control and the arrow keys is very useful in this spreadsheet because its author has left many empty cells for visual layout purposes. If you go to the top of column A of this spreadsheet, and press Control Down arrow once, you jump to cell A3, which contains the word “Income.” If you continue Control Down arrowing, you will jump to total income in cell A33, expenses in A35, total expenses in cell A130, and net income in cell A132. Obviously, just arrowing down would waste lots of time. 
Down arrowing through column B reveals actual budget line items. Corresponding dollar amounts for each month begin in column C. Column headers for the months February 2019 through February 2020 appear in cells C2through Q2. Amounts are totaled in column S. Each of the monthly columns are visually separated by empty columns. 
If we place the cursor in cell B2 and initiate the Define name command here, this will greatly aid data interpretation. Cell B2 is the intersection of column B which contains the line items, and row 2 contains the months. 
After getting a grasp on the logic of how the categories are organized in column A, and choosing the best cell to initiate the Define name command, it is now possible to understand the financial data in columns C through S. You will not be able to hear the categories (income, expenses, etc.) while navigating within the body of the table, because categories and individual line items are spread over two separate columns. However, you can now begin to understand what is going on. 
Depending on how much effort you want to invest in making this spreadsheet more efficient to navigate and easier to understand, several tools discussed earlier in this chapter can be quite helpful. They are recapped below.
· Navigating with Control and the four arrow keys: In a large spreadsheet with lots of empty cells, this is your “best friend” for quick navigation. These key combinations will leapfrog you over groups of empty cells, as well as over continuous ranges of cells filled with data. Control and Down arrow together is especially useful for moving down the first few columns of this spreadsheet because there are so many empty cells. Down arrowing cell by cell would be Slow and frustrating. 
· If the spreadsheet author has enabled Freeze panes, there are pros and cons related to disabling them. Unless you have some usable vision, freezing panes may be of limited value to you. If you want to be able to press Control Home to get to cell A1, which could make navigating this spreadsheet more straightforward in some cases, disable Freeze panes by pressing Alt W F and unchecking it here. That said, the most logical place for the spreadsheet author to set Freeze panes is the cell containing the top left cell with data values, situated just to the right of its corresponding row header, and just below its corresponding column header. If this is indeed the case, keeping Freeze panes enabled and pressing Control Home will quickly get you to that top left data cell. 
· Hiding columns: Because this is a spreadsheet that is presumably updated and distributed on a monthly basis, you might only be interested in examining financial data for the most recent month. But because the author has inserted empty columns between each data column, navigating to the far right side of the spreadsheet is tedious. To render this more efficient, you can hide the columns not of immediate interest to you. That way, it will be much quicker to get to the columns that you want to examine. In this spreadsheet, you may only be interested in viewing the February 2020 and totals columns (columns Q and S). If so, you can hide columns C through P. See Chapter 5.9.1 on how to do this. 
· Assigning monitor cells with JAWS: You might find that certain cells are especially important. For example, cells S33, S130, and S132 present totals for income, expenses, and net income, respectively. Assigning monitor cells to each of these will enable you to navigate to them quickly. See Chapter 5.9.4 about how to assign monitor cells with JAWS and navigate to them. 
Adding comments: If you assign monitor cells to each of the three cells just mentioned, this is useful for navigation purposes, but you may not remember what the data in these cells refer to. You can add comments to each of them to remind you (Chapter 5.9.2).
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PowerPoint enables you to produce slide show presentations for target audiences. It has become ubiquitous at conferences and workshops. It is often simply expected that speakers will be providing a PowerPoint presentation to participants. Students are also often required to prepare PowerPoints for class projects. 
I will begin with a short section on how to read an existing PowerPoint presentation. Even if you are not interested in learning how to produce a presentation, read this section if you don’t know the keystrokes for reading presentations. They are not intuitive. And even though you may not plan on producing PowerPoint presentations yourself, you will almost certainly receive presentations from others and will want to know how to read them. I will then go through the steps of preparing a presentation and then discuss formatting considerations. 
6.1 Reading a Presentation
When you open an existing presentation, you land in a list of slides called the Normal view. Press Page down once to move to the second slide. Your screen reader will tell you the title of that slide and say, “2 of 22,” indicating that you have landed on the second slide in a presentation with a total of 22 slides, or whatever the total number might be. Continue pressing Page down to hear more titles. You can press the home and end keys to get to the first and last slides in the presentation, respectively. 
To read the full presentation, press the F5 key to open the Slide show view. Regardless of where your cursor is in the list of slides, pressing F5 will always open the Slide Show on the first slide. The entire text of the first slide should then be read to you. 
Sometimes when you open the Slide show view, a glitch occurs. Your screen reader does not automatically read the first slide. You can use standard reading keystrokes to read the text here. 
Now press the Spacebar to go to the second slide and have it read to you. Note that the misbehavior mentioned above only occurs with the first slide. 
To go back a slide and have it read to you, press the Backspace key. 
Within any slide, you can use standard reading keystrokes to read the text:
· Right/Left arrow: Move to and read characters to the right and left.
· Control Right/Left arrow: Move to and read words to the right and left.
· Down/Up arrow: Move to and read line below and above.
· Insert Down arrow: JAWS and Narrator Say all command or continuous reading from the point of the cursor. 
· Insert A: NVDA Say all command or continuous reading from the cursor. 
Note that these keys work only within an individual slide. If you press your screen reader’s Say all key, it will read to the bottom of that slide and stop. 
When finished reading the presentation, press Escape to exit the Slide show view and return to the Normal view.
If your cursor is somewhere in the middle of the list of slides (say, the seventh slide), and you would like to get back into Slide show view from that point, rather than pressing F5, which always begins reading on the first slide, press Shift F5 and the Slide show view will open at that point. As above, press Spacebar and backspace to go forward and backwards one slide, respectively. 
To summarize, the keystrokes you need to know are:
· F5: Open the Slide show view to the first slide and read it.
· Spacebar: Go to the next slide and read it.
· Backspace: Go to the previous slide and read it.
· Shift F5: Open the Slide show view beginning with the currently selected slide.
· Escape: Exit the Slide show view.
6.2 Creating Slides in the Slide Area Pane
Individual slides are created and edited in the Slide area pane. Similar to a window on a house, a pane is a section of a window. The PowerPoint screen is partitioned into six panes. Move between them by pressing F6 and Shift F6. 
With your current focus in the Slide area pane, press F6 to move between the following panes: the Status bar, the Toolbar, the Upper ribbon, the Slide Thumbnails pane, and wrap back to the Slide area pane. For the moment, the Slide Notes pane does not appear. The Slide thumbnails and Slide Notes panes will be discussed later in this chapter. 
It can be confusing to follow instructions in the abstract. I suggest that you read through each section here and then use the information to prepare a presentation. Appendix III includes a step-by-step exercise that you can use for preparing a sample presentation. 
6.2.1 The Title Slide
When you open PowerPoint, by default you land on a blank title slide. This will be the first slide of your presentation. There are two fields you can fill in: a title and sub-title field. You move between these fields by pressing the tab key. Press tab once and your screen reader will say “title placeholder.” Press tab again and it will say “subtitle placeholder.” Press Tab a third time and you will wrap back around to the Title placeholder. 
You hear the term “placeholder” a lot with PowerPoint. A placeholder is, well, a place that holds something. That “something” could be text, a graphic, or a media icon for an audio or video clip. 
Insert text by tabbing to a placeholder and pressing Enter. After inserting your text, press Escape to exit edit mode. 
When you are in the Placeholder edit field, only press enter or tab if you want to add a new line or insert a tab in that placeholder. Initially, pressing escape may be counter-intuitive as a way to lock text into a placeholder, but you may eventually get used to the rhythm of tab, enter, escape, tab, enter, and escape. 
As you navigate through the slide area, you will hear what type of placeholder you are on. The types and number of placeholders depend on the slide type you are using. I will discuss the various slide types later. For the moment, we’ll stick with the Title slide.
As you heard while tabbing around, a title slide has two placeholders: a title placeholder and a subtitle placeholder. To prepare a title slide: 
1. Open PowerPoint and press Escape to get out of the Backstage view. You first hear “No selection. To select an object press Tab.”
2. Tab to the Title placeholder and press enter. This opens an edit field. 
3. Type in the title of your presentation. You should keep it short because the font size in the final presentation will be quite large.
4. Press Escape. 
5. Tab to the Subtitle placeholder and press Enter.
6. Type in typical subtitle content like your name, organization, and/or presentation date. Press Enter after each of these to place them on their own line. Here too, keep the amount of text limited.
7. Press Escape to exit the Subtitle placeholder. 
It is good practice to detect any errors and correct them before continuing to the next slide. Tab a couple of times to hear your title and subtitle again. To edit any placeholder text, tab to it, press Enter, and revise text within the placeholder using standard editing keystrokes, press Escape when done to exit edit mode. 
6.2.2 Other Slide Layout Types 
You have now created your title slide and it’s time to start in on slide 2. PowerPoint has a gallery of slide layout types that can be accessed via the ribbon menus, using the Applications key or using the shortcut key (Alt H I). We’ll first go there via the ribbons:
1. Press alt to open the ribbon menus, press tab several times to the New Slide split button.
2. Press alt and Down arrow to expand the options.
3. This opens a set of buttons that you can arrow through. Slide types include: title, one content, two content, comparison, title only, content with caption, and picture with caption. 
4. Press Enter or the Spacebar on your layout choice for the next slide.
To get to the same place using the Applications key, press the Applications key, Down arrow to the Layout submenu and press enter. This opens the same array of slide type choices.
Finally, the ribbon sequence of Alt H I also gets you into the choice of slide types.
Here’s an explanation of the nine built-in slide layout types: 
· Title: Discussed above.
· Title and content: Title and single object placeholder for a total of two placeholders. Text entered on each line of the object placeholder will automatically be bulleted. 
· Section header: Title and single object placeholder for a total of two placeholders. Text entered on each line of the object placeholder will not be bulleted. 
· Title and two content: Title and two object placeholders on left and right for a total of three placeholders.
· Comparison: Title and a body and object placeholder on the left, and a body and object placeholder on the right for a total of five placeholders. 
· Title only: Title placeholder at top center only. 
· Blank: No placeholders.
· Content with caption: A title, object and body placeholder. The body placeholder appears under the object placeholder. 
· Picture with caption: A title, and body placeholder. The body placeholder appears under the placeholder. It is not possible to enter text in the placeholder – only graphics or audio/video icons can be inserted.
Use the comparison slide layout for juxtaposing good and bad, pros and cons, old an new, etc. However, keep in mind that, with five placeholders, a comparison slide can quickly get cluttered and may be difficult to manage from a non-visual perspective. It might be better to split the information between two slides, the first one covering the good, pros, old, etc., and the second one covering the bad, cons, new, etc.
When you add a new slide, the first time you press the Tab key, focus will land on the Title placeholder. For two content and comparison slides, tabbing between placeholders proceeds in a counter-clockwise direction from the Title placeholder, and wraps back around to it. For any of the other slide types with two or more placeholders, tabbing proceeds vertically downwards from the Title placeholder, and also wraps back around to it. 
Several ways to create a new slide were laid out above. There is a fourth way using Control M. If you press Control M after preparing the Title slide, a Title and Content slide will appear. Pressing Control M after any of the other slide layout types listed above will insert a new slide of that same type. For example, if you have just prepared a Comparison slide and press Control M, a new blank Comparison slide will appear. 
To prepare a second slide, using the Title and Content slide type and the Ribbon shortcut key combination. 
1. Press Alt H I to get into the New slide gallery.
2. Right arrow once to the Title and content button and press Enter.
3. Tab once to the Title placeholder, press enter to get in edit mode, and type in the title for your second slide. 
4. Press escape, tab to the object placeholder, and press enter.
5. Type in text for your first talking point, and press Enter to go to the next line.
6. Type in text for your second talking point, and press Enter to go to the next line.
7. Repeat the above steps to input your remaining talking points.
8. When finished, press Escape to exit the placeholder.
Note that bullet points have automatically been added. This is the case for all object placeholders. For body placeholders, you can enter text, but bullets are not automatically added. 
Now you can continue to add new slides, either pressing Control M to add a new slide of the same type you have just used, or pressing Alt H I or the Applications key, and arrowing to a different slide layout type and pressing enter or Spacebar to add it. 
6.2.3 Inserting Pictures and Alt Text
As they say, “A picture is worth a thousand words.” A presentation with only text is boring. Add pictures and other types of graphics to enhance the visual appeal of your presentation. Graphics should reenforce the message of your content. They should not be superfluous eye candy or gimmicky distractions. 
Pictures can be obtained from several sources: 
· Files saved on your PC, usually in JPG (often called “J peg”) or PNG file format.
· Searching for them online via the PowerPoint menus.
· Reputable websites with collections of images. These sites have free public domain images, images you have to pay for, and both. Unfortunately, very few of these sites are accessible.
· Copying images off of websites. Be sure you are not violating any copyright laws before using these images. 
I will only cover using files already loaded onto your computer. Online searches are not very accessible, and I have not yet discovered an accessible site for downloading images. 
You can easily copy and paste files already stored on your computer. To do this:
1. Select the image file on your computer.
2. Press Control C to copy it. 
3. Alt Tab to PowerPoint where you have already opened a new slide and Tab to the object placeholder where you want to insert the image. It is not necessary to press Enter to open the placeholder. 
4. Press Control V to paste the picture into the placeholder. 
The picture now appears visually, and it is sized down from its original dimensions to fit into the placeholder. However, with some versions of PowerPoint other than the 365 licensed version, the blind screen reader user receives no audio feedback. With PowerPoint 365, text is automatically generated using artificial intelligence (AI). Yet this text is very generic and rarely helpful. For example, “when I inserted the iconic photo of Boston Bruins star Bobby Orr flying through the air after scoring the winning goal of the 1970 Stanley Cup finals, the AI-generated alt text was, “A picture containing outdoor, feet.” 
So, even if AI-generated alt text is automatically inserted, you will usually want to replace it with your own alt text to succinctly describe image content. Steps for doing this are: 
1. With your focus on the placeholder where you have pasted the picture, press the Applications key, Up arrow to Edit alt text, and press Enter. Your screen reader will say “description edit.” It may or may not also speak any AI-generated text. 
2. If AI-generated text is present, press Control A to select it all before typing in your replacement text over it.
3. Type a short description of the picture.
4. Press the Escape key when you are finished. Your new alt text should now be spoken by your screen reader program. 
If, during the same session, you repeat the steps above to add alt text to a second image, you will run into a minor glitch. You will not be able to access the Description edit field mentioned above. There are two ways to remedy this. You can save your work, exit PowerPoint, and reopen your presentation. The steps above will work properly. 
Alternatively, while in the same session, and with your focus on the placeholder where you have pasted the second picture, press F6 until you hear Description edit. Now type in your alt text and press the Escape key. Note that, with PowerPoint 365, when you press F6, you may hear “turn off design ideas for this session link.” If you do, press the Spacebar to disable this, and then press F6 until you return to the same place. This time around, it will say “Description edit.”
To delete a picture from your presentation, Tab to the placeholder containing it and press the Delete key to remove it. No confirmation is requested. 
After inserting a picture, run the slide show and get confirmation from a sighted person that it is properly sized. It usually will be, but in case it is not, you can change its dimensions. Steps are:
1. Tab to the object placeholder where the picture is located to place focus on it.
2. Press the Applications key, Up arrow to Size and position, and press Enter.
3. Tab to either the Height or Width edit spin box. The current height and width of the image appears in inches. 
4. You can adjust either of these by up or Down arrowing to another value, or by typing in a new value. If you change the height, the width will automatically adjust, and vice versa. This ensures that the picture does not get distorted.
5. Tab to the Lock adjust ratio checkbox and be sure it is checked. This setting prevents distortion. 
6. Tab to the OK button and press Enter.
7. Once again, get sighted confirmation that the picture is correctly sized in the Slide show view.
[bookmark: _Hlk54269226]6.2.4 Inserting Audio and Video Clips
It is easy to insert short audio and video clips into a presentation. Common audio file types areMP3 and WAV. Common video file types include MP4 and WMV. 
For files on your computer, follow the same steps outlined above for selecting, copying, and pasting pictures. After inserting these clips, the audio feedback you receive will differ depending on your version of PowerPoint. With my 365 version, when I Tab to the placeholder where I have inserted the clip, my screen reader says “audio” and “video” for these file types. For earlier versions of PowerPoint or your screen reader, your screen reader may say “media” for both file types. 
If you want to hear your clip while in the Slide area pane, with your focus on the placeholder with the clip, press Alt P to play and pause it, and Alt Q to restart it. 
Let’s say you have added your audio or video clip to a title and content slide. During the slide show, when you press the Spacebar to open the slide containing an audio or video clip, by default, your screen reader first says the title of the slide, as well as any other text inserted in placeholders before the audio or video in a counter-clockwise direction. Pressing the Spacebar a second time then plays the audio or video clip. You can press the Spacebar again if you want to stop it from playing before it ends. 
It is possible to start playing the clip immediately upon opening a slide without having to press the Spacebar a second time. To do this:
1. Place your cursor on the placeholder containing the audio or video clip.
2. Press Alt to open the Upper ribbon and Right arrow to the Playback tab. This tab only appears if your cursor focus is on the placeholder containing the media file. 
3. Tab several times into the Lower ribbon to the Start combo box, and press Alt Down arrow to expand it. 
4. Down arrow to the Automatically button and press Enter. 
Now when you press the Spacebar to open this slide in the slide show, instead of hearing the title first, your clip immediately starts playing. 
To delete an audio or video clip, as with pictures, Tab to the placeholder containing it and press the Delete key to remove it. 
6.3 Slide Thumbnails Pane
Each slide is prepared and edited in the Slide area pane. In the Slide Thumbnails pane, you can delete, copy, and move slides that you have already created. 
The Slide area and Slide Thumbnails panes are adjacent, so you can move back and forth between them by pressing F6 and Shift F6.
In the Slide Thumbnails pane, down and Up arrow through your slides. You will hear the title of each slide. Using standard windows keystrokes, it is easy to edit the presentation. 
To Delete a slide, after up or Down arrowing to it, press the Delete key. No confirmation is requested. The slide simply disappears. 
To move a slide elsewhere in the presentation order:
1. Up or Down arrow to the slide to select it. 
2. Press Control X to cut it to the Clipboard. 
3. Up or Down arrow to the slide you would like to place it after.
4. Press Control V to paste it.
To make a copy of a slide and place it somewhere else in the presentation order, repeat the steps above, just pressing Control C rather than Control X in the second step to copy the slide to the Clipboard.
There are several reasons why you might want to delete or move slides. After you have concentrated your efforts on creating your slides, you may think a different order is more logical or makes the presentation flow better. You may need to delete some slides because of time limits placed on your presentation by meeting organizers.
If you will be making repeated presentations on a particular topic to a variety of audiences in the future, you may create a master presentation with a lot of slides. You can then use the Slide Thumbnails pane to create different versions of your presentation, tailoring them to different audiences and time limits for the meetings where you will be speaking. If you create a new presentation based on slides from a master presentation, be sure to save the new presentation with a different filename. 
6.4 Slide Notes Pane
You can add notes to provide more details to your presentation. These notes can serve as reminders of the things you want to say during your talk. Because they are included in the PowerPoint file, they can be sent to meeting participants so they have them for future reference. They can also be printed out for hard copy distribution. 
Visually, the Slide Notes pane appears directly below the Slide area pane as a large edit box. Slide notes are not visible to audiences while presentations are being given. 
The Slide Notes pane does not initially appear when you cycle through the panes with the F6 key. To make it appear, press F6 until you hear Toolbar Spellcheck. Tab once to the Slide notes button and press Enter or the Spacebar. Continue pressing F6 to get to the Slide Notes pane. It is one pane before the Slide Thumbnails pane. Once again, the pane order is Slide notes, Slide thumbnails, and Slide area. Any notes you add should be associated with individual slides. To add notes:
1. After making the Slide Notes pane appear, press F6 until you get to the Slide Thumbnails pane.
2. Up or Down arrow to the slide for which you want to create notes.
3. Press Shift F6 to go to the associated edit field in the Slide Notes pane.
4. Type in your notes. However, keep in mind that it is easier to type them first in Word and copy and paste them here, rather than typing them in directly. This is because editing and spellchecking within the Slide Notes pane works poorly.
5. When finished, press F6 once to return to the Slide Thumbnails pane, arrow down to the next slide for which you want to add notes, and repeat the steps above. 
If you want your screen reader to read the notes for a given slide while in the Slide show view, press Control Shift N. After reading the notes, press Control Shift N again to return to the slide show.
6.5 Formatting Considerations 
6.5.1 Themes
A theme provides a consistent format for the background pattern, font style, point size and color, as well as the bullet shape, color, and size, of all your slides. Themes can be applied at any time in the process of creating your presentation. The default theme is called “Office.” It is simply black text on a white background – very plain and boring. 
Most of the time, you will probably want to change it to something more colorful. Changing the theme is easy, but there is one big problem. The names of the themes are completely non-descript. Facet, gallery and integral are typical examples. Consequently, independently making an informed choice is inaccessible. Therefore, you will need sighted assistance to choose a theme. Also keep in mind that some themes have font styles and colors that may be easier, or more difficult, for someone with low vision or color blindness to read. Avoid choosing such themes. 
It would be desirable for Microsoft to provide short descriptions of the themes somewhere. Unfortunately, I have never found any. Later in this section, I will provide descriptions of themes you may want to choose. I will also identify themes to avoid.
To change from the Office default theme to another one:
1. Press the Alt key and Right arrow to the Design tab.
2. Tab once into the Lower ribbon to the Themes submenu and press Enter. This opens a grid palette with small pictures of the theme background patterns and font colors visible to sighted users. The first time you come here, you will hear “Office theme selected,” indicating this to be your current theme. 
3. Use the four arrow keys to move around in the palette grid and press Enter or the Spacebar on your choice.
Your entire slide show will now appear using this theme. You can change it to a different theme at any time. The next time you open the Themes submenu, your current theme will be indicated.
Many organizations have created their own theme templates in order to ensure consistent branding for its presentations. If you are preparing a presentation for your organization, be sure to check if a company template already exists. If so, it may be the policy of your organization to use that theme.
You should use font colors that clearly contrast with your background, such as dark against a light background or light against a dark background. Use a solid background color rather than a multi-colored pattern for easier readability. 
Below are descriptions of several themes which provide adequate color contrast between foreground text and background patterns, and may be acceptable to use from an accessibility standpoint:
· Organic: The slide background resembles a light fine-grained wooden board. Title and subtitle placeholders are on top of a white square with a thin green inside border. The text is dark grey. A horizontal green line provides visual separation between the placeholders. The text color and horizontal line are similar for other slide types. A brown ribbon extends from either side of the Title placeholder and appears to wrap around the wooden board. Other slides have a thin, light wooden border around the entire slide. The remaining background is white with a thin, green inside border. Bullets are solid green and round. 
· Parallax: The Title slide has a light gray background which is slightly darker on the left and right, and becomes lighter towards the middle. Two blue and darker gray strips start near the upper left side of the slide. They get a bit thicker and curve slightly to the right as they descend towards just above the middle center of the slide. This provides a subtle three-dimensional effect as slide content seems to come closer. The background pattern is similar for other slide types, but with the blue and gray curving strips descending further down the slide as they curve towards the center. Placeholder text is black providing adequate contrast against the light gray background. Bullets are solid, round, and filled with the same blue as the blue strip in the background.
· Slate: The slide background is a rough textured black pattern resembling tile or slate roof shingles. Placeholder text is white. Bullets are white diamonds. White on black provides a good color contrast. 
· Vapor trail: The Title slide has a black background with multi-color ribbons or “vapors” swirling around on top of the black. Shades of a red and orange ribbon tinged with black swoop upwards towards the middle top of the slide. Green and blue ribbons appear at the top right. Swirling red ribbons appear on the lower left side, morphing to green and blue as one moves across to the right. Title and subtitle placeholder text is white on a black background with clear contrast. Other slide types contain the same design along the top, but solid black further down the slide. Placeholder text is white. Object placeholder bullets are solid white circles. 
· Wood type: The Title slide has a white background. The Title placeholder has its own background pattern - gray mottled with fine white dots. Text is black with small white flecks. The Subtitle placeholder text is solid black. To the right and slightly above the Subtitle placeholder, is a red circle with small white flecks, as well as a single white line crossing it. Other slides have a similar pattern as the Title slide, but the red circle is smaller and the Title placeholder background is white. Object placeholder bullets are solid red squares. 
Avoid the following themes due to poor color contrast: facet, slice, banded, basis, circuit, frame, metropolitan, parcel, and quotable.
6.5.2 Background Colors
To apply a solid color background rather than a theme, do the following:
1. [bookmark: _Hlk55040606]While in the Slide area pane, press Escape to be sure you have not selected a placeholder. If you up and Down arrow, you should hear “no selection.”
2. Open the Upper ribbon and arrow to the Design tab.
3. Tab to the Format background button and press Enter (shortcut: Alt G F).
4. A color palette opens where you can arrow among different colors and shades of those colors. Press Enter or the Spacebar on your choice. To ensure correct color contrast, choose a light background color if you are using a dark font color for the foreground, or vice versa.
5. Tab to the Apply to all button and press Enter to apply this background color to the entire presentation.
If you wish to alter the background color during the same session, you will need to press F6 a couple of times to get back to these settings. Doing this through the Design tab will not work. If you save your presentation, exit out of it, and reopen it, you can apply a new color through the ribbons. 
6.5.3 Changing Font Color
If you decide to change the background color instead of using themes, you will also want to change the font color. The default font color is black. You would not want to leave it this way if you made the background color blue. Change the font color only after you have prepared all your slides because the directions below only change font color for previously-created slides, not any subsequent ones. Steps are:
1. Navigate to the View tab in the Upper ribbon.
2. Tab to the Outline view and press Enter.
3. Press F6 until you get to the Outline Tab. This replaces the Slide Thumbnails pane when you switch to Outline view.
4. Press Control A to select all.
5. Go to the Home tab of the ribbon. Tab into the Lower ribbon to the Font color split button, and press Alt Down arrow to expand it.
6. This opens a color palette where you can use the four arrows to navigate through the choices. Similar to the background colors, they are organized in different shades.
7. Press Enter on your choice.
8. To verify that your color change took effect, press F6 to go to the Slide area pane, Tab to one of the placeholders to give it focus.
9. Press Insert F to check formatting. Your new color should be identified. 
10. Down arrow to several other slides and repeat the above two steps to check that the color has changed elsewhere in the presentation.
6.5.4 Transitions
Slide transitions are visual effects and sounds that affect the slide as a whole when you move from one slide to the next when in Slide show view. By default, slides silently appear as you move from one slide to the next during a slide show. Different visual and auditory effects can be introduced. However, be careful about using these. Anything too flashy or dramatic can seem gimmicky, diverting audience attention away from the actual content of your presentation. Overdoing it can even annoy audience members, so use transitions sparingly. 
I will first cover visual transitions. You can apply transitions to individual slides, as well as to all of them. To apply a transition to an individual slide:
1. In either the Slide area or Slide Thumbnails pane, navigate to the slide for which you want to set a transition. This will be the transition for when that slide opens during a slide show.
2. Press the Alt key to open the Upper ribbon and Right arrow to the Transitions tab.
3. Tab into the Lower ribbon to the Transition effects submenu and press Enter. This opens a grid. Use the four arrow keys to move around. Press the Spacebar on your choice.
As with themes, many of the transition names (morph, push, reveal, etc.) give you no idea about what they actually do. Other names (fade, blinds, dissolve) may give you some notion. Here too, you will need sighted assistance to describe the effect. As mentioned above, use them sparingly, if at all. My own personal inclination is to not use them, or only use very subtle ones.
Once you have applied a transition to a single slide as described above, you can apply that same transition to all slides in your presentation. With your focus on that same slide, in the Transitions tab, tab to the Apply to all button and press Enter or the Spacebar. 
To apply a sound transition to a single slide:
1. In either the Slide area or Slide Thumbnails pane, navigate to the slide for which you want to set a transition. This will be the sound you hear when that slide opens during the slide show.
2. Press the Alt key to open the Upper ribbon and Right arrow to the Transitions tab.
3. Tab into the Lower ribbon until you hear Timing sound combo box. Press Enter to open it. 
4. Down arrow through the choices and press Enter on your choice.
Among the choices are applause, arrow, bomb, click and cash register. There are numerous others. Once again, use these sparingly. You might use cash register a single time to inject a little humor into your presentation on a slide related to money, but once is plenty. 
As with visual transitions, you can apply sound transitions to all slides. The only one I use is the click sound because it is very subtle and has a practical use. It will give you a little more auditory confirmation when you are moving from slide to slide. Otherwise, exercise caution when applying sounds to all slides because any of the more noticeable sound transitions may distract or annoy your audience. 
Animations are another commonly used visual effect. These allow individual bullet points to fly into object placeholders during slide shows, Many sighted PowerPoint users like using these because it makes participants focus their attention on just one bullet at a time, rather than wander elsewhere on the slide. Animations could also be useful for non-visual presenters because they could hear just one bullet point at a time, rather than hearing the entire text of a slide all at once. Unfortunately, as of the writing of this book, they were not accessible with screen readers. Although creating animations is fully accessible, during a slide show, screen readers still read entire slides rather than one bullet at a time. Hopefully, this accessibility problem will be fixed in the future. 
6.6 Practical Tips for Creating and Delivering Presentations
Especially when new to PowerPoint, thinking about presentation content, slide type choice, moving around between placeholders and editing text, and manipulating the awkward JAWS spellcheck workaround (See Chapter 9.1.3) can be too much to juggle all at once. Consequently, you may prefer to create content in Word, edit it and spellcheck it there, and then copy and paste the text into PowerPoint. That way, you can initially focus on preparing your text in a more familiar typing and editing environment. To make it easy to navigate through your slides, as well as keep track of how many you have, think about marking up each slide title with headings in Word. Don’t bullet text in Word because this will be done automatically when you copy the text from Word and paste it into PowerPoint object placeholders. 
While in Word, don’t worry too much about the final order of the slides in your presentation. Reordering is easy to do in the Slide Thumbnails pane. 
Limit each slide to just a few bullet points. Do not write full sentences because this may tempt you to read them out loud word-for-word. Excessive text is the most common symptom of a poor PowerPoint presentation. It indicates that the speaker is a PowerPoint amateur, lacks confidence in his or her grasp of the material, that he or she has weak presentation skills, or some combination of all of these. And if you type in too much text, font size automatically gets smaller, even to the point of making it extremely difficult for sighted observers to read from the back of a room. 
All slide titles should be written in title case. The first letter of the first word of each bullet point should be capitalized, but no other words should start with a capital letter, unless of course other words are proper nouns or acronyms.
Here’s a piece of advice that is so obvious that you may wonder why I even mention it. Be 100 percent sure that all your text is spelled correctly. The sad fact is that I have seen presentations sprinkled with incorrect spelling. The presenter is broadcasting in big bold fonts to a large audience his or her lack of professionalism. 
While most of the steps for preparing PowerPoints are fully accessible, ask a sighted colleague to review the visual appearance of your slide show to be sure that:
· Text and images are large enough to be seen from the back of a meeting room.
· Color contrast between the foreground text and the background pattern is crisp and clear.
· Font style, color and size are consistent.
· Placeholders are not overlapping.
· Graphics such as imported photos are properly sized, correctly oriented, and are crisp and clear. If instead, they are fuzzy, this is probably because of insufficient pixelation. If this is the case, replace them because they will not look good when projected on a large screen. 
· Visual slide transitions are not distracting.
Practice your delivery several times in private. Better yet, also do a dry run in front of trusted colleagues. These are the best ways to ensure that you respect the time limits imposed by meeting organizers. It will also help you to avoid needless meandering and repetition. 
So, you have finalized your presentation and it is now time to deliver it to a real live audience. If you are doing this face-to-face in a physical location, be sure to get there early enough to test out the technology you will be using to give your talk. If you are delivering it on your own laptop, take time with meeting organizers to hook up your laptop to the projection screen. Ask ahead of time about what connector cable type you will need to connect your laptop to the projector or monitor where you will be displaying your slides. Test out any microphones and speakers you will be using to ensure that the audio works properly. Give yourself ample time to do this because if there are any unforeseen glitches, the last thing you want to do is start delivering your presentation to a live audience before you have recovered your composure. 
If delivering your presentation remotely via a platform like Zoom Cloud Meeting, here too, join the meeting ahead of time and test with the meeting host that screen sharing is working properly. Usually, you will only want to share the visual screen and not audio. You don’t want your screen reader rattling off all your bulleted text each time you open a new slide. One nice thing about Zoom is that if you only share your visual screen while wearing headphones, you can hear your screen reader speak the text of your slide show, but your audience will not. Of course, if some audience members are blind or visually-impaired, take time to adequately explain your text to them and describe any graphics where you have added alt text. Email them your presentation prior to the meeting, or shortly afterwards.
If you are delivering your slide show face-to-face from your laptop, turn down the computer volume to the lowest level where you can still hear the audio clearly, but others can not. If you are positioned at a podium or a head table, chances are you will be far enough apart from your audience so they will hear little or none of your screen reader speech. Alternatively, you can wear a small single earphone. That way, you can hear your slide show with one ear and audience reaction with the other one. Finally, if you are a fluent Braille reader, you can print out your text on an embosser and silently refer back to it while speaking, or use an electronic braille notetaker.
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This chapter reviews keystrokes for reading web page content with the three screen readers. Many of the keystrokes are the same. If you are already comfortable with one screen reader, you can pick up the basics of another one fairly quickly. The chapter also identifies general strategies for effective web navigation. Browser programs covered are Google Chrome, Microsoft Edge, and Mozilla Firefox. 
Much of this chapter’s content is drawn from my book entitled “When One Web Browser Is Not Enough: A Guide for Windows Screen Reader Users,” which came out in August 2020. It covers more topics related to web browsing than are contained in this chapter. I hope to eventually update it because, as of the release of this book about a year and a half later, a number of techniques and processes described in the book were no longer valid. Unlike most other applications covered in this book, procedures for executing commands and adjusting settings frequently change for the various web browser applications. Therefore, please keep in mind that things may have changed between the time this chapter was finalized in December 2021 and when you get around to reading it.
7.1 The Most Important Keystrokes for Web Navigation
The first thing to say about navigating the web with a screen reader program is that there is good news and bad news. The good news: if you can master about a dozen keystrokes, you are well on your way to being able to effectively navigate the web with all three browsers. The bad news: every website is different. No matter how proficient you get with these and other keystroke combinations, some sites may be difficult or impossible to navigate because the web developer did not adequately take accessibility into account when designing the site. Another possibility is that sites were developed and tested using one or two browsers and not the others, leading to variations in accessibility. 
Whatever the reason, there will be times when a site is more accessible using one browser, and less accessible using another. When you encounter a roadblock with one browser, your first trouble shooting strategy should be to try another one. This is the most important reason for being comfortable using multiple browsers. A second strategy to try when running into roadblocks is to switch screen readers. Trying various combinations of browsers and screen readers increases your chances of getting the information you want from finicky websites. 
Because every website is different, consider the various keystrokes enumerated in this section as a set of tools to be used flexibly. If one keystroke doesn’t do the job, reach into your tool bag and try another one. 
For screen reader users, it often appears that web pages are cluttered with lots of extraneous stuff: ads, decorative graphics, and social media links that just get in your way. Your goal should be to quickly jump over the clutter in order to zero in on meaningful content. Screen reader programs have an array of keystrokes that help you accomplish this. Fortunately, many of these keystrokes are the same for JAWS, NVDA, and Narrator. There are also a number of Windows keystrokes that are universal across all browsers.
Real estate agents stress the importance of “location, location, location.” To become an effective web surfer, “listen, listen, listen!” When exploring websites, constantly ask yourself questions like: Was that a heading? Which level was it? Was that a button? If so, can I Press B for button to get there faster next time? What was the first letter of that link? If I bring up the Links list, will first lettering to it be the fastest way to get there? Is that the only edit box or combo box on the page? If so, can I just Press E or C from anywhere on the page to quickly jump there? While this may sound like audio overload, you can train your ears so that effective listening becomes second nature. Moving around web pages will become less frustrating and more fun.
Now let’s talk about how you might go about exploring an unfamiliar website to get a broad sense of what information is available on the site and how you might quickly find content. First, how do you get to a new website? If you open a browser, and do not land on a web page, you can immediately type in the site address and press Enter. If you first land on a web page, press Alt D or F6 in any browser to access the Address Bar, type in the web address, and press Enter. See Chapter 7.6 below for more details about opening web pages. 
When I go to a website for the first time, I want to know right off the bat how many headings and links are on the page. Your screen reader will often tell you this information when you open the page, but not always. A lot of accompanying noise is also present so you may not catch this information. 
JAWS and Narrator can both give summary information with a single keystroke. With JAWS, from the top of the page, press Insert F1 to open JAWS Screen-Sensitive Help. You will hear the number of links and headings on the page. After hearing this information, press Escape to exit the virtual viewer and return to the web page.
With Narrator, press Insert S for a similar summary. With Narrator, you can also press Insert plus S twice quickly to get the following info: the number of links, landmarks, and headings on a page, and a list of popular links for a page, these being links on the page that get the most traffic. The Popular links feature is unique to Narrator. 
With JAWS and Narrator, you can also press Insert F6 and Insert F7 to get lists of headings and links, respectively. Both will tell you how many of each are on the page. 
NVDA does not have separate keystrokes for accessing lists of headings and links. All are found in the Elements list dialog. Lists of form fields and buttons are also found here. To access the Elements list dialog, do the following:
1. Press Insert F7 to land in the Elements list dialog. This puts you in a tree view of one of these element types, although it may not initially be apparent which type is being listed.
2. Press Shift Tab once to go to a set of radio buttons with types of elements. Use the Up and Down arrow keys to go to the Headings radio button.
3. Press Tab once to go to the Headings tree view. Unfortunately, what you hear is confusing because NVDA presents the information in a tree view rather than in a simple list view. Tree views are organized in levels different than those of headings. For level one headings, NVDA will say “level zero” because it is identifying its level in the tree view hierarchy rather than its level in the headings hierarchy. Level one in the tree view hierarchy means it is a level two heading, and so on. 
4. Shift Tab once again and arrow up or down to the Links Radio button. 
5. Tab once and the Links tree view now appears. 
6. Press escape to exit the Elements list dialog. 
Why is this information useful? Headings are the screen reader user’s “best friend” for web navigation. When properly incorporated by web developers, headings and their hierarchy mark up web pages similar to how an outline logically organizes the sections of a book or an essay. Navigating by heading can help you get a general sense of what is on a web page, as well as aiding in quickly zeroing in on the content you want to access. I want to know how many headings are on the page to determine whether moving by heading is likely to be a viable navigation strategy. If I hear that there is only one heading on the page, or there are none (which occasionally happens), I will need to find another navigation strategy. If I hear that there are 40 or 50 headings, that too may be a problem because too many may hinder efficient navigation. I find that somewhere in the range of five to 15 headings is best – not too many, not too few.
Hearing the number of links gives a rough indication about how “busy” the page is. Pages like the New York Times home page can have 350 to 800 links on any given day. If you hear numbers like these, you can probably assume that there will be lots of clutter, thus making navigation more challenging than on pages with fewer links. 
7.1.1 Headings 
Once you have determined that heading navigation might help you out, press H to go to the next heading and Shift H to go to the previous one. If you navigate through all the headings on a page, this can give you a quick general idea of what information may be accessed on that page. If you Down arrow to read by line under the heading, you may hear a sentence or two expanding a bit on what the heading is all about. A well -designed page will have consistent information under each heading. As you move through the headings, you may hear that some of them are also links, indicating that you can press Enter to open another page on the site. Press Enter on one of these links to open a new page. At this point, heading levels may come into play to help you quickly find content. Web pages can have up to six heading levels. Navigate levels by pressing the heading level number key on the number row of your keyboard. Press one on the number row for level one headings, two for level two headings, and so on. 
On well-designed websites, navigating to a level one heading immediately brings you to that page’s main content: for example, the headline of a news article. If you discover that navigating to a level one heading works on one page, it will usually work on that site’s other pages too.
7.1.2 Links
As mentioned above, access the JAWS and Narrator Links lists by pressing Insert F7, or via the NVDA Elements list dialog. 
On many websites, links to the most important pages tend to be clustered higher in the list. If you are exploring a site for the first time, after going through the headings on the home page, Down arrowing through the first 15 or 20 links in the Links list may be a good way to get a sense of the most important pages on the site. Web developers often build these in as main or secondary navigation regions which appear on every page of the site (see Chapter 7.2.1 below for more on regions). For example, on many college websites, links you often find near the top of the list include admissions, registration, academic calendar, financial aid, faculty directory, and course catalog. 
Webpages also usually have a footer region at the bottom of each page containing a set of links that act like a site map identifying important links. This can be another way to better understand website organization and available content.
Pressing Enter on a link activates it, redirecting you to another page on a site, or somewhere else on that page if it’s a Same page link. With JAWS, you can move to the next and previous link by tabbing and Shift Tabbing, respectively. With NVDA and Narrator, you can do this by pressing K and Shift K. However, navigation is more efficient with the Links list. After opening it, press Home and End to go to the first and last link in the list, respectively. You can up or Down arrow through the list. If you know the first letter of the link, pressing that first letter until you find the desired link is the most efficient way to navigate links. To activate a link, press Enter. 
If instead, you wish to go to the location of that link on the current page without activating it, press Tab once and then press Enter on the Move to link button. 
In sum, for many websites, or at least for those without major accessibility problems, using the above combination of headings and links can give you a quick general idea of what information is available on a website.
7.1.3 Find Command for Searching text 
Often you just want to find some specific text, rather than go on a general exploration of a web page. The Find command can save time. With JAWS, press Control F, type in the text you want to search for, and press Enter. You land on the first occurrence of that text after your current cursor location. If that is not the occurrence you want, press F3 to go to the next one. Continue pressing F3 until you find the occurrence you want. 
Corresponding keystrokes for NVDA and Narrator are Control Insert F for the first occurrence and Insert F3 for subsequent occurrences.
You can be imaginative in your searches. If I am on an Amazon page and I want to quickly find an item’s price, I will type the dollar sign in the Find command edit box and press Enter. Or if I am looking for a telephone number for a business and am pretty sure I know the three-digit area code, I will type that in, and quickly find it if it is on that page.
Even if the text you are looking for is not present on the page, you will immediately be told “search string not found.” This is still better than wasting time navigating around the page. 
7.1.4 Form Fields
A form field is an element that allows users to provide input. Five types of common form fields are encountered on web pages: edit fields, combo boxes, buttons, checkboxes, and radio buttons. 
With JAWS, you can access the Forms List by pressing Insert F5. With NVDA, press Insert F7 to bring up the Elements list dialog. Shift Tab once to the list of radio buttons, arrow up or down to the Forms radio button, and Tab once to go to the Forms List. Narrator does not have a key command for listing forms. 
The JAWS and NVDA Forms Lists are useful for previewing how many and what types of forms are on the page. You can arrow up or down to the form you want, and press Enter to be placed there on the page. However, a far better way to quickly navigate to form fields is to learn the screen reader quick keys for the various form types. These are:
· E: Edit box.
· C: Combo box.
· B: Button.
· X: Checkbox.
· A: Radio button (JAWS).
· R: Radio button (NVDA and Narrator).
· F: Form field of any kind.
You can press the Shift key in combination with any of the above quick keys to go back to the previous form field of that type. 
Let’s consider each of these in turn. 
Edit boxes are used for typing in text such as your name, street address, and city of residence. Press E and Enter or Spacebar to get into it. By default, your screen reader will make a noise of some sort to indicate that you have entered an edit box. Another noise is heard when you exit by pressing Escape or Enter. In JAWS, these sounds can be changed. Alternatively, you can turn off the sounds in favor of a spoken message of “Forms mode on” and “Forms mode off” (see Chapter 8.1.5.1 on how to do this). I will refer to these noises as “boings” from here on. 
7.1.7.3 A Short Digression on Cursors 
Why press E and then Enter for entering edit boxes? It is because you are switching cursors. Pressing the letter E is a screen reader keystroke made using a special cursor that is part of your screen reader program. It means nothing to a sighted person navigating the same screen. JAWS refers to this is the “Virtual PC Cursor.” The NVDA equivalent is referred to as “Browse mode.” Narrator calls it “Scan mode.”
Pressing Enter or Spacebar to get into the edit field changes to the PC Cursor, the same cursor that sighted people use. At this point, both the screen reader user and the sighted user are in the same place. Both can type in text. Escaping out of the edit field causes you to revert to a virtual cursor. JAWS will say “Virtual PC Cursor” to indicate this. Narrator will say “Scan mode.” NVDA just makes a sound. Thus, navigating form fields involves switching back and forth between a special virtual screen reader cursor and what I sometimes refer to as the “Sighted Person Cursor.”
If you are in an edit field, pressing Tab and Shift Tab will move you to the next and previous form field, respectively. You will not hear any boings because tabbing and Shift tabbing keeps you in the form fields, rather than exiting you out. 
By contrast, you can press the Escape key to exit an edit field. You will hear a lower pitched boing as you exit. With JAWS, if you remain in the default automatic forms field mode (see Chapter 8.1.5.2 for more about this), you can also Down arrow to leave the edit field. Both will conserve whatever text you have typed into the edit box. 
Combo boxes are drop-down lists of pre-identified selections. Lists of states and countries of residence are typical examples. Press C and Enter or the Spacebar to get into a combo box. As with edit fields, you will hear a boing upon entering and another boing when exiting. Arrow up or down to make your selection. You can also first-letter navigate to your selection. To exit out, either press Escape or Tab to the next form field. Either of these will register your selection. 
Sometimes combo boxes misbehave with screen reader programs. As you Down arrow, the screen reader program goes silent, or the page changes altogether. An “insurance policy” to guard against this and other misbehavior is to press the Alt and Down arrow keys together to expand the list. Your screen reader program will usually say “open list Box” to indicate that the combo box is now expanded. 
Thus, for both edit boxes and combo boxes, a similar two-step process is needed to switch between virtual and PC cursors. This is not the case for the remaining types of form fields. 
Buttons are most frequently used to execute an action after some previous form fields have been filled in. Examples are OK, next, previous, continue, submit and go buttons. Press B and Shift B to go to the next and previous button, respectively. Press the Spacebar or Enter to activate a button. 
Press X and Shift X to go to the next and previous checkbox, respectively. Press the Spacebar to check a checkbox, and Spacebar again to uncheck it. It is possible to check multiple checkboxes. For example, you may be asked which of the following ten activities are among your favorite hobbies. In this case, you can check more than one. 
With JAWS, press A to go to the next radio button. With NVDA and Narrator, press R instead. Radio buttons may be confused with checkboxes. The important difference is that you can only check a single radio button. This introduces a subtle difference in how to check radio buttons versus checkboxes. Unlike checkboxes where you can press the Spacebar to check and uncheck a checkbox, the only way to uncheck a radio button is to press the Spacebar on a different one. For example, let’s say you are asked a question that has yes and no radio buttons. If the Yes radio button is already checked and you Spacebar on it, nothing happens. But if you press the Spacebar on the No radio button, this will check it and uncheck the Yes radio button. 
If you are in an edit field or combo box, you can press Tab and Shift Tab to go to the next and previous form field without leaving Forms mode.
7.1.5 Tables
Tables are frequently used to display financial information such as transactions history, investment returns, and loan product details. You may also encounter tables on transportation sites with bus and train schedules. From the top of the page, press T to navigate to the first table. This places the cursor in the top left cell of the table. Your screen reader will tell you how many columns and rows are in the table, as well as the text contained in the cell. 
There are several ways to navigate within tables. Hold down the Control, Alt and Up or Down arrow keys together to move up and down a column. Hold down the Control, Alt and Right or Left arrow keys together to move left or right along a row. 
If the web developer has designed the table with accessibility in mind, as you navigate left and right along a row, your screen reader program will first read the column header along the top row of the table, and then the content of the cell where your cursor is located. As you navigate up and down a column, your screen reader will read the row header in the left-most column, and then the cell content. Your screen reader usually reads column and row headers with a higher pitch than the cell content. This makes it much easier for screen reader users to interpret cell content. 
Another way to move along a row, cell by cell, is to Down arrow to move from left to right. Press the Up arrow to move from right to left. Pressing the right and Left arrows will read character by character within a cell. 
With JAWS, you can avoid having to hold down the Control and Alt keys by using “layered” keystrokes. With the cursor situated in a table, hold down the Insert and Spacebar keys together until you hear a click. Then press T and JAWS will say “table layer.” Now use just the four arrow keys to move up, down, left, and right. You will receive the exact same audio feedback as when holding down the Control, Alt and arrow keys, as above. Additional keystrokes you can press in the Table layered mode are: Home and End to go to the beginning and end cells of a row, Control Up or Down arrow to go to the top or bottom of a column, and Control Home and Control End to go to the top left and bottom right cells. To exit the layered mode, press the Escape key. You will hear a chime. Also, Alt Tabbing away from the page or navigating out of the table exits the layered mode. 
7.2 Other Useful Keystrokes
7.2.1 Regions/Landmarks
Web pages may also be divided up into regions or landmarks. JAWS uses the term “region” while NVDA and Narrator use the term “landmark.” Press R to go to the next region with JAWS. To go to the next landmark with NVDA and Narrator, press D.
When navigating by region or landmark, you will hear terms like banner, navigation, and main region/landmark, among others. Down arrowing will lead to links or text. 
Currently, not that many screen reader users use region/landmark navigation. In a 2021 WebAIM survey of assistive technology users,[footnoteRef:6] only about one quarter of respondents said they frequently used Regions/Landmarks. The remaining three quarters of respondents seldom or never used them. However, that may change over the coming years as web developers build regions/landmarks into more and more sites and do a better job of labeling them appropriately.  [6:  WebAIM, “Screen Reader User Survey #9 Results,” June 30, 2021. Retrieved from: https://webaim.org/projects/screenreadersurvey9/] 

Given the idiosyncrasies of web page design, there are sometimes sites where this type of navigation is especially effective. For example, I use TurboTax to complete my tax forms. This application does a poor job with headings, but a good job with regions. Relevant content is located in the main region/landmark, which is quickly accessed with the letter Q with JAWS and Insert N with Narrator. As a result, I am able to efficiently input my tax data using JAWS or Narrator. 
As far as I know, NVDA does not currently have a quick key for navigating to main landmarks.
7.2.2 Non-Linked Text
With JAWS and NVDA, pressing N jumps to the next block of non-linked text: that is, text that is not links, graphics, or form fields. This can be a good “second best” strategy when heading navigation is not working well, the idea being that non-linked text may be meaningful text content. I often use this to jump over repetitive elements to more quickly access content, but it is generally not as reliable as when a page is appropriately marked up with headings. 
I also use N when there are repetitive elements just below a heading, often a series of social media and other links. I press H to go to the heading, and then N to jump closer to the content I want.
7.2.3 A Few More Keystrokes
A few more keystrokes you may find useful on some web pages are: 
· G: Next graphic, especially if alt text is presented. 
· L: Next list. 
· K: Next placemarker (see Chapter 7.10.2 on creating placemarkers).
· V: Next visited link.
There are more screen reader keystrokes relevant for web browsing. Access them by opening the following links:
JAWS Navigation Quick Keys
NVDA Command Key Quick Reference
Narrator Keyboard Commands and Touch Gestures.
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This section provides an overview of the menu structures of Google Chrome, Microsoft Edge and Mozilla Firefox.
You probably won’t spend lots of time in the various browser menus, but it’s good to know your way around. Once you open a browser, the lion’s share of your time is consumed by navigating to and browsing content. And you can use shortcut keys to perform many common commands, rather than navigating to them in the menus. Memorizing some of these keystrokes is well worth the modest effort because the most frequently used ones are universal across the browsers.
Still, there will be times when you may wish to access the menus. You may wish to change some settings, create desktop shortcuts, bookmarks, or favorites, or perform some other function for which there is not a shortcut key. 
Similar to context menus accessed via the Applications key, Chrome and Edge also use context menus. You can Up and Down arrow through the commands. As you do this, corresponding shortcut keys are identified. Firefox uses classic drop-down menus rather than context menus. I’ll start with Firefox. 
As with any standard drop-down menu, open the Firefox menu bar by pressing the Alt Key. You will first land on the File menu. Right and Left arrow to the other menus. Particularly important ones are the Bookmarks and Tools menus. Settings and Add-ons (the Firefox equivalent of extensions) are found here. To access a command in any of these menus, Down or Up arrow to the command you want to execute, and then press Enter on it. 
Although a departure from the familiar drop-down menu structure used in Firefox and the retired Internet Explorer, navigating the Chrome and Edge menus is quick and easy. Once you get used to this lean and mean menu style, you may prefer it over drop-down menus. 
Google Chrome menu items are organized in a single drop-down. Press Alt and F together to access it. Down or Up arrow to the command you want to execute, and press Enter on it. Shortcut keys are clearly identified as you Up and Down arrow through the menu items. 
Moving down the list in the Chrome context menu, items are as follows: New tab, New window, New incognito window, History submenu, Downloads, Bookmarks submenu, Make text smaller, Make text larger, Full screen, Print, Cast, Find, More tools submenu, Cut, Copy, Paste, Settings, Help submenu, and Exit. This wraps around, so you can Up or Down arrow to the desired command. To exit the context menu, press Escape. 
The Edge menu structure is very similar to that of Chrome. As with Chrome, press Alt and F together to access the context menu. Up and Down arrow through it and you will see that there are just a few differences. Edge has Favorites while Chrome has Bookmarks. Yet they serve the same purpose. Extensions are present in the list of commands in Edge’s context menu while they are found in the More tools submenu in Chrome. 
7.4 Accessing Settings
This is one area of the web browser menus that are sometimes a bit confusing. Once you figure out the process for finding the settings categories and giving them focus, it is not hard to do, but it is not intuitive and is subject to change. For example for a long time, once you opened the Chrome Settings tab, the various settings categories were nicely organized by heading. Navigation was easy and predictable. Unfortunately, the layout of the Settings tab was changed in Fall 2021 and navigation by category required a few contortions that I could only figure out with assistance from a sighted colleague. So here’s how you do it in each of the browsers, but with the caveat that it all could change in any of the browsers at any time. Consequently, I have included the browser version numbers below. Steps may also change depending on which screen reader you are using. Frankly, this instability and unpredictability can be a bit maddening. 
7.4.1 Chrome
Steps for accessing Settings categories for Chrome version 96 are:
1. Press Alt and F together, Up arrow to Settings, and press Enter. To get there more quickly, press Alt and F together and then S. 
2. This opens a Tab, just like any other web page you open as a tab. Settings is a level one heading, and there is a level two heading for the first Settings category which is You and Google. 
3. You may first land in the Settings search box. If this happens, press the Escape key to exit it. 
4. To switch categories, Down arrow from the top of the page to the category you want. These include: you and Google, autofill, privacy and security, appearance, search engine, default browser, on startup, advanced, extensions, and about Chrome.
5. If using JAWS, press Enter on the desired category, Tab once and then press Escape. JAWS should say “Virtual PC cursor on,” indicating that you can now use standard web page navigation keys. Pressing Escape is not necessary with NVDA and Narrator. 
6. Now press H to get to the associated level two heading for the category.
7. Down arrow through the various settings in the category. Standard form controls (checkboxes, combo boxes, radio buttons, etc.) appear. 
8. To change categories, return to the top of the page and repeat steps four and five above.
9. When finished, press Control W or Control F4 to close the Settings tab. 
Note that the Advanced heading is collapsed, so press the Spacebar to expand it for a list of additional settings sub-categories. These include: Languages, Downloads, Printing, Accessibility, System, and Reset and cleanup. 
7.4.2 Edge
To access the Edge (Version 96) Settings and its various categories with NVDA and Narrator: 
1. Press Alt and F together, Up arrow to Settings, and press Enter. 
2. Settings opens in a new tab. Settings is a level one heading, and there is a level two heading for the first Edge category which is Your profile. 
3. You may first land in the Settings search box. If this happens, press Escape. 
4. To switch categories, from the top of the page, Down arrow to the Settings menu toggle button and press the Spacebar to expand it
5. Down arrow through the categories which include: profiles, privacy and services, appearance, start new and home tabs, share copy and paste, cookies and site permissions, default browser, downloads, family, languages, printers, system, reset settings, phone and other devices, accessibility, and about Microsoft Edge. 
6. Arrow up or down to the category you want to select, and press Enter on it.
7. Now press H to get to the associated level two heading for the category.
8. Down arrow through the various settings in the category. Standard form controls appear for making changes. 
9. Repeat steps four through six above to switch to another category.
10. When finished, press Control W or Control F4 to close the Settings tab. 
As of the writing of this book, changing Edge Settings categories was a bit quirky with JAWS, and were as follows:
1. Once in Settings, From the top of the page, Down arrow to the Settings menu toggle button and press the Spacebar to expand the popup menu.
2. Down arrow to Settings category and press Insert Z to switch off the JAWS Virtual PC cursor.
3. Down arrow to the desired category and press Enter.
4. Press Insert Z again to toggle the JAWS Virtual PC cursor back on.
5. Press H or 2 to navigate to the level two heading associated with that category. 
6. Down arrow to the setting you want to change within that category. 
7.4.3 Firefox
Settings for Firefox Version 93 are accessed in the Tools menu as follows:
1. Press Alt to open the menus, Right arrow to Tools, Down arrow to Settings and press Enter.
2. [bookmark: _Hlk35413820]If you land in a search box, press Escape to get out of it.
3. [bookmark: _Hlk87363948]With JAWS, from the top of the page, Down arrow to the Categories list and press Enter. Note that just above the Categories list, it says “categories.” Do not press Enter on this. Down arrow through five settings categories: general, home, search, privacy and security, and sync. Press Enter on the category you wish to access, and then press Escape. With NVDA, go to the top of the page and first press Insert Spacebar to turn Browse mode off. Then press Enter on the Settings categories. Down arrow to the category you want to select and press Enter. Press Insert Spacebar once again to be sure that Browse mode is on. With Narrator, first press Insert Spacebar to be sure you are in Scan mode. Then from the top of the page, Down arrow to the five categories and press Enter on the one you want to select. Once again, press Insert Spacebar to be sure you are still in Scan mode. With Narrator, first press Insert Spacebar to be sure you are in Scan mode. Then from the top of the page, Down arrow to the five categories and press Enter on the one you want to select. Once again, press Insert Spacebar to be sure you are still in Scan mode. 
4. Press H to navigate to the first heading for that category. There are a series of level one and level two headings for each category. Having several level one headings makes little sense, but that’s how it is. 
5. Press H to navigate to the relevant heading. 
6. Down arrow to the setting you want to modify, and use standard form control keys to make changes. 
7. Repeat step three above to switch to another category.
8. When finished, press Control W or Control F4 to close the Settings tab. 
Admittedly, the ways I have described to access settings categories for the various browsers seem to have been stuck together with duct tape. There is nothing intuitive about them. While there may be other ways to access the settings categories with screen readers, as of the writing of this book, these are the ways I have been able to figure out. I hope they can eventually become more consistent, intuitive and stable. 
7.5 Switching Browsers
It is easy to change your default browser, as well as to change browsers for a particular web page where you are situated. 
7.5.1 Changing Your default browser
First, why ever change your default browser? Why not just pick one browser and stick with it forever? Or only change on very rare occasions? There are several reasons. You may like Firefox as your default, but you open a site, and it says that the site works best with Google Chrome. If you think you will be going back to that site frequently over the next several hours or days, you may find it is quicker to change the default to Chrome. Or you may be about to navigate to a “busy” web page cluttered with lots of ads, graphics and social media links that make reading and navigation tedious and frustrating. You may wish to switch your default browser temporarily to Edge in order to take advantage of its Immersive reader feature (see Chapter 7.10.4.1 below). 
As mentioned in Chapter 2.5.7, it is quick and easy to switch default browsers with Windows 10. Unfortunately, this is one area where Microsoft has taken a major step backwards with Windows 11. Procedures for doing this with Windows 11 are more complicated and time-consuming. 
To switch default browsers with Windows 10: 
1. Press the Windows Key to open the Start menu search box.
2. Type the first few letters of “Default App Settings System Settings.” As soon as you hear these words, press Enter. 
3. Tab several times to the Web browser button. Your current default browser will be identified here.
4. Press Enter or Spacebar to open a pop-up. Tab to your new default choice, and press the Spacebar to select it. 
5. Press Alt F4 to close this window (there is no OK button to activate). 
As mentioned in Chapter 2, Microsoft has made the process of changing default browsers considerably more difficult with Windows 11. I used web browsers in Chapter 2.5.7 as an example of how to change default programs with Windows 11. Check out that section of the book for instructions on how it is done. 
7.5.2 Switching Browsers for a Specific Web page
You may want to change browsers when something seems broken and you suspect that switching browsers may help. For example, you press Enter on a link and nothing happens. Or the choices in a combo box don’t appear. Switching browsers involves copying the URL from the first browser and pasting it into the other one. Steps are:
1. In the source browser, press Alt D or F6 to go to the Address bar edit box. The URL is already selected. 
2. Press Control C to copy it.
3. Open the destination browser. 
4. If the destination browser is set to open in a new Tab (more on this in Chapter 7.6 ), press Control V to paste the URL, and Press Enter to open it. Or if the destination browser is set to open on a specific page, press Alt D or F6 again, press Control V to paste the URL, and press Enter.
[bookmark: _Toc40000239][bookmark: _Toc42272530]Note that this will not work with many secure sites where you have already logged in. The log in page will open rather than the page you attempted to load.
7.6 Options for Opening Web pages
This section begins with a discussion of which page you want to land on when you first open your browser. All three browsers give you three options: open on a new tab page; open on the last page you were on during your previous session; or open a specific page or set of pages. The page or pages you choose are alternately called start or landing pages. If you pick one specific page, it may also be referred to as a homepage. For the sake of clarity, I will stick with the term “start page.”
I will first explain the concept of Tabbed browsing. Then I will lay out the process of selecting your start page. 
Many people choose to make Google their Start page because they want to be able to quickly access the Google search engine. However, if you opt to set your start page as a new tab rather than a specific page, you can immediately perform a search with your default search engine. Alternatively, you can type in the site address you wish to open if you know it already.
7.6.1 Tabbed Browsing
Tabbed browsing is a form of navigation that allows a user to browse multiple web pages in a single window. The additional pages are denoted by tabs at the top of the browser window, hence the label “Tabbed browsing.” Keystrokes are the same for all browsers. 
When you have multiple web pages open, navigating to them behaves differently than when you have multiple Word documents or multiple Excel files open. In these latter cases, you can Alt Tab through all the open files. However, when Alt Tabbing through your open windows, only the last web page you opened for any given browser will open. 
If you use Control T to load new web pages onto tabs, rather than Alt D or F6, you can consistently cycle through all the tabs you have opened in a particular browser by pressing Control Tab. Close the current tab by pressing Control W or Control F4. This will land you on one of the other web pages opened during the current browsing session. 
Besides making it easier to work with multiple web pages, using Control T to open a new website or perform a search is quick and easy. When you press Control T to open a new tab, if you know the address of the web page, you can immediately type it in and press Enter, which will open the site. Or if instead, you want to perform a search, here too, you can immediately start typing in your search term, press Enter, and your default search engine will generate search results. There is no need to navigate to an edit field or the Address bar. 
The three screen readers do not consistently say the same thing when opening new tabs. They will say something like “search with Google or enter address,” indicating that you can do either of these. So, if I type in “carroll.org” (minus the quotes) and press Enter, this will bring me directly to the Carroll Center for the Blind website. Or, if instead, I type in the search term “Carroll Center for the Blind,” and press Enter, this will open a search results page using my default search engine for that browser. If my default search engine is Google, results will appear exactly as they would if I had already been on the google.com web page and then performed a search. 
7.6.2 Setting Start Pages 
To set start pages, each browser gives you three options which are accessed through the Settings tab: a new tab, continuing where you left off during your last session, or a specific page or set of pages. Let’s start with Chrome. And because I noted above that accessing Settings categories differs between screen readers, I will demonstrate just using JAWS.
7.6.2.1 Chrome
1. Press Alt and F together to get into the Chrome context menu, Up arrow to Settings, and press Enter.
2. If you land in the search box, press the Escape key to get out of it.
3. From the top of the page, Down arrow to the On startup category, press Enter, Tab once, and then press Escape. 
4. Down arrow to the three radio buttons. Press the Spacebar on the Radio button of your choice. If you select either the New tab page or Continue where you left off radio button, you are done, and can press Control W or Control F4 to close the Settings tab.
5. Otherwise, continue Down arrowing to the Use current pages radio button and press the Spacebar. If you want to choose this option, have only the desired page or pages open when you start. While it is possible to select and unselect among open pages, this is more complicated. 
6. Down arrow to the Use current pages link and press Enter
7. Exit Chrome and reopen it to verify that your new Start page choice has registered.
If you choose the New tab option, when you open Chrome, you can immediately type in either a web address or a search term. Pressing Enter will then either open the page or generate a search results page with your default search engine. Because I like to be able to quickly access the Google search engine, I prefer the New Tab start page option. Many people do not choose the second Continue where you left off option because different Start pages open from session to session. This can be confusing. Choose the third Use current pages option if you want to always have the same Start page or pages. Some workplaces may prefer that your browser always opens on the organization’s website. Or you may have several pages that you open when you begin working on your computer every day, and it is quicker to have them all appear on startup, rather than manually reload them every time. Whichever option you choose, it is easy to change later. 
7.6.2.2 Edge
The Edge Start page choices are exactly the same as those for Chrome. Navigate to them as follows:
1. Press Alt and F together to get into the Edge Menu, Up arrow to Settings and press Enter.
2. If you land in the search box, press Escape to get out of it.
3. To switch categories, Down arrow from the top of the page to Settings categories. Press Enter on this to expand the list of categories. 
4. Down arrow to On startup, press Enter, and then press Escape.
5. Press H to navigate to the On startup Heading. 
6. Down arrow to the first of the radio buttons: Open the new tab page. If this is your choice, press the Spacebar to check it. 
7. If not, Down arrow to the other two radio buttons and check the one you want. 
8. If you choose Open a specific page or pages, as with Chrome, have only the desired pages open to simplify the process.
9. Down arrow to the Set to all currently open tabs button and press Enter. 
10. Exit Edge and reopen it to verify that your start page choice has registered.
7.6.2.3 Firefox 
The process for choosing startup pages for Firefox is more complicated than for the other browsers. Steps are:
1. [bookmark: _Hlk35585636]Press the Alt Key to open the Menu bar, Right arrow to Tools, Up arrow to Options and press Enter.
2. If you land in a search box, press Escape to exit it. 
3. From the top of the page, Down arrow to the Categories list and press Enter. 
4. Press Enter on General to select that category.
5. Down arrow below the General heading to the Restore previous session checkbox and press the Spacebar if you want all tabs from the previous session to open on startup. If you do not want this, be sure to uncheck it. If you don’t, it will override the other options discussed below.
6. Press Control Home to go back to the top of the page and Down arrow to Categories and press Enter. 
7. Down arrow to the Home category and press Enter. 
8. Press C to go to the combo box, and press Enter to open it.
9. Up or Down arrow to your choices which include Firefox home, custom URLs, and blank page. 
10. If you choose the blank page option, press Enter and this startup option is selected, meaning that a single new tab will open on startup 
11. If you choose Custom URLs, tab to Paste a URL where you can paste in a web address. But if you already have the desired tabs open and only those tabs, it is easier to tab one more time to Use current pages, and press Enter. 
12. Press Alt F4 to exit Firefox and reopen it to verify that your desired startup page choice has registered. 
7.7 Favorites and Bookmarks 
To quickly go to frequently-visited websites, use favorites and bookmarks. This saves you the time of repeatedly searching for them. If you want to be an efficient web navigator, you will want to have a well-organized set of favorites or bookmarks, as well as a few desktop shortcuts for the sites you visit most frequently. 
Chrome and Firefox call these “bookmarks,” while Edge calls them “favorites.” These are just different words for the same thing. 
Because you can organize these in folders, you can have lots of them and still easily find them. You might have quite a few bookmarks organized in folders for finances, news, school, entertainment, and so on. By contrast, you would not want to clutter your desktop with 40 or 50 web page shortcuts. If you have a large number of desktop shortcuts to wade through, this defeats the whole notion of shortcuts. Create desktop shortcuts for only those web pages that you visit with great frequency. Think of them as your “favorite favorites.” 
I will not go over the processes for creating, accessing and managing bookmarks and favorites in the various browsers. Instead, I will present a single approach for centralizing creation and management of favorites/bookmarks in a single folder. Doing all this in a single folder greatly simplifies and streamlines the whole process of managing them if you use multiple browsers. And even if you use a single browser, the process outlined below is easier to learn and use than doing it in any of the browsers. 
First, create a new folder somewhere on your computer. This could be in the Documents folder. However, if you use Dropbox or OneDrive, create it in one of those places because this will back up the folder to the cloud. Second, create a desktop shortcut for this folder (see Chapter 7.8 below on how to do this). This will speed up the process of creating, accessing, and managing your favorites. 
Steps for creating a favorite are:
1. On the web page you want to make a favorite, and in whatever browser you happen to be in at the moment, press Alt D or F6 to navigate to the Address bar where the page’s URL is already highlighted.
2. Press Control C to copy the URL to the Clipboard.
3. Open the Favorites folder shortcut that you have created on your desktop. 
4. To add the favorite to one of the subfolders here, navigate to it and press Enter. Skip this step if you do not want to place it in a subfolder.
5. Press Alt H W S which is the ribbon shortcut key for creating a shortcut (I use “World Series” as my mnemonic for this). 
6. You land in an edit field. Press Control V to paste the URL here, and then press Enter.
7. Type in the name you want to give the favorite in this second edit field, and press Enter.
Managing favorites in this folder is easy because you use the same keystrokes as when managing files and folders elsewhere on the computer. Relevant keystrokes are:
· Control Shift N: Create new folder.
· Enter: Open folder.
· Backspace: Go back up one folder level (Alt Left arrow and Alt Up arrow will also work).
· Control C: Copy favorite.
· Control X: Cut favorite.
· Control V: Paste favorite.
· F2: Rename folder or favorite.
· Delete: Delete favorite or folder.
As in your Documents folder, you can first-letter navigate to folders and individual favorites. You can also select multiple folders and favorites, something that is not possible when you manage them in the other browsers.
Many people who have made the transition away from Internet Explorer to one of the other browsers cite grappling with bookmarks as a big challenge. If you adopt the above approach, you can sidestep these problems. 
7.8 Creating Desktop Shortcuts 
As mentioned above, create desktop shortcuts for those web pages that you consider your “favorite favorites.” The procedure is quick and easy for Chrome. A universal method can be used with Firefox and Edge.
7.8.1 Chrome
To create a desktop shortcut with Chrome:
1. Navigate to the web page for which you want to make a shortcut. 
2. Press Alt and F together, Up arrow to the More tools submenu, and press Enter. 
3. Down arrow to Create shortcut, and press Enter.
4. This opens an edit box pre-populated with the web page title. Edit it if you like. When done, press Enter. The desktop shortcut is now created. 
Note that if you create a desktop shortcut in Chrome using the steps above, that shortcut will only open the associated web page in Chrome, even if Edge or Firefox is your default browser.
7.8.2 Universal Method for Creating Desktop Shortcuts for Web pages
Steps for doing this are:
In any browser, open the webpage for which you want to create a desktop shortcut.
1. Press Alt D or F6 to go to the Address bar.
2. Press Control C to copy the URL to the Clipboard.
3. Press Windows M or Windows D to go to the Desktop. 
4. Press Control Spacebar to unselect any icon that may already be selected there.
5. Press the Applications key, Up arrow to the New submenu, and press Enter to open it. 
6. Down arrow to Shortcut and press Enter. This opens the Create shortcut Dialog box.
7. In the Type the location of the item edit box, press Control V to paste the URL here, and then press Enter.
8. Type a label for the shortcut in this second edit field, and press Enter.
If you use this universal method to create a desktop shortcut, the associated web page will open in your default browser.
7.9 Extensions/Add-Ons
These are small software programs that customize the browsing experience, adding more functionality for specific and limited tasks. Chrome and Edge call them extensions, while Firefox calls them add-ons. Popular tasks perform by extensions include blocking advertisements, enhancing security, screen customization, and correcting grammar and spelling. Many are available for more than one of the browsers.
While there are literally thousands of extensions/add-ons out there, don’t go overboard with them. The vast majority do little to enhance your browsing experience,[footnoteRef:7] and many are inaccessible. Having too many running can also slow down your computer. Some have even been reported to introduce nasty malware and viruses. That said, there are a few extensions/add-ons that are worth considering. AdBlock and uBlock Origin are popular extensions that block advertisements, both for purposes of removing web page clutter and enhancing privacy. My current Favorite is Adblock for YouTube, a Chrome extension that eliminates irritating video ads so you can immediately listen to the content you want. Read Aloud strips away clutter on “busy” web pages” to improve readability. Although this book does not deal with low vision issues, the ZoomText smart invert Chrome extension enables ZoomText and Fusion users to use the invert brightness and color schemes more effectively. [7: 
 An August 2019 article from TechRadar entitled These Are the Most Popular Google Chrome Extensions provides a useful overview of extension usage.] 

If you know of an extension you would like to search for, you can go to the Chrome Store or the Firefox Add-ons page. You can also simply use your search engine to find them.
For Chrome, I will use the Adblock for YouTube extension as an example to illustrate the process of downloading and managing extensions. I will use the uBlock Origin extension as an example for Edge, and the AdBlock add-on as an example for Firefox. 


7.9.1 Chrome 
To add an extension to Chrome: 
1. In Chrome, open a new tab, type “ad block for YouTube chrome store,” and press Enter. Note that character case does not matter when typing search terms. 
2. Press H to get to the heading for this extension.
3. Down arrow under the heading to the Add to Chrome button and press the Spacebar.
4. Tab to the Add extension button and press the Spacebar. Your screen reader will confirm that the extension has been added. It is also immediately activated.
The AdBlock for YouTube extension has one shortcoming. You must open YouTube from inside Chrome. Getting into YouTube from a desktop shortcut or a link in an email will not remove ads. To make it work correctly, do the following:
1. Open Chrome in a new tab.
2. Type in YouTube.com and press Enter. Note that Chrome remembers site addresses that you frequently visit. If you go to YouTube often enough, you will only need to type the letter Y for the full address to autofill. 
3. In YouTube, perform a search, navigate to your choice, and activate the link to start the video.
The video should launch immediately, minus the ads.
To manage extensions that you have downloaded to Chrome:
1. Press Alt and F together, and then L to go to the More tools submenu. 
2. Down arrow to Extensions and press Enter.
3. If you land in the search box, press the Escape key to get out of it. 
4. Press H to navigate by heading. Each of your installed extensions has a level three heading. Underneath the heading is a Details button which you can activate to find out more about the extension, a Remove button if you want to delete it, and an Extension enabled toggle button. Press the Spacebar to enable or disable the extension. 
7.9.2 Edge
To add extensions to the Edge browser:
1. In Edge, open a new tab, type “you block origin Microsoft store,” and press Enter.
2. Press H until you get to the correct search result and press Enter. This lands you on an Edge page entitled “uBlock Origin - Microsoft Edge Add-ons.”
3. Press H to navigate to the level one heading with the name of the add-ons.
4. Down arrow to the Get uBlock Origin button and press Enter.
5. Tab to the Add extension Button, and press Enter to confirm. Your screen reader will say “uBlock Origin has been added to Edge.” It has also been activated to operate immediately.
To manage installed extensions:
1. Press Alt and F together to open the Edge menu, Down arrow to Extensions and press Enter.
2. Press H to go to the Installed extensions level two heading. 
3. Down arrow to the extension you want to manage. 
4. From here, steps are exactly the same as those outlined above for Chrome for accessing details, removing extensions, and enabling/disabling them. 
Press Control F4 or Control W to close the Extensions Tab when finished.
7.9.3 Firefox
With the other two browsers, simply initiating a search in a new tab worked well. As of October 2021, this approach did not work with Firefox. I recommend you go into the Firefox menus instead to search for an install add-ons. Do the following:
1. Press Alt to open the Menu bar, Right arrow to Tools, Down arrow to Add-ons and press Enter. 
2. In the search box, type in the name of the add-on you want to download, and press Enter. In this example, it is “AdBlock.”
3. Press H to navigate to the AdBlock heading, which is also a link. Press Enter to open the link.
4. Press Enter on the Add to Firefox link.
5. Press Alt A to allow the download. You will receive verbal confirmation that it has been added to Firefox. 
Note that it is a good idea to exit Firefox after downloading a new add-on so the Manage add-ons page loads correctly. 
To manage Firefox add-ons:
1. Press Alt to open the Menu bar, Right arrow to Tools, Down arrow to Add-ons and press Enter. 
2. Press H to navigate to the Installed add-ons heading.
3. Down arrow to the Enable checkbox and press the Spacebar to enable it. Press the Spacebar again if you want to disable it. 
4. If you want to delete the add-on, Down arrow one more time to More options and press the Spacebar to expand the list.
5. Down arrow to Remove and press Enter.
To verify it is working, go to a site like CNN.com that usually has several ads. With AdBlock disabled, press the letter M to cycle through the frames (online ads are generally contained in frames). Then enable AdBlock and repeat this. There should be far fewer frames than before.
[bookmark: _Toc42272533]7.10 Additional Useful Tools
This section identifies several more tools to enhance your browsing experience. They include copying and pasting hyperlinks, adding placemarkers, tips and tricks for copying text from the web without unwanted formatting, and using reader views to remove clutter from web pages, thus substantially improving the reading experience.
7.10.1 Copying, Pasting, and Labeling Hyperlinks
A hyperlink is a word, phrase, or image that you can press Enter on to jump to a new web page, document or a new section within the current web page or document. Hyperlinks are often visually distinguished from regular text with blue and underlined formatting. 
A link to a YouTube video is an example of a hyperlink. Let’s say you would like to share such a link with a friend by email. You can easily copy the web page address and paste it into a Word document or email message. You can also create a custom label. Steps are identical in all browsers for copying, as well as for pasting into a Word document or the body of an email message. 
To copy and paste a web address into a Word document or the body of an email message: 
1. On the web page you would like to share, press Alt D or F6 to go to the Address bar. You will hear “http” etc. Note that the text is already selected.
2. Press Control C to copy the URL to the clipboard.
3. Navigate to an open Word document or the body of an email message and press Control V to paste it there.
If you are reading this electronically with Word, below is an unlabeled hyperlink from YouTube that you can open:
https://www.YouTube.com/watch?v=TRUjr8EVgBg
If you want to give the hyperlink a more user-friendly label than “http” etc., do the following:
1. In Word or Outlook, situate the cursor somewhere in the text of the URL.
2. Press the Applications key, Down arrow to Edit hyperlink, and press Enter.
3. Tab once to the Text to display edit field, type in your label, and press Enter. 
Here is the same hyperlink as above, but this time with a more meaningful label:
America the Beautiful, Ray Charles
If you are creating a Word document that will have numerous links, you should do this extra labeling step. Then you can press Insert F7 to open a links list with JAWS or Narrator (or an elements list with NVDA), and first-letter navigate to the hyperlink you want to activate. Otherwise, you will just have a list of links that all begin with “http,” etc., and have no meaningful labels. 
7.10.2 Placemarkers 
A Placemarker is the web page equivalent of a bookmark, enabling you to quickly navigate to that point on a web page in the future. Using placemarkers can save you time if it requires a large number of keystrokes to arrive at that location on the page, or the text you are looking for is hard to find. They are particularly useful on complex websites. They can be anchored to text, elements of the current web page, or to a website's domain. Placemarkers can also be used in PDF documents. 
You can create placemarkers with both JAWS and NVDA, although with NVDA you must first download and install an add-ons. Narrator does not have a placemarker feature. 
7.10.2.1 JAWS
To create a placemarker using JAWS: 
1. For the first placemarker you want to create, navigate to that text on the web page, and press Control Windows K. JAWS will say, “temporary placemarker set.”
2. To now turn this into a permanent placemarker, press Control Shift K. You should land in a combo box where the first choice is stated as, “temporary document.”
3. Tab to the Add button and press Enter. 
4. You land in an edit box populated with the text from the web page. 
5. Tab to “Define for all pages on current domain,” and check this checkbox if you want that text marked on all pages of the website. Leave it unchecked if you are only interested in marking it on this page. 
6. Tab to “anchor to text,” and check this checkbox if you want specific text to be marked. 
7. Tab once to verify it is the correct text, but don’t modify it. 
8. Tab to the OK button and press Enter or Spacebar to save it. 
9. For any additional placemarkers you wish to create during this session, it is not necessary to mark it first as a temporary placemarker. Instead, press Control Shift K, and Down or Up arrow to temporary document. 
10. Repeat steps three through eight above to make this a permanent placemarker. 
After you have added permanent placemarkers, press K and Shift K to navigate to the next and previous placemarker, respectively. You can also press Control Shift K to open the list of placemarkers. Then arrow up or down to the one you want, and press Enter. In the placemarker list, you can also first-letter navigate to the placemarker you want, and press Enter on it. 
As an example, open the link below:
Google Search - Carroll Center for the Blind
From the top of the page, if you press H for heading, it takes quite a few keystrokes to go to the text “search results.” If you perform lots of Google searches, this can quickly get very tedious. 
Now set a placemarker, anchoring it to the text “search results.” Pressing K just once will get you to that location on the page every time. 
To delete a placemarker:
1. Press Control Shift K to open the placemarker list.
2. Up or Down arrow to the one you want to delete.
3. Tab to the Remove button and press Enter. 
There is also a Remove all button here. Tab to this and press the Spacebar if you want to remove all placemarkers for this website.
7.10.2.2 NVDA
With NVDA, as mentioned above, you will first need to download and install an add-ons called “Placemarkers” before you can create them. To add and install NVDA add-ons, see Chapter 8.2.4. After installing this add-on:
1. Navigate to the text on the web page that you want to mark.
2. Select some of the text at that point for labeling the placemarker. This is not required, but a good idea if you are going to create several placemarkers and you want to generate a list of them. 
3. Press Insert Shift Control K to mark it. Admittedly, this is an awkward keystroke combination, but try your best. NVDA will say “Saved position at character” and some number. 
4. Repeat this process for any other placemarkers you wish to create.
5. Move to the next or previous placemarker with Insert K or Insert Shift K, respectively. 
You can access a list of placemarkers with the keystroke combination Insert Alt K. Up or Down arrow to a specific placemarker, and if you Tab here, you can create a note for the placemarker. Tab a couple of times more to delete the placemarker. You can also delete a placemarker by navigating to it and pressing the keystroke combination Control Shift Insert Delete. 
7.10.3 Copying and Pasting text from the Internet 
Often when you attempt to copy and paste text from one application to another, simply pasting with Control V will import unwanted formatting from the original source. This is especially true when copying text from a website. You may very well import bizarre font styles, sizes, and colors. Using the Paste text only command can help avoid problems like this. 
Let’s say you wish to copy text from a web page and paste it into a Word document. Steps are:
1. Select the web page text and copy it as you normally would with Control C. Now navigate into your Word document, place the cursor where you want to paste it.
2. Press the Applications key, and Down arrow to Paste options. Do not press Enter here because this would execute a standard paste, which is what you want to avoid.
3. Instead, Left arrow once to Keep text only, and press Enter. 
The pasted text now appears with the default font and paragraph formatting of the Word document. All the unwanted formatting from the web page has been stripped out. 
Alternatively, use the Paste text only ribbon shortcut which is Alt H V T.
When you copy and paste text from the Internet into Word, it often comes in with lots of unwanted blank lines between your text. You will need to remove the coding for extra hard returns between the paragraphs. The symbol for the hard paragraph return is ^p, the caret being the special character above 6 in the number row on your keyboard (keystroke: Shift 6). My mother always used to tell me to eat my peas and carrots when I was a kid, so that is how I remember the caret P key combination. 
To quickly delete the extra hard returns: 
1. In Word, press Control H. This opens the Find and replace dialog box.
2. You land in the Find edit field. Type here “^p^p” minus the quotes and with no spaces
3. Tab once to the Replace edit field, and type in a single “^p” minus the quotes.
4. Tab to Replace all and press the Spacebar. You will hear the number of replacements made. This will get rid of some of the excess hard returns, but not necessarily all of them. 
5. Press the Spacebar on the OK button and immediately press Alt A to remove more unwanted hard returns. 
6. Repeat the step above several times until you are down to either one or zero replacements. 
7. When finished, press the Escape key to exit the dialog box and return to your document. 
[bookmark: _Toc27136044]7.10.4 Reader Views
Reading text on a web page that is cluttered with advertisements, inaccessible graphics, and loads of links can be frustrating. Switching to a reader view can cut out this clutter, resulting in a cleaner reading experience. Safari on the iPhone has long had an excellent reader view. PC-based web browsers have lagged until recently. Microsoft Edge and Mozilla Firefox have built-in features called Immersive Reader and Reader View, respectively. Chrome has a similar utility called “Reader mode ” that you need to install first. 
7.10.4.1 Reader Views with Edge and Firefox
The Edge Immersive Reader and Firefox Reader View features are very easy to 
Activate. On the page you would like to read, just press F9 in both Edge and Firefox. The press H to go the first heading, press your screen reader Say all keystroke and listen to the text. It’s that simple. 
Note that there is no default setting to permanently keep these reader views on. You will need to press F9 for each web page. Also, this functionality does not exist for all websites. However, I find it works for most sites where I want to use it. 
After activating Reader mode, just below the top of the page, there are buttons for accessing options for changing to other voices, as well as adjusting their speed. My preference is to continue with my own screen reader voice. 
7.10.4.2 Reader Mode with Chrome
Chrome also has a Reader mode that provides the same reading experience as the Edge and Firefox reader views. However, it is not built-in, so you need to add it to your browser. To do this:
1. In the Chrome Address bar, type “chrome://flags” minus the quotes, and then press Enter.
2. In the search box on this page, type reader, and press Enter.
3. Press H to navigate to the Enable Reader mode heading.
4. Down arrow to the combo box, press Enter to open it, Down arrow to Enable, and press Enter.
5. Press Alt F4 to close Chrome, and then reopen it. 
After Reader mode has been added, To activate it on a “busy” web page, press F6, Tab once or twice to the Enter Reader mode button and press Enter. To exit Reader mode on the same page, press F6 again, Tab to the Exit Reader mode button, and press Enter.
Unfortunately, on the laptops of the people I train, it only works about half the time. I have not been able to figure out why it works for some people but not for others. After pressing F6 and tabbing around, the Enter Reader mode button fails to appear. Hopefully, Google will eventually incorporate it into Chrome and assign a simple keystroke to activate it.
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With all three screen readers, you can make a number of customizations to render your computing experience smoother and more efficient. This chapter shows how to do this for several applications with each of the three screen reader programs. The bulk of the chapter will be devoted to JAWS because it has the greatest variety of customization possibilities. 
8.1 JAWS Customizations
Most JAWS customizations are set in Quick Settings and Settings Center. While there is significant overlap between these two areas, the most important difference is that default changes across all applications can only be set in SETTINGS CENTER, while QUICK SETTINGS is limited to application-specific changes. Roughly speaking, Settings Center customizations are more general in nature while some of those in Quick Settings are a bit more application-specific. If this sounds rather vague and imprecise, that’s because it is. 
There are a dizzying number of possible customizations, and it can be challenging to identify the most useful ones. Keeping straight which ones are set in Settings Center, Quick Settings, or in both makes it even more challenging. Hopefully, in some future version of JAWS, all will be consolidated in a single place.
I will first take us on a tour of the Quick Settings and Settings Center dialog boxes, and then discuss several of the most useful JAWS customizations. 
Let’s start our tour of Quick Settings with your cursor focus in Outlook. Press Insert V to open the Quick Settings dialog box for Outlook. Dialog box elements are described below:
· You first land in a search box where you can type in the name of the setting you want to change. As you type individual letters, JAWS reveals the number of search results as they narrow. Down arrow to the setting you want to change. 
· As an alternative to searching, you can Tab once to a tree view and navigate through it to find the setting you want to change. 
· Tab to the Read only edit field. Here you can read about the setting you are focused on in the search results or tree view, including options for changing the setting. 
· Tab to a checkbox where you can expand or collapse the tree view we encountered a couple of tabs back. 
· Tab to the OK button to save changes.
For some customizations, I prefer to use the search box, and for others I prefer the tree view. 
The Settings Center dialog box closely resembles the Quick Settings dialog box, but with one major difference. Let’s start with your focus in a web browser window like Google Chrome. Press Insert and six on the number row to open the Settings Center dialog box for the open browser. Settings Center dialog box elements are described below.
· Similar to Quick Settings, the first, second and third tabs are a search box, a tree view, and a Read only help area, respectively.
· The next Tab is an OK button for saving changes. Unlike Quick Settings, no checkbox appears for expanding and collapsing the tree view. 
· Now comes the big difference: Tab past the OK button to a combo box with the full list of applications. Focus will be on the program from which you initially opened the Settings Center dialog box. Pressing the Home key will bring you to the top of the list for making the setting a default for all relevant programs. For example, if you open the Settings Center while in Chrome, any changes you make will be for Chrome only. But if you Tab to this list and press the Home key, changes will be for all applications. In this case, this would include all browsers and PDF viewers like Adobe Acrobat Reader.
· Tab one more time to wrap back to the search box where we started.
· If you wish to make a default change, from the search box, you can also press Control Shift D rather than tabbing to the list of applications. 
Now some useful customizations and the most efficient way to change them. I will assume you want to make changes for all browsers, not just a single one. If instead, you only want to make changes for a single browser, ignore the steps below related to making default changes in Settings Center. 
8.1.1 General Customizations
8.1.1.1 Punctuation Levels
Sometimes announcement of punctuation marks (colons, semi-colons, parentheses, etc.) can seem excessive, hindering your reading experience. With JAWS, you can choose among four levels of spoken punctuation: 
· None: This is useful for casual reading of articles on the web or long Word documents that you are not editing yourself.
· Some: A limited set of punctuation marks are spoken.
· Most: This is the default. Among the most important punctuation marks included here, but not in Some, are colons, semi-colons, parentheses, and quotes.
· All: This is useful when you are editing text.
In Quick Settings, punctuation levels can be changed for individual applications, while they can only be changed globally in Settings Center. Most of the time, you will be interested in changing them temporarily for a single program. Consequently, I will only cover changing them in Quick Settings. Steps to change to None to make for a better casual reading experience are: 
1. Open the application for which you want to change punctuation levels.
2. Press Insert V to open Quick Settings. 
3. Type the first three or four letters of the word “punctuation” in the search box.
4. Down arrow to Punctuation level where the default is Most. Press the Spacebar a couple of times to “None.” Pressing the Spacebar here cycles through the four options.
5. Tab to the OK button and press Enter to make the change.
You may find it useful to change punctuation levels to All if you are proofreading a Word document or an email message. This will enable you to hear all the punctuation. When finished with None or All, you may want to change this setting back to Most or Some. 
A shortcut key to temporarily change punctuation levels was introduced in JAWS 2021. The keystroke is Insert Shift 2. Press this keystroke repeatedly to cycle through the four levels. In this context, “temporary” means that punctuation levels will revert back to the default level when you navigate away from the current window. This is a useful feature because you are often only interested in making a change on the fly. 
In the Settings Center, you can customize which punctuation marks are spoken at each level, as well as get a comprehensive list of what is currently spoken at each level. As of the writing of this book, there were 193 punctuation marks listed. To access this list and make any changes:
1. Starting in any application, press Insert 6 to open the Settings Center.
2. Press Control Shift D to make a default change for all applications. This is required if you access Punctuation in the Settings Center. 
3. Type “punctuation” in the search box. Note that typing just the first two or three letters is sufficient to make the full word appear. 
4. Down arrow to Customize punctuation and press the Spacebar. 
5. Down arrow through the list to hear each punctuation mark and the current level at which it is spoken.
6. To change the level where a particular punctuation mark is spoken, press the Spacebar to cycle through the four choices. Stop when you get to your choice. 
7. Down arrow to the next punctuation mark for which you want to change the level at which it is spoken, and repeat the previous step. 
8. When finished making your changes, Tab to the OK button and press Enter.
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Typing echo is the audio feedback that is “echoed” back to you when you type text. It can be changed in both Settings Center and Quick Settings. There are four options:
· Characters: You hear each character as you type. This is the default.
· Words: You hear no characters, but only hear a full word after you have finished typing it and either press the Spacebar or a punctuation key like a period or comma.
· Both characters and words: You hear individual characters as you type, as well as the entire word after you press the Spacebar or a punctuation key.
· None: JAWS remains silent as you type. 
Character echo is the default factory setting. Typing echo can also be temporarily changed by pressing insert 2 on the number row and toggling through the four choices. 
I will only cover changing the default in Settings Center. Steps are:
1. Starting in any application, press Insert 6 to open the Settings Center.
2. Press Control Shift D to make a default change for all applications. 
3. Type “echo” in the search box, minus the quotes.
4. Down arrow to Typing echo where the default is Characters. 
5. Press the Spacebar several times to cycle through the choices, and stop on your choice. 
6. Tab to the OK button and press Enter.
8.1.1.3 Detect Languages 
JAWS sometimes starts reading text with foreign language pronunciation, making it incomprehensible. You can turn this off in either Settings Center or Quick Settings. I will do it in Quick Settings. Steps are:
1. Press Insert V to open Quick Settings.
2. In the search box, type in the first few letters of “language.”
3. Down arrow to the Language detection checkbox and press the Spacebar to uncheck it.
4. Tab to the OK button and press Enter.
Text should now read normally in your default language.
8.1.1.4 Speak Dollars 
When turned on, numbers preceded by a dollar sign are read using the dollars and cents format. For example, “dollar three point nine five” will be read as “three dollars and ninety five cents,” thus making it sound more like when spoken aloud.
Change this in Settings Center as follows:
1. Starting in any application, press Insert 6 to open the Settings Center.
2. Press Control Shift D to make a default change for all applications.
3. Type “the first few letters of “dollar” in the search box. 
4. Down arrow to the Speak dollars checkbox and press the Spacebar to check it.
5. Tab to the OK button and press Enter. 
8.1.1.5 Number Processing 
You can change how JAWS reads numbers. Altering this can make reading more comprehensible depending on whether it is a phone number, serial number, code of some sort, or just a big number. Choices are:
· Controlled by synthesizer: Leaves it up to JAWS to figure out how numbers are read. This is the default. 
· Single digits: Reads numbers as a series of single numbers. 
· Pairs: Reads numbers as a series of paired numbers. 
· Full numbers: Reads numbers as complete numbers. 
To change this setting:
1. Press Insert 6 to open Settings Center.
2. Type the first few letters of “number processing” in the search box.
3. Down arrow to Number processing and press the Spacebar to cycle to your choice.
4. Tab to the OK button and press Enter.
8.1.1.6 Disabling and Enabling the JAWS Voice Assistant 
Beginning with JAWS 2021, the Voice Assistant allows speech input for executing selected JAWS commands. It can be initiated by voice or a keystroke combination. To initiate it by voice, say “Hey Sharky.” You will then hear a short noise, after which you concisely speak the command. The same short noise will repeat, indicating that the command has been executed. You can also enable it with the keystroke combination Insert Alt Spacebar, all held down together. You will hear the same noises as when you initiate it by voice. 
The Voice Assistant is enabled by default. On occasion, you may start it by mistake. If you want to disable it, do the following:
1. Starting in any application, press Insert 6 to open the Settings Center.
2. Press Control Shift D to make a default change for all applications. Note that this cannot be done for individual applications. 
3. Type “voice ” in the search box. 
4. Down arrow to the Enable Voice Assistant checkbox and press the Spacebar to uncheck it. 
5. Tab to the OK button and press Enter. 
In these search results, if you Down arrow one more time, there is an Enable Voice Assistant sounds checkbox. You can enable the Voice Assistant and disable sounds if you only wanted to use the Insert Alt Spacebar key combination to enable it. If I were in an office setting, I might be a bit embarrassed to have colleagues hear me say “Hey Sharky” periodically through the day. 
To reenable the Voice Assistant, just repeat the steps above, this time checking the checkboxes. 
Provided you are running JAWS 2021 or later, to learn more about the array of JAWS keystrokes that can be invoked using the Voice Assistant, visit Chapter 1.2.2.2 on how to access JAWS Help topics. On either the Contents page tree view or on the Search page, you can find information about using the Voice Assistant. Several tables with available voice commands are presented on that page. This list is expected to expand as this feature is further developed. Just a few examples of voice commands you can speak are Links list, Settings Center, and Quick Settings.
8.1.2 Word Customizations 
While all of the customizations described so far in this chapter are relevant for multiple applications, including Word, the customizations in this next section tend to be more applicable to Word than to other applications.
8.1.2.1 Comments, Footnotes, and Endnotes Detection
As you navigate through a Word document, JAWS can announce when it encounters a comment, footnote, or endnote. To access the various options:
1. Press Insert V to open Quick Settings.
2. In the search box, type the first few letters of “comments, footnotes, and endnotes detection.”
3. Down arrow to the Comments, footnotes, and endnotes detection checkbox and press the Spacebar to cycle through the four choices, which are:
· On: Comments, footnotes, and endnotes are announced as you navigate through the document. This is the default.
· Off: Comments, footnotes, and endnotes are not announced. 
· On + Count: The number of Comments, footnotes, and endnotes on the current line is announced.
· On with Text: Choose this option if you want to hear the full text of comments, footnotes and endnotes as you navigate through the document.
4. After making your selection, Tab to the OK button and press Enter. 
It is important to note that comments, footnotes, and endnotes are not actually located at the place where they are referenced as you navigate through the document. You will need to access them using the related commands in the References tab of the Word ribbons. 
8.1.2.2 Outline Level Indication
This option controls whether to indicate outline levels while reading through a Word document or Outlook message. For example, when you encounter bulleted and numbered lists, JAWS says “level one.” JAWS says “level zero” when you navigate past the list and return to normal paragraph style. This setting is turned on by default. Many people prefer to switch off this verbosity. Yet it can be helpful in situations where you have several levels present in bulleted and numbered lists. This setting can only be changed in Quick Settings. From Word or Outlook steps for switching it off are:
1. Press Insert V to open Quick Settings.
2. Type “outline” in the search box.
3. Down arrow once to the Outline level indication checkbox and press the Spacebar to uncheck it. 
4. Tab to the OK button and press Enter. 
Try this out with your cursor situated in one of the many numbered or bulleted lists in this book. 
8.1.2.3 Indentation
This option controls whether or not JAWS indicates the presence of indentation as you navigate through a document. When proofreading, this can be useful to be sure you have not accidentally added tabs or spaces. It can be changed in both Settings Center and Quick Settings. Most of the time, you will want to do this for Word only, so we will use Word in Quick Settings as an example. Steps are:
1. While in Word, press Insert V to open Quick Settings.
2. Type “indent” in the search box.
3. Down arrow once to Indentation. The default setting is Ignore.
4. Press the Spacebar once to select Indicate.
5. Tab to the OK button and press Enter.
When a change in indentation occurs, you will hear things like:
· “Two spaces,” indicating the location of a bullet or number at the beginning of the first line of a hanging indent of one-quarter inch.
· “Five spaces,” indicating the location of the first character in the second line of a hanging indent of one-half inch.
· Left margin,” indicating that you have returned to non-indented text aligned with the left margin.
To hear JAWS express the cursor position more precisely in inches, press the Alt and Delete keys together. You will hear the position of the cursor relative to the left and top edges of the page, as well as the page number. For example, you may hear “PC cursor active, one inch from left, 2.9 inches from top, page three.” If your page has normal margins of one-inch, this indicates that your current cursor position is flush with the left margin, and 1.9 inches from where text begins at the top of the page.
When finished proofreading, repeat the steps above to restore the Ignore setting. 
8.1.2.4 Indicate Capitalization
When proofreading a document, temporarily changing this in either Settings Center or Quick Settings can be useful for checking for correct capitalization. The presence of capitalization will be indicated by a higher pitch voice than for lower case letters. I will describe steps using Quick Settings.
To have capitalization indicated in Say all mode:
1. Press Insert V to open Quick Settings.
2. Type the first few letters of “capitalization” in the search box.
3. Down arrow once to Capitalization, where it will say “ignore” if still in default mode.
4. Press the Spacebar once for it to say “indicate.”
5. Tab to the OK button and press the Spacebar.
When finished proofreading, repeat the above steps to return to ignore when in Say all reading mode. 
You can also be more granular in how you have capitalization indicated. There are four options:
· On character: This indicates capital letters only when reading by character and when spelling. This is the default.
· Never: Select this if you do not want JAWS to indicate capital letters. 
· On word and character: JAWS indicates capital letters when reading by word or character, and when spelling. 
· On line, word, and character: JAWS indicates capital letters when reading by line, paragraph, word, and character, and when spelling. This is the best choice for proofreading. 
Steps for changing this setting for the current application are:
1. Press Insert V to open Quick Settings.
2. Type the first few letters of “capitalization” in the search box.
3. Down arrow to Indicate capitalization and press the Spacebar to cycle to your choice.
4. Tab to the OK button and press Enter.
Here too, when finished proofreading, you will want to change back to the default setting of indicating capitalization by character only, because the preferred proofreading setting can be very distracting.
8.1.3 Outlook Customizations 
When you open Outlook messages, there may be a great deal of verbosity that you may find distracting. Default settings were switched in a recent version of JAWS (either 2020 or 2021), so this excess verbosity may no longer be the default on your computer. Useful changes you can make in Quick Settings are. 
8.1.3.1 Reading Options
Even though you have already heard in the Inbox the name of the sender, the subject, and various other things for a given message, you may hear much of this information repeated when you open it. You can reduce this verbosity, as well as have the message automatically start reading by doing the following: 
1. While in Outlook, press Insert V to open Quick Settings.
2. Tab once to the tree view.
3. Down arrow to Reading options and press the Right arrow to open level 1 of the tree view if it is not open already.
4. Down arrow to the Message header field with message announcement checkbox and press the Spacebar to uncheck it. You will no longer hear the name of the sender and message subject repeated. This will greatly reduce message reading verbosity.
5. Down arrow to the Message type announcement and uncheck it if you don’t want to hear indication of whether the message is in HTML or text format.
6. Down arrow to the Link count announcement checkbox and uncheck it if you don’t want to hear how many links are contained in the body of a message.
7. Down arrow to the Messages automatically read checkbox and check it so that messages will automatically read continuously when you open them. 
8. Tab to the OK button and press Enter.
Now open a message and hear the difference. 
8.1.3.2 Layout Tables 
These are tables used exclusively for formatting purposes. You can choose to ignore them or hear information about them (numbers of columns and rows). In many cases, this only introduces excess verbosity and does nothing to improve navigation effectiveness. You change this customization in Quick Settings. Layout tables are often present in Outlook messages, and I prefer to ignore them. 
To access this customization in Outlook’s Quick Settings, you must first be in a window for an existing message, rather than in one that you are currently preparing. Otherwise, this option will not appear in Quick Settings. Logically speaking, just changing the setting so JAWS ignores layout tables should work. Yet I find that it is necessary to turn off all relevant table reading settings. To do this: 
1. Open an existing Outlook message, preferably one with lots of unnecessary table-related verbosity. 
2. Press Insert V to open Quick Settings, and type “table” in the search box.
3. Down arrow to the Layout table ignore checkbox and press the Spacebar to check it.
4. Down arrow to Automatic table titles, and press the Spacebar until it says, “off.”
5. Tab to the OK button and press Enter. 
6. To verify, if you are not already in a message that previously had lots of unwanted table-related verbosity, open one now to see if it has been removed. 
Keep in mind that changing these settings will remove table detection for all messages, including those where you might want table formatting information to be read. In such cases, return to Quick Settings and switch back the above settings. I prefer to leave table reading off because table formatting that is actually useful is relatively rare in outlook messages, or at least in the ones I receive. 
8.1.4 Excel Customizations
8.1.4.1 Cell Text Visibility Detection 
Turning this on alerts you that cell content is partially hidden to sighted users, or “cropped.” You will then either have to reduce the number of characters in the cell or increase column width to accommodate the entire content of the cell. See Chapter 5.8.1 on adjusting column width. This is turned off by default. Steps for turning on cell visibility detection are:
1. From inside the Excel file for which you want to change this setting, press Insert V to open Quick Settings.
2. Type the first few letters of “cell text visibility” in the search box.
3. Down arrow to the Cell text visibility detection checkbox and press the Spacebar to turn it on.
4. Tab to the OK button and press Enter. 
If, for example, you are in cell A5 and there is a text visibility problem, JAWS will announce “cropped right at B5,” indicating that text in cell B5 is partially hiding the text in cell A5. If the text in cell A5 spills over into cell B5, but there is nothing there to crop the text in cell A5, JAWS will say, “overlaps right near B5,” or whichever is the right-most cell A5’s text extends to.
If you now save this file, cell text visibility detection remains on only for this file. You cannot make this the default. You must do it for each file individually. Moreover, as of the writing of this book using JAWS 2021, this setting is inconsistent, and it has been this way with several earlier versions. Often, even after increasing column width the correct amount, JAWS still announces that the cells are cropped.
NVDA does a better job on this, always announcing the presence of cropping. In my opinion, announcing cropping should be the default for JAWS. Otherwise, most JAWS users will not even know there is a problem because JAWS announces all cell content, regardless of whether it is fully visible or not. Also, once column width is adjusted, NVDA reliably indicates that the problem no longer exists. For these reasons, I prefer using NVDA rather than JAWS when column widths may need to be adjusted due to cell text visibility issues.
8.1.4.2 Cell Verbosity 
This option controls whether to announce both cell content and coordinates (that is, cell addresses) or only cell content as you navigate through a spreadsheet. The default setting is to announce both cell content and coordinates. Most of the time you will want full verbosity. However, once you are thoroughly familiar with a particular spreadsheet or are concentrating on data entry, turning off cell coordinates can be a good option, at least temporarily. To change this setting:
1. In Excel, press Insert V to open Quick Settings.
2. Type the first few letters of “cell verbosity” in the search box.
3. Down arrow to this setting which is set as “content plus coordinates” by default. Press the Spacebar once to switch to “content only.”
4. Tab to the OK button and press Enter. 
As with cell text visibility, this cannot be changed to the default, but must be changed for each individual file.
8.1.4.3 Monitor Cells
As discussed in Chapter 8.1.4.3, you can designate up to ten monitor cells or data ranges to enable quick navigation to important areas of your worksheets. In that section, I identified shortcut keys for assigning, reassigning, and navigating to monitor cells. Alternatively, You can assign and reassign monitor cells in Quick Settings, but this is a bit slower. If you wish to remove individual monitor cell assignments, or clear all of them at once, you must do this in Quick Settings. In this section, I will cover how to perform all of these actions.
To assign monitor cells in Quick Settings:
1. Place your cursor on the cell that you want to assign. 
2. Press INSERT V to open the Quick Settings dialog box, and type "monitor" without the quotes in the search box.
3. DOWN ARROW to the Monitor cell 1 unassigned checkbox (assuming that is the one you want to assign), and press the Spacebar to check it. You will hear that it is assigned to the cell you have designated.
4. Tab to the OK button and press Enter. 
To reassign a monitor cell, navigate to the new cell you want to designate as the new monitor cell and repeat the above steps. To clear an individual monitor cell assignment, repeat the above steps to navigate to the monitor cell you want to clear, and press the Spacebar. JAWS will indicate that this monitor cell is now unassigned. And finally, to clear all monitor cell assignments:
1. Press INSERT V to open the Quick Settings dialog box. 
2. Type "monitor" without the quotes. 
3. DOWN ARROW to the Clear checkbox and press the Spacebar to check it. 
4. Tab to the OK button and press Enter. 
[bookmark: _Hlk68691590]8.1.4.4 Comments Announcement
If you use comments or notes in Excel (see Chapter 5.9.2), you can use this option to indicate whether a cell has an associated comment. The default setting is On. To access this setting:
1. While in Excel, press Insert V to open Quick Settings.
2. In the search box, type in the word “comment,” Down arrow to the Comments detection checkbox, And press the Spacebar to check or uncheck it. 
3. Tab to the OK button and press Enter. 
8.1.5 Web Browsing Customizations
8.1.5.1 Forms Fields Entry/Exit Notification Sounds 
By default, when you Enter an edit box or combo box, JAWS makes a sound. JAWS refers to the initial default sounds as “boings.” When you exit an edit field or combo box, JAWS makes a slightly lower pitch boing. For some people, including me, the difference between the two boings is a bit too subtle. I have reset the exit sound with a camera shutter, which is more distinguishable than the initial boing to me. In addition, you can turn the Forms mode entry and exit sounds off. If you do this, when you Enter and exit, JAWS will say “Forms mode on” and “Forms mode off,” respectively. Steps for changing these sounds are:
1. Starting in one of the browsers, press Insert 6 to open the Settings Center for that browser.
2. Press Control Shift D if you want to make changes for all web browsers. This will also include forms in PDF viewers like Acrobat Reader. Skip this step if you want to make changes for only the browser you are in. 
3. Tab once to the tree view, Down arrow to Forms mode, and Right arrow to expand the tree view.
4. Down arrow to the Enable sound notifications checkbox and press the Spacebar to uncheck this if you would rather hear JAWS say “Forms mode on/off” than hear sounds. Then Tab to the OK button and press Enter. 
5. Otherwise, if you want to hear sounds, Down arrow to Select sound for leaving Forms mode, and press the Spacebar.
6. Down arrow or first-letter navigate to the sound you want to select. For example, press C for camera shutter. 
7. Either press Alt P, or Tab once and press the Spacebar to hear a sample of this sound. 
8. Tab to the OK button to accept.
9. Tab to a second OK button to save the change and exit Settings Center. 
8.1.5.2 Forms mode Customization
You can choose among three ways to enter and exit Forms mode: auto, semi auto and manual. Auto is the default. Semi-auto and manual are generally more appropriate for experienced users.
It can be useful to know how to change between these modes because of requirements of different applications. One example is Google Drive, where files and folders used in the Google Suite applications are managed and stored. You must change to manual to make Google Drive accessible. 
When set to auto mode, JAWS automatically enters Forms mode when you press Tab, Shift Tab, or the Up and Down arrow keys to move to an edit field. To indicate you have entered Forms mode for edit fields and combo boxes, you will hear a boing. When finished with the edit field or combo box, you can press ESC to exit Forms mode. With edit fields, you can also press UP or DOWN ARROW to exit Forms mode. You will hear a lower pitch boing when exiting edit fields and combo boxes. This assumes you have not disabled Forms entry/exit sound notifications discussed in the previous section.
Choosing manual prevents JAWS from automatically placing you in Forms mode as you navigate using any of the commands including the Tab Key. When you move into an edit field or combo box, you must press ENTER first to type text or select a combo box choice. To manually exit Forms mode, press the Escape key.
Semi-auto is a hybrid of auto and manual. You will only enter Forms mode if you land on a control while navigating with Tab or Shift Tab. Forms mode will not be activated if you navigate with the ARROW keys or navigation quick keys. You must manually exit Forms mode when semi-auto is active. 
To access and change Forms mode options:
1. Starting in one of the browsers, press Insert 6 to open the Settings Center for that browser.
2. Press Control Shift D if you want to make changes for all applications. Skip this step if you want to make changes for just that one browser. 
3. Tab once to the tree view, Down arrow to Forms mode, and Right arrow to expand this level of the tree view.
4. Down arrow once to Select Forms mode, and press the Spacebar to cycle between the three choices: auto, semi-auto and manual. 
5. After making your choice, Tab to the OK button and press Enter.
[bookmark: _Hlk62903838]8.1.5.3 Automatic Web page Reading
By default, when you open web pages, JAWS begins to read continuously from the top of the page. This creates excess verbosity. You wind up constantly hitting the Control key to stop the computer from yapping. This can be turned off as follows:
1. Starting in one of the browsers, press Insert 6 to open Settings Center for that browser.
2. Press Control Shift D to make a default change for all applications.
3. Start typing the word “document” in the search box. You will only need to type the first two or three letters for the full search term to autofill.
4. Down arrow to the Document and web pages automatically read when loaded checkbox, and press the Spacebar to uncheck this.
5. Tab to the OK button and Press the spacebar.
When a web page loads, JAWS will now tell you the page title and the number of regions, headings and links on the page, and then stop speaking. This is useful information to have, and it is nice that this is all you hear before JAWS stops talking.
Note that if you make this a setting for all applications, it will also operate when opening PDF files with a PDF viewer like Adobe Acrobat DC. Instead of reading continuously, JAWS will be silent. You will need to use standard reading keystrokes to start reading the PDF.
8.1.5.4 Say All Scheme 
When reading text on the web, sometimes constant interruptions with announcements of links and headings becomes annoying. Wikipedia articles are good examples. There may be as many as 5 or more links in a single sentence, making it hard to concentrate on hearing the text. You can turn off heading and link announcement in Say all mode so that you can focus on listening to the text only. You can still hear headings and links announcements when not in Say all mode. Steps are:
1. Starting in one of the browsers, press Insert 6 to open Settings Center for that browser.
2. Press Control Shift D to make a default change for all applications. 
3. Type “scheme” in the search box.
4. Down arrow to Select scheme where the default is no change. Press the Spacebar until you hear “say all text only.”
5. Tab to the OK button and press Enter to make the change.
8.1.5.5 Audio Ducking 
Enabling Audio ducking is useful when listening to audio that can compete with the JAWS voice. Listening to music or a video in YouTube is a good example. Or if I am stuck in an especially boring Zoom meeting and want to check my emails, I am thankful that Audio ducking exists. With Audio ducking enabled, audio volume from other programs is temporarily lowered (or “ducked”) while JAWS speaks, allowing you to more easily hear the JAWS voice which remains at full volume. Audio-ducking can only be set for all programs. Steps for enabling Audio ducking are:
1. Starting in any application press Insert 6 to open the Settings Center.
2. Press Control Shift D to make a default change for all applications. 
3. Type either “audio” or “volume” in the search box.
4. Down arrow to the Lower audio volume of programs while JAWS speaks checkbox, and press the Spacebar to check it. 
5. Tab to the OK button and press Enter. 
To temporarily enable or disable Audio ducking, press Insert and the Spacebar together, followed by D to toggle Audio ducking on and off. While it is possible to turn Audio ducking off, I cannot think of any reason why a JAWS user would ever want to disable it. 
8.1.5.6 Inline Frames Reading 
Inline frames are most commonly used to display advertisements. In such situations, JAWS may read what appears to sound like gibberish to a non-sighted screen reader user. Turning off the reading of frames can clean up web page clutter, thus facilitating a smoother browsing experience. To be sure it works, first navigate to a web page with ads. CNN.com is a good place to try it out because this site usually displays several ads. Press M which is the JAWS quick key to navigate to the next frame, or Insert F9 which displays a list of frames and tells you how many are present on the page.
Steps for changing this setting are:
1. Starting in one of the browsers, press Insert 6 to open the Settings Center for that browser.
2. Press Control Shift D to make a default change for all applications if this is what you want to do. 
3. Type “frame” in the search box.
4. Down arrow to the Ignore inline frames checkbox, and press the Spacebar to check it.
5. Tab to the OK button and press Enter. 
6. Back on the web page you are testing, press M again. JAWS should say “there are no frames on this page,” indicating that they are no longer detected.
8.2 NVDA Customizations 
Some of the customizations listed above for JAWS are possible with NVDA. They are accessed in the Document Formatting, Speech Settings and Browse mode dialog boxes in the NVDA menus. Only global customizations can be made, not application-specific ones. Add-ons can also be downloaded and installed to extend NVDA functionality. 
8.2.1 Customizations in the Document Formatting Dialog 
You can change which elements are detected when navigating the web. To access the Document Formatting dialog box, you can either use the shortcut Insert Control D, or go in via the NVDA menus. To access this dialog box through the menus:
1. Open the NVDA menus by pressing Insert N. 
2. Down arrow to the Preferences submenu and press Enter. 
3. Press Enter on Settings.
4. Down arrow to or first-letter navigate to Document Formatting. 
5. Press Tab to move through the choices which are organized in groups. Press the Spacebar to check or uncheck your choices. Relevant settings for web browsing are contained in the Elements Group, and include headings, links, graphics, lists, block quotes, landmarks, frames, and a few more.
6. Tab to the OK button and press Enter. 
Most of the time, you will want these elements to remain checked (the default), especially headings and links. Unlike with JAWS where reading of these elements is only turned off in Say all mode, when you uncheck them in NVDA, they are no longer detected in any reading mode. 
8.2.2 Customizations in the Speech Settings Dialog Box
Punctuation levels can be altered here, and Audio ducking can be enabled and disabled. NVDA punctuation levels are identical to those for JAWS (none, some, most, and all). The default is some. To change punctuation levels:
1. Open the NVDA menus by pressing Insert N. 
2. Down arrow to the Preferences submenu and press Enter.
3. Press Enter on Settings.
4. Down arrow or first-letter navigate to Speech. 
5. Tab to the Punctuation level combo box, and Up or Down arrow to your choice.
6. Tab to the OK button and press Enter.
NVDA has three Audio ducking choices: 
· No ducking: Disables Audio ducking.
· Duck when outputting speech and sounds: NVDA lowers the volume of other audio when NVDA is speaking or playing sounds. This may not work for all synthesizers.
· Always duck: The volume of other audio will remain lower the whole time NVDA is running.
To change Audio ducking settings:
1. Open the NVDA menus by pressing Insert N. 
2. Down arrow to the Preferences submenu and press Enter. 
3. Press Enter on Settings.
4. Down arrow or first-letter navigate to Speech. 
5. Tab to the Change button and press the Spacebar.
6. Tab to the Audio ducking combo box and Up or Down arrow to your choice. 
7. Tab to the OK button and press Enter.
8. Tab to a second OK button and press Enter.
Audio ducking can be temporarily changed using the Insert Shift D key combination. 
8.2.3 Customizations in the Browse Mode Dialog Box
In this dialog box, you can turn sounds off for entering and exiting form fields. You can also stop NVDA from automatically reading a web page when it is loaded. To access this dialog box and change these settings, do the following:
1. Open the NVDA menus by pressing Insert N. 
2. Down arrow to the Preferences submenu and press Enter. 
3. Press Enter on Settings.
4. Down arrow to or first-letter navigate to Browse mode. 
5. Tab to Automatic say all and press the Spacebar to uncheck it if you don’t want web pages to be automatically read when loaded.
6. Tab to Audio indication of focus in Browse mode and press the Spacebar to uncheck it if you don’t want to hear sounds when entering and exiting form fields. 
7. Tab to the OK button and press the Spacebar to save your changes. 
If you turn off the Automatic say all setting, when you load a new page, NVDA will tell you the web page title, and then say “clickable” and the label of the first link on the page. It will then stop speaking. If you turn off Audio indication of Browse mode, instead of hearing noises when entering and exiting form fields, NVDA will say, “Focus mode” when entering form fields and “Browse mode” when exiting them.
8.2.4 NVDA Add-Ons
NVDA has a large number of add-ons for extending its functionality. These can be download at the NVDA Community Add-ons website, a page easily navigated using headings. As of the writing of this book, there were almost one hundred add-ons available on this page. 
To find information on an add-ons and download it to your PC:
1. On the heading for the add-ons (which is also a link), press Enter to open the web page for that add-ons. 
2. Press H to go to the level one heading. Under the heading, you can find information about how to use the add-ons.
3. To download it, press Enter on the Stable version link. The installation file will be downloaded to your Downloads folder.
4. Now in NVDA (you can use any screen reader to execute the above two steps), press Enter on the downloaded file.
5. A User account dialog pops up asking you to confirm if you want to install this add-ons. Tab twice to the Yes button and press Enter. The add-ons will quickly be installed. 
6. NVDA prompts you to close and reopen NVDA to enable the add-ons to be activated. Press Enter on the Yes button to do this. 
To manage add-ons:
1. Press Insert N to open the NVDA menus, Down arrow to the Tools submenu, and press Enter.
2. Down arrow to Manage add-ons and press Enter. 
3. You land in the Installed add-ons combo box where those add-ons that have already been installed are listed.
4. Down or Up arrow to one of the add-ons
5. From here you can Tab to buttons and links for accessing help and information about the add-ons, disabling it, removing it, and getting more add-ons (this opens the NVDA Community Add-ons page mentioned above). 
Here are a few add-ons you may want to try out:
· Zoom Accessibility Enhancements: This add-ons provides keyboard shortcuts to handle alerts for different events while in a meeting and makes the process of using remote control more accessible.
· systrayList: This enables the Insert F11 key combination to open the System Tray and allows NVDA users to received similar audio feedback as when using JAWS.
· Say Product Name and Version: Press Insert Shift V to hear the version of the software running in the open window. Press this key combination twice to copy this text to the Clipboard so that you can paste it elsewhere. 
· Placemarkers: See Chapter 7.10.2.2 on how to use this add-ons for creating placemarkers on web pages with NVDA.
8.3 Narrator Customizations
The array of Narrator customizations are more limited, but there are still a number of useful ones. Several of them can be quickly and easily activated with shortcut keys. 
8.3.1 Verbosity Levels
You can change verbosity levels for indicating formatting and punctuation. Verbosity levels for text reading including formatting, can be changed in the Narrator Settings menu or with a shortcut key. Change them in the menus as follows:
1. Press Control Windows N to open Narrator Settings. 
2. Tab to the Change the level of detail Narrator provides about text and controls combo box. 
3. Up and Down arrow through the five options, ranging from text only to all text details. Press Enter on text only to select the least encumbered reading experience, or press Enter on All text details when proofreading document formatting. 
Alternatively, you can use the shortcut key Insert V to cycle between these choices.
You can change the amount of punctuation verbosity that Narrator reveals by pressing Insert Alt Plus or minus on the number pad. Verbosity levels are:
· Default: Reveals little to no punctuation. Natural pauses will indicate items such as commas and periods.
· Math: Reveals most mathematical symbols.
· Some: Reveals most conversational punctuation, such as commas and periods.
· Most: Reveals additional symbols, such as parentheses.
· All: Reveals all punctuation, including all special symbols. This is the best choice when proofreading a document. 
8.3.2 Audio Ducking 
In Narrator Settings, you can customize Audio ducking. First, press Control Windows N to open Narrator Settings. Then Tab to the Lower the volume of other apps when Narrator is speaking checkbox and press the Spacebar to enable Audio ducking. You are done. There is no final OK button in this dialog box.
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[bookmark: _Hlk76732871]All three screen reader programs have useful tools for proofreading text. This chapter will begin by discussing spellchecking, the most important tool for correcting typing mistakes and some grammatical errors. In Chapter 3.5, I covered styles. Using styles for font and paragraph formatting will ensure more consistent document formatting. Using the proofreading tools in this chapter will further ensure you are formatting documents consistently and correctly. 
The JAWS Text Analyzer utility is used primarily for correcting punctuation mistakes, although it can also be used for detecting font formatting inconsistencies. The JAWS Speech and Sounds Schemes tool is a powerful way to detect font formatting errors. The NVDA Document Formatting and Narrator Verbosity utilities detect a wide array of format settings. They are easy to use and will detect numerous errors that you otherwise might have failed to detect. If you consistently use these tools, in combination with spellcheck and styles, you will cut down substantially on typing, punctuation, and formatting errors. Your documents and email messages will have a more professional look. 
Most of the tools covered in this chapter can be used for both proofing Word documents and Outlook messages. That said, I vastly prefer doing the bulk of text composition and formatting in Word. If I want to prepare an Outlook message longer than two or three sentences in length, it is more efficient and reliable to first prepare the text in Word. Once finalized, I then select and copy the text from Word and paste it into the body of an email message. Experience has taught me that too many things can go wrong when preparing and formatting text in an Outlook message. First, your unfinished message can disappear without you ever knowing why, forcing you to start over. Second, I mentioned in Chapter 4.8.1 that the Outlook Drafts folder is dysfunctional with Gmail accounts, my own included. I have little confidence that when a message contained in this folder is ready to go that I will be able to send it off smoothly. I avoid saving unfinished messages to the Drafts folder whenever possible. Instead, I save the text as a Word file until ready to copy and paste it into an Outlook message. Third, as of the writing of this book, all versions of Outlook use the older 2013/2016 Word Spellcheck utility. I prefer the newer 365/2019 version, so like to spellcheck in Word rather than Outlook. And finally, even though default fonts are identical between Word and Outlook (Calibri 11 point), a single line of text in an email message is much longer than in a Word document. To test this, I copied and pasted the beginning lines of this paragraph into a blank Word document and the body of an email message. The first line of the email message contained 47 words while only 17 words were contained in the first line of the Word document. This makes text editing more time-consuming in Outlook because of the longer distance needed to navigate within message lines to get to the text to be edited. 
As you will see below, the PowerPoint Spellcheck utility works very poorly. Here too, I prefer to do the bulk of my PowerPoint editing in Word first, and then copy and paste the text into PowerPoint.
Other people often review documents that you prepare. This is of course a central role for teachers. You may also collaborate on documents with co-workers on a team. Word has two useful tools for use in these contexts. Comments can be electronically inserted into documents by reviewers. You will need to know how to access and delete them, as well as how to prepare comments yourself. Teachers or collaborators may also suggest specific text changes. The Track Changes (also known as Revisions) tool enables you to detect these editing suggestions, as well as accept or reject them. 
[bookmark: _Toc1629863]9.1 Spellchecking
Spellcheck your work early and often to correct typos. Keep in mind that when a sighted person sends out a document with lots of typing errors, other sighted people think it’s just because that person is sloppy. When a visually impaired person does this, some sighted folks will take pity, assuming that because he or she is blind they just can’t do any better. Prove them wrong!
I will first discuss spellchecking Word documents and Outlook messages, the two applications where you will presumably do the bulk of your spellchecking. I will then discuss spellchecking Excel spreadsheets and PowerPoint presentations.
The Spellcheck utility has evolved over the years. One interesting challenge is that the Spellcheck dialogs differ between the Office programs, even for Office 365. Word uses the version that came with Word 2019, Outlook and PowerPoint use the 2016 version, and Excel uses the 2010 version. Hopefully sometime soon, Microsoft will make all Office Suite applications consistent, using the 2019 version, the one I consider best.
9.1.1 Spellchecking in Word and Outlook
There are several versions of Spellcheck for Word: a 2013/2016 version and a 365/2019 version. As of the writing of this book, Outlook uses just the older 2013/2016 version used by Word.
9.1.1.1 2013 and 2016 Spellcheck in Word and Outlook
To start spellchecking, press F7. If you are not sure whether you have the old or new version, the first time you Press F7, if you have the older version, you will land on the Ignore button in the Spellcheck dialog box. 
When you start Spellcheck with F7, Word jumps to the first word or grammatical construction that it thinks is misspelled or incorrect. It will first read the misspelled word, letter by letter, and then the suggested correct spelling, letter by letter. If Spellcheck thinks it has encountered a grammatical error, it will explain the error and suggest a change. One example is extra spaces between words. As mentioned above, the first time you Press F7 while spellchecking, you will land on the Ignore button. For all subsequent times, you will land on the button you previously hit. In other words, you will land in different places in the dialog box while spellchecking. Therefore, it’s a good idea to know the order in which the buttons appear in the dialog box. Here’s a list of the buttons you can move through with Tab and Shift Tab in their correct order, their corresponding shortcut keys, and what they do.
· Change (C): Accept suggested correct spelling.
· Change All (L): Accept suggested correct spelling for all occurrences of this misspelled word in this document.
· Ignore (I): Ignore suggested spelling change and retain current spelling.
· Ignore All (G): Ignore suggested spelling change for all occurrences of this spelling in this document.
· Add (A): Add this word to the permanent dictionary.
· Change combo box: List of suggested spelling changes. Down arrow to move to the correct option, Tab once to the Change button, and press the Spacebar to accept. 
In the dialog box, you have the option of pressing Tab to get to the button you wish to select and pressing the Spacebar to activate it. Or you can press the shortcut key for that button, provided that your cursor is not already situated on that button. That’s the theory. In practice, the first option often works more cleanly than using the shortcut key. 
Inevitably, you will encounter glitches. Here are a few common ones and their potential solutions:
· The screen reader fails to read the incorrect and suggested correct spelling. With JAWS, you can press Insert F7 and JAWS will hopefully say it this time. This does not work with NVDA or Narrator. With these screen readers, press Escape to get out of The Spellcheck, and press F7 to get back in. Hopefully, you will hear the information this second time. 
· No spelling suggestions are given. Press Escape to get out of Spellcheck. Your cursor will be situated on the line with the supposed spelling or grammatical error. Read through it and make the correction manually. If you Escape to get out of Spellcheck, your previous corrections are not lost. When you Press F7 to resume spellchecking, you will come back into it right where you left off. 
· While not a glitch, sometimes you don’t have enough context to know if you should accept the suggested spelling change. With JAWS, press Insert C (for context) and JAWS will read the full line where the word is located. This should help you make the right choice. 
· Alternatively, with any of the screen readers, press Escape to get out of Spellcheck, press the Up arrow once and the Down arrow once. This will read you the entire line. With JAWS, you can press Insert Up arrow once and JAWS will read you the current line. With NVDA, you can read the current line by pressing Num Pad 8. With Narrator, press either Insert I or Insert Up arrow. Now press F7 to get back into Spellcheck and you will return to exactly where you left off. 
9.1.1.2 2019 or 365 Spellcheck in Word
In my opinion, the Word 2019 or 365 version of Spellcheck is a big improvement over earlier versions for two reasons. First, it automatically gives much more contextual information, so you can quickly decide whether or not to accept suggested changes. Second, you always land in the same place in the dialog box, rather than on the previously-activated button. This is less confusing than with the older version. 
As with the older version press F7 to start the Spellchecker. For documents of one hundred words or more, you will first hear a percentage calculation of correct spellings in the document. If no spelling or grammatical errors have been detected, you will instead hear “no issues found” 
If errors have been detected, press the Spacebar to start spellchecking. In the Tab order, here’s what you will encounter in the dialog box:
· Your screen reader will read the misspelled word letter by letter, and then the suggested correct spelling, letter by letter. It will then read you the phrase or sentence where that word appears, giving you immediate contextual information. You can press Enter to accept the change and move to the next misspelling, or you can press Tab twice to move to a split button and press the Spacebar on that to accept the change. 
· Read original sentence button: Press the Spacebar on this button and the full sentence where the word appears will be read back to you, giving you additional contextual information.
· A split button with the first suggested spelling or grammar correction. Press the Spacebar to accept or Press Alt Down arrow for more options. Options include hearing the word read back to you again, letter by letter spelling, a change all button, and a few other options.
· Additional split buttons you can move through by tabbing if there is more than one suggested correct spelling. 
· Ignore button (I)
· Ignore all button (G)
· Add button (A)
While the above may sound a bit complicated, with practice you will quickly get used to whichever Spellcheck utility you have.
9.1.1.3 Customizing Spellcheck in Word and Outlook
By default, spelling errors are announced as you type by making various sounds. Also by default, when you run the Spellcheck utility, possible grammar errors are also announced. Some people (myself included) prefer not to hear spelling errors announced as they type. It may make it harder for them to concentrate on writing content. It may also compel them to correct spelling errors one by one rather than using the Spellcheck utility which is a more efficient way to correct errors. Many people don’t want the distraction of checking grammar, instead using this utility exclusively for detecting and correcting spelling errors, and thus speeding up the whole process. Spellcheck can be customized in the Proofing part of the Word and Outlook Options categories. How you get there is slightly different between the two applications. 
To navigate to the Proofing dialog in Word and make the above-mentioned changes:
1. [bookmark: _Hlk93584613]Press Alt F t to access the Options categories list.
2. Down arrow or press P to first-letter navigate to the Proofing category.
3. Tab to the Check spelling as you type checkbox, and press the Spacebar to uncheck it if you do not want to be notified about grammar errors while you type.
4. Tab to the Mark grammar errors as you type checkbox, and press the Spacebar to uncheck it if you do not want to be notified of spelling errors while you type.
5. Tab to the Check grammar and refinements in the editor pane checkbox and press the Spacebar to uncheck it if you do not want grammar errors detected while running the Spellcheck utility.
6. Tab to the OK button and press Enter. 
To make the same changes in Outlook:
1. Press Alt F t to access the Options categories list.
2. Down arrow once to the Mail category.
3. Tab once to Editor options and press Enter. This lands you on the Proofing dialog. 
4. Repeat steps three through five above.
5. Tab to the OK button and press Enter.
6. Shift Tab to a second OK button and press Enter.
9.1.2 Spellcheck Excel Spreadsheets
Spellchecking Excel spreadsheets with the three screen reader applications requires a few workarounds. As with Word or Outlook, start Spellcheck by pressing F7. The Spellcheck utility will detect the first perceived misspelling from where your cursor is situated. You first land on the Suggested language combo box in the Spellcheck dialog. And guess what? This is not the 2019 or 2016 Spellcheck dialog, but the one from Office 2010 and earlier!
Unlike in Word, you will not first hear the misspelled word and suggested correct word, letter by letter. If you just want to hear the suggested replacement spelling, Shift Tab once to the list of suggested corrections. You will hear the first recommended word, and JAWS will spell it out. With NVDA and Narrator, press Caps Lock and Numpad 5 twice to hear it spelled out character by character. You can also Down arrow to alternative choices. To accept a spelling change, press Enter on it. 
Other elements of the Spellcheck dialog resemble those of the Word/Outlook 2010 version. Fortunately, it is not that different from newer versions. Instead of tabbing, you can use the following shortcut keys:
· Alt C: Change (accept the suggested correction).
· Alt L: Change all.
· Alt I: Ignore once.
· Alt G: Ignore all.
· Alt A: Add to dictionary.
How to hear misspelled words varies between the screen readers. With JAWS, press Insert F7 and JAWS will spell out both the misspelled word and suggested correct choice. 
To hear the misspelled word with NVDA, after landing on the Suggested language combo box, Shift Tab twice to Not in dictionary. Then Down arrow once to hear the word spoken in its entirety. Now Left and Right arrow to hear it spoken character by character. You can also use this technique with JAWS if you can’t remember the Insert F7 keystroke mentioned above.
with Narrator, hearing the misspelled word character by character is a bit more cumbersome. As above, Shift Tab twice after landing on the Suggested language combo box. You will hear the misspelled word in its entirety. Press Caps Lock plus Numpad five twice to hear it spelled out. Unfortunately, you will first hear "not in dictionary” spelled out before hearing the misspelled word. If you do not have a number pad, press Caps Lock and K twice. 
If you start spellchecking with your focus on a cell other than A1, when you get to the last misspelled word on the sheet, you will be asked if you wan to continue checking from the beginning. Press the Spacebar if you want to do that; otherwise, press Escape to exit the Spellcheck utility. To spellcheck workbooks with multiple sheets, you must perform it in each individual worksheet. 
9.1.3 Spellchecking PowerPoint Presentations
Spellchecking in PowerPoint works poorly in conjunction with screen reader programs. It is possible to use it with a rather awkward JAWS workaround. While I am aware of an NVDA workaround, I was not able to replicate it, and even if I could, I sensed that it was simply not worth the effort. To the best of my knowledge, no Narrator workaround exists, and if there is one, here too, I doubt it is even worth even trying.
Before discussing the JAWS workaround, I strongly suggest you do one of the following two things instead. First, simply check your spelling while preparing your presentation and make corrections manually. PowerPoint presentations should not be too wordy, so there is not nearly as much to check as with a lengthy Word document. If you are a decent speller, this should probably suffice. Better yet, prepare your text and any speaker’s notes in Word, including spellchecking it there. Then copy the text from Word and paste it into the individual placeholders. 
Regarding the JAWS workaround, if you want to try this out, you can use the practice file entitled “Disclosure and Accommodations.badly spelled.ppt.” 
when you invoke the Spellchecker with F7, two weird things happen. First, focus does not immediately land on the Spellcheck dialog. You must press Tab to place focus on it. And second, you either hear nothing or just the word “edit.” You do not hear the incorrectly spelled word and the proposed correct spelling. To hear the misspelled word and the suggested correction, press Insert F7, and JAWS will say them.
Now press Tab or Shift Tab to go to whichever button you want to choose (change, ignore, etc.) and press it.
Let’s say you pressed the Change button to accept the proposed correction. This brings you to the next misspelled word and the same problems occur again. You must Tab once, which places focus on the Change All button. Press Insert F7 again to hear the misspelled word and proposed correction. If you want to accept it, press Shift Tab once and then the Spacebar on the adjacent Change button.
Assuming that you will be accepting the bulk of the suggested changes, you can perhaps develop a rhythm of Tab, Insert F7, Shift Tab, Spacebar, Tab, Insert F7, Shift Tab, Spacebar, and so on. And if you are a decent typist with a reasonably good grasp of spelling, it is not so unwieldy.
9.2 Detecting Punctuation Errors
Spellcheck detects extra spaces between words, but this is the only type of punctuation error it finds. Nor is it entirely dependable for finding all occurrences of this type of punctuation error. Fortunately, there are better tools for detecting an array of punctuation errors. Before describing these below, keep in mind that when proofreading, it can be useful to adjust screen reader settings to read all punctuation. How to make these changes was covered in Chapters 8.1.1 for JAWS, 8.2.2 for NVDA, and 8.3.1 for Narrator.
9.2.1 JAWS Text Analyzer 
Text Analyzer is especially valuable for detecting punctuation errors, although it can also be used for checking font formatting. NVDA and Narrator have no comparable tool.
Hold down Alt Windows I together and Text Analyzer will jump to the next punctuation error or format change, which it calls an “inconsistency.” It will also announce a column number (as in, “space run at column 473”), but this has no practical value. Your cursor is placed in the text where the perceived error is located. Left or Right arrow a few times in this vicinity to find exactly where the problem is and do your edits. Press Alt Windows I again to jump to the next inconsistency, and continue on until Text Analyzer says, “no more inconsistencies in document.”
Punctuation errors that Text Analyzer detects include: 
· Space runs: Extra spaces between words. Also detects incorrectly placed tabs.
· Stray punctuation: Periods, commas, and other punctuation marks with at least one space between them and preceding characters.
· Unclosed/unopened quotes: Missing quotation marks at beginning/end of quote.
· Unopened/unclosed parentheses: Mismatched parentheses, i.e., only the left or right parenthesis present with no corresponding right/left parenthesis nearby.
· Missing capitals: No capital letter at beginning of a sentence. 
· Inverted capitals: Inverted lowercase and uppercase letters. For example, the first letter of a proper noun is lowercase while the rest of the word is uppercase. 
With regard to space runs, in principle, Spellcheck detects these too, calling them extra spaces between words. However, Text Analyzer is much more reliable. Recently, I spellchecked several documents, totaling about 25 pages. Spellcheck detected several instances of extra spaces between words. However, when I ran Text Analyzer immediately afterward, it detected additional instances that Spellcheck had missed. 
Text Analyzer will also detect font changes, including font name, size, attributes, and color. This can be useful for detecting unexpected font anomalies. 
You can customize Text Analyzer to choose what you want detected. For example, if you have many headings in your document, you may want to stop it from detecting font changes, so that you can focus on punctuation errors. Alternatively, you may wish to check just font changes if you are expecting few or no font changes in a document, and you want to be sure that you did not inadvertently insert some. I have used Text Analyzer for this and have sometimes been surprised at how many weird and inexplicable font changes have found their way into my documents, even after assiduously updating my normal text style to supposedly prevent such errors.
Text analyzer customization is done in JAWS Settings Center. Steps are:
1. Press Insert 6 (on the number row) to open Settings Center.
2. Press Tab once to get to the tree view.
3. Down arrow or first-letter navigate to Text Analyzer.
4. Right arrow once to expand the tree view where a list of formatting and punctuation categories are listed. These categories are symbols, punctuation inconsistencies, and font changes. 
5. Right arrow on one of these categories to expand its corresponding list in the tree view.
6. Down arrow through the list, pressing the Spacebar to check on or off the items you want detected or not detected. 
7. Open additional categories in the tree view and check or uncheck the items you want detected or not detected. 
When finished, Tab to the OK button and press Enter or Spacebar.
9.2.2 Find and Replace 
While neither NVDA nor Narrator have a tool like JAWS Text Analyzer, you can use Word’s Find and replace dialog to correct some of the punctuation errors mentioned in the preceding section. In fact, if you suspect that the number of space runs or stray punctuation errors may be numerous, it is quicker to use Find and replace to correct them all at once, rather than correct them one-by-one with Text Analyzer. 
To detect and correct space runs using Find and replace, do the following:
1. Press Control H to open the Find and replace dialog. 
2. In the Find edit field where you first land, type in two spaces.
3. Tab once to the Replace field and type in a single space.
4. Tab three times to the Replace all button, and press Enter or the Spacebar. Your screen reader will say, “all done. We made 19 replacements,” or whatever the number is. 
5. Press Enter on the OK button.
6. If you mistakenly put in more than two unwanted spaces between words, this will not delete all the errors. Now press Alt A to perform Find and replace again.
7. Press OK and Alt A until you hear zero replacements. Then press Escape to exit the Find and replace dialog. 
You can also use Find and replace To correct stray punctuation mark errors (commas, periods, colons, and semi-colons). Using stray commas as an example, type space comma in the Find edit field and comma by itself in the Replace edit field. Then repeat steps four through seven above. 
The other types of errors detected by Text Analyzer (unclosed/unopened parentheses and quotes and a few others) cannot be corrected using this method, but using Find and replace is a good way to quickly get rid of a substantial number of common punctuation errors in your documents.
9.3 Proofreading Text Formatting
In Chapter 3.2.1, I covered using Insert F to reveal font and paragraph formatting at individual points of a document or for a segment of selected text. While this is useful for checking formatting at individual points in a document, Insert F does not give a more global view of document formatting. Think of Insert F as a good tool for giving a micro-level glimpse of document formatting. The tools discussed below provide a more complete, or macro, picture. If you discover unintended formatting changes, you can then correct them. 
[bookmark: _Toc1629888]9.3.1 JAWS Speech and Sounds Schemes
The Speech and Sounds Schemes tool helps you detect font formatting changes by telling you what changes have occurred as you navigate through the text. There are several categories of schemes, but we will only discuss the Classic category. To open Speech and Sounds Schemes, hold Insert Alt S down together. JAWS will say “select a scheme dialog.” It will also say the current default scheme, which if you have never opened this before is the Classic scheme within the broader Classic category. To change the scheme, press the Down arrow or first-letter navigate to the one you want and press Enter. 
Within the Classic category you can choose among schemes which give you varying amounts of formatting information. The most relevant Classic choices are:
· Classic: No font information is read back to you. This is what you are used to hearing.
· Classic, Attributes: Bold, italics, and underlining are read back to you.
· Classic, Attributes, and Font Info: Font name as well as bold, italics, and underlining are read back to you.
· Classic, Attributes, Font, and Color: Font name, bold, italics, underlining, and color are read back to you. You should choose this one when you are proofing your formatting because it provides the most information.
When you change the scheme, it becomes the default for Word until you change it back again. Use these various schemes only when you are proofreading. Remember to switch back to Classic when you are done. Otherwise, you will continue to hear this formatting feedback in all Word documents. It will quickly drive you crazy.
[bookmark: _Toc1629889]9.3.2 NVDA Document Formatting 
This tool serves a similar purpose as JAWS Speech and Sounds Schemes, but can be used to reveal much more than just font changes. To access it, you can either use the shortcut Insert Control D, or go in via the NVDA menus. Steps for accessing document formatting through the menus are:
1. Open the NVDA menus by pressing Insert N. 
2. Down arrow to the Preferences submenu and press Enter. 
3. Press Enter on Settings.
4. Down arrow or first-letter navigate to Document Formatting. 
5. Tab through the choices, and use the Spacebar to check those elements that you wish NVDA to detect.
6. Tab to the OK button and press Enter or Spacebar. 
As you Tab through the Document Formatting dialog, you will find that there are quite a few format settings that NVDA can announce as you read through a document. Most are relevant for Word documents. A few are useful for Excel and web browsing. The choices are organized in groups and include:
· Font: Name, size, attributes, emphasis, style, color.
· Document information: Comments, editor revisions, spelling errors.
· Pages and spacing: Page numbers, line numbers, line indentation, paragraph indentation, line spacing (single, double, etc.), alignment.
· Table information: Tables, row/column headers, cell coordinates, cell borders.
· Elements: Headings, links, lists, block quotes, landmarks, frames, clickable.
The only drawback to using the NVDA Document Formatting tool is that it cannot be toggled on and off. Therefore, when you are finished proofreading, you will need to go back into the dialog box and uncheck all the items that you no longer want announced. You will definitely want to do this. As with JAWS Speech and Sounds Schemes, the verbal feedback on format changes can be overwhelming. However, I recommend that you do not uncheck items in the Elements group. These are important for web browsing. 
9.3.3 Narrator Verbosity Levels for Formatting
You can vary the amount of verbosity Narrator speaks for proofreading document formatting. This was mentioned in Chapter 1.4.1 as one of the elements in Narrator Settings. You can quickly cycle through the five verbosity levels by pressing Insert V. The levels are:
· Level one: Text only..
· Level two: Some control details.
· Level three: All control details (the default level).
· Level four: Some text details: gives most text attributes (bold, italics, heading levels, etc.).
· Level five: All text details.
Level five is best for proofreading a document. This level provides complete details about heading levels, font attributes, type and size, bulleting and numbering, and other formatting information. 
[bookmark: _Toc1629890]9.4 Tools for Collaborative Review 
Word has two useful tools you can use when working collaboratively on documents – Comments and Track Changes. You can insert comments into documents if you have questions or suggestions on ways to revise a document. Comments are usually focused on identifying possible substantive revisions. I think Comments are a great tool for reviewing documents among collaborators. 
Track Changes (also known as Revisions) focus on detailed editing. This is important for legal documents. Exact wording and precise punctuation are important in such documents and are subject to negotiation. Lawyers and others drafting contracts frequently use Track Changes. 
I need to make one caution here. Track Changes is a great visual tool. Yet in my opinion, interpreting the audio feedback provided by your screen reader program is confusing and exhausting. If you have to use Track Changes because you have sighted colleagues who use them, then by all means, bite the bullet and try to become comfortable with them. But if you have an alternative way to work collaboratively on documents where it is important to monitor lots of proposed small changes, you may prefer using that instead. For example, some reviewers and editors put proposed changes in brackets. You can then use the Find command (Control F) to search for left brackets. 
9.4.1 Comments
You can insert electronic comments in your documents. These are useful when collaborating on team projects. Also, instructors will often insert comments in term papers and other assignments. 
To add a comment to your document:
1. Place your cursor on the line where you wish the comment to appear. If you wish to reference specific text on a line, select that text first. 
2. Press the Applications key, Up arrow once to New comment, and press Enter. This opens the Comment pane where you can type in text. 
3. Once you have written your text, press Escape to exit the Comment pane and return to the document. Do not Press Enter or Tab. These will just put a hard return or tab in the Comment pane. 
You can also use the shortcut key (Alt R C) to add a comment. 
JAWS has several ways to access comments that are already in documents. The easiest way is to switch from Edit mode to Quick keys mode. Press Insert Z and JAWS will say “Quick keys on.” Now Press N to jump to the next comment after your cursor point, and JAWS will read it. Shift N will go to the previous comment and read it. If instructors have inserted comments into term papers, this is a great way to get a quick sense of their impressions. 
I have inserted a couple of comments in this section. If you are reading the electronic version of this book in Word, use the various ways mentioned above for accessing them.	Comment by David Kingsbury: I think that comments are under-utilized by screen reader users, mainly because they don’t know how to use them. It’s a great tool for zinging in on issues highlighted by reviewers. And they are easily accessed, especially by JAWS. 


With JAWS, you can also open a virtual viewer to access a list of comments. To open the virtual viewer, press the Windows and Semi-Colon keys together. This gives you a list of four items to view. The first item in the list is comments. Press Enter and JAWS will indicate how many comments are in the document. Down arrow and you will hear a numbered link and the comment’s author. The text of the comment appears under the link. Continue Down arrowing and you will hear the link and text for the second comment, and so on. Press Enter on the link if you wish to navigate to the location of the comment in the text, pressing Enter on a link navigates to the vicinity of the comment in your document, but does not place your focus within the comment itself. Press Escape if you just want to exit the virtual viewer. 
Finally, with JAWS, you can customize what feedback you hear on comments as you are reading through the document line by line or in Say all mode. Customization is done in JAWS Quick Settings. To access these options, while in Word press Insert V to open the Quick Settings dialog. In the edit box where you land, type in the word “comment.” Now Down arrow to “comments, footnotes and endnotes detection” and press the Spacebar to cycle through the four options, which are: 
· Off: No comment information is provided. 
· On: Says “has comment.” 
· On with text: Reads the comment, as well as the name of the comment’s author. With Eloquence voices, JAWS reads this information with a lower pitch (no pitch change for Vocalizer Expressive or Microsoft voices). 
· On plus count: In Say all mode, the same feedback is provided as with On with text. When Down or Up arrowing to read by line, JAWS will indicate the number of comments on the line. 
When you have made one of the above choices in Quick Settings, Tab to the OK button and press the Spacebar. 
If you wish to hear comments as you are navigating through the text, On with text is your best choice. If you do not want to hear any comment information, choose Off.
You can also navigate to comments via the Word ribbons or use shortcut keys. The shortcut key to go to the next comment is Alt R N. To go to the previous comment, press Alt R V. The Comments group is located in the Review tab. 
When you press Alt R N, your screen reader enters into the next comment pane where, among other things, you can edit it. 
With NVDA, another way to access comments is to open the Elements list as follows:
1. Press Insert Spacebar to switch to Browse mode. 
2. Press Insert F7 to open the Elements list.
3. Press Shift Tab once to get to the list of different elements.
4. Up or Down arrow to the Annotations radio button.
5. Tab once and the list of comments will appear. Up or Down arrow to move through the comments to listen to them. 
6. Press Enter on one of them if you wish to navigate to the location of that comment in your document. Otherwise, press Escape to exit the Elements list.
7. Press Insert Spacebar again when you want to exit Browse mode and return to Edit mode. 
To get a list of comments with Narrator, you can open Word’s Review pane by pressing Alt R T P, and then either H or V. You can Down arrow to read the comments line by line. Then press Escape twice to return to the main document. You can not use the Review pane to navigate to any of the comments. Press Escape twice to return to the main body of the document.
You can delete individual comments as well as reply to them, but you must be inside the Comment pane to do this. Otherwise, you will be unable to access these two choices via the Applications key. 
You may decide to delete an individual comment after you have revised the text to address it, or because you decide to ignore it. When you have finalized your document, always delete all comments before circulating it to others.	Comment by David Kingsbury: If I receive comments back on a document I have prepared, I like to deal with them one by one. I will then delete the individual comment, and move on. If I start with 25 comments and work my way down to 15 or so, I feel I have accomplished something that day. 

To delete an individual comment:
1. Press Alt R N or Alt R P to navigate to the next or previous comment, respectively.
2. Press the Applications key, Down arrow to Delete comment, and press Enter. 
To reply to a comment:
1. Press Alt R N to navigate to the next comment to which you want to reply.
2. Press the Applications key, Down arrow to Reply to comment, and press Enter. 
3. Type the text of your reply, and when finished, press Escape. 	Comment by David: I rarely use the Reply command. Most of the time, I am receiving comments from reviewers on a document I have drafted. They have no interest in reading my replies to their comments, but only in eventually getting the final version. The extent to which you may use the Reply command depends on your office’s practices and culture.

Replies will appear in the list of comments, so use the same procedures described above to navigate to them. 
When your document is in its final version, be sure to delete all comments if you have not already done so. To delete all comments at once, the shortcut key is Alt R D O. To navigate to this command via the ribbons:
1. Press Alt to open the ribbons and Right arrow to get to the Review tab.
2. Press Control Right arrow several times to get to the Comments group.
3. Tab to the Delete split button, and press Alt Down arrow to expand the options. 
4. Down arrow to Delete all comments in document, and press Enter. Note that as you Press the Down arrow, you will first hear “delete all comments shown unavailable.” Ignore this.
To verify that you have indeed deleted all the comments, use any of the methods outlined above for detecting existing comments. You should now hear that there are no comments in your document. 
[bookmark: _Toc1629891]9.4.2 Track Changes or Revisions 
This is a Word feature also found in the Review tab of the ribbons. It is supported by JAWS and NVDA, but not currently by Narrator. The terms Track Changes and Revisions are used interchangeably. This tool is used to display text changes, that is, insertions, deletions, and format changes. As with the Comments tool, Track Changes is used in collaborative or team settings. The tool is most commonly used when very specific word changes are important. Lawyers and contract negotiators are frequent users of Track Changes. For them, precise wording and punctuation are critical. A misplaced comma or incorrect word choice could have major impacts. In such situations, it is important for all parties to see specific suggested text changes. A grammar instructor might also use Track Changes to clearly identify writing mistakes in an assignment submitted by a student. 
To turn Track Changes on, hold down Control, Shift, and E together (this is a toggle). JAWS says, “Track Changes on.” NVDA and Narrator do not announce it. At this point, any edits (insertions, deletions, and font changes) you make will be registered. Note that font changes are announced as “properties.” 
If you later turn Track Changes off, any subsequent edits will not be registered. 
Once you have activated Track Changes, when you insert new text and navigate through the document, JAWS will announce the text and say that it has been inserted. JAWS will do the same for deleted text. NVDA will only announce insertions when you are navigating the document. To also hear deletions, you will need to use one of the methods identified below. Font changes (font name, attributes like bold and italics, point size, and color) are announced as “properties” by both JAWS and NVDA. To detect what actual font changes have been made, navigate just past where the change is announced and press Insert F. 
With JAWS, you can customize how revisions are announced as you move through the text. This is done in Quick Settings, which is opened with Insert V. Your cursor lands in the search box where you can type in Track Changes. You will get only one search result, so press the Down arrow once. Then press the Spacebar to cycle through the seven options, which are: 
· Do not detect revisions: The option is turned off. 
· Speak revision type: JAWS announces the type of revision made. For example, inserted text or deleted text. This is the default. 
· Speak revision type plus count: JAWS also announces the revision’s placement in the document. For example, if this is the third revision, JAWS says “third.” 
· Speak revision type and author: JAWS also announces the username of the individual who made the revision. 
· Speak revision type and author plus count
· Speak revision type, author, and date: JAWS also announces the date the revision was made. 
· Speak revision type, author, and date plus count
After making your selection, Tab to the OK button and press Enter or Spacebar. 
With NVDA, you can only hear the revision type and the accompanying text. 
Parallel to how comments are accessed, JAWS has several ways to access revisions beyond simply navigating through the document. Turn on Quick keys with Insert Z, and press R to jump to the next revision, or Shift R to go to the previous one. 
You can also access a list of revisions using the same virtual viewer used for comments, footnotes, and endnotes. Track Changes must first be turned on for this to work. Press the Windows and Semi-Colon keys together and either Down arrow to Revisions or press R to first-letter navigate there. Now press Enter and the virtual comments viewer opens. When you press the Down arrow, you will hear links with the text of the revisions immediately under the links. Press Enter on one of the links if you wish to go to that revision in the text, or press Escape to exit the virtual viewer.
You can access revisions several ways with NVDA. First, activate Browse mode by holding down the Insert and Spacebar together. Then press A, which will jump to the next “annotation.” Revisions count as annotations, as do comments. Unlike with JAWS, it is not necessary to have Track Changes turned on for this to work. 
Also, with Browse mode on, you can bring up the Elements list with Insert F9. Press Shift Tab once and Up or Down arrow to the Annotations radio button. Now Tab to the list of annotations. This list includes inserted and deleted text, as well as comments, and are clearly labeled as such. 
Once revisions have been made to a document, you have the ability to accept or reject them via the Applications key. The easiest way to do this is to press the Left or Right arrow until the cursor is inside the revised text. JAWS clearly says “revision” when you move into a revision and “out of revision” when you move out of it. So, for example, if the change is an insertion, and with your cursor inside the revision text, press the Applications key, and Down arrow to Accept insertion or Delete insertion. Press Enter on your choice. The change is made, and is no longer counted as a revision in your document. If the change you want to accept or reject is a deletion or a format change, this will also be clearly stated in the context menu. 
When arrowing into or out of revisions, NVDA will also indicate this. However, NVDA’s audio feedback on this is less straightforward than that of JAWS.
There is one important caveat to note here. If Word detects that the revision you want to make has a spelling error, the context menu will consist of Spellcheck options. The Accept Revision and Reject Revision options will not appear in the context menu. You will need to address the Spelling issue before you can accept or reject the revision. 
As was the case with comments, you should remove all traces of revisions from your final document before circulating it. Do this by accepting all revisions. The shortcut key is Alt R A 2 S. It does not matter whether Track Changes is turned on or off for this to work. To navigate there via the ribbons:
1. Navigate to the Review tab on the Upper ribbon.
2. Press Control Right arrow to get to the Tracking group. 
3. Tab to the Accept split button and press Alt Down arrow to expand the options. 
4. Down arrow to Accept all changes and stop tracking, and press Enter. 
Use one of the above-mentioned JAWS or NVDA methods for listing or navigating to revisions to confirm that none remain in the document.
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This final chapter discusses a set of other useful applications, topics, and tools. These include reading PDFs with Adobe Acrobat Reader DC, file sharing with Dropbox and OneDrive, and several other useful tips and tricks. I conclude by identifying some commonly encountered issues and possible ways to address them. 
10.1 Accessing PDF Files with Adobe Acrobat Reader DC
A portable document format file (PDF) is a file format designed to present documents consistently across multiple devices and platforms. Note that I will use an apostrophe in this book for the plural form of PDF because it reads better with screen readers. PDF’s are frequently used for financial and legal documents so that recipients can not edit them in any way. Professional journal articles and promotional flyers with elaborate formatting and images are other examples of documents that commonly appear as PDF’s. 
While each of the web browser applications have PDF viewers, for the most consistent results in terms of accessibility, screen reader experts usually recommend using Adobe Acrobat Reader DC. This is free software that can be downloaded from:
Adobe Acrobat Reader DC Download Free PDF viewer for Windows, Mac OS, Android
When you download this software, read through the page carefully. There are several checkboxes that are checked by default for downloading additional software. If you do not want to download this software, be sure to uncheck these checkboxes before downloading the Acrobat Reader DC installation file.
10.1.1 Acrobat Reader Accessibility Settings
Once downloaded and installed, Acrobat Reader detects that you are using assistive technology software, and you land in the first panel of the Accessibility setup wizard. Proceed through it as follows:
1. You first land on a tab with three radio buttons for adjusting assistive technology settings. Up or Down arrow to your choice: all accessibility options, screen reader options, and screen magnification options. If you only use a screen reader program, choose this radio button. If you have some usable vision, choose the All accessibility options radio button instead. 
2. Tab to the Next button and press Enter. 
3. If you chose the All options radio button in the first panel, the second panel identifies screen magnification options. Go through these if you have some usable vision. In the order in which they appear, tabs are: a high contrast checkbox; a combo box with four high contrast foreground and background color options; a field highlighting color combo box; a required field color combo box; and a disable text smoothing checkbox (check this if you want a crisper delineation between foreground characters and the background). When finished in this panel, Tab to the Next button and press Enter.
4. There is nothing to change in this pane whose first option is Infer reading order from document, Tab to the Next button and press Enter.
5. You first land on a set of radio buttons for determining how much of the PDF is loaded upon opening it. Up or Down arrow to the Read the entire document at once radio button. This is recommended, because in most instances, you will want to access the entire document, list of headings, links, etc. This is the only recommended change in this pane. Tab to the Next button and press Enter.
6. Tab once to the Reopen document to the last page viewed checkbox. Leave it unchecked if you want PDF’s to always reopen on the first page. Otherwise, check it if you want your place to be saved from the previous session for each file. 
7. Tab to the Done button and press Enter. 
You can later return to adjust the additional settings described below as follows:
1. Press Enter on the Acrobat Reader DC desktop shortcut. This was created during the program installation process.
2. Press Alt to open the menu bar. This is a classic drop-down menu setup. 
3. Right arrow once to the Edit menu, Up arrow several times to the Accessibility submenu and press Enter.
4. Down arrow to the Setup assistant and press Enter. 
5. Follow the steps outlined above to make any desired accessibility changes. 
There is one more change to make. Disabling Protected view is absolutely crucial. Until you do this, you simply will not be able to read PDF’s with your screen reader. Steps are: 
1. Press Alt to open the menu, Right arrow once to the Edit menu, Up arrow to Preferences, and press Enter. 
2. This opens a categories list. Press S until you get to Security enhanced.
3. Tab once to the Enable Protected view at startup checkbox and press the Spacebar to uncheck it.
4. Tab to the OK button and press Enter. 
5. Pres Alt F4 to close Acrobat Reader and then reopen it. The application must be closed for this change to take effect. 
10.1.2 Setting Acrobat Reader As Your Default PDF Viewer
Each web browser has a feature for viewing PDF’s. In Windows 10, Microsoft has set Edge as the default PDF viewer. This means that when you open any PDF, it will open in Edge. After installing Acrobat Reader, you will want to make it your default PDF viewer instead of Edge.
Just after you install Adobe Reader, you may be asked if you want to open all PDF’s with it. If you receive this prompt, be sure to check the appropriate checkbox to confirm. However, this prompt does not consistently appear. If you do not encounter it, when you first attempt to open a PDF, instead of pressing Enter to open it, press the Applications key, Down arrow to the Open with submenu, and press Enter. You land in a list of installed programs that can view PDF’s. Up or Down arrow to Adobe Acrobat Reader DC. Tab to see if there is a checkbox here for making it the default. If yes, check it, Tab to the OK button and press Enter. This PDF and all subsequent PDF’s should open in Acrobat Reader. Unfortunately, here too, it is inconsistent. 
The one surefire way to change your default PDF viewer to Acrobat Reader is to do so through the Windows Settings, but options for doing this differ according to your Windows 10 version. If you are using Windows 10 Build 2004 or earlier:
1. [bookmark: _Hlk69915252]Press the windows key to open the search box, type in the first few letters of “Default apps system settings” until you hear it, and then press Enter.
2. Tab to the Choose default by file type link and press Enter.
3. This opens an extremely long alphabetical list of file extensions, each starting with a period. You must Tab through these. First-letter navigation is not possible. Rather than press the Tab key repeatedly which will take far too long to reach the PDF extension, hold down the Tab key for about 10 or 15 seconds, and then release it. Hopefully, you will be close to the dot PDF extension. When you eventually land on it, press the Spacebar, which opens a shorter list of programs that could be chosen as the default PDF viewer.
4. Tab to Adobe Acrobat Reader DC and press the Spacebar to select it as your new default PDF viewer.
5. Press Alt F4 to close this window. There is no OK button.
6. To verify, open a PDF file saved on your computer. It should now open in Acrobat Reader.
If instead, you are using the 20H2 Windows 10 version or a more recent version:
1. Press the Windows key to open the Start menu. You land in the search box, type in the first few letters of “Default apps system settings” until you hear it, and then press Enter.
2. Tab to the Set default by apps link, and press Enter.
3. Tab once to where it says, “set your default programs.” This lands you in a list of the programs installed on your computer. Down arrow to Adobe Acrobat Reader DC and press Enter.
4. Tab once to the Manage button and press the Spacebar.
5. Tab to dot PDF where you will also hear its current default program association, and press the Spacebar.
6. Tab to Adobe Acrobat Reader DC, and press the Spacebar to select it as the new default.
7. Press Alt F4 to close the window. 
8. To verify, open a PDF file saved on your computer. It should open in Acrobat Reader.
10.1.3 Reading and Navigation Keystrokes
Assuming no major accessibility problems exist with the PDF you have opened, all standard reading and navigation keystrokes used with Word work with PDF’s. This includes navigating to next and previous pages with Control Page down and Control Page up, respectively. A few keystrokes are different:
· Search command: To search for text, press Control Insert F (rather than Control F as is the case with Word), type in the text, and press Enter. That keystroke works with all three screen readers for finding the first occurrence of a search term. To jump to the next occurrence, press F3 with JAWS, and Insert F3 with NVDA and Narrator.
· Go to page command: With any of the screen readers, press Control Shift N to hear your current page location. You can then type in a page number and press Enter to navigate to that page.
With JAWS, you can also find out your page location by pressing Shift F4 (which toggles off the Acrobat Reader Tools pane), and then pressing Insert Page down. This brings up the Status bar. You will hear “4/20,” indicating that you are on the fourth page of a 20 page document. To subsequently access the Status bar during the same session with this PDF, just press Insert Page down. It is not necessary to press Shift F4 again. 
10.1.4 Reading PDF’s with Varying Levels of Accessibility
Reading PDF’s used to be an accessibility nightmare. Fortunately, tools have been developed in recent years to remedy a number of accessibility problems. 
To make PDF’s accessible, those who prepare them need to take two factors into account: tags, which label and structure the content, and reading order, which controls the sequence in which the content is voiced to the user. If both factors are properly addressed, screen reader users will be able to efficiently navigate and reading will be clear and comprehensible. 
I will go through a set of examples using the files in the ZIP folder that accompanies this book. To follow along, open them in a separate window and press Alt Tab to switch between this text and the PDF.
10.1.4.1 Fully Accessible PDF Files
PDF’s can be designed to be fully accessible in much the same way as web pages on the Internet. You can navigate as follows:
· By heading, by pressing H.
· By heading level, by pressing 1, 2, 3, etc. on the number row.
· By table, by pressing T, and within tables, by pressing Control Alt and the four arrow keys.
· To form fields, by pressing E to get to edit fields, X to get to checkboxes, and so on.
If the PDF is an accessible form (referred to as a “fillable form”), after having partially or completely filled it out, you can save the revised file. 
The standard two-page Internal Revenue Service (IRS) tax form is a good example of a fillable PDF form. Open the file entitled “Form 1040.pdf.” All the keystrokes mentioned above will work with this file. 
To save it after filling some of the form fields:
1. Press the Alt key to open the menu bar. This lands you on the File menu.
2. Down arrow to Save as and press Enter.
3. You land in the Filename edit box of the standard Save as (dialog box (see Chapter 2.9 for the full discussion of this dialog box). If you are revising a previously blank form, you may want to rename the file here to create a new file and preserve the blank form. 
4. Press Enter if you want to save it in the same folder as the original blank PDF. Otherwise, Shift Tab back several times to designate a different folder location.
If you simply want to save it with the revisions in the same folder and with the same name, press Control S to save the updated file. 
Unfortunately, you will often encounter what I will call “unfillable PDF forms.” These are PDF’s that have not been created with accessible edit fields and checkboxes. They are inaccessible because you will not be able to fill them out independently. Instead, you will first have to print them in hard copy and have a sighted person fill them out for you.
10.1.4.2. Changing Reading Order
For PDF documents, “reading order” refers to the sequential presentation of content by screen readers and other assistive technology. Ideally, the screen reader reads the content as it appears on the screen, and in a way that is comprehensible. However, reading problems occur from time to time in untagged or improperly tagged PDF’s. Text may sound jumbled or garbled. Words sound like they are running together without spaces between them. If you are using Eloquence voices with your screen reader, reading may even switch to a foreign language accent or syntax.
Most of the time, changing to a different reading order will quickly fix the problem. To change reading order, press Control Shift 5 (on the number row). You land in a list of reading order options, with your focus on the current reading order. 
From the top of the list, reading order options are: 
· Infer reading order from document.
· Left-to-right, top-to-bottom.
· Raw print stream.
· Tagged reading order (this fourth option is not always present).
Up or Down arrow to one of these other options and press Enter. By trial and error, you will usually pick one that solves the problem. You can press Control S to save the file with its new reading order.
The file “What Is Mixed Reality.pdf” is an example where reading is garbled for screen reader users. Changing reading order to one of the other choices will make it read clearly. 
If using an Eloquence voice with JAWS, the file “Team Viewer.pdf” reads with a thick German accent, even though it is an English language document. Or at least this is what happens on my computer. Here too, changing the reading order resolves this problem. 
10.1.4.3 JAWS Convenient OCR
If a PDF has been created from a scanned image, it is not directly accessible with a screen reader. However, JAWS uses Optical Character Recognition (OCR) technology to access these types of PDF’s. The JAWS utility is called Convenient OCR and is extremely easy to use. Open the PDF. JAWS will alert you that it is a scanned image and ask you to press the Spacebar to start Convenient OCR. 
Once processing is finished, JAWS will read it to you. Beginning with JAWS 2021, you can Tab once and press Enter to open the document in Word. Here, you can save the text if desired. If you have an earlier version of JAWS, you can select the text, copy it, and paste it into Word or Notepad. 
There may be errors in the output, especially if the quality of the original scanned image was poor. If you import the text into Word, it is likely that you will need to edit and modify formatting if you want to make the document presentable to others.
NVDA has an OCR feature, but I have never been able to make it work, so will not cover it here. There are several ways to perform OCR with Windows. I have never tried any of these, but if you wish to find out more, activate the following link: 
Five OCR Ways to Extract Text from Images on Windows 10
10.1.5 Adding Placemarkers 
Similar to web pages, you can add placemarkers to PDF’s to enable quick navigation to important text in the document. You can do this with JAWS and NVDA, but not with Narrator. As on the web, you first mark a point in the document as a temporary placemarker and then mark it as permanent. 
With JAWS, steps for inserting placemarkers in PDF’s are as follows:
1. For the first placemarker you wish to insert, navigate to the text in the PDF that you want to mark, and press Control Windows K to mark it as a temporary placemarker. JAWS will say “temporary placemarker set.”
2. Press Control Shift K. This opens the Placemarker list dialog where you land on “temporary document.”
3. Tab to the Add button and press Enter. You land in an edit box populated with the text of the line that you marked as a temporary placemarker. Edit this to make it shorter, or leave it unchanged, and then press Enter. 
4. I have found that on some computers, you can skip the first step of creating a temporary placemarker before making it permanent, while on others, you need to first create a temporary placemarker. See what works on your own computer. 
To create an additional placemarker, navigate to the text you want to mark. When you press Control Shift K to open the Placemarker list dialog, previously created permanent placemarkers are listed here. Up or Down arrow to “temporary document” and repeat step three above to make it permanent. 
Similar to placemarkers on web pages, to navigate to the next and previous placemarker, press K and Shift K, respectively. You can also press Control Shift K to open the list of placemarkers. Then arrow up or down, or first-letter navigate to the one you want, and press Enter to navigate to it in the PDF. 
To delete a permanent placemarker:
1. Press Control Shift K to open the placemarker list.
2. Up or Down arrow to the one you want to delete.
3. Tab to the Remove button and press Enter. 
There is also a Remove all button in the placemarker dialog for deleting all permanent placemarkers at once. 
To try this out, open the file entitled “college microwave cooking.pdf.” Create three or four placemarkers, navigate through them, and remove one or two. If you now press Control S to save the updated file, and then reopen it, the previously-created placemarkers should have been retained. 
To create placemarkers with NVDA, see Chapter 7.10.2.2.
[bookmark: _Hlk92481147]10.1.6 Saving a Word File as an Accessible PDF File
Any file you create in Word can easily be saved as a PDF. Taking a little time to create an accessible source file will yield a more accessible PDF. To make the file easily navigable, add headings with appropriate levels. Any tables created will also be navigable. 
Creating fillable PDF’s can only be reliably done using Adobe Acrobat Pro DC. Unfortunately, the Pro version of this software is expensive and the process for creating fillable forms is not accessible. Although it is possible to create forms in Word, it is neither easy to create such forms, nor is it easy to fill them out.[footnoteRef:8] [8:  As far as I know, the only accessible way to create forms is with Google Forms. Google Forms is free, but you must have a Gmail account to access it. Forms are web-based and are accessible. Filling them out is fully accessible.
] 

To save a Word file as a PDF:
1. In Word, press F12 to open the Save as dialog box. 
2. You land in an edit field where a filename with a.DOCXending is proposed. 
3. Press tab once to navigate to the File type combo box, and press P to select PDF.
4. [bookmark: _Hlk92481119]Shift Tab once to return to the filename edit field. A PDF file extension should have replaced the .DOCX file extension. Press Enter to save the file as a PDF.
10.2 Cloud Storage with Dropbox and OneDrive
Cloud storage is a way to save files and folders online so they can be accessed on multiple devices, as well as shared between those who have been given permission to access them. Among the most popular cloud storage services are Dropbox, OneDrive, and Google Drive. For those already familiar with PC-based file management, getting comfortable with Dropbox and OneDrive is quick and easy. The learning curve for Google Drive is considerably steeper. Consequently, I will only cover Dropbox and OneDrive here.
There are various personal plans for Dropbox and OneDrive. As of the time this book was written, a free Dropbox account entitled you to two gigabytes (GB) of storage on up to three devices. For two terabytes of storage, Dropbox Plus costs $9.99 per month, and a family plan (up to six members) costs $16.99 per month. For more details on the various options, including additional features, visit:
Buy your Dropbox plan for personal or professional use
When you purchase a computer with the Windows 10 operating system, five gigabytes of free storage with OneDrive are included on up to three devices. You just need to sign up with your Microsoft account to access the OneDrive folder located in your user folder. If you purchase a Microsoft 365 annual license ($69 for an individual account and $99 for up to six people), one terabyte of storage (that is, 1000 gigabytes) of OneDrive storage is included in this package. In my opinion, this is a great deal. For more details, visit OneDrive Cloud Storage Pricing and Plans
	Unlike OneDrive, you will need to create an account and install Dropbox on your computer. This involves several steps and is sometimes a bit clunky. To create a free account, start by going to How to download and install Dropbox.
Under the first level two heading, you can follow the instructions for downloading and installing the software, and signing up for a free account. You will also need to be on the lookout for an email asking you to verify your identity.
Once the program is installed on your computer, a Dropbox shortcut appears on your Desktop. The Dropbox folder is located in your user folder. 
With the paid accounts for both programs, you can select folders to download to your computer, and others to be stored only in the cloud. If you anticipate using a significant amount of this storage space, considering which folders you want to take up space on your computer may be an important issue. 
For individuals, there are four categories of sharing: between your devices, with other people without editing rights, with other people with editing rights (also known as sharing collaboratively), and between apps on your smartphone. Each will be discussed below.
10.2.1 Sharing Between Your Devices 
If you work on more than one device, you will derive benefits from cloud sharing because you can share files and folders between them. I work on a personal computer, a computer at work, and an iPhone. With these two cloud storage applications installed on all three devices, I can effortlessly share files and folders between them. If I add, delete or revise a file on one device, these changes will be synchronized across my other devices. Before cloud sharing became commonplace, I spent a lot of time carting around files on a thumb drive so I could copy and paste them between my work and personal computers. Nowadays, any changes I make on one computer are reflected on the other computer, and vice versa. All without the hassle of constantly copying and pasting between computers and a thumb drive. 
As part of the Dropbox installation process, a Dropbox folder is placed in your user folder. When you purchase a Windows PC, a OneDrive folder is already placed in your user folder. However, you will need to sign in with your Microsoft email and password to allow syncing between your devices. For Dropbox, a desktop shortcut is placed on your Desktop. You may need to add a desktop shortcut for OneDrive. Use the procedures in Chapter 2.8.2 to do this. You can now add folders and files to these folders and manage them using the same procedures and shortcut keys that you use in any other folder on your PC. The only difference is that these folders and files will automatically be backed up to the Cloud, and be available on any of the other devices where you have Dropbox and OneDrive installed, including your smartphone.
The three other forms of sharing are discussed below. These are: sharing without editing rights; sharing collaboratively; and sharing between apps on your smartphone.
10.2.2 Sharing Without Editing Rights
With both Dropbox and OneDrive, it is quick and easy to share files and folders with other people without granting editing rights. Recipients of your shared files and folders can download these to their computers, but whatever they do with them will not effect your own files in any way. Recipients are not required to have their own Dropbox or OneDrive accounts when you share in this way. 
10.2.2.1 Dropbox
Steps are:
1. In your Dropbox folder, place cursor focus on the file or folder you wish to share. Do not open it. 
2. Press the Applications key, Down arrow to Copy Dropbox link, and press Enter. This generates a hyperlink and places it on the Clipboard.
3. In the body of an email message, paste the link from the Clipboard by pressing Control V. A URL appears.
4. Send the email message to those recipients with whom you wish to share the file or folder. 
When recipients press Enter or click the mouse on the URL in the email, they will be redirected to a web page. The title of this page will say the name of the file or folder, and the name of your default web browser. Exact steps for downloading the file or folder change periodically when Dropbox revises its website. As of the writing of this book, after landing on the web page, press B several times to navigate to the Download button and press Enter. The file or folder will now be downloaded to your PC’s Downloads folder. 
If you have shared a folder, the name of the folder will have a.zip extension. All folders that you download from the Internet have this extension. This is called a Zip file. If recipients press Enter on the zip file, they will now have access to all the folders and files contained in the shared folder. They can open them here. They can also copy or move them elsewhere on their PC. But as mentioned above, none of their actions will affect the folders and files on your own computer.
You can also edit the hyperlink so that the shared file or folder downloads directly to the recipient’s Downloads folder. This saves them time. It also saves you the effort of having to explain how to perform the download from the Internet if they don’t know how to do it already. Steps are:
1. Repeat steps one through three above for copying and pasting the hyperlink.
2. Place your cursor focus anywhere on the URL that you pasted in the draft email message. 
3. Press the Applications key, Down arrow to Edit hyperlink and press Enter. 
4. This lands you in an edit field prepopulated with the URL. Press the Right arrow once to deselect the URL and place your cursor focus at the right side of the edit field. 
5. If you Left arrow a couple of times, you hear that the URL ends with “=0,” minus the quotes.
6. Delete the 0, replace it with 1, and press Enter. This places you back in the email message. 
7. Place your focus on the URL and listen to your screen reader to verify that it now ends with 1. 
8. Send the email message.
When email recipients press Enter on the URL, the file or folder will download directly to their Downloads folder.


 10.2.2.2 OneDrive
To share without editing rights in OneDrive:
1. In your OneDrive folder, place cursor focus on the file or folder you wish to share.
2. Press the Applications key, Down arrow to Share, and press Enter. 
3. Tab several times to the Copy link button and press Enter. This generates a hyperlink and places it on the Clipboard.
4. In the body of an email message, paste the link from the Clipboard by pressing Control V. A URL appears.
5. Send the email message to those recipients with whom you wish to share the file or folder. 
When recipients press Enter on the URL in the email, they will be redirected to a web page. The title of this page will say the name of the file or folder, and the name of your default web browser. As with Dropbox, exact steps for downloading the file or folder change periodically. As of the writing of this book, steps were:
1. After landing on the web page, Down arrow several times to the Download menu. 
2. Press Enter or the Spacebar to expand it. The download process should immediately begin. 
As with Dropbox, the file or folder will now download to your PC’s Downloads folder. Folders will have a.zip extension, and can be accessed in the same way as with Dropbox. 
Unfortunately, unlike with Dropbox, there is no way to simplify the downloading process by editing the URL. 
10.2.3 Sharing Collaboratively
Use this sharing method for team projects where you need to work collaboratively, jointly editing files and storing folders in a place where all team members can access and revise them. All those granted permission to edit files and folders must have Dropbox or OneDrive accounts. While these processes are accessible, they can be a bit finicky and may require a bit of Tabbing and Shift Tabbing around to gain focus on the field where you insert recipient email addresses. My experience is that Dropbox tends to be more finicky than OneDrive when it comes to adding recipient emails. Also remember that recipients must have Dropbox or OneDrive accounts for this to work. Check with them before sending a request to collaborate. 


10.2.3.1 Dropbox 
To share folders collaboratively with others:
1. In your Dropbox folder, place cursor focus on the folder you wish to share.
2. Press the Applications key, Down arrow to Share, and press Enter. 
3. You land in the Contact name edit field. However, you may not hear this. Tab and Shift tab back to it to verify. Type in the email addresses of those you want to share with. If you are going to share with several people, it may be better to type the email addresses in Word first, and then copy and paste them into this edit field because text editing works poorly here. Be sure to type a semi-colon between email addresses if you intend to share with multiple recipients. 
4. Tab to the Can edit combo box. “Can edit” is the default. This means that those you share with can edit files and folders within the shared folder, including adding and deleting files and subfolders, revising and renaming them, and commenting. 
5. Otherwise, Down arrow to the second choice in the combo box, which is “can view, download, and comment.” If you Up or Down arrow in this combo box, press the Spacebar to make the selection. 
6. Tab to the Add a message edit field, where you can insert an optional message that will appear in the body of the email sent to recipients. 
7. Tab to the Share button and press Enter. You may or may not hear a confirmation that the file or folder has been shared. 
If you are a recipient of a request to share with editing rights, you will receive an email message with a link. Do the following to add the folder to your Dropbox.
1. Press Enter on the link which brings you to a web page whose title is the name of the file or folder being shared and the word “Dropbox.” 
2. Press B several times to navigate to the Add to Dropbox button and press Enter or the Spacebar.
3. This opens a dialog that simply says “dialog.”
4. Down arrow to the Add to Dropbox button and press Enter. You may or may not hear a confirmation that the folder has been added to your Dropbox.
5. Open the Dropbox folder on your PC where it should now appear. 
Because the Dropbox website is regularly updated, the above steps are subject to change.


10.2.3.2 OneDrive
To share folders collaboratively with others:
1. In your OneDrive folder, place cursor focus on the file or folder you wish to share.
2. Press the Applications key, Down arrow to Share, and press Enter. 
3. You land in the Enter the name or email address for people to share with edit field. Here too, as in Dropbox, you may not initially hear this. Tab and Shift Tab back to hear it. Type in the email addresses of those you want to share with. Be sure to place a semi-colon between email addresses if you intend to share with multiple recipients. 
4. Tab to the Can edit combo box and Down arrow to your choice. The two options are: can edit, delete, comment, and add the folder to their Dropbox; or can view, download, and comment.
5. Tab to the Add a message edit field, where you can insert an optional message that will appear in the body of the email sent to recipients. 
6. Tab to the Send button and press Enter. 
If you receive this type of sharing request, steps for downloading it to your OneDrive folder are:
1. Press Enter on the link in the message. This will bring you to a web page where the list of files in the folder appears.
2. From the top of the page, Down arrow to where you hear the folder name, followed by the Folder is shared button, and press the Applications key. 
3. Down arrow to Add to my OneDrive and press Enter. 
4. Tab to the Add to my OneDrive button and press Enter. 
The folder should now appear in the OneDrive folder on your PC. As with Dropbox, these steps may change as the website is updated. 
10.2.4 Sharing with Other Apps On Your Smartphone
When you install the Dropbox and OneDrive apps on your smartphone, these will synchronize with your Dropbox and OneDrive folders on the PC. Not only can you access these files and folders there, but you can export them to, or import them from, other apps on your smartphone.
It is beyond the scope of this book to provide detailed instructions on how to use the Dropbox and OneDrive smartphone apps, as well as for popular apps used in conjunction with them. However, below is a short discussion of some of my favorite iPhone apps with links to iPhone App Store pages where you can find out more about them. 
10.2.4.1 RecUp 
Developed by Irradiated Software, this app costs only $1.99. It’s easily the best two bucks I’ve ever spent! RecUp is an easy-to-use voice recorder that automatically uploads MP3-formatted audio recordings to a folder in Dropbox (but only Dropbox). You can listen to the recordings on your phone or on your computer. I can efficiently manage uploaded files on my computer, deleting, renaming, and moving them elsewhere. The quality of the audio is also quite good. Find out more at:
‎RecUp - Record to the Cloud on the App Store
10.2.4.2 Voice Dream Reader
Developed by Voice Dream LLC, the price of this app is $19.99. You can import files in various text and audio formats (Word, PDF, MP3, WAV, and several others). You can also download books from Bookshare. While it is possible to read or listen to files directly in Dropbox or OneDrive, navigation is more flexible with this app. You can also adjust the voice rate of audio files in Voice Dream. This is not possible in Dropbox and OneDrive. The developer is very attuned to accessibility concerns. Find out more at:
‎Voice Dream Reader on the App Store
10.2.4.3 Outlook
Developed by Microsoft, this app is free for all users. It includes both email and calendar functions. After many years of using the iPhone’s native Mail ap, I switched over to Outlook in late 2020 and prefer it for several reasons. 
Procedures are more straightforward for exporting attached files to Dropbox or OneDrive, as well as for attaching files to messages I am preparing. I also prefer the mail and calendar interfaces over the iPhone’s native apps. For details, go to:
‎Microsoft Outlook on the App Store
10.2.4.4 Cloud Music App Pro
Developed by Mymacapps.com, this app costs $3.99. It is an easy to use alternative to iTunes and the iPhone’s native Music app for syncing music stored in my Dropbox and OneDrive folders (it also supports other cloud storage apps). Syncing steps are straightforward, and playlists are automatically created by artist and album. It is completely Voiceover accessible, and on those rare occasions when I have contacted the developers about problems, they were very responsive.
10.3 Additional Useful Features in Windows and Office
In this section, I cover some great features that you can use in the various Office applications to enhance your productivity. 
10.3.1 Tell Me with Alt Q
For any of the Office Suite products, if you have difficulty remembering shortcut keys, or wish to execute a seldom-used command, you can press Alt Q to open a search box where you can search for a command (think of the Q as standing for “question” or “query”). Type in the name of the command you are searching for and Down arrow through the results. If you press Enter on one of these, you can start the process of executing the command. For example, if you are in a Word document, press Alt Q, type in “margins,” Down arrow to the Adjust margins submenu, and press Enter. This opens the same submenu found in the Layout tab of the ribbons. 
You can do several other things with the Tell me feature. Still using the margins example, continue Down arrowing to the Get help on: margins split button. Pressing Enter on this opens a help page where you can learn more about this and related commands. If you press Alt Down arrow on this split button, a list of associated commands appear. You can press Enter on one of these to open a help page related to that command. 
If instead of executing the command, you want to add it to the Quick Access toolbar (see the section immediately after this one), after Down arrowing to it, you can press the Applications key and press Enter on Add to Quick Access toolbar.
Finally, if you press Alt Q and leave the search box empty, you can Down arrow through a short list of recent queries you have made and execute one of those. 
10.3.2 Quick Access Toolbar
The Quick Access toolbar (QAT) allows you to assign shortcuts for Office commands that are hard to remember or involve more keystrokes than you prefer to type, especially if you use the command often. The QAT is present in all the Office Suite programs, as well as with Windows File Explorer. 
The QAT can be customized in each of these applications. Shortcuts initially set by Microsoft can be deleted and new ones can be added.
I’ll continue with Outlook to discuss how to navigate to the QAT, delete existing QAT shortcuts, and add new ones. To navigate to the QAT, press Alt, and then Shift Tab once. You land on the Ribbon display submenu. Right arrow once and you land on the first QAT shortcut, which is assigned Alt 1, the next one to the right is assigned as Alt 2, and so on. You can set a maximum of ten QAT shortcuts per program (up to Alt 0). 
Outlook comes with two preset QAT shortcuts: Send/receive all folders (Alt 1) and Undo (Alt 2). Because easy-to-remember shortcut keys exist for these two already (F9 and Control Z, respectively), I don’t find I need them as QAT shortcuts. To delete a QAT shortcut:
1. Navigate to the QAT by pressing Alt, and then Shift Tab.
2. Right arrow once to the first of these which has been assigned Alt 1. 
3. Press the Applications key. You land on Remove from Quick Access toolbar. Press Enter. 
Any QAT shortcuts to the right of the deleted shortcut will move up one number. That is, the previously designated Alt 2 shortcut will become Alt 1, Alt 3 will become Alt 2, and so on. 
Repeat the same steps if you want to delete other preset QAT shortcut assignments.
You can add new QAT shortcuts in two ways: through the ribbons and through the Customize Quick Access toolbar submenu. One QAT shortcut I like to assign in Outlook is the command for changing the sort order of inbox messages. Without a QAT shortcut, this involves either navigating to the command in the Lower ribbon of the View tab, or memorizing the ribbon shortcut key combination of Alt V A B F to sort by sender, and Alt V A B D to return to sorting by date. To assign a QAT shortcut for this command:
1. Press Alt to open the Upper ribbon, and Right arrow to the View tab.
2. Tab in the Lower ribbon to the Arrange by button, but do not press Enter. 
3. Press the Applications key. You land on Add to Quick Access toolbar. Press Enter on this.
A QAT shortcut is now designated for this command. If you removed the two presets mentioned above, this becomes the new Alt 1 QAT shortcut. 
Now if you want to sort your inbox by sender, all you have to do is press Alt 1 F (for “from”). To return to sorting by date, press Alt 1 D. With JAWS, to make the QAT shortcuts work correctly, you must press the Alt and 1 keys separately. Pressing them at the same time will not work. For example, if you press them together while in Outlook, JAWS will say,” that field is not available outside an open message.” With NVDA and Narrator, it is OK to press the Alt and number keys together.
You can use the Customize toolbar submenu to assign QAT shortcuts for a number of commands. In Outlook, I have found it useful to do this for emptying the Deleted items or Trash folder. Using a QAT shortcut is much faster than navigating to this command via the ribbons. To assign this QAT key:
1. Navigate to the QAT by pressing Alt, and then Shift Tab.
2. Right arrow to the Customize toolbar submenu and press Enter to open it.
3. Down arrow to Empty deleted items and press Enter.
This command is now assigned a QAT shortcut, Alt, plus one additional number above the highest number already assigned. When you press the QAT shortcut to empty the Deleted items folder, you will be asked to confirm that you want to empty it. Press the Spacebar on the Yes button to confirm. 
Below are some additional commands for which you may wish to assign QAT shortcuts. 
Attaching files in Word, Excel and PowerPoint to an email message: Assign the QAT shortcut from within any of these programs via the Customize toolbar submenu. In the submenu, Down arrow to Email and press Enter. This command allows you to attach a file while in the window for that file, provided that it has already been saved. When you execute this command, you will land in the To field of your default email program. The file will already be attached and the Subject field will be pre-populated with the file name. All you need to do is address the message, add text to the message body and send it. You can edit the Subject field if you like. 
Create shortcut command in Windows 10 File Explorer: See Chapter 2.8.1 to read about this command. To assign it a QAT shortcut:
1. While in a folder such as Documents, navigate to the Home tab on the Upper ribbon.
2. Tab to the New item button.
3. Press Enter on Add to Quick Access toolbar.
When you activate the QAT shortcut, Down arrow once to Shortcut and press Enter to open the relevant dialog.
Copy Path command in Windows 10 File Explorer: If you have selected a single file or folder, or multiple ones, you can copy the full file path to the Clipboard and then paste it in Word or some other text editor. To assign it a QAT shortcut:
1. While in a folder such as Documents, navigate to the Home tab on the Upper ribbon.
2. Tab to the Copy path button.
3. Press Enter on Add to Quick Access toolbar.
10.3.3 AutoText in Word and Outlook
Among other things, this is a handy tool for quickly inserting text that you otherwise type repetitively. Think of how many times during the day you might type a salutation to a co-worker or friend, or sign-off at the end of an email message. On any given day, I write several messages beginning with “Hi all” followed by a comma. And at the end I sign off with “Thanks” or “Best regards” followed by a comma, and my first name on the next line. Rather than type these over and over again, you can speed all this up by using the AutoText tool in Word and Outlook. You will need to define a piece of AutoText separately in each of these two applications. I will use Outlook as an example to add “Hi all comma” to AutoText. Note that I wrote out the word “comma” just now so it is clear here in the text, but you will actually type the comma symbol immediately after the text, exactly as you would in an email message. Steps are:
1. In Outlook, press Control N to start a new message and Tab to the body of the message.
2. Type in “Hi all comma” as you normally would.
3. Select this text.
4. Press Alt F3 which lands you in the Create new building block edit field. 
5. Type in a letter or small number of letters that you can easily remember, for example, just a lower case h, and press Enter. This is not case-sensitive, so just stick with lower-case letters. Your AutoText and its corresponding keystroke, or keystrokes, are now defined. 
From now on, when you want to insert this text in the body of an email, type h immediately followed by F3, and the text will appear. 
There is no character limit on the amount of text you can select for Autotext. For example, you might use Autotext for quickly inserting the Zoom link for a recurring meeting, the agenda for a weekly office meeting, your email signature, or the boilerplate text for a newsletter. The only limiting factor is your ability to remember the keys you assign to your Autotext entries. 
Steps are exactly the same for creating AutoText entries in Word. 
It is easy to replace an Autotext entry with something else. For example, let’s say that in Outlook, I want to redefine my h entry of “Hi all comma” as “Hello all comma.” Repeat steps one through four above, but this time in step two, typing in and selecting the text “Hello all comma.” When you press Alt F3 to get into the Create new building block edit field, type in h, and then Enter, you will be asked “do you want to replace the building block entry?” Press the Spacebar to confirm. 
If you later decide to delete an AutoText entry, or you just want to see the list of AutoText entries you have created in either Word or Outlook, they are found in the Quick parts gallery in the Insert tab of the ribbon. For Outlook, you must first be in the body of an email message you are currently preparing. Only then can you access the Quick parts submenu. Again, I will use Outlook as an example.
1. In Outlook, press Control N to start a new message and Tab to the body of the message.
2. Press Alt, Right arrow once to the Insert tab, Tab to the Quick parts submenu and press Enter (shortcut is Alt N Q).
3. Press Enter on the AutoText submenu. This opens the list of your AutoText entries, listing the keystrokes you have created.
4. Down arrow to the entry you want to delete.
5. Press the Applications key, Down arrow to Organize and delete, and press Enter.
6. Tab to the Delete button and press Enter. 
When I first discovered this tool, I went nuts creating scores of AutoText entries for everything from the name of my state blindness agency and workplace, to my bank account routing number and checking account numbers, to the titles and web addresses of previous books I have written. But over time, I have dropped most of these from my daily habits and come to use AutoText most frequently for email salutations and sign-offs. In any event, use AutoText for whatever segments of text work best for you. 
10.3.4 Password-Protecting a File 
With Microsoft Office, you can protect a file by creating a password for it. This works for Word, Excel and PowerPoint files. Steps for doing this are:
1. While in the file, press Alt to open the ribbons, Left arrow to the File Tab, Down arrow to the Info tab and press Enter.
2. Tab to the Protect document submenu, and press Enter. The shortcut for getting here is Alt F I P.
3. Down arrow to Encrypt with password and press Enter.
4. You land in an edit field. Type in a password for the file and press Enter.
5. You are asked to confirm the password. Type it in again and press Enter.
6. Press Escape to return to the workbook or main body of the document. 
7. Save the file if you have not already done so, or press Control S to save it with this revision, now updated with password protection.
8. To be sure it works, press Alt F4 to exit the file and then reopen it. You are prompted to enter the password. Type it in and press Enter. You are now in the file.
Be sure to choose a password that you can remember. If you forget it, you are completely out of luck.
After protecting a file with a password, you can change the password by getting back into the file and repeating the steps above. You can also remove password protection by returning to the edit field where you first entered the password, deleting the text, pressing Enter, and saving the revised file.
As you may know, there are many password manager applications on the market, some paid and others free. Popular examples are 1Password which carries a modest monthly subscription fee, and KeyPass which is free. All of these applications have several common characteristics, including:
· You are required to create a master password which enables you to open a secure vault where you can store usernames and passwords. 
· They enable you to generate strong passwords with many characters, combining upper and lower case letters, numbers and special characters.
· Your secure vault is stored online so it is automatically backed up, not just saved locally on your computer.
· They can be used across multiple devices, including computers, smartphones and tablets. With smartphones like the iPhone, you will need to enable touch or face ID in order to quickly log in.
While you may decide to use one of these applications, there is a learning curve for getting accustomed to using them. As an alternative, you can recreate all of the elements above by creating a password-protected Excel or Word file where you store your usernames and passwords. Password managers generate strong passwords by stringing together a bunch of random characters. You can create a strong password yourself that you then copy and paste into the password field of a login page. With Chrome and Edge, you can save login information for some websites so you don’t have to retype these credentials every time you log into a site.[footnoteRef:9] For those sites where this does not work, you can open the password-protected file and copy and paste the password, or you can generate a password that you can remember, while still being a strong one. Strong passwords contain a mix of upper and lower case letters, numbers, and special characters. [9:  In theory, you can also save passwords with Firefox but I have never figured out a way to do this with a screen reader. A dialog to save passwords frequently pops up, but I have never figured out a way to gain focus so I can save my user IDs and passwords.
] 

If you save your password-protected file in Dropbox, OneDrive or some other file sharing cloud application, this stores them online. And if you use an iPhone and enable touch or face Id, this will allow you to log in to apps more easily. 
This way, you can develop a do-it-yourself password management system with a relatively flat learning curve. I have done this in Excel with account names contained in column A, user ID’s in column B, passwords in column C, and login page URL’s in column D.
Telling you about my strategy is not meant to discourage use of password management applications, some of which have additional valuable features. However, as a technology instructor, I have found it useful to demonstrate this alternative to my trainees. For anybody with basic knowledge of Word, Excel, and cloud sharing services like Dropbox or OneDrive, it takes just a couple of minutes to learn this technique, versus the several hours required to get comfortable with a password manager app. It is a quick and easy way to begin transitioning out of the all too common bad habit of using the same password for everything, frequently forgetting passwords, or having no password management system at all. 
10.3.5 Windows and FS Clipboards
When you select text and then copy or cut it to the Clipboard by pressing Control C or Control X, only the latest text selection is placed on the Clipboard. With both Windows and JAWS, it is possible to place multiple selections on the Clipboard so you can paste them elsewhere. 
With Windows, you must first enable the Windows Clipboard as follows:
1. Press Windows I to open Windows settings.
2. Type “clipboard” in the search box, minus the quotes, Down arrow to Clipboard settings, and press Enter. 
3. Tab to the Save multiple items to the Clipboard toggle and press the Spacebar to turn it on. 
4. Tab to Sync across devices. For privacy reasons, you may not want to enable this.
5. Press Alt F4 to close the window. There is no OK button here. 
To test out the Windows clipboard, open an existing Word document and select and copy several items. Then open a new document and Press Windows V. If you Up and Down arrow, a list of copied items appears in chronological order, with the most recent one at the top of the list. Press Enter on any of these to paste them into the new document. 
Unfortunately, you can only paste them one at a time. It is not possible to paste all of them at once. 
All the copied items remain on the Windows clipboard and across multiple applications, (for example, Word and Excel). There are two ways to clear the Clipboard. First, you can shut down the computer, or:
1. Press Windows V to open the Windows clipboard.
2. Down arrow to any of the copied items.
3. Tab to the More button and press Enter. 
4. Down arrow to Clear all and press Enter. 
Note that text you copy to the Windows clipboard does not retain any formatting from the original document. If you copy Excel formulas, only values are retained. 
While the Windows Clipboard automatically retains all copied items once you have enabled the feature, with JAWS, you have to append each item to be retained. Items are copied to the FS Clipboard (this stands for Freedom Scientific). The FS Clipboard only works in text editors. It does not work in Excel. To append text to the FS Clipboard, first select text as you normally would. Then press Insert Windows C. Now go to the destination and press Control V to paste all the items on the Clipboard
If, after appending items to the FS clipboard, you select text and press the standard Control C, you will be asked if you want to override what is on the FS Clipboard. If you press the Yes button, all items on the FS clipboard will be cleared. You will now be back with the standard clipboard where only the last item copied or cut is retained on it prior to pasting. 
Note that you can only copy text to the FS Clipboard. It is not possible to cut selections to it. 
10.3.6 Accessibility Checker 
Microsoft has a useful tool for flagging accessibility issues for the Office Suite of products. It has been available for quite some time for Word, Excel and PowerPoint, and only more recently for Outlook. Note that this utility does not work with files with the older 1997/2003 Office extensions (.doc,.xls and.ppt). If you are using such files, resave them with the newer file extensions ending with X (.docx,.xlsx and.pptx).
To run the Accessibility Checker for Word, Excel, and PowerPoint, press Alt to open the Upper ribbon, Right arrow to the Review tab, Tab to the Check accessibility split button and press Enter. To use shortcut keys instead:
· For Word and PowerPoint, press Alt R A 1, and Enter. 
· For Excel, press Alt R A, and Enter.
· For Outlook you must be in the message preparation window. Press Alt V A.
After activating the Accessibility Checker, you may first land on the Keep the Accessibility Checker running while I work checkbox. Press the Spacebar if you wish to do this. Tab to the Inspection results tree view. If no accessibility issues are present in the file, this will be indicated. Otherwise, a tree view appears with the accessibility issues encountered grouped into three categories:
· Errors: Content that makes the document difficult or impossible to read and understand for persons with disabilities. A frequently-encountered example is absence of descriptive text for a graphic in a PowerPoint slide or chart in an Excel worksheet (referred to as “alternative text”). 
· Warnings: Content that in most (but not all) cases makes the document difficult to understand for persons with disabilities. An example is text that is hard to read on a PowerPoint slide.
· Tips: Content that people with disabilities can understand but that could be presented in a different way to improve the user’s experience. One example is absence of headings in a Word document, thus impeding efficient navigation. 
Each accessibility issue appears at level 0 of the tree view, along with how many instances of that problem have been identified. Each specific instance of that problem is listed at level 1. If you simply want to navigate to that point in your file, press Enter. You can also rectify the problem within the Accessibility Checker. Below is a step-by-step example of adding alt text to a PowerPoint image which previously had none:
1. After opening the PowerPoint presentation, press Alt R A 1 and Enter to run the Accessibility Checker.
2. Tab to the Inspection results, and Down arrow to Missing Alternative text in the tree view. This is categorized as an error. 
3. Right arrow to open level 1 of the tree view, and Down arrow to the first instance of a graphic lacking alt text.
4. Press Alt Down arrow, and Down arrow through several options. For alt text, these include: add a description, label as decorative, and learn more. Choose decorative if the graphic conveys no substantive information. Choose learn more if you want to get help on this topic. 
5. Otherwise, press Enter on Add a description, type in the text, and press Escape when finished. 
Open the link below to read about common errors, warnings and tips provided by the Accessibility Checker for the Microsoft Office Suite:
Rules for the Accessibility Checker22
10.3.7 Dictation in Word and Outlook 365 
If you are not a great typist, or want to prepare a short Outlook message, Word document, or PowerPoint slide, try the Dictate feature. Use it to quickly record notes or prepare a draft document. Provided that you speak reasonably clearly, the results are impressive in terms of being error-free. This feature is only available with an Office 365 license. 
The first time you use the Dictate feature in Word or Outlook, you may need to navigate to it in the Home tab of the Ribbon menu. To do this in Word, press Alt to open the Upper ribbon, Left arrow to the Home tab if you are not already there, press Control Right arrow to move by group to the Dictate button, and press the Spacebar to check it. In Outlook, your cursor must be positioned in the body of a message you are preparing before you can execute these steps. From now on, you can use the shortcut key which is Alt H D.
With your cursor positioned in the location in the Word document or Outlook message where you want to add text, press Alt H D to start dictation. You should hear a chime. When you are finished dictating, press Alt H D again to end dictation. You will not hear a chime at this point. Check if your dictated text has been inserted. 
You can add punctuation marks by saying them. Among the most common are: period, comma, question mark, new line, and new paragraph. For more information about dictation and the full set of words you can say related to punctuation and editing, check out this link from MS Office Support:
Dictate in Microsoft 365.
To access the various dictation options, first dictate a few words. Then press F6 several times to navigate to the Dictation settings submenu, and press Enter to open it. Options include: auto-punctuation, a profanity filter (checked by default), and a Spoken language submenu. If you want to change your dictation language, open this submenu, Down arrow to the language of your choice, and press Enter. English is the default language. If you switch to another language, this will be your new default dictation language until you return here to change it back again.
When you are finished changing Dictation settings, press Escape to return to your document.
10.4 Participating in Zoom Meetings
Since the outbreak of the COVID pandemic in early 2020, Zoom has become an indispensable tool for communicating in work, school, and social settings. While there are several online platforms for such communication, Zoom is by far the most popular. It is nearly 100 percent accessible and its usability is unparalleled. It is beyond the scope of this book to give a full presentation of Zoom’s capabilities. Discussion here is limited to keystrokes for participating in zoom meetings. 
The keystrokes below only work if you are situated in the active Zoom meeting window. If you press Insert T, your screen reader will either say “meeting controls,” or “Zoom meeting.” If it only says “Zoom,” this means you are in the window for the desktop Zoom app, not the active meeting window. The keystrokes below will not work if you are in the “Zoom” window. 
If you are not currently in the active meeting window, press Alt Tab until you get back to it. To get into that window more quickly, hold down Control Shift and Alt together. 
Once you are in the active meeting window, you can Tab through a dialog box to find the various controls, but it is more efficient to use the following keystrokes instead. 
· Alt A - mute/unmute audio: In any Zoom meeting with a reasonably large number of participants, you should always stay muted if you are not speaking or do not plan on speaking soon. Unwanted background noise is disruptive and irritating. It reflects poorly on the person who is unaware that he or she is unmuted. You should frequently double-check your muted/unmuted status to avoid this problem.
· Alt V - toggle video on/off: With your video on, participants will see whatever images your computer camera displays. If using a laptop, be sure you know where the camera is located. It is usually near the top middle of your screen, but not always. Verify with a sighted person that the screen is properly tilted to focus on your face rather than on some other part of your anatomy. Also be vigilant that nothing unsightly is visible in the background. The camera typically displays a wider background image than you might imagine. Horror stories abound on embarrassing images being picked up from people’s cameras. 
· Alt Y - raise your hand: In large meetings hosts may ask you to raise your hand to be acknowledged during pauses for discussion. You can press Alt Y again to lower your hand if you no longer wish to be acknowledged. 
· Alt H - Chat: You can submit questions or comments during a meeting in text format. Pressing this key combination opens a dialog box where you first land in an edit field, (although your screen reader may not announce it). Type in a message and press Enter to send your chat to all meeting participants. Tab one more time to access a list of chats sent during the meeting. The list is organized chronologically, with the earliest chat message at the top of the list. Press Tab again to the To everyone button drop-down. To send a chat to an individual rather than the entire group, press Enter here and Down arrow to the participant to whom you would like to send a chat. Press Enter, type in your text, and press Enter again to send it. To save a list of chats sent during the meeting, continue Tabbing to The More chat options button drop-down, and press Enter. If the host has enabled saving chats, you will land on “Save chat.: Press Enter here and a text file will be saved in a folder entitled “Zoom,” located in your Documents folder. The text file will be placed in a subfolder for this meeting.
· Alt U - Participants list: You first hear the number of participants currently on the Zoom call. You can then Down arrow through the list, hearing the name of each participant, as well as information about their status (muted/unmuted, video on/off, etc.). Your information is found at the top of the list, followed by hosts and participants with raised hands. I frequently go here to check my status and to see who else is on the call. It is not always clear to me whether or not I am muted, so I often navigate here to double-check.
· Alt S - screen share: After pressing this keystroke, Tab several times to the Share computer sound checkbox. Press the Spacebar to check this if you want to share your computer audio, including your screen reader voice. Tab several more times to the Share screen button and press Enter. To end screen sharing, simply press Alt S again. 
· Alt R - Start and end local recording: If you are a meeting host, use this keystroke to start and end recordings. If you are a participant, you must ask the host for permission to record. After the meeting is finished, recordings will be converted and saved to the same folder mentioned above for chat text files.
· Alt P - Pause and resume recording: You can pause and resume in mid-recording using this keystroke. 
· Alt Q or Alt F4 - Leave meeting: If you are a participant, press either of these two keystrokes, Tab to the Leave meeting button and press Enter. If you are a host, continue Tabbing to the End meeting for all button and press Enter to terminate the meeting. 
10.5 YouTube 
YouTube is one of the most popular websites on the planet. You can access videos and accompanying audio for just about any topic imaginable. In this section, you can find some hints on how best to navigate the website, helpful quick keys for playing videos, and an easy way to download YouTube video and audio files to your PC. 
10.5.1 Navigating YouTube
Searching for YouTube videos is quick and easy. There is only a single edit field on the YouTube page. With JAWS, just press E and then Enter to get into the search box. You can do this from anywhere on the page because JAWS wraps back to the top of the page when pressing quick keys. NVDA and Narrator do not wrap around, so press Control Home to start from the top of the page. Then press E and Enter to get into the search box. 
After typing in your search term, press Enter. Each search result is a heading and a link, so press H until you get to the one you want to play, and then press Enter.
Here are a couple of hints. First, after typing in a search term and pressing Enter, press Escape to be sure you are not still in the search box. For some reason, after pressing Enter on your search, your cursor sometimes remains in the search box. 
Second, have Audio ducking enabled (see Chapter 8.1.5.5 on how to do this with JAWS, 8.2.2 For NVDA, and 8.3.2 for Narrator). This will make it easier to hear your screen reader keystrokes while the video is playing. 
While playing a video, there are a number of useful quick navigation keys you can access. There are several ways to do this. I will only describe what I consider to be the best ways to access the widest array of useful controls. 
Once the video starts playing, Tab once or twice to the first left/right slider related to moving through the video play time. With JAWS and Narrator, use the following keystrokes:
· Spacebar or K: Pause and resume playing.
· Right/Left arrow: Move forward/back five seconds.
· Page Up/Down: Move forward/back one minute.
· 1 through 9: Move to 10 percent through 90 percent mark.
· Home/End: Move to beginning/end.
To make the above keys work with Narrator, once you Tab into the Left/right slider, you need to manually disable Scan mode by pressing Insert Spacebar. 
To adjust the volume of the video (and this will adjust independently of the overall system volume of your computer), continue tabbing to the second left/right slider, and use the following keystrokes:
· Up/Down arrow: Raises/lowers volume by five percent.
· Home: Mutes volume.
· End: Maximizes volume. 
To slow down or speed up playback, continue tabbing to the Settings button and press the Spacebar to expand it. Down arrow to the Playback submenu and press Enter. Normal is the default speed. There are 25 percent increments, ranging from 25 to 200 percent. Up or Down arrow to your choice and press Enter to change the playback speed. 
Finally, you can press Shift N to go to the next video. However, I do not find that this works consistently. 
10.5.2 Downloading YouTube Videos with Pontes Media Downloader 
This is a free app for downloading and converting YouTube videos. You can download the original file format, as well as convert to other formats like MP3, WAV, and others. Any advertisements are not present in the downloaded file.
There are several versions of this software. It is preferable to download version two rather than the newer version three. Version two is more accessible and includes MP3 audio while version three does not. Download the installation file to your Downloads folder at: 
Download Pontes Media Downloader Version 2
Although there is a checkbox with the option to create a desktop shortcut for the program, this never works. After installing the program, create a desktop shortcut using the steps outlined in Chapter 2.8.2.
Steps for downloading and converting a YouTube video are as follows:
1. Search for and start playing a video on YouTube. 
2. After it starts playing, press Alt D or F6 to get to the Address bar. You should hear “http, etc.” The URL is already selected.
3. Press Control C to copy the URL to the Clipboard.
4. Open the Pontes Media Downloader app on your PC. You should land in the URL field. Press Control V to paste the URL here.
5. Tab once to the Convert to combo box and Down arrow to your choice. A single Down arrow brings you to MP3, and after you Down arrow there the first time, focus tends to remain there in the future. 
6. Tab to the Download button and press Enter or Spacebar. File conversion will start and percentages will be read. You will also hear when it is finished.
7. Navigate to your Documents folder. During program installation, a folder entitled “Pontes Media Downloader” was created. Open it where you will find the file that you downloaded and converted. Press Enter on it and your default music player app will play it.
I should mention that, unfortunately, the download process has slowed down considerably over the past several months. Perhaps the folks at YouTube just don’t want people listening to their videos outside of their own environment and have figured out a way to hamstring this app. 
10.6 When Things Go Wrong
Technology is quirky. Things inevitably go wrong. I will conclude this book by identifying some commonly encountered issues and possible ways to address them. Here goes!
10.6.1 JAWS or NVDA stops talking.
I am primarily a JAWS user and find that it frequently goes silent. This might be because my personal laptop is rather old and it takes a lot of juice to run JAWS together with other applications. However, all JAWS users experience this problem from time to time. To get some speech back, first try turning on Narrator by pressing Control Windows Enter. I like to say that JAWS gets jealous easily, not wanting an uppity competitor to butt in on its turf. Turning on Narrator often wakes up JAWS. If that doesn’t immediately get JAWS talking, navigate to the Desktop and click on the JAWS icon, hopefully getting JAWS back this way. If this works, then press Control Windows Enter again to exit Narrator. 
Although not yet as versatile as JAWS and NVDA, I consider Narrator an indispensable tool when things go wrong with the other screen readers. I switch it on and off several times every day. 
If attempting to activate Narrator fails to get speech back, it’s probably time to power off the computer by holding down the Power button until the computer is turned off. Then boot it up again to restore speech. 
10.6.2 You open a window that you know has content, but when you Down arrow, you hear nothing. 
If this happens in a Word document, first press Alt R W to get a word count, just to doublecheck that text is present and that you have not accidentally deleted it. Then close your screen reader program and reopen it (see Chapter 1.2, 1.3, and 1.4 on how to close and open JAWS, NVDA, and Narrator, respectively). This usually fixes the problem. 
You also may try maximizing the window by pressing either Windows Up arrow or Alt and the Spacebar together and then X. But turning JAWS off and then on again pretty much always works.
10.6.3 You receive the message “program not responding.” 
This most frequently happens to me with Outlook. I naturally first try pressing Alt F4 to exit the program. I try other things too, like pressing Escape. But invariably, the program does not close and I cannot resume working in that application. Short of rebooting the computer, open the Task Manager and close the program there. To do this, press Control Shift Escape together, Down arrow to the offending program, Tab to the End task button, and press Enter. Reopen the program, and it should now work correctly. If the problem persists, it’s time to reboot the computer. 
10.6.4 You accidentally delete text.
In any application where you are in edit mode, immediately press Control Z to undo your last keystroke. If you are working in Excel, and press a wrong key in a particular cell, immediately press the Escape key. Whatever you just typed will not replace previous cell content. 
The above said, your best defense against losing substantial amounts of work is to save files early and often. If you do this and then make a serious editing mistake, just close your document without saving it, and reopen it. The amount of work you lose will be minimal. 
10.6.5 A file does not open in the program you want it to open in.
If you want to permanently change the default program for opening this file type, see Chapter 2.5.7. 
If you want to open the file in an application other than the default one, place your focus on the filename. Then press the Applications key, Down arrow to the Open with submenu, and press Enter. Now Up or Down arrow to the desired application and press Enter. 
10.6.6 I am having a problem but don’t know whether it’s an issue with my screen reader, the application I am in, or with my own computer. 
First try to narrow down the possibilities to isolate the problem. This will help you to better articulate your problem if you need to call tech support or post a question to a discussion list. 
Let’s say you experience a problem while using JAWS. Try switching to NVDA or Narrator. If performance improves, chances are good that the problem is with your initial screen reader. If nothing changes, the problem is unrelated to your choice of screen reader.
If you encounter a problem on a website, try switching browsers. Here too, this might help you isolate it. If the problem first arises using Google Chrome, try Firefox rather than Edge. Chrome and Edge are both Chromium-based while Firefox is not, so there is a greater likelihood that performance will be different. Also try switching screen readers. If the problem persists regardless of which screen reader and/or browser you switch to, then the problem almost certainly lies with the application itself or the specific website. At this point, you may wish to contact customer support for that application or website. You might also query a technology discussion list to which you subscribe, asking if others have had similar problems, and if so, what they did to resolve it. 
10.6.7 I open a web page and my screen reader remains silent. 
First try refreshing the web page by pressing F5, and wait a reasonable time for your screen reader to start telling you the number of headings, links, and so on, that are present on the page. Also try maximizing the page by pressing either Windows Up arrow or Alt and the Spacebar together and then X. 
10.6.8 Quick key navigation fails to work on a web page.
Let’s say you open a web page, and then press H to navigate to the first heading, or you press E to get to the first edit box, but your screen reader only says H or E. Try any of the following:
· Press F5 to refresh the page to see if it correctly loads this time. 
· You may have landed on the Address bar instead of the main body of the web page. Shift Tab several times to see if you can get to the main body of the page that way. 
· Toggle screen reader cursor modes off and on. With JAWS, press Insert Z to toggle Virtual PC cursor mode on and off. Try Down arrowing to see if you can now activate links. Press H to see if you can navigate by heading. In some cases where accessibility problems exist, Down arrowing and pressing Enter on a word or set of words that are not expressed as links or buttons may activate them. If using NVDA or Narrator, press Insert Spacebar to toggle on and off Browse mode or Scan mode. These are there equivalent to the JAWS Virtual PC cursor mode. 
· Close the web page and reopen it and see if it behaves properly this time. 
· Change web browsers and/or screen readers to see if performance improves. 
10.6.9 You can’t remember how to do something or want to figure out how to do something you have never done before.
Before posting a message to a technology discussion list or contacting tech support, try conducting an online search. You will be amazed at how many things you can figure out by “Googling it.” The more precise you can be in the wording of your search, the more likely you will be to find an answer. 
Keep in mind that many of the step-by-step instructions you encounter will be written for sighted people. You will be told to drag this from here to there, click on the red or green button, and various other things of little or no help to screen reader users. YouTube demo presenters will fail to describe what they are clicking on. 
If keystroke combinations are identified, these are what you want. If you are instructed to “right click” on something, this is the equivalent of pressing the Applications key. If you are told to click on a particular command in one of the Office applications, try to figure out how to get there via the ribbon menus, or use the Tell Me feature of Office (see Chapter 10.3.1 above). 
Try subscribing to several assistive technology user discussion lists. I find some of the lists managed by Groups.io especially informative. Find out how to create an account at:
Creating a Groups.io account
Links to the home pages of some of the lists that I have found informative include:
For JAWS: main@jfw.groups.io and jfw-users@groups.io.
For NVDA: nvda@nvda.groups.io.
For Microsoft Office: office-accessibility@groups.io.
For news about assistive technology for the blind: tech-vi@groups.io. This is an announce-only list rather than a discussion list. 
These home pages provide information on the subject matter of the lists, numbers of members, previous discussion threads, and links for subscribing and unsubscribing.
If you are concerned about getting inundated with email messages, you can set parameters on how you receive messages. Rather than getting individual messages, I prefer receiving a daily digest from each list with links to the various message threads. That way, I only get one message per discussion list each day, and I can quickly see if a particular discussion thread interests me. To specify your mode of email delivery, open the Subscription link on a list’s home page. That page includes radio buttons where you can choose among several email delivery options. 
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In this appendix, programs are alphabetically listed below and all are marked as level two headings. Subsections of each program are marked as level three headings. 
Excel
Navigation 
[bookmark: OLE_LINK18]Control Home: Go to cell A1
Control end: Go to intersection of last column and row with data
Control and four arrow keys: Navigate to last and first cells in regions
Control G or F5: Go to a specific cell
Insert Shift 1, 2, 3, etc.: Create monitor cell 1, 2, 3, etc. with JAWS
Alt Shift 1, 2, 3, etc.: Read monitor cell 1, 2, 3, etc. with JAWS
Control Shift M: List monitor cells with JAWS
Editing, Formulas and Data Manipulation
Addition: =A1+A2
Subtraction: =A1-A2
Multiplication: =A1*A2
Division: =A1/A2
Sum of the data range A1 through A10: =SUM(A1:A10)
Average of the data range A1 through A10: =AVERAGE(A1:A10)
Minimum value in the data range A1 through A10: =MIN(A1:A10)
Maximum value in the data range A1 through A10: =MAX(A1:A10)
Alt =: Auto sum (selects a default data range to speed up summing a column or row)
Shift Spacebar: Select row
Control Spacebar: Select column
Alt H I R: Insert row 
Alt H I C: Insert column 
Alt H D R: Delete row
Alt H D C: Delete column
[bookmark: OLE_LINK15][bookmark: OLE_LINK17]Alt H O W: Manually adjust column width
Alt H O I: Autofit column width
Control 1: Format cells dialogue box
Control Shift 4: Format dollars with two decimals
Control Shift 5: Format percentages with no decimals
Control semi-colon: Insert today’s date
Alt H M: Merge Cells 
Insert F1: Find information about a spreadsheet with JAWS 
[bookmark: OLE_LINK66][bookmark: OLE_LINK67][bookmark: OLE_LINK68][bookmark: OLE_LINK69]Control Shift L: Toggle filtering on/off
Alt N V: Create pivot table
Multiple Worksheets
[bookmark: OLE_LINK13][bookmark: OLE_LINK14][bookmark: OLE_LINK65]Control Page up/down: Move to previous/next worksheet
Control Shift S: List worksheets with JAWS
Insert Shift S: Context menu with JAWS for worksheet actions (delete, move, copy, rename, etc.)
Alt H V S and Shift Tab once: Paste links (copy formulas or values from one sheet to another)
Shift F11: Add new worksheet in workbook with focus in new worksheet
Alt H O R: Rename worksheet
Alt H O M: Move or copy worksheet
Alt H D S: Delete worksheet
Printing Worksheets
Control P: Open print dialog
Control Shift B: Location of row and column breaks with JAWS
Insert F1: Number of printable pages with JAWS
Alt P M: Margins submenu
[bookmark: _Hlk508880682]Outlook 
[bookmark: OLE_LINK32][bookmark: OLE_LINK26][bookmark: OLE_LINK27][bookmark: OLE_LINK28][bookmark: OLE_LINK29]Control N: Create new message if in one of the mail folders, create new appointment if in calendar folder, create new contact if in contacts folder. 
Shift Tab and Tab: Move up and down through fields in an open message
Alt S or Control Enter: Send message
Control R: Reply to sender
Control Shift R: Reply to all 
Control F: Forward message
Control Y: Open folder tree view
Alt O N or Control Shift E: Create new folder
Alt P B: Add/remove BCC field (only while in message preparation window)
Control Shift I: Go to inbox
Control 1: Go to last message folder
Control 2: Go to calendar folder
Control 3: Go to contacts folder
Control Shift C: Create new contact
Control E: Search 
Control Alt A: Search All Mail
Insert Control F: Find text within an email 
F3: Find next with JAWS 
Insert F3: Find next with NVDA and Narrator
Outlook Calendar
[bookmark: OLE_LINK34][bookmark: OLE_LINK35]Control 2: Go to calendar
[bookmark: OLE_LINK20][bookmark: OLE_LINK19]Control Alt 1: Day view
[bookmark: OLE_LINK22][bookmark: OLE_LINK21]Control Alt 2: Work week view
Control Alt 3: Full week view
Control Alt 4: Month view
Tab and Enter: Navigate to an existing appointment to edit
Control N: Create new appointment from inside the calendar folder
Control Shift A: Create new appointment from anywhere in Outlook
Control Shift Q: Create new meeting from anywhere in Outlook
PDF’s Using Acrobat Reader
Ctrl Home: Go to beginning of document
Ctrl End: Go to end of document
Control Page up/down: Go to previous/next page
Control Shift N: Go to page
Shift F4 and then Insert Page down: Status bar for indicating page number and total number of pages in document
Control Insert F: Find command for searching text
Insert F3: Find next occurrence of text
Control Shift 5: Change reading order 
Control Windows K: Create temporary placemarker with JAWS
Control Shift K: List placemarkers with JAWS
K: Navigate to next placemarker with JAWS
PowerPoint
[bookmark: OLE_LINK11][bookmark: OLE_LINK12]F5: Opens Slide show view and reads first slide
Shift F5: Opens Slide show view and reads current slide
Spacebar: In Slide show view, goes to next slide and reads it
Backspace: In Slide show view, goes to previous slide and reads it
Ctrl Shift N: Read notes in Slide show view
Escape: Exit Slide show view
F6 and Shift F6: Switch between panes (the most useful being slide area, thumbnail and Notes panes)
Tab: Move between objects on slide
Tab and enter: Move to and get into object to edit
Escape: Exit object after editing
Control M: Create new slide (same type as current slide)
Alt H I: Create new slide (different type than current slide)
Insert tab: Speak selected object
Ctrl Shift S: Speak information about current slide with JAWS
Ctrl Shift D: Speak dimensions of object with JAWS
Screen Reader Basics
JAWS 
Insert T: Title of window
Control Alt J: Open JAWS (needs to be set up by user)
Insert F4: Exit JAWS 
Control F: Find text
F3: Find next occurrence on web pages and in PDF’s
Spacebar: Find next occurrence in Word documents
Control Windows Alt Page up/Page down: Increase/decrease default voice rate
Control Windows K: Temporary placemarker for Extended text selection
Insert Spacebar together and then M: Select between temporary placemarker and cursor position
K: Move to next placemarker 
Insert and Spacebar together and then T: Toggle Table layer
Insert and Spacebar together and then S: Toggle speech off/on 
Insert Z: Toggle quick keys on/off
NVDA
Insert T: Title of window
Control Alt N: Open NVDA
Insert Q: Quit NVDA
Insert N: Open NVDA menu
Insert A: Say all text (continuous read in laptop mode)
Insert Down arrow: Say all text (continuous reading desktop mode)
Insert 4: Toggle command keys speak on/off
Control Insert F: Find text
Insert F3: Find next
Control Insert Up/Down arrow: Increase/decrease default voice rate
Insert S: Speech on/off
Insert Spacebar: Browse mode on/off
Insert F9: Extended text selection - mark start of text
Insert F10: Extended text selection - mark end of text 
Narrator
Control Windows Enter: Open/exit Narrator
Control Windows N: Open Narrator menu
Insert Spacebar: Scan mode on/off
Insert Down arrow: Say all or continuous reading
Insert Plus/Minus: Increase/decrease default voice rate
Web Browsing 
[bookmark: OLE_LINK39][bookmark: OLE_LINK40][bookmark: OLE_LINK55][bookmark: OLE_LINK56]Opening and Closing Web pages
Alt D or F6: move to address bar (URL is selected)
Control T: Open new tab
Control Tab: Move between open tabs
Control W or Control F4: Close current tab
Alt F4: Close all tabs and exit browser 
Web Navigation
Control Home: Go to top of page 
Control End: Go to bottom of page
Insert F1 at top of page: JAWS context help tells number of regions, links and headings
Alt Left arrow or Backspace: Move back one page 
Alt Right arrow: Move forward one page
H: Go to next heading (Shift H to go back one heading)
1, 2, 3, etc.: Move to next level 1, 2, 3, etc. heading
Insert F6: Headings list (JAWS and Narrator)
Insert F7: Links list (JAWS and Narrator)
Insert F7: NVDA Elements list 
Tab and Shift Tab: Go to next/previous link
N: Move to next block of non-linked text 
P Go to next paragraph (JAWS and Narrator)
G Go to next graphic
R: Go to next region or landmark (JAWS)
D: Go to next region or landmark (NVDA and Narrator)
Control F: Find text, F3 Go to next occurrence (JAWS)
Control Insert F: Find text, Insert F3 Go to next occurrence (NVDA and Narrator)
Web Forms and Tables
Insert F5: List of form fields (JAWS only)
B: Next button
C: Next combo box
E: Next edit box
X: Next checkbox
F: Next form field. 
A: Next radio button (JAWS)
R: Next radio button (NVDA and Narrator)
T: Next table
Control, Alt and Up, Down, Left and Right arrow keys: Move up, down, left, and right in a table
Up and Down arrow: Move right and left along a row in a table
Right/Left arrow: Move right/left by character in a cell
Other Universal Web Keystrokes
Control D: Create favorite or bookmark
Control H: Open History
Ctrl J: Open downloads manager
Control Shift Delete: Open Clear browsing history 

Accessing Google Chrome and Microsoft Edge Menus
Alt and F together: Open context menu
Alt and F together and then S: Open Settings 
Alt and F together and then L: Open More tools submenu
Windows
Windows Navigation
[bookmark: OLE_LINK47][bookmark: OLE_LINK48]Windows M or Windows D: Go to desktop
Windows key: Open Start menu with focus in search box
Insert F11: Open System Tray with JAWS
Windows B: Open Notification Area with NVDA and Narrator
[bookmark: OLE_LINK51][bookmark: OLE_LINK52]Alt Tab: Move between open windows
[bookmark: OLE_LINK49][bookmark: OLE_LINK50]Alt F4: Close window/program
File and Folder Management
Control Shift N: Create new file
Down arrow or first-letter navigate: Select individual file or folder
Spacebar: Select first file or folder in a list
Shift Down arrow: Select files or folders continuously
Control Spacebar: Select files or folders discontinuously (Down arrow past ones you don’t want to select)
Control A: Select all files or subfolders in a folder
Shift Control Home: Select from cursor to first file or folder in a list
Shift Control End: Select from cursor to last file or folder in a list
Control C: Copy selected files 
Control X: Cut selected files
Control V: Paste selected files
Text Reading and Navigation
Right/Left arrow: Read by character
Control and right/Left arrow: Read by word
Down/Up arrow: Read by line
Control Down/Up arrow: Read by paragraph
Insert Down arrow: Reads continuously (Say all) in JAWS, narrator, and NVDA if NVDA is set in desktop mode
Insert A: Read continuously (Say all) in NVDA (in laptop mode) 
Control Home: Go to top of page
Control End: Go to bottom of page
Home: Go to beginning of line
End: Go to end of line
Text Selection and Basic Editing
Shift Right arrow: Select character 
Shift Control Right arrow: Select word
Shift Down arrow: Select line
Shift Home: Select from cursor to start of line
Shift End: Select from cursor to end of line
Shift Control Down arrow: Select paragraph
Shift Control Home: Select from cursor to top of document
Shift Control End: Select from cursor to end of document
Control A: Select all
Control C: Copy text to Clipboard
Control X: Cut text to Clipboard
Control V: Paste text from Clipboard
Control Z: Undo	
[bookmark: _Toc1629900]Word
Alt: Open Upper ribbon
Tab/Shift Tab: Move between commands in Lower ribbon
Control Right/Left arrow: Move between groups in Lower ribbon
F12: Save As dialog box
Control S: Save revised document
Text Formatting
[bookmark: OLE_LINK9][bookmark: OLE_LINK63][bookmark: OLE_LINK64]Insert F: Check formatting of character or selected text
Control B: Bold on/off
Control I: Italics on/off
Control U: Underline on/off
Control L: Left align text
Control E: Center align text
Control J: Justify align text
Control R: Right align text
Alt H E: Clear formatting (returns font and paragraph settings to default)
Insert F1: JAWS Screen-Sensitive Help (good for checking margin dimensions and header/footer content)
Insert Page down: Status bar (current page and total number of pages in document). JAWS only
Alt R W: Number of pages and word count
Alt H U: Bullets split button
Alt H N: Numbering split button
Headers and Footers
Alt N H: Header submenu
Alt N O: Footer submenu
Alt N H R: Remove header
Alt N O R: Remove footer
Alt N U: Page number submenu
Alt Shift P: Insert page numbers in header/footer fields
Headings, Styles, and Table of Contents
[bookmark: OLE_LINK43][bookmark: OLE_LINK44]Control Alt 1: Apply level one heading
Control Alt 2: Apply level two heading
Control Alt 3: Apply level three heading
Control Shift N: Apply normal style (or remove heading format)
Insert F6: List of headings (JAWS and Narrator) 
Insert Z and H: Quick keys mode in JAWS, navigate by heading with H, 
Insert Spacebar: Browse mode with NVDA and Scan mode with Narrator, navigate by heading with H,
Alt H L: Styles submenu
Alt S T: Table of contents submenu
Alt S U: Update table of contents
Proofreading and Review
[bookmark: OLE_LINK8]Insert F: Check formatting (font and paragraph settings)
[bookmark: OLE_LINK23][bookmark: OLE_LINK24]Alt Windows I: JAWS Text Analyzer, jump to next inconsistency
Alt Insert S: JAWS Speech and Sounds Schemes
Alt Delete: Vertical and horizontal cursor location on page with JAWS
F7: Spellcheck
Control Shift E: Track changes on/off
Windows Semi-Colon: List comments, revisions, footnotes, or endnotes in JAWS virtual viewer
Alt R C: Add new comment
Insert Z N: Quick Nav key to jump by comment. With JAWS
Alt R N: Go to next comment
Alt R V: Go to previous comment
Windows Semi-Colon: List comments, revisions, footnotes, and endnotes in JAWS virtual viewer
Applications key: Open context menu on comment (can edit, delete and reply)
Alt R D O: Delete all comments
[bookmark: OLE_LINK37][bookmark: OLE_LINK38][bookmark: OLE_LINK25]Alt S P: Insert caption (or title) in a table
Insert F1: Table information with JAWS (when cursor is inside table)
Control Alt and the four arrow keys: Move vertically and horizontally within a table
Tab and Shift Tab: Move between cells in a table (cell content is highlighted)
Control Alt Home: Go to top left cell
Control Alt End: Go to bottom right cell
Control Insert T: List tables in document. JAWS only
Zoom Meeting Room
Alt A: Mute/unmute audio
Alt V: Video on/off
Alt S: Screen share
Alt Y: raise/lower hand 
Alt H: Chat
Alt U: Participants list
Shift Control Alt: Moves to meeting controls window
Alt R: Start and end local recording
Alt P: Pause and resume recording


[bookmark: _Toc76134048][bookmark: _Toc88666521][bookmark: _Toc89178578][bookmark: _Toc89179305][bookmark: _Toc90034566][bookmark: _Toc90034696][bookmark: _Toc90201430][bookmark: _Toc90459036][bookmark: _Toc91081659][bookmark: _Toc91241389][bookmark: _Toc91585888][bookmark: _Toc92278049][bookmark: _Toc92536801][bookmark: _Toc92653260][bookmark: _Toc93222526][bookmark: _Toc93387477][bookmark: _Toc93922918][bookmark: _Toc93928871][bookmark: _Toc94189409][bookmark: _Toc94629804]Appendix II Glossary of Computer Terms
This glossary is arranged alphabetically with each entry marked as a level four heading. Press Insert F6 for a list of Headings. Use first-letter navigation to quickly navigate to an entry, and press Enter to access the text. Many of these entries were drawn from an excellent website that provides definitions of technology terms, Tech Terms.com. Another good source for definitions of computer terms is Techopedia.com Dictionary.
Address Bar 
A text field near the top of a browser window that displays the URL of the current webpage. The URL, or web address, is the address of the current page and automatically changes whenever you visit a new webpage. 
Alt Text (or Alternative Text)
Descriptive text of a graphic image used to make it accessible to screen reader users. 
Application Key
A key that might be to the right of the Spacebar, depending on computer model. On any keyboard, it can also be activated by pressing Shift F10. Used to bring up a context menu, it is nearly equivalent to right clicking with a mouse.
Banner Ad 
A long, rectangular image placed on a web page to generate revenue from advertising. After clicking the advertisement, the user is redirected to the advertiser's website.
Basic Input/Output System (BIOS)
A program pre-installed on Windows-based computers that the computer uses to start up. The BIOS checks all your hardware connections and locates all your devices. It then loads the operating system into the computer's memory and finishes the boot-up process. It is inaccessible because it starts up before programs resident on the computer start up, including screen readers.
Bit, Byte, Kilobyte, Megabyte, Terabyte
A bit is a computer's smallest unit of data. A byte is 8 bits, usually holding one character. A kilobyte (KB) is 1,024 bytes. A megabyte (MB) equals 1,024 kilobytes, enough storage to contain a 600-page book. A terabyte is 1,024 gigabytes.
Blog 
Short for "web log," this term refers to a list of journal entries posted on a web page. 
Browser or Web Browser
A program used to view World Wide Web pages, such as Google Chrome, Mozilla Firefox, and Microsoft Edge. 
Buffer
Contains data that is stored for a short amount of time, typically in the computer's memory. Its purpose is to hold data right before it is used. If you download an audio or video file from the Internet, it may load the first 20% of it into a buffer and then begin to play. While the clip plays back, the computer continues to download the rest of the clip and stores it in the buffer. Because the clip is being played from the buffer, not directly from the Internet, this reduces the possibility that the audio or video will stall or skip when there is network congestion.
Button
Appears visually as a rectangular shape, and is a control for launching some action (typically has a label like OK, continue, next, submit, save). To activate a button, press Enter or the Spacebar. 
Cache
Stores recently used information so that it can be quickly accessed at a later time. Computers incorporate several different types of caching in order to run more efficiently, thereby improving performance. These include browser, disk, and memory caches.
CAPTCHA 
This term comes from the word "capture," since it captures human responses. The acronym stands for "Completely Automated Public Turing test to tell Computers and Humans Apart.” These are programs used to verify that a human, rather than a computer, is entering data. They are commonly seen at the end of online forms and most frequently ask users to enter text from a distorted image or short audio recording. 
Cell Reference
Also referred to as a cell address, is an alphanumeric value used to identify a specific cell in a spreadsheet. Each cell reference contains one or more letters followed by a number. The letter or letters identify the column and the number identifies the row. 
Central Processing Unit (CPU)
The primary component or “brain” of a computer. It processes instructions and runs the operating system and applications, constantly receiving input from users and active software programs. 
Checkbox
A form field for choosing whether a particular option or property is turned on or off. A screen reader program says “checked”, or “unchecked.” Pressing the Spacebar toggles it on and off. 
Chromium
An open-source project that forms the basis for the Google Chrome and Microsoft Edge browsers, both of which also have proprietary features.
Clipboard
A section of memory where your computer stores copied data. This can be a selection of text, an image, a file, or other type of data. It is placed here whenever you use the Copy or Move commands. Data can then be pasted into a document or program using the Paste command.
Cloud 
This term is now synonymous with the Internet. It may also be used to describe specific online services, which are collectively labeled "cloud computing." Examples of popular cloud-based services include web applications, online backup, and other types of online storage. 
Combo Box
A dropdown from which you choose among a set of standard choices. Up or Down arrow to move through the choices or press the first letter of the choice you want. You may need to first press Alt + Down arrow to display the full list of choices before moving through them.
Context Menu
A menu that appears if you press the Applications key on a control or while in a window. Choices depend on which program they are activated from, And more specifically, where focus is located within the program. Up and Down arrow to move through the items, and press ENTER to activate a menu choice.
Control Panel
A feature of Windows that allows the user to modify system settings and controls. It includes several small applications that can be used to view and change hardware or software settings.
Cookie
A small amount of data generated by a website and saved by your web browser. Its purpose is to remember information about you, such as login information for a specific site. 
Cursor
Visually, the cursor on your screen can indicate two things: where your mouse pointer is, or where the next character typed will be entered when editing text. Screen reader applications like JAWS also incorporate specialized cursors to facilitate efficient screen navigation. 
Desktop
The primary user interface of a computer. When you boot up your computer, the Desktop is displayed once the startup process is complete. It includes the background (or wallpaper) and icons of shortcuts to files, folders, applications and web pages, as well as files or folders you have saved directly to it. It includes a Taskbar, which is located at the bottom of the screen by default. 
Desktop Shortcut
Usually represented by an icon, is a small file that points to a program, folder, document, or Internet location. Clicking on a shortcut icon takes you directly to the object to which the shortcut points. Shortcut icons contain a small arrow in their lower left corner. 
Dialog Box
Serves to initiate a “dialogue” with the user. It is a window that pops up on the screen with options that the user can select. After the selections have been made, the user can typically tab to an OK button to enter the changes or a Cancel button to discard them. 
Disk Drive 
A device that reads and/or writes data to a disk. The most common type of disk drive is a hard drive. 
Dongle
A small device, typically about the size of a flash drive, that plugs in to a computer, usually via a USB port. Some dongles act as security keys while others serve as adapters for external devices. 
Download
This term can be used as either a verb or a noun. As a verb, it refers to the process of receiving data over the Internet. Downloading is the opposite of uploading, or sending data to another system over the Internet. As a noun, download refers to a file that is retrieved from the Internet. 
Driver
A software program that enables a hardware device to work with a computer's operating system. Drivers may be required for internal components, such as video cards, microphones and speakers, as well as external peripherals, such as printers and monitors.
Drop-Down Menu
A horizontal list of options that each contain a vertical menu. When you Down arrow to one of the primary options in a drop-down menu, a list of choices will cascade below the main menu.
Edit Box
A form field used for entering or editing text, also known as a text box. 
Edit Combo Box
A combination of two types of controls found in a dialog box, the edit box and the combo box. 
Edit Spin Box
A field that contains an editable area where you can type information. Also you can Up or Down arrow through a set of fixed numerical values. 
Ethernet
A common way to connect computers on a network over a wired connection. It provides a simple interface for connecting multiple devices, such as computers, routers, and switches. A standard Ethernet cable is slightly thicker than a phone cable and has a connector on each end. Ethernet ports look similar to telephone jacks, but are slightly wider. 
Executable File
A type of computer file that runs a program when it is opened. It executes code or a series of instructions contained in the file. 
Extended Select List Box or Multi-Select List Box
Similar to a combo box, but differing in that you can select multiple items.
Extension or Add-On
Small software programs that customize the browsing experience, enabling users to tailor functionality to individual needs or preferences. 
Favorites or Bookmarks
These can be created for frequently-visited web pages, speeding up the process for accessing them. They are referred to as favorites by Microsoft Edge, and bookmarks by Google Chrome and Mozilla Firefox.
File Extension
The suffix at the end of a filename that indicates what type of file it is. 
Flash Drive
Also known as jump drives, thumb drives, pen drives, and USB keychain drives, they are small data storage devices that use flash memory and have built-in USB connections. They are typically no more than two to three inches in length and less than an inch in width. 
Focus
A Windows term used to describe the state when a window, dialog, menu, or control can receive keyboard input. For example, if a control can receive input from the keyboard, it is said to have focus.
Font
A specific typeface for printed and onscreen characters of a certain size and style. This may include attributes such as bold, italics and underlining, different sizes and colors. 
Footer
Text and/or images appearing below the bottom margin of each page in a Word document or Excel sheet when displayed on a screen or printed. Footers also typically appear on webpages, most often containing links to other important pages on the site, as well as copyright information. 
Forms 
The collective term encompassing the following elements that enable user interaction on web pages: edit boxes, combo boxes, buttons, checkboxes, and radio buttons. They may also be present on PDF’s. 
Frame
A rectangular area meant for inserting graphics, videos, and text. A frequently-encountered type of frame is an inline frame. It is a component of an HTML element that allows you to embed documents, videos, and interactive media within a page. They are often used for inserting advertisements. In such cases, they are rarely accessible to screen reader users.
Graphic
Term used to denote a picture, image, or decorative element appearing in a document or on a web page. 
Hard Drive
A device (usually within the computer case) that reads and writes information, including the operating system, program files, and data files 
Header
Text and/or images that are inserted above the top margin of each page in a Word document or Excel worksheet when displayed or printed. In email messages, the header is the part of a message that describes the originator, recipients, and message priority level.
Heading
Used to organize and format Word and PDF documents. On webpages, headings are HTML elements that should be used to create organization, structure, and semantic meaning. They can be defined at different levels to aid in logically outlining a document or organizing web page content.
Home Page 
Also referred to as a landing page, a page that serves as the starting point of a website. It is the default webpage that loads when you visit a web address that only contains a domain name. 
Hot Key
An assigned key or sequence of keys programmed to execute a command or perform a specific task in a software application. For example, in many programs the hotkey Control S can be used to quickly save a file.
HTML (Hyper Text Markup Language)
The computer coding language used to create webpages. "Hypertext" refers to the hyperlinks that HTML pages contain. "Markup language" refers to the way tags are used to define the page layout and elements on the page. 
HTTP and HTTPS
These acronyms stand for “Hyper Text Transfer Protocol” and "Hyper Text Transport Protocol Secure." This is the protocol used to transfer data over the web. HTTPS is similar to HTTP, but uses a secure socket layer for security purposes. Banking and investment websites, e-commerce websites, and most websites that require you to log in use the HTTPS protocol.
Icon
A graphic representation of an item that can be selected and opened, such as a document or program.
IMAP (Internet Message Access Protocol)
A method of accessing email messages on a server without having to download them to your local hard drive. This is the main difference between IMAP and POP3, which requires you to download messages to your hard drive before reading them. The advantage of using IMAP is that users can check their mail from multiple devices (computers and smartphones) and always see the same messages. In essence, this synchronizes your messages on all your devices.
Insertion Point
The point within a document at which text can be inserted or deleted. It is visually represented by a blinking vertical line within the document.
Internet
A network that connects computer systems across the world. It includes several high-bandwidth data lines that comprise the Internet "backbone." These lines are connected to major Internet hubs that distribute data to other locations, such as web servers and Internet Service Providers (see definition below). The Internet provides different online services, such as: the web – a collection of billions of webpages that you can view with a web browser; email – the most common method of sending and receiving messages online; social media – websites and apps that allow people to share comments, photos, and videos; online gaming – games that allow people to play with and against each other; and software updates – operating system and application updates that can be downloaded. 
ISP (Internet Service Provider)
Refers to a company that provides access to the Internet to both personal and business customers, making it possible for them to surf the web, shop online, and conduct business. They may also provide other services including email services, domain registration, web hosting, and browser packages. 
JAWS Cursor
Activated by pressing Num pad minus in desktop keyboard layout, it corresponds directly to the mouse pointer. 
Label
Term used to describe what a screen reader speaks when encountering actionable elements such as form fields, buttons, etc. 
Link or Hyperlink
A word, phrase, or image that you can click on to jump to a new web page, document, or a new section within the current document or webpage. Hyperlinks are found in nearly all web pages, allowing users to click their way from page to page. Text hyperlinks are often blue and underlined.
List View
A view containing multiple items such as files or folders, allowing users to select or open them.
Margin
The area of a page in a document between its edge and the main body of printed content. This includes the left, right, top and bottom margin. 
Maximize/Minimize
When maximized, the state of a window when it is enlarged to fill the entire screen. When minimized, it is reduced to an item on the Taskbar.
Menu Bar
The bar located along the top of many application windows, which contains command and settings groupings that sometimes expand vertically to list commands. 
Modal
A dynamically generated area of content created when additional information is presented upon activating an element on a web page. This generally appears as an overlay or pop-up on top of the original page. 
Modifier Key 
Refers to a special key that modifies the normal action of another key when pressed. For screen reader programs, and for computers that have these keys, these are the Insert key and the Zero key on the Number pad. The Caps lock key can also be programmed as a modifier key for screen reader programs. Other keys may be assigned as modifier keys for other types of applications. 
Mouseover
Mouseovers or On Mouseovers are used by web developers to display text or images when a sighted person moves the mouse pointer over a part of a page. This is also called “hovering” as in “the mouse hovers over.” These may be graphic links with product information, word definitions, tool tips, or other supplementary information. They are often inaccessible although JAWS has a feature to access them. 
Multi-Page Dialog Box
A dialog box with multiple pages (or tabs) allowing related settings to be grouped on each page. Press Control Tab or Control Shift Tab to switch between the pages.
Navigation Bar 
A user interface element within a webpage that contains links to other sections of the website. In most cases, the navigation bar is part of the main website template, which means it is displayed on most, if not all, pages on the website. Regardless of what page you are viewing, you can use it to visit other pages on the site. 
Network
A collection of computers that are connected 
Notifications
Alerts that suddenly appear on the screen, commonly used to inform a computer user about updates, queries for changing settings, and possible technical problems. They may be generated by websites via browsers or applications installed on the computer. 
PC Cursor
A JAWS term, the main focus of the active program. It can be seen visually, usually represented by a caret, arrow, or other symbol, and is limited by the window currently in focus. The PC Cursor is used when navigating menus and dialogue boxes, editing or reading documents, and most functions that do not directly involve the use of a screen reader program. 
PDF (Portable Document Format)
A file format developed by Adobe Systems to present documents consistently across multiple devices and platforms. Now an open standard, it is one of the most widely used formats for saving and exchanging documents.
Pop-Up
A window that automatically opens without the user selecting a new window from a program's menu. They are often generated by websites that include advertisements. 
Processor
Also referred to as a microprocessor, it is a small chip residing in computers and other electronic devices. It receives input and provides the appropriate output. Modern processors can handle trillions of calculations per second.
Radio Button
Found both on web pages and in dialog boxes, these are used for choosing a single option from a small number of choices. 
Random Access Memory (RAM)
Hardware in a computing device where the operating system, applications, and data in current use are kept so they can be quickly reached by the device's processor. RAM is the main memory in a computer. The amount of RAM in a device determines how much memory the operating system and open applications can use. When a device has sufficient RAM, several programs can run simultaneously without any slowdown. When a device uses close to 100% of the available RAM, memory must be swapped between applications, which may cause a noticeable slowdown. 
Recycle Bin
A Windows folder that stores deleted files until you permanently delete them. Files and folders can be retrieved from here before permanently deleting them, providing an additional layer of protection against accidental removal from your computer.
Refresh (or Page Refresh)
Occurs when new content is downloaded and causes a change to a webpage. Sometimes the user can control it by pressing F5, but sometimes the site owner controls refreshing frequency.
Rich Text Format (RTF)
A file type that supports text formatting such as bold, italics, and underlining, as well as different fonts, font sizes, and colored text. Most word processors, including Microsoft Word, can create rich text documents. If you save a document in a program's native format, it may only open with the program that created it. However, if you save a document in the generic Rich Text Format, it keeps most, if not all the text formatting. It can then be opened by other word processing programs such as WordPad and Pages on a Mac.
Router
A hardware device that “routes” data from a local area network (LAN) to another network connection. A router allows only authorized machines to connect to other computer systems. Most routers also keep log files about local network activity.
Search Engine 
A tool that indexes millions of websites so that computer users can find the site they are searching for after typing in a few keywords. Google, Bing, and Duck Duck Go are some of the most popular search engines.
Solid State
At its most basic level, this means there are no moving parts. Solid state hard drives are made up of solid components that do not move, while many other computers have disk drives that spin and require a fan to prevent overheating. 
Sound Card
A component inside a computer that provides audio input and output capabilities. Most sound cards have at least one analog line input and one stereo line output connection. The connectors are typically 3.5 mm minijacks, the size most headphones use. 
Spreadsheet
A document that stores data in a grid of horizontal rows and vertical columns. Rows are typically labeled using numbers, while columns are labeled with letters. Individual row/column locations, such as C3 or B12, are referred to as cells. Each cell can store a unique instance of data. The row/column structure allows data to be analyzed using formulas and calculations.
Start Page
The first page you land on when opening a web browser. Within individual browser programs, users can set this as a new tab or a specific page.
Status Bar 
A small area at the bottom of a window used by some applications to display helpful information. For example, in your Documents folder, the Status bar displays the number of items in the folder and how many items are selected. In a Word document, it indicates the current page location and the total number of pages in the document.
Streaming 
Commonly used with audio and video, streaming refers to web-based multimedia files that can be played back without being completely downloaded to your device first. 
System Tray (also referred to as the Notification Area)
Located in the Windows desktop user interface in the lower right area, it displays a series of icons for certain programs, as well as some important computer settings, including speaker volume, network connectivity status and battery level for laptop computers. 
Tabbed Browsing 
A web browser feature in which several websites may be opened in one window, versus opening each of them in an individual window. It allows a user to cycle through web pages opened during a session. Visually, tabs display in a row at the top of a browser window and include short titles for identifying them.
Tab Order
The order in which items on a web page are brought into focus when using the Tab Key for navigation. 
Taskbar 
The bar that spans the bottom of the screen in Windows. It contains the Start button on the left side and the System Tray on the right. It also includes the current time on the far right side and can hold labels to programs directly to the right of the Start button. Most of the Taskbar, however, contains titles for open windows. Whenever you open a program or window, it shows up in the Taskbar. When you click on a window title in the Taskbar, that window will become active and appear in front of other open windows. You can also cycle through the Taskbar items by holding the Alt key and pressing Tab a few times.
Title Bar
A small strip that extends across the top of a window. It displays the title of the window and typically includes the close, minimize, and maximize buttons. In Windows, these buttons are on the right side of the screen.
Toolbar
A set of icons or buttons that are part of a software program's interface or an open window. When part of a program's interface, toolbars typically sit directly under menu bars. Toolbars can also reside within open windows. For example, web browsers include a toolbar in each open window with items such as back, forward, and home buttons, and address fields.
Touchpad
Also known as a trackpad, it is a flat control surface used to move the cursor and perform other functions on a laptop computer. They replace the functionality of a mouse and are designed to be controlled with your fingers. By sliding a fingertip along the surface, you can move the cursor on the screen. Some touchpads have two physical buttons below them, which correspond to the left-click and right-click mouse buttons. 
Tree View 
A graphical control element that presents a hierarchical view of information. Each item, or level, can have a number of subitems, or lower levels (expressed as level one, two, three, etc.). An item can be expanded to reveal subitems, if any exist, and collapsed to hide subitems. These are most commonly encountered in file manager and email applications, where they allow the user to navigate the folder and file system directories. 
Two-Factor Authentication 
A security measure requiring two forms of authentication to access an account. It often works in combination with a username and password to add an extra level of security. Common types of two-factor authentication include: a four to six-digit code sent via text message to the user's mobile phone; a one-time code sent via email to the user's email address; an additional PIN or passcode required in addition to a username and password; or a secret question and answer created by the user.
Uploading
Transferring data from a computer to the Internet. It is the opposite of downloading. 
URL (Uniform Resource Locator)
The address of a page or file on the Internet, consisting of three elements. For the Carroll Center Store’s URL, which is https://carroll.org/store/, these are: https:// – the URL prefix, which specifies the protocol used to access the location; carroll.org– the domain name or IP address of the server; and /store/ – the path to the page or file on the site.
USB (Universal Serial Bus)
The most common type of computer port used in today's computers. They are used for connecting keyboards, mice, game controllers, printers, scanners, digital cameras, removable media drives, and other external devices.
Virtual Cursor
A JAWS term, this is a special cursor used only in specific programs, the most common being web browsers and PDF viewers like Adobe Acrobat Reader. When the Virtual Cursor is active, text cannot be edited. However, text can be selected and copied to the clipboard, and links can be activated by pressing Enter.
Virus 
A deliberately harmful computer program designed to create annoying glitches or destroy data. 
Virtual Viewer
In JAWS, a message window providing helpful information. Help messages can be accessed for lists of JAWS and Windows keystrokes, Screen-Sensitive Help, and several types of informational messages In Microsoft Office applications 
Web Content Accessibility Guidelines (WCAG)
Part of a series of guidelines published by the Web Accessibility Initiative of the World Wide Web Consortium (W3C), the main international standards organization for the Internet. They are a set of recommendations for making Web content more accessible, primarily for people with disabilities.
Web Server 
A computer system that hosts websites. It runs software that provides access to hosted webpages over the Internet. Most web servers are connected to the Internet via a high-speed connection.
Window
An area on the screen that displays information for a specific program. This often includes the user interface as well as the program content. They are used by most applications as well as the operating system itself. A typical window includes a title bar along the top that describes the contents of the window, followed by a toolbar that contains user interface buttons. Most of the remaining area is used to display content.
Windows Settings
The Windows Settings app is a part of the operating system first introduced in Windows 8, and included in later versions of the operating system. It is the central location for customizing, configuring, and updating the operating system.
World Wide Web
Or “web” for short, is an interconnected system of public webpages accessible through the Internet. It is not the same as the Internet, but is one of many applications built on top of the Internet. First proposed by Tim Berners-Lee in 1991, it consists of several components: the HTTP protocol governing data transfer between a server and a client; a unique universal identifier, called a URL (uniform resource locator); use of the HTML (hypertext markup language) format for publishing web documents; and linking, or connecting documents and resources through hyperlinks.
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This appendix presents a set of step-by-step exercises to practice your skills in Windows and file management, the Microsoft Office Suite of programs, and web browsing. Some of them refer to files contained in the Practice files folder that accompanies this book. 
Windows and File Management
Using File Explorer to Navigate the Folder Structure
Refer to Chapter 2.6.1 for information related to this exercise.
1. Open File Explorer by typing in the first few letters of “This PC” in the search box, and then pressing Enter. 
1. Right arrow to your C drive and identify its associated first letter. If Right arrowing does not work, Down arrow instead. Depending on your computer model, the name may be OS C, local drive C, or Windows C. After navigating to it, press Enter to go down one level.
1. Press U for users and press Enter.
1. Up or Down arrow to your user folder name and press Enter.
1. Down arrow to documents and press Enter.
1. Press Alt Left arrow or Backspace to go back up through the folder hierarchy path you just traveled. 
1. This time, using first-letter navigation, repeat the above steps and navigate to your music folder and press Enter.
1. Press Alt Left arrow or Backspace out of music, navigate to Downloads and press Enter.
1. Backspace out of downloads, navigate to Documents and press Enter. 
[bookmark: OLE_LINK1]Desktop Shortcuts for Programs and Folders
Refer to Chapter 2.8.1 for information related to this exercise.
1. Add shortcuts to the Desktop for the following programs: Word, Outlook, Excel, PowerPoint, and Adobe Acrobat Reader. If shortcuts are already present, delete them first.
2. Navigate to your user folder and create desktop shortcuts for the Documents and Downloads folders.
3. Rename these folders using the F2 key, deleting “- shortcut.” 
4. Navigate to a file you think you may frequently access and create a desktop shortcut for it. 
Quick Access Toolbar
Refer to Chapter 10.3.2 for information related to this exercise.
1. In Outlook, delete the existing shortcuts on the Quick Access toolbar that you don’t want to keep.
2. Also in Outlook, create a shortcut key assignment for emptying the Deleted items folder. Find it in the Customize toolbar submenu.
3. Also in Outlook, create a shortcut key assignment for the Arrange by button. Find it in the View tab of the ribbon.
4. In Word, delete the existing shortcuts on the Quick Access toolbar that you don’t want to keep. 
5. Also in Word, create a Quick Access shortcut key for Email document (find it in the Customize toolbar submenu), and any other commands you wish to add to the Quick Access toolbar (most useful are commands that you have difficulty remembering, or ones that you frequently use but require a significant number of keystrokes to execute). 
6. In Excel, delete the existing shortcuts on the Quick Access toolbar that you don’t want to keep. 
7. Also in Excel, create a Quick Access shortcut key for Email document (find it in the Customize toolbar submenu), and any other commands you want.
Microsoft Word
This section includes a set of exercises you can follow to practice a number of the formatting procedures laid out in Chapters 3 and 9. Use the document entitled “Daily Training Journal.docx,” contained in the zip file. 
Basic Formatting
Refer to Chapter 3.2 for information related to basic formatting, Chapter 9.1 on spellchecking, and Chapter 3.3 on adding headers, including page numbers.
1. Open the file entitled Daily Training Journal.docx.
2. Press F12 and resave the file with a new name. This way, the original document will be retained so you can go back to it and practice more, if you like. At the same time, you won’t lose any work you do on this new document. 
3. Spellcheck the document. It intentionally has many spelling errors. 
4. Select all of the text with Control A and change the font to Arial, regular, 12 point, color automatic.
5. Select all the text and open the Paragraph dialog box. Make the following changes: Left-align the text; indent the first line of every paragraph by 0.5 inches; change the Before and After paragraph spacing to 0 point; and change the line spacing to double.
6. Change the margins to moderate. This corresponds to dimensions of one inch top and bottom, and 0.75 inches left and right. If using JAWS, Press Insert F1 to verify that you have correctly changed the margins.
7. Add page numbering to the document as a right-aligned header.
8. Resave the final updated version of the document.
Headings and Styles
Refer to Chapter 3.5 for information on this topic.
1. In the same file saved from the previous exercise, add appropriate headings (title as level 1, weeks as level 2, days as level 3) for the entire document.
2. Change the heading 1 style to Arial 16 point, bold, and centered, color automatic. Also change the Before paragraph spacing to 0 point. Don’t forget to select the line of text for this and other headings in this exercise before making these changes. Otherwise, the changes will not take effect.
3. Update the heading 1 style.
4. Change the heading 2 style to Arial 14 point, bold, left justified, color automatic. Also change the Before paragraph spacing to 0 point.
5. Update the heading 2 style for the entire document.
6. Change the heading 3 style to Arial 13 point, italics, color automatic. Also change the Before paragraph spacing to 0 point.
7. Update the heading 3 style for the entire document.
8. Change the normal body text font to Arial 12 point, and change special to first line to indent the first line of every paragraph by 0.5 inches.
9. Update the normal text style for the entire document.
10. Save the document.
Bulleting, Numbering, Bookmarks, and Comments
Refer to Chapter 3.4 for information related to bulleting and numbering, Chapter 3.8.4 on bookmarks, and Chapter 9.4.1 on comments. 
1. Navigate to Week 3, Day 4. Here you will find a list of PowerPoint topics covered during the training program. 
2. Create a bulleted list beginning from “reading presentations” to “slide transitions.”
3. Navigate to Week 3, Day 5 where you will find a list of Windows 10 topics covered during the training program. 
4. Create a numbered list of these topics from “screen elements” to “JAWS hot keys.”
5. Add four bookmarks to the document.
6. Now delete one of the bookmarks so only three remain. 
7. Add four comments to the document. Note that comments are covered in Chapter 9, not in Chapter 3.
8. Delete one of the comments so only three remain. 
9. Save the document.
Editing and Proofreading 
1. Run Spellcheck a final time.
2. If you are a JAWS user, run the JAWS Text Analyzer tool (see Chapter 9.2.1) to identify punctuation errors and correct them. If you are an NVDA or Narrator user, refer to Chapter 9.2.2 and use the Find and replace command to correct for extra spaces between words and also stray punctuation. 
3. If you are a JAWS user, set the JAWS Speech and Sounds Scheme (see Chapter 9.3.1) to Classic, Attributes, and Font Info, and check for correct formatting (remember to return to the default Classic scheme when finished). If you are an NVDA user, use the Document Formatting tool to do this (see Chapter 9.3.2). If you are using Narrator, use the Verbosity Level tool to proofread formatting (see Chapter 9.3.3). 
4. Determine the word count (see Chapter 3.8.8).
5. Save the document a final time. 
Microsoft Outlook 
These exercises draw on topics covered in Chapter 4. 
Attachments
1. Find a message in your inbox with a single attachment, and open it without saving it. 
1. Close the file and now save it to your documents folder using the copy and paste method for saving. 
1. Find a message in your inbox with multiple attachments, select all the attachments, and copy them to the clipboard. 
1. Create a folder in your documents folder entitled “Practice.”
1. Paste all the files into that folder. 
1. Prepare a message to yourself, and attach a file to the message using the copy and paste method.
1. Send the message.
Custom Folders 
1. From your Inbox, create a folder entitled “Practice.”
2. Go to the tree view with Control Y and verify that it is located at level 2, to the right of the Level 1 Inbox.
3. Return to the Inbox and copy several messages into the practice folder from here.
4. While in this practice folder (again, it should be at level two in the tree view), move it to level one of the tree view (hint: use the Move command in the Lower ribbon of the Folders tab). 
5. Navigate into the practice folder and delete it. 
6. Create several folders at level two of the tree view that you will use in the future and move several messages into them from your inbox.
Calendar
1. Either by navigating to one of the Calendar views, or using the Control Shift A shortcut keystroke, create three appointments for yourself. Make each of them between one and two hours long.
1. Using the Control Shift Q shortcut, create a fictitious meeting, calling it “Practice Meeting.” Invite several friends. In the body of the email, ask them if they know how to use the Outlook Calendar, and if so, request they send you a second practice meeting invitation. 
1. If you are fortunate enough to receive a meeting invitation, accept it.
1. Create another practice appointment, and make it a recurring appointment that meets at the same time every week for the next 10 weeks.
1. After completing all the steps above, delete all fictitious appointments and meetings from your calendar.
1. If you have any upcoming real-life appointments, add them to your calendar.
Microsoft Excel
The following two exercises use the file entitled “Quarterly Sales by Employee.xlsx,” which is contained in the zip file accompanying this book. The file contains quarterly sales data for employees in five electronics stores in the Boston area. Before starting the exercises, arrow around a bit to get familiar with the worksheet. The first exercise is about filtering and creating multiple worksheets. See Chapter 5.5 and 5.6 on these topics. The second exercise is about pivot tables. This topic is covered in Chapter 5.7. 
Remember to save your work early and often. Save the file to your computer with a new name so that the original file remains unchanged. For the initial save, use F12 to open the Save as dialog box. For all subsequent saves, just press Control S. 
Filtering and Multiple Worksheets 
1. Open the Excel file entitled “Quarterly Sales by Employee.xlsx.”
2. Place your cursor on one of the column headers and turn on filtering using the key combination Control Shift L.
3. First, filter by store, choosing the Watertown store only.
4. Second filter by product, choosing just HP laptops.
5. Insert a new worksheet. If you are using JAWS, do this with the multi-sheet context menu (shift insert S opens it). Otherwise, use the Windows shortcut key Shift F11. 
6. Go back to the initial sheet, select the entire sheet with Control A and copy it with Control C.
7. Go to the new blank sheet, make sure your cursor focus is in cell A1, and paste the data by pressing Control V.
8. Rename the new sheet as “HP Sales for Newton.” If you are using JAWS, do this with the multi-sheet context menu (shift insert S opens it). Otherwise, use the ribbon shortcut key Alt H O R.
9. Return to the initial data sheet and now filter for just the Watertown store. 
10. Repeat steps five through nine above, but rename the new sheet as “HP Sales for Watertown.”
11. Repeat the above steps to create new sheets for Quincy, Boston, and Cambridge.
12. If using JAWS, In the multi-sheet context menu, use the Move or copy command to reorder the sheets, with the initial data sheet as the first sheet, and the store sheets alphabetically ordered after it. If using NVDA or Narrator, use the ribbon shortcut key Alt H O M.
13. Return to the initial worksheet and turn off filtering.
14. Save your work one last time. 
Pivot Tables 
1. Open the Excel file entitled “Quarterly Sales by Employee.xlsx.”
1. Delete row 1 by pressing Alt H D R With your cursor in this row. This will simplify data selection in subsequent steps. 
2. Select all the date in the worksheet by pressing Control A.
3. Open the Upper ribbon, Right arrow once to the Insert tab, Tab once to the Pivot table button in the Lower ribbon, and press Enter. 
4. Press Enter again which lands you in cell A3 of a new sheet. 
5. Press F6 twice to navigate to the Pivot table field pane, and Tab once to the list of column headers. Here you will build your first pivot table on sales by store, with stores serving as row labels and sales as values. 
6. To do this, Down arrow to store, press the Applications key, Down arrow to Add to row labels, and press Enter. This will return you to the list of variables and the stores will now be checked.
7. Down arrow to sales, press the Applications key, Down arrow to Add to values, and press Enter. 
8. Press F6 several times until you land in the newly created pivot table and examine your work. Store names should be contained in column A beginning in cell A4. Corresponding sales by store should be calculated in column B, including a grand total at the bottom of the column. 
9. Rename this sheet as “Sales by Store.”
10. Return to the initial data sheet where all the data remain selected. 
11. Repeat steps 4 through 9, this time creating a pivot table for sales by store and quarter. To do this, store will be the row label, quarter will be the column label, and sales will be the value. 
12. Rename the sheet as “Sales by Store and Quarter.”
13. Create any other pivot tables you wish. Examples could be sales by product and quarter, quantity by product, quantity by product and store, and quantity by store and quarter.
14. Also try filtering by store, quarter, and/or product. 
Microsoft PowerPoint 
Refer to Chapter 6 for information related to this exercise. 
Preparing a Presentation
1. Prepare a presentation with eight to ten slides on a topic of your choice. Incorporate the following elements in your presentation.
2. A title slide with the title of your presentation in the Title placeholder and your name and date of the presentation on separate lines in the Subtitle placeholder. 
3. A second slide in title and content format. Insert a short slide title in the Title placeholder and three or four bullet points in the Object placeholder. 
4. Insert at least two pictures in your presentation. For at least one of these slides, use the two content slide type. If you don’t have any pictures on your PC, use the files from the zip file entitled “Businesswoman points at white board in front of colleagues.png” and “Smiling blind Woman with Sunglasses at Massachusetts state House Advocacy Event.jpg."
5. Add alt text to each picture. Use variations on their filenames as your alt text.
6. Insert at least one comparison slide in the presentation. 
7. Insert at least one other slide type in your presentation. 
8. Insert a slide with an audio clip into one of your slides. If you don’t have any short audio files on your PC, use the file from the zip file entitled “Crunch Noises.mp3."
9. Insert a slide with a video clip into one of your slides. If you don’t have any short video files on your PC, use the file from the zip file entitled “Carroll Center Campus Promo.wmv."
1. In the Thumbnails pane, move at least two slides to another position in the order of the slides. 
10. Change the theme to one of the recommended ones in the PowerPoint chapter. These include organic, parallex, slate, vapor trail, or woodtype.
11. For two slides, add notes in the Notes pane.
12. Choose the click sound transition and make it the same for all your slides. 
13. Press F5 to open the presentation in Slide show view and hear the text of the Title slide. Press the Spacebar to read each subsequent slide, one by one.
Web Browsing
Hyperlinks
Refer to Chapter 7.10.1 for information on this topic. 
1. From a new tab in your chosen browser, search for the following web pages, navigate to them, copy and paste their URLs in a Word document, and give the hyperlinks appropriate labels:
· American Foundation for the Blind.
· National Federation of the Blind.
· American Council of the Blind.
2. In YouTube, search for three of your favorite songs, copy and paste their URLs in an Outlook message, give the hyperlinks meaningful labels, and send them to a friend.
Favorites/Bookmarks
Refer to Chapter 7.7 for information on this topic. 
1. Create a folder called “Favorites” or “Bookmarks.” If you already have an account set up in Dropbox or OneDrive, create it there. Otherwise, create it in your Documents folder. 
2. Create a desktop shortcut for this folder. 
3. In this folder, create two subfolders entitled “Blindness Organizations” and “Songs.”
4. Using the process outlined in Chapter 7.7, in the Blindness Organizations subfolder, create favorites/bookmarks for the three blindness organizations listed in the hyperlinks exercise above. 
5. In the Songs subfolder, create favorites/bookmarks for the three songs for which you created hyperlinks in the previous exercise.
6. Create an additional five favorites/bookmarks for web pages you think you may visit again in the future. 
Desktop Shortcuts
Refer to Chapter 7.8 for information on this topic. 
1. Create desktop shortcuts via the Google Chrome More tools submenu for the three blindness organizations listed in the exercise on hyperlinks.
2. With either Edge or Firefox, create three additional desktop shortcuts using the universal method outlined in Chapter 7.8.2.
3. Delete whichever of these desktop shortcuts you don’t want to keep. 
Placemarkers with Jaws and NVDA
Refer to Chapter 7.10.2.1 and 7.10.2.2 for information on this topic for JAWS and NVDA, respectively. 
1. Go to google.com and perform a search.
1. Create permanent placemarkers for the two level two headings entitled “Search Results” and Web Results.”
1. Go to the Carroll Center for the Blind home page at: carroll.org.
1. Create permanent placemarkers for the level two heading entitled “Who We Serve” and the level three heading under it entitled “Adults.”
1. To test this out, if using JAWS, press K to quickly navigate to them. If using NVDA, press Insert K.
Extended Text Selection and Paste Text Only
Refer to Chapter 3.8.6 for information on Extended text selection with JAWS and NVDA. Refer to Chapter 3.8.7 for information on Paste text only.
1. Identify a blindness-related topic you would like to know more about. Possible examples could be: employment resources for the blind; accessible technology for the blind; overview of eye-related diseases; or disability-related policy under the Biden administration.
2. Perform a Google search on your chosen topic. 
3. Find an interesting article on your topic and copy and paste the text into a Word document using Extended text selection and Paste text only to paste it into your Word document. 
4. Use Find and replace (Control H) to remove any unwanted hard paragraph returns (refer to Chapter 7.10.3).
5. Save the file.
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